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Introduction

Thank you for purchasing the TOC-VCPH/TOC-VCPN Total Organic Carbon Analyzer and 
the TOC-Control V software.

This instruction manual is a TOC-V user manual. It provides operation and maintenance 
procedures for the TOC-V. The procedures related to TOC-Control V software system 
administration are described in detail in the TOC-V Administrator's Manual.

Be sure to read this documentation carefully before using the instrument for the first time. 
Read the Operational Precautions before operating the instrument. Follow the procedures in 
the manual to avoid compromising user or instrument safety.

CAUTION
• Do not operate this instrument before understanding the contents of this manual.
• If this manual or the warning labels on the instrument become lost or damaged,

promptly obtain replacements from your Shimadzu representative.
• To ensure safe operation, read and follow the procedures in Section 1.2 "Opera-

tional Precautions" before operating the instrument. 
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Product Warranty and Post Sale Service

Product Warranty

The warranty does not cover malfunctions that result from:
•   misuse

•   repairs or modifications made by any company other than the manufacturer or a 
manufacturer-approved company

•   external factors

•   operation in environments with severe conditions, such as high temperature, high 
humidity, corrosive gas, or vibration

•   fire, earthquake or other forces of nature

•   moving or transporting the unit after its initial installation

•   the consumption of items or parts that can be regarded as consumable. For 
example, the service life of an LCD display panel depends on actual operating 
conditions.

Post Sale Service

If any problems occur with this instrument, inspect it and take appropriate corrective action 
as described in Section 5.7 "Troubleshooting". If the problem persists or symptoms not 
covered in the Troubleshooting section occur, contact your Shimadzu representative.
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Contents of This Manual

Chapter 1 Overview

This chapter provides an overview of the instrument and operational precautions for its use.

Chapter 2 System Description

This chapter describes the TOC-V system components and optional accessories.

Chapter 3 Software Overview, Administration, and Setup

This chapter provides an overview of the TOC-Control V software and describes the 
software’s Administration and Instrument Setup Wizard tools, which are used to manage 
user accounts and configure new systems.

Chapter 4 Operation

This chapter describes pre-analysis preparations and instrument and software functions, 
such as setting measurement parameters, starting up the instrument, generating calibration 
curves, and conducting sample analysis. This chapter also includes a tutorial that covers 
setup and measurement procedures.

Chapter 5 Maintenance

This chapter describes maintenance procedures and periodic checks required to ensure that 
the instrument provides consistently high accuracy analyses. Troubleshooting procedures 
and error messages are also included in this chapter.

Chapter 6 Reference Information

This chapter describes principles of analysis and lists specifications, standard and optional 
accessories, and specialized terms associated with this instrument. This chapter also 
includes the installation procedure, for use in the event that instrument is moved to another 
site.

Appendix A Method Validation

This appendix describes the software’s Method Validation tool, which is used to test the 
variance and linearity of a data set.

Appendix B Control Charts

This appendix describes the software’s Control Charts tool, which is used to monitor the 
precision and accuracy of a data set.
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Notation Conventions 

Precautionary Conventions Used in this Manual

The following precautionary conventions are used in this manual.

Other Conventions Used in this Manual

Instrument Model Names

Descriptions in this documentation pertain to two models of the TOC-V Total Organic 
Carbon Analyzer, namely the TOC-VCPH and TOC-VCPN. These models will be referred to 
in relevant descriptions as the H Type and N Type, respectively.

Supplementary Conventions

In addition to the precautionary conventions, the “Tips” and “Reference” conventions are 
used to supply additional information.

Convention Description

CAUTION Indicates the possibility of slight to moderate injury or equipment dam-
age.

Note: Provides additional information to ensure the correct use of the instru-
ment. 

Convention Description

TIP » Indicates a particular technique, alternative means of operation, or useful advice.

Reference: Indicates a reference location in the manual where more detailed information can 
be found.
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Warning Labels Used on this Instrument

High Temperature Warning

When the electric furnace is heating up, or is at its operational temperature (680°C or 
720°C), the central portion of the electric furnace is extremely hot. To prevent burns, 
NEVER touch the electric furnace area with bare hands. Allow the furnace to cool before 
performing any maintenance on the combustion tube or catalyst.

The internal temperature of the ozone treatment unit reaches 50°C while the instrument is 
running. To prevent burns, switch off the TN unit and wait at least 2 hours for the unit to 
cool sufficiently before performing any maintenance. 
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Electric Shock Warning

Do not remove this panel, as there is danger of electric shock.

Due to the danger of electric shock, do not remove this cover. In the event that the cover 
must be removed, first disconnect the TNM-1 power cord.
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Injury Warning

The sample injection components of this instrument move during operation. To prevent 
injury, keep hands away from this mechanism.

During operation, the pressure in the CO2 absorber of the gas purifier is about 200kPa. To 
prevent injuries, turn off the carrier gas and switch off power to the TOC main unit. Wait 
until the pressure inside the container and the instrument flow lines return to normal 
atmospheric pressure before performing any maintenance.
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Corrosion Warning

Acid and other corrosive substances are present in the liquid waste drained from this 
instrument. Be careful not to touch or spill the liquid waste.

The soda lime in the CO2 absorber of the carrier gas purifier is a corrosive chemical 
substance. Be careful not to touch or spill this substance. 
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The liquid discharged from the drain tube connected to the TC injector contains acid and 
other corrosive substances. Verify that the tip of the drain tube is securely inserted into the 
Y-shaped fitting when connecting the combustion tube and sample injector.

The IC reaction solution is acidic. Be careful not to touch or spill the IC reaction solution.
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Hydrochloric acid is a corrosive chemical substance. Be careful not to touch or spill the 
hydrochloric acid.
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1Overview
This chapter provides an overview of the instrument and operational precautions for its 
use.

1.1 Overview

Provides an overview of the TOC-VCPH/TOC-VCPN instrument.

1.2 Operational Precautions

Lists precautions necessary to ensure that the instrument is used correctly.
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1.1  Overview

The TOC-VCPH/TOC-VCPN (hereinafter referred to as TOC-V) instrument measures the 
amount of total carbon (TC), inorganic carbon (IC) and total organic carbon (TOC) in 
water. Purgeable organic carbon (POC) can also be measured when the POC accessory is 
installed. “Oxidative combustion-infrared analysis” is a widely-used TOC measurement 
method that has been adopted by the JIS1 and other international standards. The TOC-V 
instrument can also measure total water-borne nitrogen (TN) if the optional TN unit is 
installed. TN is measured using the principles of “oxidative combustion-
chemiluminescence.”

Moreover, when the ASI-V Autosampler or OCT-1 8-Port Sampler is used in combination 
with the main unit, a fully automatic system is created, allowing automatic analysis of 
multiple samples.

This instruction manual covers both the TOC-VCPH and TOC-VCPN models. These models 
will be referred to in relevant descriptions as the H Type and N Type, respectively.

Read this user manual carefully before using the TOC-V instrument to ensure its proper 
use. The manual should be stored in a convenient location for future reference.

CAUTION
Safety may be compromised if the instrument is used in a fashion other than that
indicated in this user manual. Pay particular attention to the CAUTION sections
to ensure safety when using the instrument.

1. JIS K-0102 "Industrial Waste Water Testing", JIS K-0551: "Total organic carbon (TOC) testing methods for 
ultra-pure water", U.S. Pharmacopoeia, EPA 415.1, EPA 9060A, ASTM D2575, Standard Methods for 
Examination of Water and Waste Water 5310B
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1.2  Operational Precautions

Take the following precautions when using this instrument.

CAUTION
• Do not touch the electric furnace while it is heating.  The center of the electric furnace 

(near the combustion tube insertion opening) reaches very high temperatures, and burns 
may result.  <Burn prevention>

• To prevent high sensitivity catalyst from being forced upward in the combustion tube, 
verify that carrier gas is flowing when heating the electric furnace.  <Prevents the 
floating of high sensitivity catalyst>

• Allow the electric furnace to cool to room temperature before removing or exchanging 
the combustion tube.  Burns may result if this procedure is attempted when the furnace 
is at a high temperature.  <Burn prevention>

• Do not heat the electric furnace without the combustion tube installed.  Parts employed 
by the TC injection port (slider block assembly) will be exposed to radiant heat from the 
center of the electric furnace and may be deformed. If the furnace must be heated with-
out a combustion tube installed, first remove the TC injection port parts to prevent 
deformation, or close off the furnace core opening with a heat-insulating material such 
as quartz wool.  <Part damage prevention> 

• To reduce back pressure, verify that the external drain tubing connected to the waste 
port on the right side of the instrument does not touch the surface of the liquid in the 
waste container. The height of the external tube must always be lower than the height of 
the drain port. Excessive back pressure will result in insufficient drainage and waste will 
overflow inside the instrument.  <Part corrosion prevention>

Figure 1.1  External Drain Tubing

• Hand tighten the various connectors to the 8-port valve.  Use of a tool may cause 
deformation and leakage in the valve.  <Part damage prevention> 

Drain tubing (Tubing
placement should be as 
indicated by the solid line.)

Drain container
(Supplied by user.)

TOC-V
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• Stop operation of the instrument when performing maintenance on any of the drive 
components, such as connecting lines to the 8-port valve, or connecting/disconnecting 
lines on the sample injector.  If these parts are manipulated or if the lines are 
disconnected during operation, the drive component could move and cause injury or 
discharge of liquid.  <Injury prevention, corrosion prevention>

• To shut down the instrument, first select “Shut down instrument” in the TOC-Control V 
Standby window. Refer to Section 4.3.3 "Ending Measurement" for more information.  
The electric furnace turns off and, after 30 minutes, the power supply shuts off.  This 
shutdown process extends the life of the TC injection port parts by preventing 
unnecessary wear.  This procedure does not apply to emergency shutdown.  
<Maintaining durability of TC injection port parts>

• The lever of the 3-way valve at the bottom of the IC reaction vessel should normally be 
turned to the left position. Refer to Figure 1.2 "Lever Position of 3-Way Valve on the IC 
Reaction Vessel". The lever should never be turned to the lower position.  The lower 
position allows carrier gas to flow at a pressure of 200kPa upstream from the 3-way 
valve, causing possible disconnection of joints and damage to parts such as the 
combustion tube.

Figure 1.2  Lever Position of 3-Way Valve on the IC Reaction Vessel

• To use the ozone generator of the TN unit, verify that air is supplied at a rate of 0.5 L/
min to the ozone air source flow meter inside the instrument. Refer to Figure 2.5 "Inside 
Front View".  Turn ON the ozone generator.  This prevents ozone leaks and line 
corrosion.  <Ozone leak prevention, line corrosion prevention>

• If ozone odor is detected during operation of the TN unit, stop the gas supply by turning 
the ozone generator OFF, and contact your Shimadzu representative to request 
maintenance.  Ozone can cause respiratory organ injury and equipment damage. 
<Prevention of injury to respiratory organs and equipment damage>

• To shut down the TN unit, turn the ozone generator OFF at least 3 minutes prior to 
switching OFF the TN unit power to stop ozone generation.  This prevents ozone leaks 
and line corrosion.  <Ozone leak prevention, line corrosion prevention>

Carrier gas is discharged
to the front of the IC
reaction vessel. (Turn
the lever to this position
only when detaching an
IC reaction vessel that
contains liquid.)

Never turn the lever
to this position.
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• The optional POC measurement circuit incorporates a carbon dioxide (CO2) absorber 
packed with lithium hydroxide for removal of carbon dioxide gas.  Misuse of lithium 
hydroxide can cause bodily harm.  During packing or replacing the CO2 absorber 
container, exercise adequate precaution.  After use, treat the material as industrial waste.  
The properties and handling guidelines for lithium hydroxide are described in the mate-
rial safety data sheets (MSDS) in Section 6.9 "Material Safety Data Sheets". 

• To clean the instrument, wipe the surface with a soft cloth moistened with water.  Do not 
use chemicals. 

• Repairs to the inside of the instrument can be dangerous.  Contact your Shimadzu 
representative to have a trained service engineer perform repairs. 

• Do not disassemble or modify the instrument beyond the scope of the maintenance 
procedures described in this manual, as safety may be compromised.

• The construction of the instrument is not explosion-proof.  It must not be used in 
dangerous areas.

• Use the instrument with a power supply of AC 100-127V ±10% (100V systems) or AC 
220-240V ±10% (200V systems).

• The instrument backup battery will last for approximately one year. Connection to a PC 
may not be possible if the instrument has been idle for more than one year. If this is the 
case, turn the instrument power ON for at least 30 seconds, then turn the instrument 
power OFF for 10 seconds and back ON again.
If the instrument usually remains idle for extended periods, turn the instrument power 
ON for 24 hours once every six months.

• Do not use the following characters when naming files or systems to be saved:
/ ,  . \ (back slash) : ; (these are all normal-width characters), space (normal width, em 
width)

• Turn OFF the Power Management function of the PC to prevent shutdown of the PC 
power while it is controlling the TOC analyzer. A shutdown of this nature would 
adversely affect performance. 

• Hand-tighten the connectors to the 8-port valve of the 8-port sampler. Over-tightening 
with a tool may exert excessive force to the internal valve body, causing deformation 
and internal leakage. <Part damage prevention<

• Shut down the instrument before connecting or disconnecting tubing to the 8-port valve 
or performing maintenance to the drive parts. Liquid may be discharged from tubes 
during operation. <Part corrosion prevention>)

• When utilizing the software's printing function, set the paper size to letter or A4 and 
printer graphic resolution to 600 dpi.
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2System Description
This chapter describes the components of the TOC-VCPH/CPN, autosampler (ASI-V), 8-
port sampler (OCT-1), and the TN unit (TNM-1).

2.1 TOC-VCPH/CPN Construction
Describes the construction of the TOC-V unit using front, right, left, rear and 
internal views of the instrument, as well as flow diagrams.

2.2 Autosampler ASI-V (Option)
Describes the construction of the ASI-V unit using front and rear views of the 
autosampler.

2.3 8-Port Sampler OCT-1 (Option)
Describes the construction of the 8-port sampler using front and rear views of the 
unit.

2.4 TN Unit TNM-1 (Option)
Describes the construction of the TNM-1 unit using front, right and internal 
views of the unit.

2
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2.1  TOC-VCPH/CPN Construction

2.1.1  Front View

Figure 2.1  Front View

2.1.2  Right Side View

Figure 2.2  Right Side View

Start Button

Stop Button

Front Door

Power Switch

Tubing and Wiring
Opening for the
TN Unit

Drain Tubing
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9TOC-VCPH/CPN

2.1.3  Left Side View

Figure 2.3  Left Side View

2.1.4  Rear View

Figure 2.4  Rear View

1) Flash ROM rewrite switch

2) Printer cable terminal

3) RS-232C terminal (1)

4) RS-232C terminal (2)

5) ASI-V/OCT-1 signal cable connector

6) ASI-V/OCT-1 power cable connector

Sample Tubing

Hydrochloric Acid

IC Reagent

Dilution Water
Bottle

CO2 AbsorberCarrier Gas Inlet

AC Cord Socket

1
2 3 4 5 6
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2.1.5  Inside Front View

Figure 2.5  Inside Front View

1) Sliding sample injector (H Type only)

2) IC reagent vessel (H Type only)

3) Solenoid valve (for IC drainage) (H Type only)

4) Carrier gas pressure gauge

5) Carrier gas flow adjustment knob

6) Carrier gas flowmeter

7) Carrier gas pressure adjustment knob

8) Sparge gas flowmeter (option)

9) Sparge gas flow adjustment knob (option)

10) Halogen scrubber

11) Humidifier

12) Pump (for IC reagent supply) (H Type only)

13) Syringe pump cover

14) 5mL syringe

15) 8-port valve

16) 3-way valve

1 2 3 4 5

7

9

10

Front Door

1112

13

14

16

6

15 8
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2.1.6  Inside Top View

Figure 2.6  Inside Top View

2.1.7  Flow Diagrams

Figure 2.7  Flow Diagram (TOC-VCPH)

Slide Motor
Cooling Fan for
Sample Injection
Block 

Slider

Sample Injection Block

Sample Injection
Tubing
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Figure 2.8  Flow Diagram (TOC-VCPH+TNM-1)

Figure 2.9  Flow Diagram (TOC-VCPH+POC Option)
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Figure 2.10  Flow Diagram (TOC-VCPN)

Figure 2.11  Flow Diagram (TOC-VCPN+TNM-1)
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2.2.1    Front View
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2.2  Autosampler ASI-V (Option)

2.2.1  Front View

Figure 2.12  Front View

2.2.2  Rear View

Figure 2.13  Rear View

Needle Replacement Window

Sample Tubing

Sample Cover
Stirrer Speed
Control (option)

Rinse Solution Tubing

Drain Tubing

Signal Cable

Power Cable
(attached to ASI)

Terminal
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2.3.1    Front View
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2.3  8-Port Sampler OCT-1 (Option)

2.3.1  Front View

Figure 2.14 Front View

2.3.2  Rear View 

Figure 2.15 Rear View 

8-Port Valve

8-Port Sampler 1 8-Port Sampler 2

Signal Power
(with Power Supply)CableCable

Signal Cable
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2.4  TN Unit TNM-1 (Option)

2.4.1  Front and Right Side Views

Figure 2.16  Front and Right Side Views

Ozone Air Source Flowmeter

 POWER: Power Lamp 

REACT: Reactor Temperature
                 Control Heater Lamp

O3GEN: Ozone Generator
               Status Lamp

PRESS: Ozone Source Air

 Ozone Generator Switch

                Supply Warning Lamp
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2.4.2    Inside Front View
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2.4.2  Inside Front View

Figure 2.17  Inside Front View

Reactor

 Viton Joint

 Ozone Treatment Unit

 Flowmeter

Ozone Source Airflow 
Adjustment Knob



2.4    TN Unit TNM-1 (Option)
2.4.3    Rear View
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2.4.3  Rear View

Figure 2.18  Rear View

Ozone Source Air Inlet

AC Cable Socket

Gas Exhaust Port



3Software Overview, Administration,
and Setup

This chapter provides an overview of the TOC-Control V software and describes the 
software’s Administration and Instrument Setup Wizard tools.

3.1 Introduction to System Administration Functions
Describes the system administration functions performed by the user.

3.2 Instrument Setup and System Properties
Describes the software’s Instrument Setup Wizard, which is used to configure 
new systems by collecting information such as installed instrumentation, 
instrument settings and communication parameters. Also describes procedures 
for viewing the properties of and removing previously-configured systems.
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3.1   Introduction to System Administration Functions

This section describes the various system administration functions in the TOC-Control V 
software that are available to the user. For a description of system administration functions 
that can be performed by the system administrator, refer to the TOC-V Administrator's 
Manual.

3.1.1  Screen Lock Function

If user must temporarily leave the PC during measurement, the screen can be locked to 
protect the data from another individual making improper or malicious operations in TOC-
Control V. 

This function can be used only if the User ID / Password item is checked in the Security 
dialog box. Consult with the system administrator to implement changes in the security 
settings.

To lock the screen, select Screen Lock in the Tools menu. The screen is locked and the Re-
enter Password dialog box displayed. Once the screen is locked it can only be unlocked by 
entering the User ID and Password of the user who was logged on at the time the screen 
was locked.

Figure 3.1 Screen Lock Command

Figure 3.2 Re-enter Password Dialog Box
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3.1.2  Change Password

This function is used to change the password of a registered user. 

Select Change Password in the TOC-Control V Administrator window to open the Change 
Password dialog box. This function can be used only if the User ID/Password item is 
checked in the Security dialog box. Refer to Section 3.2.4 “Security” in the Administrator’s 
Manual for more information.

Figure 3.3 TOC-Control V Administrator Window

Figure 3.4 Change Password Dialog Box
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3.1.3  Add Event Log

This function is used when a comment is to be included with the operation history. This 
function is useful for documenting items in the operation history, such as the replacement 
of catalyst, that cannot be recorded automatically through the software. Only users with 
access rights to Add Event Log can use this function. 

This function can be used only if Audit Trail is checked in the Security dialog box. Refer to 
Section 3.2.4 “Security” in the Administrator’s Manual for more information.

When Add Event Log is selected in the TOC-Control V Administrator window, the Add 
Event Log dialog box is displayed.

Figure 3.5 Add Event Dialog Box

Select one of the items in the Select Item array, and then enter a comment in the 
Comment text field. If the Comment text field is left blank, an error message is 
displayed, and the comment is not added to the Event Log.
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3.2  Instrument Setup and System Properties

This section describes the Instrument Setup Wizard, which is used to configure new 
systems. This section also describes procedures for viewing the properties of and removing 
previously-configured systems.

The TOC-Control V Instrument Setup Wizard is used to enter properties for a new system. 
Access the Wizard by double-clicking the “New System” icon in the TOC-Control V main 
window.

Multiple instruments can be configured for the TOC-Control V software system by 
entering information into the series of Wizard screens.

TIP » Use the Back and Next buttons to move among the various Instrument Setup Wizard 
windows.

3.2.1  System Information Window

The System Information window of the Instrument Setup Wizard is used to enter basic 
system information.

Figure 3.6 Instrument Setup Wizard: System Information Window

System

Enter a unique name for the system, using up to 32 characters. A name must be entered 
before continuing to the next Wizard page. If a system with the entered name already exists, 
an error message is displayed requesting entry of a unique name.

Serial Number

Enter the serial number of the TOC-V. The serial number of the unit is an 8-character 
number (No. ********) that is printed on the plate attached to the lower right side of the 
instrument. 
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User

The name of the current user is automatically entered into the User field and cannot be 
edited.

Date of Creation

The current date is automatically entered into the Date of Creation field and cannot be 
edited.

Comment

Enter additional system information in the Comment text box. The Comment field is 
optional and can contain up to 512 characters.

3.2.2  Options Window

The Options window of the Instrument Setup Wizard is used to specify the instrument 
hardware configuration and attached accessories.

Figure 3.7 Instrument Setup Wizard: Options Window

Oxidation

Select “Combustion” from the drop-down list to specify the oxidation method.

Options

Select the installed instrument components by clicking the appropriate check boxes. The 
options include TOC, ASI, SSM (solid-sampler unit), POC, IC Unit, TN, Sparge Kit, 
Manual Injection Kit, 8Port Sampler-1, 8Port Sampler-2 and ESU (external scrubbing 
unit). The selected options determine which Instrument Setup Wizard screens are 
displayed.

Select the IC Unit for the H-type. If Manual Injection Kit is selected, the ASI, SSM, and 
POC options are disabled.



3.2    Instrument Setup and System Properties
3.2.2    Options Window

25TOC-VCPH/CPN

Option Description

TOC Displays the TOC screen of the Instrument Setup Wizard to allow TOC 
instrument parameters to be set. 

ASI Displays the ASI screen of the Instrument Setup Wizard to allow 
autosampler parameters to be set. This option is disabled if the Manual 
Injection Kit option is selected.

SSM Displays the SSM screen of the Instrument Setup Wizard to allow solid 
sampler unit parameters to be set. This option is disabled if the Manual 
Injection Kit option is selected.

POC Specifies that the purgeable organic carbon accessory is installed. 

IC Unit Specifies that the instrument will be used to measure inorganic carbon. 
Select this option for only instrument model TOC-VCPH. Do not select 
this option for instrument model TOC-VCPN. If the IC Unit is selected as 
an option, the “Auto regeneration of IC solution” check box will be 
enabled on the Instrument Setup Wizard TOC screen.

TN Specifies that the TN accessory is installed.   If the TN Unit is selected as 
an option, the “TN Power” check box will be enabled on the Instrument 
Setup Wizard TOC screen.

Sparge Kit Specifies that the Sparge Kit accessory is installed and that external 
sparging is desired. If the Sparge Kit is selected as an option, the “Nee-
dle” parameter will be enabled on the Instrument Setup Wizard ASI 
screen.

Manual Inj. Kit Specifies that the Manual Injection Kit accessory is installed. The ASI, 
SSM, and POC accessories cannot be used simultaneously with the Man-
ual Injection Kit. If the Manual Injection Kit is selected as an option, the 
options for ASI, SSM, and POC are deselected and disabled. 

8-Port Sampler 1 Select this option when one 8-port sampler accessory is installed. 8-Port 
Sampler 1 cannot be selected if the ASI or SSM are selected.

8-Port Sampler 2 Select this option when two 8-port sampler accessories are installed. 8-
Port Sampler 2 can only be selected if 8-Port Sampler 1 is selected.
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3.2.3  TOC Window

The TOC window of the Instrument Setup Wizard is used to set TOC instrument 
parameters.

Figure 3.8 Instrument Setup Wizard: TOC Window

Catalyst Type

Select the type of catalyst to be used in TC or TC/TN measurement from the drop-down 
list. Available options are:

• Regular: for TC measurements (concentrations of 500ppb or greater)
• High Sense: for TC measurements (concentrations below 500ppb)
• TC/TN: for combined TC and TN measurements
Note: The instrument does not automatically recognize the type of cata-

lyst that is installed. Be sure to select the catalyst type that is actu-
ally installed in the instrument.

The high sensitivity catalyst should be used when the expected sample concentrations are 
below 500ppb or when detection of minute changes in concentration is necessary.

Tubing Diameter

Select the diameter size of the sample injection tubing from the drop-down list. Available 
options are:

• Regular: 0.5mm diameter
• Suspended Particle: 0.8mm diameter

The typical tubing diameter is 0.5mm. Select a tubing diameter of 0.8mm if the Suspended 
Solids kit is used.

Cell Length

Select the length of the NDIR detection cell from the drop-down list. Available options are:

• Long: for typical measurements
• Short: for measurements using the Suspended Solids kit
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Buzzer

Enables the internal buzzer function. Select this option to allow the buzzer to sound during 
measurement.

Auto regeneration of IC solution

Select this option to automatically regenerate the IC solution. This option is enabled only if 
IC Unit was selected in the Options window of the Instrument Setup Wizard.

The acidity of the IC solution gradually decreases over time, as the acid is used to convert 
the IC components in samples into carbon dioxide. Unless the IC solution is periodically 
regenerated, it eventually loses its ability to fully convert IC into carbon dioxide, which can 
affect the accuracy of analysis. 

When the Auto Regeneration option is selected, the pH and volume of the IC solution are 
automatically maintained at the appropriate levels. The instrument automatically pumps IC 
solution from the IC reagent reservoir in the following cases:

• When the instrument is turned on
• Prior to the initial IC measurement, following a preset number of injections and preset 

volume of injected samples
• If peak tailing is observed during an IC measurement. (The system notifies the user of 

peak tailing by inserting a “T” into the Notes column of the Injection Table and the 
Remark column of the Sample Table.)

Enable ready status check

Select this option to enable the Ready Status Check function. When the function is enabled, 
the software always verifies that the instrument is in the Ready state prior to starting 
measurement. Enabling the Ready Status Check function is recommended. When the 
function is deselected, measurement can be performed when the instrument is not in the 
Ready state, an option that is mainly for use by service personnel.

TN Power

This item is displayed if “TN” was selected as an option in the previous screen. Select this 
item to perform TN analyses.

TC Furnace

Select the desired TC furnace temperature by clicking the appropriate radio button. Select 
680 (°C) for regular or high sensitivity catalyst. Select 720 (°C) for TC/TN catalyst.
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3.2.4  ASI Window

The ASI window of the Instrument Setup Wizard is displayed if ASI was selected in the 
Options window of the Wizard. Use the ASI screen to set the autosampler parameters.

Figure 3.9 Instrument Setup Wizard: ASI Window

Tray Type

Select the ASI tray type from the drop-down list. Options are 24mL Vial and 40mL Vial.

Needle

Select the needle type from the drop-down list. Options are:

• Sample: for analysis using only a sample needle
• Sample+Sparge: for analysis using both a sample needle and a sparge needle
• Coaxial: for analysis using an integrated sample and sparge needle
• Coaxial+Sparge: for analysis using both the coaxial needle and a sparge needle, 

which allows a sample to be measured while the next sample is sparged.
The Needle field is enabled only if Sparge Kit was selected in the Options window of the 
Wizard.

Note: The instrument does not automatically recognize the type of needle installed. Be
sure to select the type of needle that is actually installed in the instrument.

No. of Needle Washes

Enter the number of times (0-10) the outside of the needle will be washed with water from 
the dilution water bottle, at the end of a sample run. 

No. of Flow Line Washes

Enter the number of times (0-10) the flow lines will be washed after all samples listed in the 
Sample Table have been measured. Water from the dilution water bottle is used to wash the 
flow lines.
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Rinse

Select this option to rinse the sampling needle between each sample with water from the 
dilution water bottle.

Rinse After Acid Addition

Select this option to rinse the sampling needle after each acid addition with water from the 
dilution water bottle.

Stirrer On

Select this item to use the optional magnetic stirrer during measurement.

3.2.5  SSM Window

The SSM window of the Instrument Setup Wizard is displayed if SSM was selected in the 
Options window of the Wizard. Use the SSM screen to set the SSM parameters. Refer to 
the SSM-5000A User Manual for details.

Figure 3.10 Instrument Setup Wizard: SSM Window

SSM TC Furnace On

Select this option for TC measurement.

SSM IC Furnace On

Select this option for IC measurement.
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3.2.6  Communication Window

The Communication window of the Instrument Setup Wizard is used to set parameters for 
communication between the instrument and the PC.

Figure 3.11 Instrument Setup Wizard: Communication Window

Com Port

Select the communication port from the drop-down list. Options include Com1, Com2, 
Com3, and Com4.

Stop Bits

The Stop Bits value is determined by the hardware and is set automatically based on the 
Com Port selection. This field is disabled and cannot be edited by the user.

Parity

The Parity value is determined by the hardware and is set automatically based on the Com 
Port selection. This field is disabled and cannot be edited by the user.
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3.2.7  History Function Window

The History Function window of the Instrument Setup Wizard is used to enable the History 
Log. The History Log records all modifications to the system properties. The History Log 
can be set to require users to enter comments for each modification. 

Note: Once the History Log is enabled, it cannot be disabled. All modifications to the
system properties will be tracked. If the mandatory comment option is selected,
the user will be required to enter a comment each time any system parameter is
modified.

Figure 3.12 Instrument Setup Wizard: History Function Window

Enable History Log

Select this option to enable the software to monitor all modifications to the system 
properties. Once the History Log is enabled, the check box is disabled and the log cannot be 
turned off. The History Log is maintained on the History tab of the Instrument Properties 
dialog box. Refer to Section 3.2.8 "Instrument Properties Dialog Box". If the History Log is 
not required, it need not be enabled, as the software operates properly without it.

A Comment is Required for All Modifications

Select this option to require the user to comment on or obtain approval for all 
modifications. Once this option is selected, the check box is disabled and the option cannot 
be turned off. If the History Log is not required, it need not be enabled, as the software 
operates properly without it.

Finish Button

The History Function window is the final screen in the Instrument Setup Wizard. Make the 
appropriate selections, then click the Finish button. The new instrument is created and 
saved, and its icon appears in the TOC-Control V main window.
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3.2.8  Instrument Properties Dialog Box

Instrument parameters can be viewed and modified using the Instrument Properties dialog 
box, shown below. Open the dialog box by double-clicking the instrument icon in the TOC-
Control V main window.

Figure 3.13 Instrument Properties Dialog Box

System Tab

The System tab displays the System Information window for the selected system and 
allows editing of the Comment field.

Options Tab

The Options tab displays the oxidation method and instrument components that were 
selected in the Options window of the Instrument Setup Wizard. Information on this tab can 
be viewed but not changed.

TOC Tab

The TOC tab is identical to the TOC window in the Instrument Setup Wizard. Some fields 
on the TOC tab can be edited. If the History Log was enabled during setup, edits to the 
TOC tab will be tracked and listed in the History tab.

ASI Tab

The ASI tab is identical to the ASI window in the Instrument Setup Wizard. Some fields on 
the ASI tab can be edited. If the History Log was enabled during setup, edits to the ASI tab 
will be tracked and listed in the History tab.

Communication Tab

The Communication tab is identical to the Communication window in the Instrument Setup 
Wizard. Some fields on the Communication tab can be edited. If the History Log was 
enabled during setup, edits to the Communication tab will be tracked and listed in the 
History tab.
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SSM Tab

The SSM tab is identical to the SSM window in the Instrument Setup Wizard. Some fields 
on the SSM tab can be edited. If the History Log was enabled during setup, edits to the 
SSM tab will be tracked and listed in the History tab.

History Tab

If the History Log was not enabled during setup, the History tab is identical to the History 
Function window in the Instrument Setup Wizard. Use this screen to enable the History log.

If the History Log was enabled during setup, the History tab lists all changes made to the 
system parameters. The log lists modifications chronologically, with the most recent 
modification at the top. If the mandatory comment option was selected during setup, all 
modifications listed in the History tab window contain a comment describing the reason for 
the change. View or edit previously entered comments by selecting the modification from 
the list and clicking the Edit Comment button. If the History Log is not required, it need not 
be enabled, as the software operates properly without it.

Figure 3.14 Comment Dialog Box

Note that if the mandatory comment option was selected in the History Function window 
during instrument setup, the Comment dialog box (shown above) is displayed after any 
change is made in the Instrument Properties dialog box. 

3.2.9  Removing a Configured System

Systems are removed from the TOC-Control V software using the main window. To 
remove a system, right-click the appropriate system icon and select Delete. Once a system 
is deleted, it cannot be restored.
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4Operation
This chapter describes procedures for pre-analysis preparations, setting measurement 
parameters, starting up the instrument, generating calibration curves, and conducting 
sample analysis. This chapter also includes a tutorial that covers setup and measure-
ment procedures.

4.1 Analysis Preparation
This section describes instrument preparation procedures such as catalyst filling, 
combustion tube connection, and syringe replacement as well as other 
preparation procedures for actual sample analysis.

4.2 Setting General Measurement Parameters
This section describes procedures for setting TOC, ASI and default measurement 
parameters using the TOC-Control V software.

4.3 Measurement Procedures and Tutorial
This section describes and provides a tutorial for measurement procedures, such 
as instrument startup, calibration curve generation, method development, sample 
analysis, halting of analysis and instrument shutdown.

4.4 Sample Table Editor
This section provides a detailed description of the TOC-Control V Sample Table 
Editor menus and commands. The Sample Table Editor is used for instrument 
startup, calibration curve generation, method development, sample analysis, 
halting of analysis and instrument shutdown.

4.5 Application Operations
The procedures for performing manual injection analysis and gaseous sample 
analysis are described in this section.

4
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4.1  Analysis Preparation

4.1.1  Catalyst Filling

Three types of catalyst are available: TOC standard catalyst, TOC high sensitivity catalyst 
(H Type only), and TOC/TN catalyst (option). The procedures for filling the combustion 
tube with catalyst are described in this section. For TOC standard and high sensitivity 
catalyst filling, follow the procedure in Section 4.1.1.1 "Catalyst for TOC Analysis". For 
TOC/TN catalyst filling, follow the procedure in Section 4.1.1.2 "TOC/TN Catalyst 
(Option)".

CAUTION
Exercise caution when handling the combustion tube to prevent breakage, as it is
made of quartz glass.

Note: When filling the combustion tube, verify that the catalyst does not become con-
taminated. Contamination will cause high blank values and abnormal analysis 
values.

Using New Catalyst

Broad blank peaks are obtained when using new catalyst for the first time. The blank peaks 
will become progressively smaller and more stable with repeated injections, and their size 
will stabilize. If calibration or analysis is performed while the blank peaks are large, the 
measurements are affected by the changing magnitude of the blank peaks, resulting in 
errors in the analysis values. Such errors are especially significant for high sensitivity TC 
analysis. 

TC Analysis Using New Catalyst

Catalyst regeneration should be conducted 1-2 times for TC analysis using new catalyst. 
This reduces the size of the blank peaks. Use continuous injections of pure water until the 
blank peak area becomes small and stable. The blank peak magnitude depends on the 
quality of the water (TC impurity concentration) and the TC analysis range used for 
analysis. For example, a blank peak of 1mg/L has little influence on results greater than 
100mg/L but has a significant influence on results equal to or less than 10mg/L. Analyses 
for expected concentrations around 10mg/L must have stable blank peaks of 0.5mg/L or 
less.

For TOC high sensitivity catalyst, conduct the TC blank check analysis described in  
Section 4.1.15.2 "TC Blank Check Analysis".

TN Analysis Using New Catalyst

Blank peak magnitude poses no practical problems for TN analysis using new catalyst. The 
blank peaks are fairly small and stable. Perform analysis with distilled or deionized water to 
confirm the size of the blank peaks.
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4.1.1.1  Catalyst for TOC Analysis

Either standard or high sensitivity catalyst can be used for TOC analysis. The furnace 
temperature is set to 680°C for TOC analysis.

TOC Standard Catalyst

The TOC standard catalyst is appropriate for both the TC-IC method and NPOC method of 
analysis.

Note: Analyze TOC high precision samples (with expected concentrations of about 
1mg/L) using the TOC high sensitivity catalyst because smaller blank peaks are 
generated. 

Filling Combustion Tube with TOC Standard Catalyst

1. Insert two sheets of platinum mesh into the combustion tube.

2. Layer about 5mm. of quartz wool onto the platinum mesh using the catalyst filling 
rod.

3. Fill the TOC standard catalyst to a height of about 100mm.

Figure 4.1  Combustion Tube with TOC Standard Catalyst

TOC High Sensitivity Catalyst (H Type only)

Use the TOC high sensitivity catalyst for low level TC analysis. The blank values are 
controlled to negligible levels, and analysis is performed primarily for trace TOC in pure 
water (1mg/L or less).

Combustion Tube

TOC Standard Catalyst

Quartz Wool

100mm

Platinum Mesh



4.1    Analysis Preparation
4.1.1    Catalyst Filling

38 TOC-VCPH/CPN

Filling Combustion Tube with TOC High Sensitivity Catalyst

Two cylindrical containers of catalyst are required for a single load.

1. Place two sheets of platinum mesh in the combustion tube.

2. Fit together the combustion tube opening and the opened end of the cylindrical 
catalyst container.

3. Use the catalyst filling rod to push catalyst into the combustion tube from the other 
opened end of the cylindrical catalyst container.

4. Transfer the contents of the two cylindrical catalyst containers to achieve a catalyst 
layer height of 130mm in the combustion tube.

Figure 4.2  Filling of TOC Combustion Tube with High Sensitivity Catalyst

Samples containing IC in excess of 5mg/L

The detection rate for IC decreases with increasing concentration. As a result, use the 
NPOC method instead of the TC-IC method when analyzing samples that contain IC 
concentrations in excess of 5mg/L.

Combustion Tube

TOC High-Sensitivity

Platinum Mesh

130mm

Catalyst
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4.1.1.2  TOC/TN Catalyst (Option)

TOC/TN catalyst is used for TN analysis and TOC/TN simultaneous analysis. The 
detection rate is low for the IC component when it exceeds 10mg/L; as a result, TOC in 
samples containing more than 10mg/L IC cannot be measured using the TC-IC method and 
should be measured using the NPOC method. The furnace temperature is set to 720°C for 
TOC/TN and TN analysis. 

Filling Combustion Tube with Catalyst for TN Analysis

1. Insert two sheets of platinum mesh into the combustion tube.

2. Layer about 5mm of quartz wool onto the platinum mesh using the catalyst filling rod.

3. Introduce the TOC standard catalyst into the combustion tube to a height of 140mm 
from the top end of combustion tube.

4. Introduce a small amount of ceramic fiber to cover the catalyst.

5. Lightly press with a catalyst filling rod so that the thickness of the ceramic fiber is 
10mm.
Note: • The thickness of the ceramic fiber must be uniform, covering the entire 

surface of the catalyst, or a poor TN detection rate may result.
• The filling heights of the catalyst and ceramic fiber influence the TN 

detection rate, so it is important that the dimensions are close to those 
indicated below.

Catalyst: 140mm from the top end of combustion tube
Ceramic fiber: 10mm

Figure 4.3  Filling Combustion Tube with Catalyst for TOC/TN Analysis

Combustion Tube

Ceramic Fiber

TOC Standard Catalyst

Quartz Wool

Platinum Mesh

10mm
140mm



4.1    Analysis Preparation
4.1.2    Connecting the Combustion Tube

40 TOC-VCPH/CPN

4.1.2  Connecting the Combustion Tube

The procedure for installing the combustion tube differs depending on whether the 
instrument is the H Type or the N Type. The procedure for each type is described below.

CAUTION
• Due to the potential for burns, maintenance of the combustion tube and catalyst

should be performed after the electric furnace temperature has cooled to room
temperature.

• When connecting the combustion tube, handle it carefully to avoid breakage. The
combustion tube is constructed of quartz glass, and injury is possible. 

• Do not use a wrench or other tool. Injury could result if the combustion tube
breaks.

Installation for the H Type

1. Push the capillary end of the catalyst-filled combustion tube downward, into the 
center of electric furnace (about 22mm diameter).

2. Apply an extremely thin layer of the provided high-vacuum silicone grease to the 
outside of the combustion tube tip (part in contact with O-ring).
Note: Use the smallest possible amount of silicone grease. Absolutely no

grease should be applied to the interior of the combustion tube.

3. Insert the tip of the combustion tube, with the silicone grease, securely into the 
opening at the bottom of the sample injector.
Note: At this point, be sure to connect the drain tubing exiting the slide

injector to the Y-fitting of the system drain line.

4. Connect the tubing at the bottom end of combustion tube, as shown in Figure 4.4 
"Connecting Combustion Tube to the Compression Fitting". Push the narrow end of 
the combustion tube into the compression fitting. Adjust the distance between the 
bottom of the compression fitting and the base of the instrument to 1mm or less, and 
then tighten the top compression fitting nut firmly by hand.
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Figure 4.4  Connecting Combustion Tube to the Compression Fitting 

CAUTION
• The instrument is sealed sufficiently if the combustion tube does not move when

pulled upwards.
• The quartz glass combustion tube will break if the compression fitting is over-

tightened.
• Use only the provided Teflon ferrules for the front and rear ferrules. Do not use

any other material, such as metal.
• Do not allow organic contaminants such as grease or oil to touch the inner or

outer surfaces on the tip of the combustion tube and gas connection parts of the
ferrules. This is especially important for high sensitivity analysis.

TC Combustion Tube

Nut

Rear Ferrule

Front Ferrule
Sleeve Set 6F-T
(P/N 035-62994-03)

TC Combustion Tube

Stainless Tubing 

Compression Fitting

(toward detector)
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Figure 4.5  Connecting the Combustion Tube

5. Secure the sample injector with the knurled thumbscrew.

Figure 4.6  Securing the Sample Injector 

6. To prevent heat escape from the furnace, pack the space around the capillary part of 
the combustion tube with the provided ceramic fiber. 

CAUTION
Use caution to avoid inhaling ceramic fibers when inserting the fibers into the
combustion tube.

Combustion
Tube

Knurled
Thumbscrew
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7. Verify that the gap between the adjustable base at the bottom of the instrument and the 
bottom-most part of the compression fitting is 1mm or less (preferably no gap).

8. If the gap is too large, loosen the nut at the top of the compression fitting and pull the 
combustion tube upwards. Since the TC combustion tube is inserted into the 
compression fitting, pulling up on the combustion tube shortens the insertion length 
and ultimately lowers the compression fitting assembly. When almost no gap remains, 
firmly tighten the nut at the top of the compression fitting.
Note: The sample rapidly vaporizes in the combustion tube when injected

in large quantities with a gap present between the bottom-most part
of the compression fitting and the base of the instrument. The
pressure increases, resulting in a separation at the connection
between combustion tube and sample injector.

Installation for the N Type

1. Push the capillary part of the catalyst-filled combustion tube downward into the 
center of electric furnace (about 22mm diameter).

2. Apply an extremely thin layer of the provided high-vacuum silicone grease to the 
outside of the combustion tube tip (part in contact with O-ring).
Note: Use as small amount of silicone grease as possible. Absolutely no

grease should be applied to the interior of the combustion tube.

3. Insert the silicone grease coated tip of the combustion tube into the opening at the 
bottom of the sample injector.
Note: Connect the drain tubing exiting the slide injector to the Y-fitting of

the system drain line.

4. Connect the tubing at the bottom of the combustion tube, as shown in Figure 4.7 
"Connecting the Combustion Tube".

CAUTION
• The instrument is sealed sufficiently if the combustion tube does not move when

it is pulled upwards.
• The quartz glass combustion tube will break if the compression fitting is over-

tightened.
• Do not allow organic contaminants such as grease or oil to touch the inner or

outer surfaces on the tip of the combustion tube and gas connection parts of the
ferrules. This is especially important for high sensitivity analysis.
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Figure 4.7  Connecting the Combustion Tube 

5. Secure the sample injector with the knurled thumbscrew, as shown in Figure 4.8 
"Securing the Sample Injector".

Figure 4.8  Securing the Sample Injector 

6. To prevent heat escape from the furnace, pack the space around the capillary part of 
the combustion tube with the provided ceramic fiber.

CAUTION
Use caution to avoid inhaling ceramic fibers when inserting the fibers into the
combustion tube.

Combustion
Tube

Knurled
Thumbscrew
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4.1.3  Installing the Syringe

This section describes the procedure for attaching the syringe to the syringe pump 
assembly.

Depending on the instrument status, flow lines are connected to each of the 8 ports of the 
syringe pump valve. If the syringe is installed or removed without following the sequence 
described below, acid can be released from the syringe connection port. The sequence 
described below must be followed.

CAUTION
• Due to the potential for injury, keep hands away from the sample injector during

operation of the syringe pump unit.
• The syringe barrel is made of glass and must be handled carefully to avoid break-

age.

Syringe Installation

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>Change Syringe.
The Syringe Change dialog box is displayed.

Figure 4.9  Syringe Change Dialog Box

3. Click the Preparation Start button to begin the procedure. A progress bar is active 
while the syringe moves to the position where it can be replaced. 

4. When the progress bar begins blinking, remove the screw at the bottom of the syringe 
pump cover, and remove the cover.

5. Remove the sparge gas line from the syringe.

6. Remove the syringe from the syringe connection port of the 8-port valve.

7. Attach the new syringe to the syringe connection port of the 8-port valve.
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8. Connect the sparge gas line to the syringe using the bushing and spacer.
Note: Do not use tools when replacing the syringe; hand-tighten only.

Over-tightening can deform the components of the 8-port valve and
result in leaks.

Figure 4.10  Installing the Syringe

9. Verify that the syringe moves smoothly between the upper and lower positions by 
clicking the directional arrows on the Syringe Change dialog box. 

10. With the syringe in this position, hand-tighten the plunger retaining screw on the 
plunger holder. 

11. Click the Finish Replacement button to move the syringe to its initial position.

12. Click the Close button.
Note: Once the syringe is installed, perform the syringe pump zero point

detection operation.See  Section 4.1.3.1 "Syringe Pump Zero Point
Detection" for details.

Syringe

Plunger
Retaining
Screw
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4.1.3.1  Syringe Pump Zero Point Detection

This section describes the procedure for performing automatic detection of the syringe 
pump zero point.

Note: Perform the zero point detection procedure whenever a new syringe is installed 
or the syringe is replaced. 

Procedure

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>Zero Point Detection.
The Zero Point Detection dialog box is displayed.

Figure 4.11  Zero Point Detection Dialog Box

3. Click the Start button. 
A progress bar is active while the syringe moves to the position where the zero point 
can be detected. When the progress bar stops blinking, the procedure is complete.

4. Click the Close button.
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4.1.4  Water Supply to the Cooler Drain Container

The drain container must be filled with water to prevent carrier gas from being released 
from the drain tubing.

Procedure

1. Remove the rubber cap from the drain container.

2. Remove the drain container from the mounting clip.

3. Introduce pure water (deionized water is acceptable) into the cooler drain container up 
to the level of the drain discharge tube on the side of the container.

4. Cap the drain container with the rubber cap.

5. Return the drain container to its position in the mounting clip. 

6. Verify that the cooler drain tube reaches to the bottom of drain container.

CAUTION
Do not bend drain tubing, as this may prevent drain discharge.

Figure 4.12  Filling the Cooler Drain Container with Water

Rubber Cap

Drain Tubing

Drain Container

Drain Discharge Tube

Mounting Clip

Pure Water



4.1    Analysis Preparation
4.1.5    Filling the Humidifier with Water

49TOC-VCPH/CPN

4.1.5  Filling the Humidifier with Water

The carrier gas must be humidified for high sensitivity analysis to ensure high analysis 
precision. Water is supplied to the humidifier using the following procedure.

Procedure

1. Remove the cap from the water supply port at the top of the humidifier.

2. Introduce water through the water supply port to the “Hi” marking on the side of the 
humidifier.
Note: Use pure water containing as little TC as possible for high

sensitivity analysis.

Figure 4.13  Filling the Humidifier with Water

Humidifier

Water Supply
Port

Pure Water

“Hi” Marking
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4.1.6  Preparation of Dilution Water

This section describes the preparation of water used to automatically dilute samples.

Procedure

1. Wash the provided dilution water bottle with laboratory glassware detergent, rinse 
well with tap water, then wash a number of times with pure water.

2. Fill the container with pure water to the 2 liter level.

3. Place the container to the left of the instrument, toward the rear.

4. Pass the dilution water intake tubing, labeled DILUTION, through the hole in the cap. 

5. Secure the tubing, using a wire clamp about 200mm from the end of the tubing, to 
prevent the tubing and cap from separating.

6. Place the cap on the container.
Note: Verify that the tip of the intake tubing nearly reaches the bottom of

the container.

Figure 4.14  Preparing Dilution Water

Note: About pure water:

• Use the purest water that can be obtained. 

• Refer to Section 4.1.14.1 "Preparation of Standard Solutions" for details on 
the degree of purity of “pure water”. 

Dilution Water 
Intake Tubing

Dilution Water
Bottle
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4.1.7  Acid Preparation

This section describes the preparation of acid used for IC removal in NPOC analysis or for 
IC analysis with the N Type instrument.

Procedure

1. Prepare 2 M HCl by diluting 1 part commercially available concentrated HCL (12 M) 
with 5 parts pure water. A final concentration accuracy of ±2% is acceptable. 
Note: The pure water used as the diluent must have a TOC concentration

no greater than 0.5 mg/L. Since the TOC value of the diluent pure
water can have a large effect on the analysis result with high
sensitivity analysis (low TOC concentrations), it is necessary to use
pure water having a very low TOC concentration. 

CAUTION
Hydrochloric acid is a hazardous chemical. Use precautions to avoid contact when handling 
this substance. For details, refer to  Section 6.9 "Material Safety Data Sheets".

2. Transfer the prepared acid to the 250 mL bottle provided as a standard accessory, and 
place it to the left of the instrument, toward the front. 

3. Pass the acid intake tubing through the hole in the cap.

4. Secure the tubing, using a wire clamp about 100mm from the end of the tubing, to 
prevent the tubing and cap from separating.

5. Place the cap on the container.
Note: Verify that the tip of the acid intake tubing nearly reaches the

bottom of the container.

Figure 4.15  Acid Preparation

Acid Intake Tubing

Cap

Hydrochloric Acid
Container
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4.1.8  Installation of the CO2 Absorber

A CO2 absorber is used to remove CO2 from the carrier gas that purges the optical system 
of the detector. The CO2 absorber is installed using the following procedure. 

Procedure

1. Cut the tips of the 2 rigid tubes in the lid of the CO2 absorber with a knife.

2. Connect the flexible tubing that exits the rear panel of the instrument (near the top) as 
follows:

Tubing labeled “L”: Connect to tube labeled “L” on CO2 absorber.
Tubing labeled “S”: Connect to tube labeled “S” on CO2 absorber.

Note: The flexible tubing should not be bent.

3. Place CO2 absorber in the holder behind the instrument.

Figure 4.16  Installation of the CO2 Absorber 

Flexible Tubing

Rigid Tubes

CO2 Absorber
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4.1.9  Adjusting Sparge Gas Flow Rate

The sparge gas flow rate should be adjusted before sparging is performed using the optional 
external sparge kit. The procedure for adjusting the sparge gas flow rate is described below. 

Procedure

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>Sparge Gas Valve.
The sparge gas solenoid valve opens and sparge gas begins to flow.

3. Open the front door of the instrument.

4. Adjust the flow rate to about 100mL/min using the sparge gas flow rate adjustment 
knob.
Note: The flow rate should be adjusted according to the size and shape of

the sample container.

5. Close the front door of the instrument.

Figure 4.17  Sparge Gas Flow Rate Adjustment

Sparge Gas Flow
Rate Adjustment Knob

Halogen
Scrubber
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4.1.10  Installing the Suspended Solids Kit

To analyze samples containing suspended solids, the sample flow line diameter can be 
increased from 0.5mm to 0.8mm by installing the optional Suspended Solids Kit. 

This section describes the installation of the Suspended Solids Kit.

There are two kits available:

(1) For TOC-V (TOC-V main unit only)
(2) For TOC-V+ASI-V (used with TOC-V and autosampler)

CAUTION
Switch OFF the TOC-V before attempting to install the Suspended Solids Kit.

Replacing the Flow Line Parts and Slider

This procedure is used for both kits.

Procedure

1. Remove the bushing from port 7 of the 8-port syringe pump valve, and disconnect the 
TC injection tubing. For the H-type, remove the bushing from port 5, and disconnect 
the IC injection tubing.

2. Remove the slider mounting screws from the TC and IC injection blocks, and detach 
the sliders.

3. Remove the slider bushings and replace the sample injection tubing with the 0.8mm 
diameter sample injection tubing provided in the kit. 

4. Reinstall the sliders on the sample injection blocks.

5. Connect the TC injection tubing and the IC injection tubing to port 7 and port 5, 
respectively.
Note: During analysis, verify that the sample flow is normal. Refer to

Section 5.7.2.4 "Corrective Actions for Poor Reproducibility" 
If the sample stream is not normal, the tip of the Teflon tube may be 
deformed or scratched. Use a knife to cut off a portion of the tube. 
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Replacing Sample Tubing

For TOC-V (TOC-V main unit only)

1. Remove the bushing from port 1 of the 8-port syringe pump valve and replace the 
sample tubing with the 0.8mm diameter tubing provided in the kit.

2. Connect the new sample tubing to the 8-port valve in the original position.

For TOC-V+ASI-V (TOC-V and autosampler)

Refer to Section 6.8.4 "Installing the Autosampler" to remove the autosampler sample 
needle and sample tubing. Replace these with the sample needle and tubing provided in the 
Suspended Solids Kit.

Precautions for Measuring Suspended Solids
When performing measurement of solid samples using the Suspended Solids
Measurement kit, follow the precautions below to ensure the best possible
conditions for measurement. Refer to  Section 4.1.15.4 "Analysis of Samples
Containing Suspended Solids".

• Before measurement, use a homogenizer, etc. to make the sample as uniform as
possible. After homogenizing the sample, depending on the type of suspended
substance, precipitation and coagulation may occur after a period of time. Prior
to measurement, mix the sample again using a magnetic stirrer to ensure that pre-
cipitated/coagulated material is well dispersed throughout the sample. 

• If the suspended material is present in large quantities, clumping of the material
and obstruction may occur inside the sample flow line even if the particles are of
smaller diameter that the sample flow line diameter. Take measures such as sam-
ple dilution to prevent flow line obstruction,

• The suspended solids measurement kit employs a 0.8mm Teflon tube for sample
injection. Diminished reproducibility may occur with small sample injection vol-
umes. Make injection volumes as large as possible. 

• When conducting IC measurement of suspended solid samples using the H type
instrument, obstruction of the IC measurement flow line drain tube may occur.
Sufficiently pulverize the suspended particles to allow free flow through the
drain tube. 
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4.1.11  IC Analysis Preparations 

Certain preparations are necessary for the H Type instrument. These include installing and 
replenishing the IC reagent in the IC reaction vessel. This section describes the procedures 
for installing and replenishing the IC reagent. 

CAUTION
The IC reagent contains phosphoric acid. Use care while handling to prevent contact or 
spills. For details, refer to Section 6.9 "Material Safety Data Sheets".

Preparing and Placing the IC Reagent

Procedure

1. Prepare the IC reagent by diluting 50 mL of commercial 85% phosphoric acid (ACS 
Reagent grade) to a final volume of 250 mL with pure water. 
Note: Since the specific gravity of 85% phosphoric acid is about 1.7, the

concentration of the phosphoric acid is about 25% (weight%) in the
prepared IC reagent. A final concentration accuracy of ±2% is
acceptable. 

2. Transfer the prepared acid to the 250 mL bottle provided as a standard accessory, and 
place it on the left side of instrument, toward the front.

3. Pass the tip of the IC reagent tubing through the hole in the cap.

4. Secure the tubing, using a wire clamp at a point about 100mm from the end of the 
tubing tip, to prevent the tubing and cap from separating.

5. Replace the cap on the container.
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Replenishing IC Reaction Vessel with IC Reagent

Use the following procedure to replenish the IC reagent.

Procedure

1. Verify that the lever of the 3-way valve at the bottom of the IC reaction vessel is 
positioned to the left as shown in Figure 4.18 "Lever Position of IC Reaction Vessel 3-
Way Valve".

Figure 4.18  Lever Position of IC Reaction Vessel 3-Way Valve

2. Open the TOC-Control V Sample Table Editor and connect the instrument.

3. From the Instrument menu, select Maintenance>Regeneration of the IC solution.
The Regeneration of IC solution dialog box is displayed.

Figure 4.19  Regeneration of IC Solution Dialog Box

4. Click the Start button. The IC reagent will be delivered to the IC reagent vessel by the 
liquid delivery pump. During the process, the Start button is disabled.

5. A progress bar is active until the IC reagent is completely regenerated. Click the Close 
button.
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4.1.12  Preparation for POC analysis

POC analysis can be performed if the optional POC analysis kit is installed on the 
instrument. This section describes preparations required for POC analysis.

Installation of the CO2 Absorber for POC Analysis

1. Remove the CO2 absorber.

2. Insert about 5mm of quartz wool into the bottom of the container.

3. Add commercially available anhydrous lithium hydroxide to the container on top of 
the quartz wool until it reaches just below the screw threads of the container.
Note: About 6g of anhydrous lithium hydroxide is required for a single

load.

4. Place about 5mm of quartz wool on top of the lithium hydroxide.

5. Attach the O-ring and nipple to the top of the container, and firmly tighten the cap.

6. Install the CO2 absorber for POC analysis in the original position.

CAUTION
• Lithium hydroxide is a corrosive (strongly basic) powder. Use care when han-

dling to prevent contact or inhalation. Refer to Section 6.9 "Material Safety Data
Sheets" for details.

• Lithium hydroxide is available in anhydrous and hydrated forms. Since the abil-
ity of the hydrated form to absorb carbon dioxide is slightly inferior to that of the
anhydrous form, use anhydrous lithium to fill the CO2 absorber container.

• When introducing the quartz wool and lithium hydroxide into the container, do
not pack too tightly. 

• The CO2 absorber container is constructed of glass. Handle it carefully to prevent
breakage.

Figure 4.20  Preparing the CO2 Absorber for POC Analysis

Lithium Hydroxide
Quartz Wool

Cap

Nipple

O-Ring
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4.1.13  TN Analysis Preparations

TN analysis can be performed if the optional TN unit is installed on the instrument. The 
NOx absorber also must be connected to perform TN analysis. The CO2 absorber (soda 
lime) is used as the NOx absorber. Connect it to the instrument using the following 
procedure.

Procedure

1. Cut the tips of the rigid tubes (2) in the lid of the CO2 absorber with a knife.

2. Connect the Viton tubing to the 2 rigid tubes as follows:
Tubing labeled “L”: Connect to tube labeled “L” on the CO2 absorber.
Tubing labeled “S”: Connect to tube labeled “S” on the CO2 absorber.

3. Place the NOx absorber behind the instrument.

Figure 4.21  Connecting the NOx Absorber 

Viton Tubing

Rigid Tubing

TN Unit
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4.1.14  Preparation and Storage of Standard Solutions

4.1.14.1  Preparation of Standard Solutions

Zero water refers to a standard solution with zero concentration of TC, IC or TN; zero 
water also refers to the water used to prepare these standard solutions. Water that is, in 
theory, absolutely free of carbon (TC) or nitrogen (TN) is used as zero water. In practice, it 
is difficult to obtain this type of water. Even ultra-pure water obtained using a high-
performance membrane technique and water that has been repeatedly distilled will have a 
TC content of about 10µg/L. This value is measured directly after manufacture, and 
increases when the water is stored in a container. Carbon dioxide is contained in the 
atmosphere at concentrations ranging from 300 to 500mg/L. The CO2 content of ambient 
air is higher in a room with many people or where combustion equipment is used. Carbon 
dioxide in ambient air dissolves in stored water, taking the form of IC. The dissolved 
amount is generally about 0.2mg/L, but depends on the water temperature and carbon 
dioxide content of the air in contact with the water. Refer to Table 6.2 • "CO2 Content 
(ppm) in Distilled Water Equilibrated with Atmosphere Temperature (°C)". Instruments 
that prevent contact with air are not incorporated in water uptake, retention or storage 
processes during common distillation and purification of water. For this reason, IC is 
present in most types of distilled and purified water. In some cases, the TC content of 
commercially-available distilled water stored in plastic or glass containers is 1ppm.

Note: The degree of purity required varies depending on the analysis range. Use of 
commercially-available purified water is acceptable when measuring samples 
with expected TC concentrations around 100ppm. The quality of the zero water 
should be considered along with the analysis range.

Preparation of TC Standard Solutions 

1. Accurately weigh 2.125g of reagent grade potassium hydrogen phthalate that was 
previously dried at 105-120°C for about 1 hour and cooled in a desiccator.

2. Transfer to a 1 L volumetric flask and dissolve in zero water.

3. Add zero water to the 1 L mark, and stir the solution.
The carbon concentration of the solution is 1000mgC/L (1000mgC/L = 1000ppmC). 
This solution is the standard stock solution.
Note: The standard stock solution may be prepared at other

concentrations. For example, a 2000mgC/L solution can be used as
the standard stock solution.

4. The standard stock solution is diluted with zero water to prepare standard solutions at 
the required concentrations.
Note: The TC standard solution reagent need not be potassium hydrogen

phthalate. Depending on the application, other substances are also
acceptable (e.g., sucrose, etc.).
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Preparation of IC Standard Solution (HV)

1. Accurately weigh 3.50g of reagent grade sodium hydrogen carbonate that was 
previously dried for 2 hours in a silica gel desiccator, and 4.41g of sodium carbonate 
previously dried for 1 hour at 280-290°C and cooled in a desiccator.

2. Transfer the weighed materials to a 1L volumetric flask.

3. Add zero water to the 1L mark.

4. Stir well to mix.
In this instance, the carbon concentration of 1000mg/L is indicated as 1000mgC/L. 
The concentration of this solution is 1000mgC/L (1000ppmC) and is referred to 
below as the “TC Standard Solution”.

Preparation of TN Standard Solution 

1. Accurately weigh 7.219g of special reagent grade potassium nitrate dried for 3 hours 
at 105-110°C and cooled in a desiccator.

2. Transfer the weighed material to a 1L volumetric flask.

3. Add zero water to the 1L mark.

4. Stir well to mix.
In this instance, the nitrogen concentration of 1000mg/L is indicated as 1000mgN/L. 
The concentration of this solution is 1000mgN/L (1000ppmN) and is referred to 
below as the “TN Standard Solution”.

Preparation of POC Standard Solution (using the optional POC analysis kit)

IC standard solution is used as the POC standard solution with this instrument for the 
following reasons. 
• In POC analysis, the measured substance is an organic material that is volatile and 

poorly soluble in water (for example, benzene or chloroform). Preparing a stan-
dard solution at an appropriate concentration using these types of organic sub-
stances is difficult.

• Volatile and poorly soluble organic substances tend to undergo changes in concen-
tration during storage or handling after preparation. 

• Standard solutions that are produced using volatile and poorly soluble organic sub-
stances are difficult to use.

Consequently, the IC standard solution is used for this instrument. The preparation 
method is listed above.

TC/TN Mixed Standard Solution Preparation Procedure

When TC (or NPOC) and TN analyses are performed simultaneously, a mixed TC and 
TN standard solution is prepared.
The mixed standard solution is prepared by mixing the TC standard solution and TN 
standard solution. The mixed standard solution must contain 0.05M hydrochloric 
acid. 
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Preparation of 100mgC/L TC - 100mgN/L TN Mixed Standard Solution

1. Prepare 1L of 1000mgC/L TC standard solution using the preparation method 
described above.

2. Prepare 1L of 1000mgN/L TN standard solution using the preparation method 
described above.

3. Introduce 100mL of each of the prepared standard solutions into a 1L volumetric 
flask.

4. Add 25mL of 2M hydrochloric acid to the flask 

5. Add zero water to the 1L level. 

6. Stir well to mix.
The hydrochloric acid concentration will be about 0.05M after dilution.

4.1.14.2  Storage of Standard Solutions

The standard solutions undergo concentration changes, particularly when low-
concentration solutions are stored even for short periods. As a result, high-concentration 
standard stock solutions (for example, 1000mgC/L) should be stored in airtight containers 
in a cool, dark place. Glass bottles are suitable storage containers. Dilute the stock solution 
prior to each use. 

Storage Time

The limitation on storage of standard solutions is about 2 months for 1000mgC/L standard 
stock solutions and about 1 week for diluted standard solutions (for example, 100mgC/L). 
The limitations are for cold storage in sealed containers.

Note: IC standard solution absorbs atmospheric carbon dioxide and undergoes concen-
tration changes. As a result, it is particularly important to store IC standard solu-
tion in a sealed container.

Prepare fresh standard solutions:

• If reproducibility of analysis values is poor or concentration fluctuates.
• If contaminants, including even small amounts of dust, are present in the standard 

solution.
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4.1.15  Sample Preparation

4.1.15.1  High Sensitivity Analysis 

High sensitivity analysis refers to use of the high sensitivity analysis kit to measure trace 
amounts (commonly 0.5mg/L or less) of TOC in samples such as ultra-pure water. The 
precautions described in the sections below should be followed when conducting trace 
analysis on the order of 10 - 100µg/L.

Precautions for High Sensitivity Analysis

• Use TOC high sensitivity catalyst.
Carefully fill the combustion tube with high sensitivity catalyst to prevent contamina-
tion of the combustion tube. Measuring high-concentration samples using TOC high 
sensitivity catalyst that is intended for the analysis of ultra-pure water will influence the 
results of subsequent analyses on ultra-pure water samples. This is primarily caused by 
remaining sample residue. The residue may be removed by running repeated analyses of 
zero water. 

Since removal is difficult with residual salt, alkali or highly acidic samples, a separate 
combustion tube containing TOC high sensitivity catalyst should be prepared for use 
only with ultra-pure water samples.

Verify that both ends of the combustion tube are sealed when storing catalyst that is to 
be used only for ultra-pure water samples.

• Measure samples immediately.
Samples containing trace carbon (such as ultra-pure water) should be measured immedi-
ately after collection. If analysis cannot be performed immediately, store the sample in a 
dark location at 0-10°C (without freezing) and perform analysis as soon as possible. 

To collect the water, introduce water into a well-washed container, leaving no head-
space, and seal the container. 

• Use glass sample containers.
Glass containers are optimal for samples containing trace carbon. Commercially-avail-
able 500mL to 1 L glass screw-lid jars with Teflon seals (generally referred to as heat-
resistant screw-top jars or hermetic jars) are appropriate for use as water collection and 
transport containers.

Note: Exercise caution with plastic containers, as elution of TOC-
containing components can occur.
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• Use NPOC analysis for ultra-pure water samples.
Use the NPOC method for analysis of ultra-pure water samples. Measuring TOC in 
ultra-pure water samples by using the difference between TC and IC is prone to large 
analysis errors for the following reasons:

• The TOC value is significantly affected since a large portion of TC often comprises 
IC. Errors in TC analysis and IC analysis are additive. 

• Carbon dioxide is absorbed from the atmosphere during sample collection and anal-
ysis. During the elapsed time between TC analysis and IC analysis, the sample 
absorbs more carbon from the atmosphere, causing the IC result to be higher than the 
IC content in the TC result. As a result, subtracting the elevated IC result from the 
TC result yields a biased TOC value. 

• The TOC value can also be greatly influenced if standard solutions are not prepared 
and measured carefully. Errors are compounded since two calibration curves must be 
generated for TC and IC.

• The calibration curves are used in sample analysis by extending a two-point calibra-
tion curve through the origin.

• In NPOC analysis, POC may be volatilized from the sample during sparging for IC 
removal. This is not a problem since the ultra-pure water contains practically no 
POC.

Cautions in Calibration Curve Generation and Sample Measurement Using High 
Sensitivity Analysis

The case below describes the generation of a 2-point calibration curve shifted through the 
origin. The calibration standard concentrations are 0µg/L and 400µg/L.

Preparation of Standard Solutions

A 2-point calibration curve using 0µg/L and 400µg/L is generated. The calibration curve is 
shifted through the origin to correct for the TC contained in purified water used for 
preparation of the standard solutions.

The 0µg/L and 400µg/L TC standard solutions should be prepared at the same time using 
the same purified water. Wash well, two 250mL volumetric flasks with purified water 
(preferably water containing low TC concentration). Carefully introduce 1mL of 100mg/L 
TC standard stock solution (for a 400µg/L solution) into one of the volumetric flasks. 
Distilled water is introduced up to the graduation line in both volumetric flasks.

Standard preparation procedures should be performed as quickly as possible, using caution 
to avoid inclusion of external contaminants. If a water purification apparatus is the source 
of purified water, allow the water to flow for a few minutes prior to use, as the initial water 
will have a higher TC concentration. Alternate the flasks a number of times while filling 
them with water to equalize, as much as possible, the TC concentration of the purified 
water.

Use fresh purified water when filling the volumetric flask to the graduation line. Do not use 
rinse bottle water that has been standing for a long period of time because the TC 
concentration continually increases with time.
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Instrument Preparation

The blank peaks present at the start of high sensitivity analysis will become progressively 
smaller and gradually stabilize. As a result, calibration curves generated too soon after the 
start of analysis may be inaccurate because they contain data collected during unstable 
conditions. To prevent this problem, perform 5 or more measurements of purified water 
containing 2-3 drops of 1M HCl per 100mL of water prior to analyzing the calibration 
standards. Use the same measurement parameters (injection volume, sparge time) that will 
be used for the calibration standards and samples. 

Calibration Curve Analyses

Calibration curves are generated using the following two methods.

(1) Using standard solution in a 250mL volumetric flask
Insert the sample tubing directly into the volumetric flask until it reaches the bottom 
of the flask. Perform analyses quickly. Four to five repeated analyses can be made 
with almost no effects from the absorption of atmospheric carbon dioxide. Cover the 
opening of the volumetric flask with sealing film or paraffin to prevent contamination. 
Use this method when the IC value of the purified water used for standard solution 
preparation (specifically, 0µg/L standard solution) is about 50µg/L or less.

(2) Sparging the standard solution
To sparge in the sample injection syringe, set the acid addition ratio to 0.5%, and the 
sparge time to 2 minutes. To sparge using the optional external sparge kit, transfer 
about 60mL of the standard solution to a clean sample container, add 1-2 drops of 2M 
hydrochloric acid, sparge for 10 minutes and analyze.
Cover the sample container with paraffin or sealing film to prevent contamination. A 
glass container with an external diameter of 24-25mm and a height of 200-250mm is 
appropriate. Test tubes, stopper-equipped test tubes and chromatography tubes of 
suitable size are available commercially. If the outer diameter of the container is too 
large, the air-to-water contact efficiency is decreased, requiring a longer sparge time. 
Ensuring that the tip of the sparge tube is near the bottom of the container will 
improve the sparging efficiency.

Reference: Refer to Section 4.3.2 "Tutorial" and Section 4.4.2.2 "Calibration Curve" for detailed 
descriptions of generating calibration curves using the TOC-Control V software.

Sample Analysis

Use the calibration curve generated in the previous section to measure NPOC in the sample. 
Measure the sample using the same method used for the calibration standards. If the values 
gradually decrease with each repeated analysis using the optional external sparge kit, 
extend the sparge time to ensure sufficient sparging. The shape of the sample container, the 
sample amount, the amount of sparge gas and the IC content of the sample all have a 
bearing on the required sparge time. Determine the appropriate sparge time in accordance 
with these parameters. 

Reference: Refer to Section 4.3.2 "Tutorial" and Section 4.4.5.2 "Sample" for detailed descriptions of 
conducting sample analysis using the TOC-Control V software.
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4.1.15.2  TC Blank Check Analysis

A TOC system invariably contains substances in the instrument flow lines that produce 
peaks. These peaks are referred to as blank values or system blank values, and are present 
even in water samples containing absolutely no carbon. The magnitude of peaks in the 
blanks differs based on various factors such as system construction and the catalyst used. 
For the TOC-V, every effort has been made to minimize these peaks, which can affect the 
accuracy of TC analyses. Accuracy is particularly affected when trace TOC is measured 
(such as in high sensitivity analysis of ultra-pure water samples); for this type of analysis, 
the blank peaks must be small and stable. To check and correct for the magnitude of the 
system blank peaks, use the TOC-Control V Blank Check procedure described below.

Note: • The Blank Check procedure is available only when the high sensitivity
catalyst is used.

• The Blank Check procedure takes approximately 8 hours to complete and 
does not require continuous monitoring by the user. As a result, performing 
the procedure overnight is recommended.

• Blank values measured during the Blank Check procedure should rapidly 
decrease in magnitude and stabilize. If the instrument flow lines, syringe 
pump interior, or catalyst have been contaminated, the blank values will not 
rapidly decrease. In such instances, the Blank Check procedure should be 
repeated.

• Blank peaks are negligible in the IC analysis flow line. The IC value will be 
zero if the water is acidified and sparged. This can easily be confirmed by 
conducting analysis using the IC flow line; however, this is not normally 
necessary. Consequently, there are no special IC flow line check procedures, 
as with the TC blank check.
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Blank Check Procedure

1. Open the TOC-Control V Sample Table Editor and create a blank Sample Table for 
the high sensitivity system.
Note: Do not insert a sample into the Sample Table. The Blank Check

procedure only works in an empty Sample Table.

2. Connect the instrument by selecting Connect from the Instrument menu.

3. From the Instrument menu, select Maintenance>Blank Check.
The Blank Check Parameters dialog box is displayed.

Figure 4.22  Blank Check Parameters Dialog Box
4. Enter the desired injection volume, and click the Start button.

The Standby dialog box is displayed.

Figure 4.23  Standby Dialog Box
5. Select an option to determine the condition of the instrument after the blank check is 

complete. Options are:
• Keep running
• Shut down instrument
• Auto Restart (TC furnace, carrier gas, restart time)

6. Fill the dilution water bottle to full capacity with purified water, and place it in the 
specified position. About 200mL of dilution water is used for the blank check 
measurement.

7. Click the Standby button.
The Save As dialog box is displayed.

8. Enter a file name and click the Save button. Data from the Blank Check procedure 
will be stored in the created file.
Blank check analysis begins. The procedure that the instrument executes is described 
below.
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Description of TC Blank Check Analysis Procedure

1. Washing the inside of the trap
First, the trap is washed with water from the dilution water bottle. A 6mL aliquot from 
the dilution water bottle is drawn into the ultra-pure water trap and the trap is emptied. 
This step is repeated using another 6mL aliquot from the dilution water bottle.
Next, the trap and the system is washed with ultra-pure water. The ultra-pure water 
used to wash the trap is created when a 2mL aliquot of water from the dilution water 
bottle is injected through the TC injector and onto the catalyst. The ultra-pure water 
resulting from the analysis fills the trap and is then drawn into the syringe and 
discharged a total of 4 times.

2. Preparation of purified water for blank check
The ultra-pure water that will be used for the Blank Check procedure is created as 
follows: Six 2mL aliquots of water from the dilution water bottle are injected through 
the TC injector and onto the catalyst. The ultra-pure water resulting from the analysis 
is caught in the ultra-pure water trap. Water in the trap is further purified by injecting 
it onto the catalyst five more times in 2mL aliquots.

3. Blank check analysis
Using the ultra-pure water created in Step 2 and caught in the purified water trap, TC 
analysis is conducted 5 times. The results of each analysis are stored in the data file. 
Steps 2 and 3 are then repeated 9 more times.
Note: The magnitude and stability of the system blank value can be

evaluated from the blank check results. If the blank value is not
stable, repeat the Blank Check procedure until the magnitude of the
blank peak stabilizes.

4.1.15.3  Pretreatment for IC Removal (Sparging)

Errors for TC and IC analyses are additive. For samples that have a comparatively large IC 
concentrations relative to TOC concentrations, the TOC analysis error is large if it is 
determined by the difference between TC and IC results. Samples of this type include 
samples from water treatment facilities or from the natural environment, such as rivers, 
lakes, swamps, oceans and groundwater. 

Using the difference between TC and IC to determine TOC is not appropriate for purified 
water or ultra-pure water samples. The CO2 in air dissolves in the sample and is measured 
as IC, causing the concentration to vary.

In such cases, the sample is pretreated with aeration or sparging before analysis to remove 
the IC. The sample is then subjected to TC analysis, immediately followed by TOC 
analysis using the NPOC method.

Sparge Sequence

There are two methods for sparging with this instrument.

(1) Sparging in the sample injector syringe
This is performed only when the instrument is set for automatic sparging before 
analysis. 
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(2) Independent sparging of sample using the optional external sparge kit 
Sample is introduced into a clean sample container, acidified, and then sparged.
A glass container with an external diameter of 24-25mm and a height of 200-250mm 
is appropriate for use as the sample container. Test tubes, stopper-equipped test tubes 
and chromatography tubes of suitable size are available commercially. If the outer 
diameter of the container is too large, the air to water contact efficiency is decreased, 
requiring a longer sparge time.

Sparge Procedure

1. Refer to Section 4.1.9 "Adjusting Sparge Gas Flow Rate" for the sparge gas delivery 
procedure. 

2. Add 2M hydrochloric acid to the sample to adjust the pH to 2-3.

3. Insert the sparge tubing into the sample.
To improve the sparging efficiency, the tip of the sparge tubing should be as close to 
the bottom of the sample container as possible.

Note: In this method, sparge gas can be used independently. While the first sample is 
being measured, another sample can be sparged, thereby improving analysis effi-
ciency.

4.1.15.4  Analysis of Samples Containing Suspended Solids

Effect on Analysis

Large variations sometimes occur in TOC analyses of samples containing suspended solids 
because TOC is often contained in the suspended material. This effect is evident when the 
same sample is analyzed on two different TOC analyzers. Good results are not obtained if 
the suspended solids are handled differently in the gathering of biochemical oxygen 
demand (BOD) and TOC correlative data. 

The suspended solids described here are primarily considered impurities in the sample that 
will pass through a 50 mesh strainer (openings of approximately 0.28mm). When larger 
solid particles are present, analysis should be performed without drawing water into the 
instrument.

The procedure described below is for TOC analysis, but is also valid for TN analysis.

Analysis Restrictions 

Since Teflon tubing with an inner diameter of about 0.5mm is used in the instrument for 
injecting the sample, suspended solids that do not pass through cannot be measured. 
Analysis reproducibility is poor for samples that do not uniformly contain such solids even 
if they should pass through the tubing.

Solids that are heavy and readily form sediment, such as silt, can accumulate at the bottom 
of the syringe. This can scratch the rotor of the sample injector 8-port valve, causing leaks. 
Sedimentation and separation should be performed to as great an extent as possible prior to 
analysis.
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Countermeasures

The following types of processing operations are normally used for measuring samples 
containing suspended solids.

(1) TOC Analysis of Supernatant 
In situations when the suspended solids are of no great concern, sedimentation occurs 
in the sample container, and the supernatant sample is used. Results depend on the 
sedimentation and separation properties of the suspended solids, but usually the 
dissolved TOC (DOC: dissolved organic carbon) is measured.

(2) TOC Analysis of Filtrate
The suspended solids are removed using glass fiber filter paper or a membrane filter, 
and only the dissolved TOC is measured. Because the filter paper or filter itself is 
likely to contain TOC, thorough washing with water or sample is performed prior to 
use until no TOC is present in the eluate. Perform heat treatment on the filter for glass 
fiber filter paper.

(3) TOC Analysis of Stirred Samples
To perform intentional analysis of suspended solids, the sample is stirred using a 
magnetic stirrer or other instrument. Simple stirring can lead to extreme variability in 
the results because the suspended solids contained in the sample may not be 
distributed uniformly throughout the suspension.

(4) TOC Analysis after Homogenization of the Sample
If the application requires that the suspended solids be included in the analysis, it is 
critical that the solids are as fine as possible and distributed uniformly throughout the 
suspension. Accurate and reproducible TOC results can be obtained when the sample 
is highly homogenized to form uniform micro-size particles. 
Homogenizing systems may include a mixer to perform high-speed stirring or an 
ultrasonic system. (These are homogenizers with outputs of 150-300W. Typical 
washing sonicators do not have sufficient output for this use.) Ultrasonic systems are 
generally more powerful, though performance varies with the type of suspended 
solids.
Uniform suspension cannot always be achieved with all types of suspended solids. 
Sludge-like materials are comparatively easy to process while fibrous materials are 
more difficult.
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4.1.15.5  Handling Samples Containing Acids, Bases or Salts

Various problems can be encountered when measuring samples that contain acids, bases or 
salts. Such problems include corrosion of the NDIR analysis cell as well as detrimental 
effects on analysis values and the life of the combustion tube and catalyst. If corrosion of 
the inner surface of the NDIR cell occurs, baseline stability will decline and noise will 
increase. Samples containing acids, bases or salts should be handled as described below.

The concentration at which adverse effects are produced varies depending on the type of 
acid or salt and the TOC or TN concentration. Prior to analysis, dilute the sample so that 
acid, base and salt concentrations are reduced to 1000mg/L or less. Neutralization is also 
required for bases. The TOC-V is equipped with an automatic dilution function to perform 
these dilutions.

Acids

Acids should be diluted to a concentration of 1000mg/L or less. Concentrations up to 
5000mg/L can be used if this level of dilution cannot be reached. The acidity of 
hydrochloric acid or sulfuric acid can be reduced to a pH of 2-3 with sodium hydroxide or 
potassium hydroxide. This process produces thermally stable sodium chloride or sodium 
sulfate, which prevent the generation of acidic gas when combusting the sample. 
Neutralization of the acid is stopped at a pH of about 2-3, and TOC direct analysis (NPOC 
analysis) with sparging to remove the IC is performed. It is necessary to consider the TOC 
associated with impurities contained in the alkali reagents used for neutralization. All salts 
of nitric acid generate acidic gas under thermal decomposition; as a result, neutralization is 
ineffective. When the sample contains hydrochloric or hypochlorous acid, hydrochloric 
acid gas is generated from salts that are readily subject to thermal decomposition, such as 
ammonium chloride, calcium chloride and magnesium chloride. The instrument is 
equipped with a halogen scrubber; however, the scrubber’s main function is absorb 
hydrochloric acid gas generated by corrosion of the gold plating on the internal surface of 
the NDIR cell. 

Alkaline samples

When performing TC analysis on alkaline samples, the following problems can arise:

• Rapid decrease in sensitivity and loss of reproducibility
• Rapid degradation of catalyst or wear of the combustion tube
• Likelihood that IC will be high due to absorption of carbon dioxide

For these reasons, the NPOC analysis is suitable for alkaline samples.

In NPOC analysis, dilute hydrochloric acid is added to adjust the solution to a pH of 2-3, 
thereby forming a salt. For example, calcium chloride will be formed as a salt if the sample 
contains calcium hydroxide as the base. Since it is preferable for this salt concentration to 
be low, alkaline samples should be diluted as much as possible.

Salt accumulation

Samples should be diluted as much as possible to reduce the salt concentration and extend 
the life of the combustion tube and catalyst. Conducting a large number of analyses on 
samples containing salts will allow the salts to accumulate in the combustion tube, 
gradually increasing resistance to the flow of carrier gas and resulting in decreased analysis 
reproducibility. When decreased reproducibility is observed, perform the combustion tube 
maintenance procedure described in Section 5.2.3 "Washing/Replacing the Combustion 
and Carrier Gas Purification Tubes". 
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4.1.16  Sample Preparation 

4.1.16.1  Vial Types

Two types of autosampler vials are available. The sample volume associated with each vial 
type is shown below. Introduce the specified volume of sample into the vials; introducing 
too little sample may result in insufficient sample for analysis.

Note 1: Sample volume when sample is introduced to the bottom of vial cap.

Note 2: Sample volume when sample is introduced to about 1cm from bottom of vial cap.

In NPOC analysis, the sample volume is decreased to reduce its contact with the sample 
cap during sparging.

Note: Vials to be used for the first time should be washed with laboratory detergent and 
then rinsed well with water.

4.1.16.2  Filling Vials with Sample

In most cases, vials can be placed in the ASI-V turntable and analyzed without being 
sealed. Vials must be sealed in the following situations: 

(1) sparging with the autosampler for NPOC analysis 
(2) measuring acidic samples
(3) IC analysis 
(4) POC analysis
(5) low-concentration samples (as a guideline, less than 10mg/L) 
(6) alkaline samples (pH 7 or higher)
(7) samples that contain volatile organic hydrocarbon components
(8) a large number of samples to be measured 
(9) standard solutions

Identifying Salt Accumulation

The following situations arise when salts accumulate and clog the catalyst:

• The sound of gas release is heard when the slider moves during analysis.
• A dramatic fluctuation in carrier gas flow is noticed after the sample is injected.

Table 4.1 • Vial Types

Vial Typical Sample Volume1 Sample Volume for NPOC Analysis2

24mL 24mL 20mL

40mL 40mL 35mL
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In situations (1) and (2) above, corrosion of the instrument may occur due to spattering of 
sample, which contains acid. If the samples are left in the autosampler following 
measurement, there is danger that the autosampler may be subjected to corrosion due to the 
volatilization of acid. 

In situations (3) through (9), results may be affected by either volatilization of the TOC 
components in the sample or contamination from substances that absorb CO2 from the 
atmosphere. If aluminum foil is used to cap the sample vial for NPOC or acidic sample 
measurement, there is a danger of acid volatilization through the hole caused by insertion of 
the needle. Do not use aluminum foil to cap the vials.

Methods of Sealing Vials

Two methods of sealing the vials are acceptable. 

(1) Using the caps provided with the vials.
(2) Using a sealing material marketed under such names as Parafilm or Sealon Film. 

Note: Use caps only after washing them with water, or washing them with laboratory
cleaning solution and then rinsing with water. 

Using Caps

For 24mL vials 

Holed caps and seals are provided with the vials. 

1. Place a seal over the vial opening. 

2. Cap the vial over the seal. 
Note: Because the seals are perforated during injection, discard the seals

after use. 

For 40mL vials

Seal-equipped caps are provided with the vials.

1. Using a seal-equipped cap provides an adequate seal for the vial. 
Note: Because the seals are perforated during injection, discard the seal-

equipped cap after use.

Using Parafilm or Other Sealing Materials 

Procedure

1. Cut the Parafilm or other sealing material into approximately 25 x 25mm squares. 

2. Place a square over the opening of the vial, and stretch it to seal to the edges of the 
vials. 



4.1    Analysis Preparation
4.1.16    Sample Preparation

74 TOC-VCPH/CPN

3. Press the edges down so that they wrap around the outside of the vial. 

Figure 4.24  Sealing the Vial

4.1.16.3  Placing Vials in the Vial Rack

Remove the vial rack from the ASI-V before inserting the sample vials. There are three 
different types of vial racks, each accommodating a different vial size.

The ASI-V permits random access of vials in the vial rack. Vials are measured according to 
the sequence set in the Sample Table Editor, thus enabling analysis to start from any 
position number in the vial rack, and for analysis to occur in non-sequential vial positions.

TIP » When samples are to be sparged using the optional external sparge kit, analysis is 
performed more efficiently if the vials are placed in sequential rack positions without gaps. 
This allows a vial to be sparged while an adjacent vial is being measured.

Installing the Vial Rack 

Install the rack using the following procedure.

1. Insert the vials into the vial rack and place the rack on the ASI-V turntable.

2. Place the cover over the turntable.
Note: During analysis, the turntable must be covered. The ASI-V will not

operate if the turntable cover is not detected.

Be careful that
 film edges do not
 descend below
 vial threads.
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4.1.16.4  High Sensitivity Autosampler Analysis

If samples with TOC concentrations of 100µg/L or less (such as purified water or ultra-pure 
water) are measured using an autosampler, the following precautions associated with high 
sensitivity analysis must be considered. Refer to Section 4.1.15.1 "High Sensitivity 
Analysis" for additional information.

(1) NPOC analysis is recommended. TOC (TC-IC) analysis tends to have a greater 
variation in measured values than the NPOC analysis because IC often accounts for a 
significant portion of the TC, and the errors in the two values are additive, which 
significantly affects TOC analysis.

(2) To generate a calibration curve, fill well-washed vials with standard solutions to about 
5-10mm from the top of the vial, and immediately seal each vial.
Use a cap that has been washed with purified water prior to use.
When placing the vial in the rack, handle the vial carefully to avoid contact between 
the standard solution and the cap. 
Low-concentration standard solutions must be prepared each time they are used.

(3) To stabilize the peaks, perform 4 to 5 injections using the same analysis parameters 
prior to analyzing the calibration standard solutions. For example, to generate a 
400µg/L calibration curve, place a 0µg/L standard solution in vial position 1 and 
measure it 4 to 5 times using the same analysis parameters that were selected for the 
calibration curve. Refer to Section 4.4.4.1 "Calibration Curve". The objective at this 
point is not to generate a calibration curve, but to inject water using the same injection 
volume used for the calibration curve that is to be generated. This not only stabilizes 
peaks but also thoroughly washes the sample needle and sparge needle with purified 
water. 
After the stabilizing injections are complete, place the 0µg/L and 400µg/L calibration 
standard solutions in vial positions 2 and 3, insert the calibration standards into the 
Sample Table Editor, and start measurement. Refer to Section 4.4.4.1 "Calibration 
Curve".

(4) Acid addition for NPOC analysis can be performed automatically using the ASI-V. It 
is best to perform manual addition of hydrochloric acid for NPOC analysis on the 
order of 10µg/L. This is because, automatic acid addition pierces the vial seal and 
allows CO2 contamination from the air.

(5) To prevent rinsing of the needle, deselect the “Rinse” option and set the “No. of 
Needle Washes” field to zero in the Instrument Properties Dialog Box>ASI Window. 
Refer to Section 3.2.4 "ASI Window".
Even if ultra-pure water is used as rinse water, the TOC concentration of the rinse 
water will increase during the time it is exposed. For best results, do not rinse the 
needle for analyses on the order of 100µg/L. 

(6) Do not use the analysis value acquired from the first sample vial. In sample analysis, 
particularly analysis on the order of 10µg/L, the first sample measured may yield high 
results.

(7) When using the optional external sparge kit, perform sparging using a sparge gas flow 
rate of 100mL/min.
As a guideline, use sparge times of 5 to 10 minutes for 24 and 40mL vials. Increase 
the gas flow rate or sparge time if sparging is insufficient.
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4.1.16.5  Acid Addition in NPOC Analysis

Automatic addition of acid is possible using the autosampler when the optional external 
sparge kit is installed. Using the ASI-V, acidification and sparging can be performed on 
samples during NPOC analysis. To perform acid addition using the autosampler, enter the 
desired amount in the “Acid Addition” field on the Injection Parameters window of the 
Sample Wizard (refer to Section 4.4.5.2 "Sample") or Method Wizard (refer to 4.4.2.3 
"Method Wizard").

When analysis is started, acid is drawn from the acid bottle into the syringe, and the set 
amount of acid is added from the sample needle into each of the vials that have been 
designated for acid addition. Use 2M hydrochloric acid. The acid addition ratio (ratio of 
acid with respect to sample) should be set to about 2-5%. However, a setting of about 0.5% 
is used for purified water analysis.

The hydrochloric acid concentration or amount added should be adjusted in accordance 
with the sample pH or buffering strength to bring the sample pH to 2-3. Prior to analysis, 
verify that the pH is 2-3 using pH paper. The pH need not be checked each time if the same 
type of sample is routinely measured.

CAUTION
Hydrochloric acid is a hazardous chemical. Exercise caution when handling to
prevent contact and spills. For details, refer to  Section 6.9 "Material Safety Data
Sheets".

If the sample pH does not reach a value between 2 and 3, increase the acid addition ratio or 
the acid concentration. Excessively increasing the acid addition ratio will result in dilution 
of the sample. On the other hand, if the acid amount is too small, the size of the acid droplet 
on the tip of the needle will not be large enough to drop from the needle. 

Visually observe the process through the glass vial to determine if the acid droplet is 
actually added to the sample. 

The needle will be rinsed following each acid addition by selecting the “Rinse after acid 
addition” option in the Instrument Properties Dialog Box>ASI Window. To save time 
during the analysis sequence, rinsing of the needle is unnecessary if the variation in NPOC 
concentration among the samples is not large.
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4.1.16.6  Sparging in NPOC Analysis 

Samples placed in the autosampler can be sparged by setting a sparge time if the optional 
external sparge kit is installed. 

If the coaxial needle is used (24mL or 40mL vials), sparging can be performed for the 
specified time, followed immediately by drawing sample into the syringe and then by 
analysis.

If the coaxial+sparge needle is used (24mL and 40mL vials), the next sample to be 
measured can be sparged while the sample vial in the sampling position is being measured. 
In this case, sparging is not performed again on the sample when it reaches the sampling 
position, which does not pose a problem for ppm-level NPOC. 

When measuring NPOC at the µg/L level, use the coaxial needle. This will prevent 
atmospheric CO2 and other contaminants from entering the vial. 

If the sparge gas flow rate is set too high, sample will be spattered onto the cap seal. Adjust 
the sparge gas flow rate to avoid this undesirable spattering.

To verify that enough IC is removed during sparging using the autosampler to enable 
unhindered NPOC analysis, perform IC analysis on the remaining sample following NPOC 
analysis. 

CAUTION
When the vials are capped and sparging is performed without automatic acid
addition via autosampler, pierce the caps before analysis by using the tip of a
provided needle or other instrument. This allows the sparge gas to vent. If sparge
gas is not vented from the vials, pressure will build inside the vials and prevent
effective sparging. 
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4.1.16.7  Stirrer Preparation

This section describes the procedure for enabling the optional stirrer.

Procedure

1. Open the TOC-Control V Sample Table Editor.

2. From the Instrument menu, select Properties.
The Instrument Properties dialog box is displayed. 

3. Click the ASI tab, then click in the “Stirrer On” check box to enable the stirrer.

4. Click the OK button.

Adjusting the Rotation Speed

Turn the knob at the bottom of the right side of the autosampler to adjust the stirring speed.

Note: Capabilities of the Optional ASI-V Magnetic Stirrer

• The stirrer bar rotates inside the vial to agitate and mix suspended solids in 
the sample. The magnetic stirrer cannot be expected to pulverize and 
homogenize suspended solids, except when they are extremely easy to crush. 

Pretreatment of samples that contain suspended solids should include sample 
homogenization to a point where the particles are distributed uniformly in as 
small a particle size as possible. Well-homogenized samples can be measured 
with good reproducibility. Stirring a non-homogeneous suspension will not 
provide a uniform suspension, resulting in poor measurement reproducibility. 
First apply a powerful enough homogenization process (ultrasonic waves, 
etc.) to crush every particle in the sample as much as possible, and then 
perform the TOC measurement. 

• The ASI-V stirrer bar may not be able to sufficiently agitate and mix the 
sample because of the wide variety of characteristics of suspended particles, 
such as shape, specific gravity, size, strength, degree of cohesion, etc. For 
example, solid particles with a high specific gravity sink to the bottom and 
prevent formation of a good mixture. 
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Note: Operation of the Optional ASI-V Magnetic Stirrer

• Two types of magnetic stirrers available, one for the 24mL and one for the 40mL 
size vials. 

• All of the vial positions may be used with 40mL vials. All positions except the 
innermost row can be used with 24mL vials. 

• The magnetic stirrer will only properly agitate vials in the sampling position and 
the position just in front of the sampling position (advance processing position).
For example, if vial number 20 is selected, stirring is performed for vial 20 (sam-
pling position) and vial 21 (advance processing position). The stirrer bar may not 
work normally for other vial positions. The stirrer bar rotation axis may shift, 
depending on the shape of the vial bottom; this has almost no effect on the effec-
tiveness of the stirring. 

• Adjust the stirrer rotation speed according to the sample properties. Use the stirrer 
rotation speed adjustment control on the right side of the ASI-V.
Increasing the speed excessively may cause the stirrer bar to jump around instead 
of rotate.

• Turning the stirrer on and off repeatedly, while the stirrer is set at the slowest 
speed could cause the rotation speed to become uneven.
In this situation, adjust the rotation speed using the following procedure. ON /OFF 
control of the stirrer is performed on the screen.

Setting the Stirrer Rotation Speed

Perform the following steps to achieve nearly equivalent rotation speeds in all of the 
instruments used.

1. Turn the stirrer OFF.

2. Set the stirrer speed to the highest speed using the “Stirrer Rotation Speed Adjustment 
Knob”.

3. Turn the stirrer ON and OFF several times.

4. With the stirrer ON, lower the stirrer speed. 
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4.1.17  8-Port Sampler Measurement

4.1.17.1  Type of Sampler Container

There are no restrictions on the type of sample containers that can be used with the 8-Port 
Sampler. It is only necessary that the containers be placed so the sample tubing from the 
various ports can be inserted directly into the containers. 

Note: Wash all sample containers with an appropriate laboratory detergent, and rinse 
them thoroughly with water before using them for the first time. 

Loading the Sample

Although it is possible to perform measurement of a sample using the 8-Port Sampler, 
while the container open, in the following situations, it is necessary to seal the sample 
container. 

(1) When performing IC measurement
(2) When performing POC measurement
(3) When performing measurement of low concentration samples (e.g., 10 mg/L)
(4) When performing measurement of alkali samples of pH 7 or higher 
(5) When performing measurement of samples containing volatile organic carbon 

compounds
(6) When the number of samples is so great as to require a long measurement time
(7) When performing measurement of standard solutions
Note: If the sample container openings are not sealed in the situations listed above, 

measurement values may be influenced by such factors as absorption of atmo-
spheric CO2, contamination with carbon containing substances, and evaporation 
of TOC constituents from the samples. 

Sealing the Sample Containers

Sample containers may be sealed using commercial sealing films such as Parafilm. It is also 
possible to pierce the lid of the container and insert the sample tubing into the container 
through this opening. 

Note: In either case, wash the container with a laboratory detergent, and rinse it thor-
oughly with water before use. 
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Sealing the Container with Parafilm

1. Cut a piece of Parafilm to size according to the size of the sample vessel opening.

2. Insert the tip of the sampling tube into the vessel, cover the opening with the prepared 
Parafilm, and seal the opening of the vessel, stretching the Parafilm over the edges. Be 
sure that a very small gap in the seal is formed to prevent creation of negative pressure 
inside the vessel. 

3. Press the overlapping portions of the Parafilm around the neck of the opening.

Figure 4.25  Sealing the Container

Parafilm
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4.1.17.2  High Sensitivity Using the 8-Port Sampler

If samples such as purified water or ultra-pure water, having a TOC concentration of 
100ppb or less, are to be measured using the 8-Port Sampler, it is necessary to consider the 
following precautions associated with high sensitivity analysis. Refer to Section 3.3.1.4 
“High Sensitivity Autosampler Analysis” in the TOC-VCSH/CSN User Manual for more 
information.

1) NPOC analysis is recommended because TOC (TC-IC) analysis tends to have a 
greater variation in measured values than NPOC. This is because IC often accounts 
for a significant portion of the TC, and the errors in the two values are additive using 
TOC (TC-IC) analysis. This affect significantly influences TOC analysis. 

2) For calibration measurement of standard solutions, fill well-washed containers 
with standard solutions to about 5-10 mm from the top of the container, and 
immediately seal each container. When placing the container below the 8-Port 
Sampler, handle it carefully to avoid the standard solution contacting the sealing 
surface. Low-concentration standard solutions must be prepared each time they 
are used. 

3) To ensure that the peaks are stable for generating the calibration curve, perform 
4-5 injections using the same analysis parameters prior to performing the 
calibration curve analysis. For example, to generate a 400ppb calibration curve, 
set 400ppb as the 1st standard solution concentration, and enter 1 as the 
container number. Actually place a 0ppb solution in the container for port No. 1. 
The objective at this point is not to generate a calibration curve, but to inject 
water using the same injection volume that will be used to generate the 
calibration curve. This not only stabilizes the instrument but also thoroughly 
washes the sampling needle with purified water. 

In the 2nd row of the settings screen and using the same calibration curve number 
as above, set the analysis parameters for 0ppb and 400ppb. When sample mea-
surement starts, the calibration curve to be used will be created with the correct 
standard solutions. 
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4.2  Setting General Measurement Parameters

4.2.1  TOC Parameter Settings

The following parameters must be set for analysis using the PC-controlled TOC-V 
analyzer: The items available for editing change depending on the options that are installed.

• Tubing Diameter
• Buzzer
• Auto regeneration of IC solution
• Ready status check
• TN Power Source

Setting Procedure

1. In the TOC-Control V main window, double-click the icon for the desired instrument.
The Instrument Properties dialog box is displayed.

Figure 4.26  Instrument Properties Dialog Box: TOC Tab

2. Click the TOC tab.
The Main Unit Version field displays the instrument version number; this field cannot 
be changed by the user.

3. Enter the parameters as described below:

Tubing Diameter

Specifies the diameter size of the sample injection tubing. Select the tubing diameter 
from the drop-down list. Available options are:
• Regular: 0.5mm diameter
• Suspended Particle: 0.8mm diameter
The typical tubing diameter is 0.5mm. Select a tubing diameter of 0.8mm if the Sus-
pended Solids kit is used.
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Buzzer

Enables the internal buzzer function. Select this option to allow the buzzer to sound 
during measurement.

Auto regeneration of IC solution

Enables the automatic regeneration of IC solution. This option is enabled only when 
IC measurement is being performed, and is typically selected. Refer to Section 3.2.3 
"TOC Window" for a detailed description of this option.

Enable ready status check

Enables the Ready Status Check function. When the function is enabled, the software 
always verifies that the instrument is in the Ready state prior to starting measurement. 
Enabling the Ready Status Check function is recommended. When the function is 
deselected, measurement can be performed when the instrument is not in the Ready 
state, an option that is mainly for use by service personnel.

TN Power Source

Select this item if the optional TNM-1 unit is installed to perform TN analyses.

TC Furnace

Select the desired TC furnace temperature by clicking the appropriate radio button. If 
“Combustion” is the selected oxidation method, select 680 or 720. If “Wet Chemical” 
is the selected oxidation method, the TC Furnace field is set to Off and disabled.

4.2.2  ASI Parameter Settings

The following parameters must be set when using the ASI-V:

• Tray type
• Needle
• Number of needle washes
• Number of flow line washes
• Rinse
• Rinse after acid addition
• Stirrer ON

Setting Procedure

1. In the TOC-Control V main window, double-click the icon for the desired instrument.
The Instrument Properties dialog box is displayed.
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2. Click the ASI tab.

Figure 4.27  Instrument Properties Dialog Box: ASI Tab

3. Enter the parameters as described below:

Tray Type

Specifies the size of the vials used in the ASI rack. Select the vial size from the drop-
down list. Available options are 24mL Vial and 40mL Vial.

Needle

Specifies the type of needle used for analysis. Select the needle type from the drop-
down list. Options are:
• Sample: for analysis using only a sample needle
• Sample+Sparge: for analysis using both a sample needle and a sparge needle
• Coaxial: for analysis using an integrated sample and sparge needle
• Coaxial+Sparge: for analysis using both the coaxial needle and a sparge needle, 

which allows a sample to be measured while the next sample is sparged.
• The instrument does not automatically recognize the type of needle

installed. Be sure to select the type of needle that is actually installed in
the instrument.

No. of Needle Washes

Specifies the number of times the needle will be rinsed after sample injection. This 
operation rinses the outside of the needle using water drawn from the dilution water 
bottle. Rinsing the needle can prevent poor injection quality that results from salt 
buildup at the tip of the injection tube during sample analysis. Such salt buildup is 
especially problematic when analyzing samples with high salt concentrations 
(1000ppm or greater). 
Enter a number ranging from 0 to 10 in the No. of Needle Washes field.
Note: Needle rinsing is not required when samples contain low salt con-

centrations. Three rinses are recommended for samples containing
salt concentrations of 1% or more.
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No. of Flow Line Washes

Specifies the number of times the flow lines will be rinsed after all samples listed in 
the Sample Table have been measured. This operation rinses the flow line from the 
sample needle to the injection tube using water drawn from the dilution water bottle. 
If the automatic acid addition option has been selected, the flow lines will be rinsed 
the specified number of times following acid addition to each sample; rinsing after 
acid addition removes acid that remains in the sample needle or flow lines.
Enter a number ranging from 0 to 10 in the No. of Flow Line Washes field.
Note: Typically, 2 flow line rinses are sufficient. Three to four rinses are

recommended for samples containing acid, base, or salt.

Rinse

Enables automatic rinsing of the sample needle and sparge needle between each sam-
ple using water from the dilution water bottle.
Note: • Rinsing between each sample prevents carryover from one sample to the 

next. Rinsing is not necessary if all samples contain similar analyte con-
centrations.

• Rinsing is not recommended when analyzing ultra-pure water samples
with expected concentrations of less than a few hundred µg/L. The con-
centration of carbon in the rinse water may affect the sample results.
Rinsing with ultra-pure water will not reduce this effect, as the concen-
tration of carbon in the rinse water will increase with exposure to the
atmosphere.

Rinse after acid addition

Enables automatic rinsing of the sample needle and flow lines after each acid addi-
tion. 
Note: Rinsing the needle after each acid addition is not necessary if all

samples contain similar NPOC concentrations. Eliminating the
rinsing operation will save time during the analysis sequence. 

Stirrer On

Enables the magnetic stirrer. Select this option to stir the samples while measurement 
is being performed.
Note: Stirring a sample during measurement prevents settling or clump-

ing of suspended solids, thereby including suspended solids when
the sample is drawn into the syringe.
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4.2.3  Setting Default Measurement Parameters

The Default Measurement Parameters window is used to enter the default values for sample 
measurement parameters. The selections made in the Default Measurement Parameters 
window will be displayed as the default values when setting calibration curve and sample 
measurement parameters.

Procedure

1. From the Options menu in the Sample Table Editor, select Default Measurement 
Parameters.
The Default Measurement Parameters window is displayed.

Figure 4.28  Default Measurement Parameters: TC/IC/NPOC/POC/TN Tabs
2. Enter the following parameters on each of the applicable tabs:

• Units: Select the default concentration units for the measurement results
• No. of Injections: Enter the default minimum/maximum number of injections
• No. of Washes: Enter the default number of times the syringe is to be washed with 

sample prior to the first injection. In POC analysis and IC analysis with the N-type 
this refers to the number of syringe rinses using dilution water.

• Max SD: Enter the default maximum standard deviation that is acceptable for 
repeat measurements. If this value is met, no additional injections are required. 
However, if both this value and the Max CV value are exceeded, the samples are 
automatically reinjected up to the maximum number of times specified in the No. 
of Injections field. The Max SD field is disabled if the Number of Injections is 1 or 
if the minimum is equal to the maximum. The default value for Max SD is 0.1.

• Max CV: Enter the default maximum coefficient of variation that is acceptable for 
repeat measurements. If this value is met, no additional injections are required. 
However, if both this value and the Max SD value are exceeded, the samples are 
automatically reinjected up to the maximum number of times specified in the No. 
of Injections field. The Max CV field is disabled if the Number of Injections is 1 
or if the minimum is equal to the maximum. The default value for Max CV is 2%.

Note: The “maximum” No. of Injections field refers to the maximum
number of repeat injections to be performed when the automatic
additional measurement function is enabled. Additional measure-
ments are performed when both the Max SD and Max CV settings
are exceeded. When both of these values are exceeded for the set
number of sample injections, the additional measurement function
is automatically activated and the sample is reinjected.
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4.2.4  Maintenance History Settings

Enter limits for the following parameters to display a warning message when the limits are 
exceeded:

• Combustion Tube Sample Injection Volume: Refers to the total volume of sample that 
can be injected into the combustion tube before catalyst and combustion tube mainte-
nance is required.

• Dilution Water: Refers to dilution water volume
• Total Acid Volume: Refers to the total volume of acid used
• Syringe Stroke: Refers to the number of syringe operations
• UV Lamp: Refers to time of operation of UV lamp
• IC Unit Pump Tubing: Refers to time of IC unit pump tubing use. The recommended 

warning value is 300 hours.
• ASI Rinse Pump: Refers to time of ASI rinse pump tubing use. The recommended 

warning value is 300 hours.

Procedure

1. From the Instrument menu in the Sample Table Editor window, select 
Maintenance>History.
The Maintenance History dialog box is displayed.

Figure 4.29  Maintenance History Dialog Box

2. Enter warning limits by placing the cursor in the appropriate fields and entering 
numeric values.

3. Click the OK button.

TIP » Measurement will be interrupted if the dilution water or acid reservoirs run dry during 
analysis. To prevent measurement interruption, set the dilution water and total acid volume 
limits to values slightly less than the remaining volume of each respective liquid. A warning 
message will be generated before each liquid is completely consumed.Click the Reset 
button to the right of a parameter to clear its current value.
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4.3  Measurement Procedures and Tutorial

4.3.1  Starting Up the Instrument

4.3.1.1  Turning on the Power

Turn on the power to the instrument by pressing the power key on the bottom right of the 
front panel.

Note: Press the power key again to turn off power to the instrument.

4.3.1.2  Carrier Gas Pressure

Procedure for setting the carrier gas pressure

1. Set the supply pressure of the carrier gas to 300kPa using the pressure regulator at the 
carrier gas supply source (cylinder).
Note: If compressed air or instrumentation air is used, verify that the

supply pressure is greater than 300kPa and does not exceed 600kPa.

2. Open the front door of the instrument and adjust the carrier gas pressure to 200kPa 
using the carrier gas pressure regulation knob.

Figure 4.30  Setting the Carrier Gas Pressure

Carrier Gas Pressure 
Regulation Knob

Carrier Gas
Pressure Regulator
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4.3.1.3  Carrier Gas Flow Rate

Procedure for setting the carrier gas flow rate

1. Open the front door of the instrument.

2. Turn the carrier gas flow adjustment knob. For H Type, adjust the flow rate to 
150mL/min, as indicated on the flow rate gauge. 

Figure 4.31  Setting Carrier Gas Flow Rate

Note: • Do not change the carrier gas flow rate during analysis. The peak area
changes in an inversely proportional relationship and may cause errors in
analysis precision.

• With the N Type, although the flow rate is adjusted to indicate 130mL/min on 
the flow rate gauge, the actual flow rate used is 230mL/min.

4.3.1.4  Electric Furnace 

The electric furnace power must be turned on for TC, TOC, NPOC, POC and TN analyses. 
The electric furnace does not need to be turned on if only IC analysis is performed. When 
TN analysis is conducted, the TN unit must also be turned on.

Turn On Power to the Electric Furnace

1. In the TOC-Control V main window, double-click the icon for the desired instrument.
The Instrument Properties dialog box is displayed.

2. Click the TOC tab.

3. Set the TC furnace temperature to either 680°C or 720°C (used for TN measurement).

4. Click the OK button.
The screen returns to the TOC-Control V main window.

Note: It takes 30-40 minutes after the electric furnace power is turned on for the tem-
perature to reach the set value. Refer to Section 4.3.3 "Ending Measurement" to 
turn Off the instrument,.

Carrier Gas Flow

Flow Rate Gauge

Rate Adjustment 
Knob
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4.3.1.5  TN Unit

When TN analysis is to be performed using the optional TN unit, power to the TN unit and 
ozone generator must be turned on.

Turning Power to the TN Unit ON 

1. In the TOC-Control V main window, double-click the icon for the desired instrument.
The Instrument Properties dialog box is displayed.

2. Click the TOC tab.

3. Click in the TN Power check box to select the option.

4. Click the OK button.
The screen returns to the TOC-Control V main window.

Turning Power to the Ozone Generator ON 

1. Press the power switch at the lower right of the TN unit.

TIP » Power Button positions:

4.3.1.6  Ozone Source Airflow Rate for the TN Unit

Adjust the ozone source airflow knob on the TN unit to indicate 500mL/min on the flow 
rate gauge.

ON
OFF
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4.3.2  Tutorial 

This tutorial gives step-by-step instructions on the use of the TOC-Control V software. The 
tutorial assumes that the hardware and software have been installed in the manner 
described in Chapters 2 and 3, and that users have a configured system that includes the 
TOC-VCPH, ASI and TNM-1 unit.

Note: • If your system does not include the ASI and TNM-1 units, please adjust the
tutorial procedure as appropriate.

In the tutorial, a three-point TC/TN calibration curve and one unknown sample will be 
measured. Pure water and the following calibration standards are needed for the tutorial:

• A calibration standard mixture of 0ppm potassium hydrogen phthalate and 0ppm 
ammonium chloride

• A calibration standard mixture of 50ppm potassium hydrogen phthalate and 10ppm 
ammonium chloride

• A calibration standard mixture of 100ppm potassium hydrogen phthalate and 20ppm 
ammonium chloride

Reference: Prepare calibration standards as described in Section 4.1.14.1 "Preparation of Standard 
Solutions".

The following topics are covered in the tutorial:

Step 1 Configuring the instrument

Step 2 Connecting the instrument

Step 3 Creating a sample table

Step 4 Setting up the calibration standard runs

Step 5 Setting up an unknown sample run

Step 6 Performing measurement

Step 7 Evaluating the results

Step 8 Printing a report
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Configuring the Instrument (Step 1)

Procedure

1. Start the TOC-Control V software by double clicking the icon or selecting it from the 
Start>Programs list. 
The TOC-Control V main window is displayed. 

Figure 4.32  TOC-Control V Main Window

2. The instrument configuration must be specified in the software before the instrument 
can be connected to the PC for the first time. Only users with administrative privileges 
can configure the instrument. If the system has already been configured, proceed to 
Step 2 of the tutorial.

3. From the TOC-Control V main window, double-click the New System icon.
The User dialog box is displayed.

4. Enter your user name and password as shown below.

Figure 4.33  Enter User Name and Password
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Click the OK button. The Instrument Setup Wizard opens.

Figure 4.34  Enter the Name of the System

5. In the System Information window of the Instrument Setup Wizard, enter the System 
Name and Instrument Serial Number. Click the Next button.
The Options window of the Instrument Setup Wizard is displayed.

Reference: For details on the System Name and Instrument Serial Number, refer to  Section 3.2.1 
"System Information Window".

Figure 4.35   Configured Options

6. Specify the options that are configured on the system by clicking in the appropriate 
check boxes, as shown in the above figure.

7. Click the Next button. The TOC window of the Instrument Setup Wizard is displayed.
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8. Select the TOC analysis parameters, as shown in the figure below.
Note: Be sure that the “Enable ready status check” option is selected.

Enabling the ready status check function means that the instrument
will not begin a new injection until the instrument status is Ready. 

Figure 4.36  TOC Analysis Parameters

Reference: For details on TOC parameters, refer to Section 4.2.1 "TOC Parameter Settings"

9. Click the Next button. The ASI window of the Instrument Setup Wizard is displayed. 
Verify that the ASI parameters match those shown on the figure below.

Figure 4.37  Autosampler Parameters

10. Click the Next button. The Communication window of the Instrument Setup Wizard 
is displayed. 

11. Verify the communication information (COM Port, Stop Bits, and Parity). 
Note: If a Shimadzu representative installed your TOC-Control V soft-

ware, the correct settings for your system are already configured.
Please do not change the settings. Refer to Section 3.2.6 "Commu-
nication Window" for more information on Communication set-
tings.
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12. Click the Next button. The History Function window of the Instrument Setup Wizard 
is displayed. If desired, enable the History Log to track all changes to the method. 
Refer to Section 3.2.7 "History Function Window" for more information about the 
History Log.
Note: If Audit Trail was checked for the GLP/GMP 21 CFR item in

System Administration Tools of the TOC-Control V main menu,
the History Log function is automatically activated.

13. Click the Finish button.
An icon for the system  now appears in the TOC-Control V main window.

TIP » To edit the system configuration, double-click the system icon in the TOC-Control V main 
window or, when in the Sample Table Editor window, select Properties from the Instrument 
menu. The Instrument Properties dialog box opens, and system configuration options are 
displayed on tabs in the dialog box.

Connecting the Instrument (Step 2)

Opening a New Sample Table

1. In the TOC-Control V main window, double-click the Sample Table Editor 
icon. The User dialog box is displayed.

2. Enter your user name and password. Click the OK button.

3. Open a new Sample Table by either selecting New from the File menu or clicking the 

New  toolbar button. The New dialog box is displayed.

Figure 4.38  Sample Run Icon

4. Click the Sample Run icon, then click the OK button. 
The General Information dialog box opens.

Change Graphic
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5. Click the System tab and select the desired system from the drop-down list.

6. Select Save File As in the File menu. Enter Tutorial and click the Save button.

Figure 4.39  Save As Dialog Box

7. Click the OK button.
A new, blank Sample Table is displayed.

Figure 4.40  New Sample Table
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Connecting to the Instrument

1. To establish communication between the software and the instrument, either select 

Connect from the Instrument menu or click the Connect  toolbar button.
The Parameter Configuration dialog box is displayed. Click the Use Settings on PC 
button.
The Sequence dialog box is displayed.

Figure 4.41  Connection in Progress

2. The Sequence dialog box displays information about the attempt to establish 
communication between the software and the instrument. 

Creating a Sample Table (Step 3)

Procedure

Creating a Sample Table involves three steps. First, enter the default analysis parameters 
for the Sample Table (.t32) file.

1. From the Options menu, select Default Measurement Parameters.

2. Three injections of each calibration standard and unknown sample will be made. On 
the TC tab change the “No. of injections” value to 3.
The other default measurement parameters should not be changed.

3. On the TN tab change the “No. of injections” value to 3.
The other default measurement parameters should not be changed.

Figure 4.42  Default Measurement Parameters Dialog Box
Note: The selected measurement parameters will appear as default values

when setting up calibration and method files.
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Reference: For details, refer to Section 4.2.3 "Setting Default Measurement Parameters".
Modify the Sample Table window display settings so that all items contained in the 
Sample Table are shown on the screen. The default display settings may not include 
all of the Sample Table parameters.

4. From the Options menu, select Display Settings>Table Settings.

5. Ensure that all items on both tabs in the Table Options window are selected. If not, 
click the Select All button.

Figure 4.43  Table Options Window

Note: Use this window in the future to create custom Sample Table win-
dows that display only the desired items.

6. Save the Sample Table (.t32) file.

7. From the File menu, select Save As.
The Save As dialog box is displayed. Enter “Tutorial” as the file name and click the 
Save button.
Note: The name “Tutorial” appears at the top of the Sample Table win-

dow and for the directory name after the file is saved.
The basic instrument configuration and analysis parameters have been set up.

Reference: Refer to Section 4.4 "Sample Table Editor" for detailed descriptions of the Sample Table 
Editor menus and commands.
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Setting up the Calibration Standard Runs (Step 4)

Setting up calibration standard runs involves two steps: creating a calibration file, which 
stores information about calibration standard measurements, and inserting the calibration 
standard runs in the Sample Table. Separate calibration files are created for the TC and TN 
analyses. The calibration is a three-point curve generated using standard mixtures of 
potassium hydrogen phthalate and ammonium chloride.

Creating the TC Calibration File

1. Open the Sample Table. From the File menu, select New. 
The New dialog box is displayed. Click the Calibration Curve icon.

Figure 4.44  Creating a New Calibration File

2. Click the OK button to open the Calibration Curve Wizard. Specific information 
about the calibration will be entered in the wizard.

Figure 4.45  System for Analyses of the Calibration Standard 



4.3    Measurement Procedures and Tutorial
4.3.2    Tutorial

101TOC-VCPH/CPN

3. Select the system to be used for the analyses from the drop-down list on page 1 of the 
Calibration Curve Wizard. Click the Next button.
Page 2 of the Calibration Curve Wizard, which lists options for calibration curve type, 
is displayed. The four types of calibration curves available are:
• Calibration points are distributed uniformly over the concentration range
• Edit calibration points manually
• Calibration curve according to DIN38402/P-51
• Calibration curve according to USP/EP

Figure 4.46  Calibration Curve Type

4. Click the radio button for “Calibration points are distributed uniformly over the 
concentration range.” In the future, other options may be more appropriate. Refer to 
Section 4.4.2.2 "Calibration Curve" for a detailed description of the calibration curve 
types. 
Click the Next button.
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5. Page 3 of the Calibration Curve Wizard is displayed. The following options for 
calibration analysis are displayed:
• Analysis
• Default Sample Name
• Default Sample ID
• Calculation Method: Linear Regression or Point to Point
• Check box for Zero Shift 
• Check box for Multiple Injections
• Calibration File Name

Select the following options, as shown on the figure below:
• Analysis: TC
• Default Sample Name: Standard
• Default Sample ID: Tutorial
• Calculation Method: Linear Regression
• Check box for Zero Shift: Deselect this option 
• Check box for Multiple Injections: Deselect this option
• Calibration File Name: TCTutorial.cal

Figure 4.47  TC Calibration Analysis Information

6. Click the Next button. Page 4 of the Calibration Curve Wizard is displayed.
Notice that the No. of Injections displayed matches the number entered when setting 
the default measurement parameters for the Sample Table in Step 3 of the tutorial.
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7. Enter the TC calibration standard concentration range values of 0 to 100ppm.
Enter 3 as the number of calibration points.

Figure 4.48  TC Calibration Standard Information

8. Click the Next button.
Page 5 of the Calibration Curve Wizard displays the Calibration Points List.

9. Notice that the Calibration Points List was completed based on information entered 
on the previous Wizard pages. To make any changes, select a row and click the Edit 
button.

Figure 4.49  TC Calibration Points List

10. Click the Next button. 
Page 6 of the Calibration Curve Wizard, which specifies peak integration parameters, 
is displayed.

11. Settings can be made on this page to delay the peak detection start time or extend the 
peak detection time. View but do not change the default setting on the page.
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12. Click the Next button.
Page 7 of the Calibration Curve Wizard is displayed. The History function can be 
enabled on this page of the wizard. View but do not change the default setting.

13. Click the Finish button.
The Calibration Curve Wizard closes. The TC calibration curve file is now complete 
and has been saved.

Creating the TN Calibration File

The TN calibration file is created by following the same steps used to create the TC 
calibration file, with the exceptions described below. 

1. On page 3 of the Calibration Curve Wizard, specify the Analysis as TN and enter 
“TNtutorial.cal” as the calibration file name.

Figure 4.50  TN Calibration Analysis Information

2. On page 4 of the Calibration Curve Wizard, enter 0 to 20ppm for the Concentration 
Range and 3 for the number of calibration points. 

Figure 4.51  TN Calibration Measurement Parameters
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3. Page 5 of the Calibration Curve Wizard should match the following figure.

Figure 4.52  TN Calibration Points List 

4. Complete the TN calibration file by viewing but not changing pages 6 and 7 of the 
Wizard and clicking the Finish button. 
The TN calibration curve file is now complete and has been saved.

Reference: Refer to Section 4.4.2.2 "Calibration Curve" for a detailed description of the Calibration 
Curve Wizard.

Entering the Calibration Standard Runs in the Sample Table

Now that the calibration files have been created and saved, the calibration standard runs 
must be inserted into the Sample Table. The TC and TN calibration standards are inserted 
separately.

1. Insert the TC calibration standard runs by placing the cursor in the first line of the 
Sample Table.

2. From the Insert menu, select Calibration Curve.

3. Specify the name of the TC Calibration Curve (TCtutorial.cal) and click the Open 
button.
The Sparging/Acid Addition window is displayed. Notice that the TC calibration stan-
dards have been automatically added to the table.
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4. Enter the vial positions (1-3) for the calibration standards directly into the Vial 
column of the table. As vial positions are entered in the table, they are highlighted on 
the tray diagram in the Sparging/Acid Addition window.

Figure 4.53  Sparging/Acid Addition Window for the ASI-V Autosampler

OCT-1 8-Port Sampler Sparging/Acid Addition Window

Figure 4.54  Sparging/Acid Window for the OCT-1 8-Port Sampler

TIP » The vial position for a sample can also be entered by placing the cursor in the appropriate 
row of the Sparging/Acid Addition window and then double-clicking the desired vial 
position in the tray diagram.
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5. Verify the information, then click the OK button.
The Sample Table is displayed. Notice that the first row of the Sample Table now con-
tains complete TC calibration standard measurement information.

Figure 4.55  TC Calibration Standard Information in the Sample Table

6. Insert the TN calibration standard runs by placing the cursor in the second line of the 
Sample Table. 
From the Insert menu, select Calibration Curve. The Open dialog box is displayed. 
Specify the name of the TN Calibration Curve (TNtutorial.cal) and click the Open 
button.

Figure 4.56  Select the TN Calibration File

The Sparging/Acid Addition window is displayed. Notice that the TN calibration 
standards have been automatically added to the table.

7. Enter the vial positions for the calibration standards directly into the Vial column of 
the table. Because the calibration standards are TC/TN mixtures, enter the same vial 
positions (1-3) for the TN standards that were entered for the TC standards.
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8. Click the OK button to display the Sample Table window. Notice that the second row 
of the Sample Table now contains complete TN calibration standard measurement 
information. 
Take a moment to scroll through the completed Sample Table. Notice that the col-
umns in the left portion of the Sample Table contain the specified analysis parameters. 
Actual measurement information will appear in the columns in the right portion of the 
Sample Table once the measurements are completed.

9. Save the Sample Table by selecting Save from the File menu or by clicking the Save 

button  in the toolbar.

Setting up an Unknown Sample Run (Step 5)

In Step 4 of the tutorial, you learned that information about calibration standard 
measurement is saved in a calibration file. You also learned that setting up a calibration 
standard run involves two steps: creating a calibration file and then inserting the calibration 
standards into the Sample Table. 

By contrast, information about unknown sample measurement is saved in a method file. 
Setting up an unknown sample run involves two steps: creating a method file and then 
inserting the unknown sample into the Sample Table. In this tutorial, one “unknown” 
sample will be analyzed. The “unknown” sample is actually the mid-level calibration 
standard (50ppm TC/10ppm TN).

Creating a Method File

1. Open the Sample Table. From the File menu, select New.

2. The New dialog box is displayed. Click the Method icon and then click the OK 
button. The Method Wizard opens.

3. Select the system to be used for the analysis from the drop-down list on page 1 of the 
Method Wizard. Click the Next button.
Page 2 of the Method Wizard lists options for the analysis.

4. Select TC/TN from the Analysis drop-down menu. Enter “Sample” in the Default 
Sample Name field and “Tutorial” in the Default Sample ID field. In the File Name 
field, enter “Tutorial.met” as the name of the Method File.

Figure 4.57  Method Wizard (Page 2) Analysis Information



4.3    Measurement Procedures and Tutorial
4.3.2    Tutorial

109TOC-VCPH/CPN

5. Click the Next button.
Page 3 of the Method Wizard specifies the calibration curves to be used to calculate 
unknown sample results. 
Note: It is possible to enter the calibration curve file in this screen since it

contains the data that needs to be entered on this page.

6. Place the cursor in the Calibration Curve 1 field. Click the Browse  button.
Select the file for the TC calibration curve created previously (TCtutorial.cal).

Figure 4.58  Method Wizard (Page 3) Calibration Curves

7. Click the Next button.
Page 4 of the Method Wizard is displayed. 

Figure 4.59  Method Wizard (Page 4) Injection Parameters
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8. The following TC analysis parameters can be entered. 
• Analysis (disabled)
• Units
• Injection Volume (disabled)
• Number of Injections
• SD Max
• CV Max
• Number of Washes
• Auto Dilution
• Acid Addition
• Expected Concentration Range
• Multiple Injections
• Use blank check area
• Auto reinjection If both the CV max and SD max values have been exceeded.

9. Click the Next button. 
Page 5 of the Method Wizard is displayed. View but do not change the default settings 
for options on this page.

10. Click the Next button.
The Method Wizard (Page 3) Calibration Curve screen is displayed. Enter the TN 
measurement parameters.

11. Click the box beside [Calibration 1], and either select the TNtutorial.cal file or enter 
the calibration curve file.

12. Click the Next button.
The Method Wizard (Page 4) Measurement Parameters screen is displayed. Set the 
TN measurement parameters in the same way as for TC measurement. 

13. Click the Next button.
The Method Wizard (Page 5) Peak Detection Time screen is displayed. Do not change 
the default settings on this page. 

14. Click the Next button.
Page 6 of the Method Wizard is displayed. View but do not change the default settings 
for options on this page. 

15. Click the Next button.
Page 7 of the Method Wizard is displayed. View but do not change the default settings 
for options on this page. 

16. Click the Finish button.
The Method Wizard closes. The method file is now complete and has been saved. 
Insert the sample into the Sample Table.

Reference: Refer to Section 4.4.2.3 "Method Wizard" for a detailed description of the Method Wizard.
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17. Insert the unknown sample by placing the cursor in the third line of the Sample Table. 
From the Insert menu, select Sample.
Page 1 of the Sample Wizard (Parameter Source) is displayed.

TIP » To set up multiple analyses using a previously created method, select the Auto Generate 
Table command from the Insert menu. Refer to Section 4.4.5.1 "Auto Generate".

Figure 4.60  Sample Wizard (Page 1) Parameter Sources

18. Click the Method radio button. By selecting this option, the sample will be analyzed 
using the measurement parameters specified in the method file we created previously. 
Enter the name of the method file (Tutorial.met) or click the Browse button to search 
for the file.
Click in the “Skip remaining Wizard pages and use measurement parameters from the 
source” check box. By selecting this option, the analysis parameters for the unknown 
sample are copied from the source (method) file. The parameters do not need to be 
entered manually and the remaining pages of the Sample Wizard do not need to be 
displayed.

19. Click the Finish button.
The Sparging/Acid Addition window is displayed.

20. Enter the vial position (2) for the unknown sample (the 50ppm TC/10ppm TN 
calibration standard) directly into the Vial column of the table. 

21. Verify the information, then click the OK button.
The third row of the Sample Table now contains the measurement parameters for the 
unknown sample. (Note that a value will not be displayed in the Result column until 
measurement is complete.)

22. Save the Sample Table by selecting Save from the File menu or by clicking the Save 
button  in the toolbar.

Measurement can now be performed.
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Performing Measurement (Step 6)

Procedure

1. Prepare the three calibration standards (0ppm potassium hydrogen phthalate/0ppm 
ammonium chloride, 50ppm potassium hydrogen phthalate/10ppm ammonium 
chloride, and 100ppm potassium hydrogen phthalate/20ppm ammonium chloride) and 
place them in autosampler tray vial positions 1, 2, and 3.
Note: Calibration standards and unknown samples can be placed in any

vial position when controlling the instrument with the TOC-Control
V software. 

2. Check the status of the instrument detectors before starting analysis. From the 
Instrument menu, select Background Monitor, or click the Background Monitor  
button on the toolbar.
The Background Monitor window is displayed; this window is used to monitor the 
real time signal from the ASI and the detectors. On the TOC tab, the status of the 
baseline should be OK for each parameter (position, fluctuation, and noise).

3. Click the TN tab to check the status of the nitrogen detector.

Figure 4.61  Background Monitor

4. Close the Background Monitor window. It cannot be open during analysis.

5. Place the cursor in the first row of the Sample Table; this allows the measurement 
sequence to begin with the TC calibration. From the Instrument menu, select Start, or 

click the Start button  on the toolbar.
The Standby window is displayed.
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6. The Standby window displays 3 options:
• Keep running
• Shut down instrument
• Auto restart

Figure 4.62  Standby Window

Reference: Refer to Section 4.4.6.3 "Standby" for detailed descriptions of the Standby window options.

7. Click the Keep Running radio button. Then Click the Standby button.
The Sparging/Acid Addition window is displayed.

8. Verify the vial positions, then click the OK button.

9. The Start ASI measurement window is displayed. Click the Start button to begin the 
analysis.

10. The status of the measurements can be monitored during analysis by viewing the 
Sample Window. To open the Sample Window, either select Sample Window from the 
View menu or select the Sample Window  button on the toolbar.

Figure 4.63  Sample Window
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Note: • The Sample Window is divided into 3 sections, as shown in the above figure.
The Graph is in the upper left corner, the Parameter Table is in the upper right
corner, and the Injection Table is the bottom half of the window. The current
injection is displayed with asterisks in the Injection Table. As each
measurement occurs, information in the appropriate Injection Table row is
completed. Previous injections are shown above the current row. Use the
scroll bar to see all of the information, and use the tabs at the bottom of the
table to toggle between analysis types (between TC and TN, in this case).

• To view the peak profile of the measurement in progress, click the asterisk of 
Sample No. To view a previous measurement, click that row.

• When the Sample Window is opened, the text on the graph may be overly 
enlarged. In that situation, close the Sample Window and then open it again. 

• During measurement, even if “All Peaks” is selected, because it takes time for 
the screen to update, the peak display may not change. In this case, select “All 
Peaks” following measurement. 

• When the measurement Type is TC/TN, NPOC/TN, TOC/TN or 
POC+NPOC/TN, the peak profile of the selected measurement type may not 
be displayed even after clicking the measurement type (for example, TC and 
TN toggle) tab in the Sample Window. In that situation, click the data in the 
Sample Window corresponding to the peak you wish to display. 

11. Statistical information about the current set of injections is calculated and displayed in 
the Sample Window. As a result, preliminary decisions about the measurements can 
be made while the analysis is still in progress.
Note: Information about the current injection is shown in the status box in

the upper right portion of the Sample Window.

TIP » The drop-down list above the graph is used to set the graph display. When Current Peak is 
selected, the peak profile of the current injection is drawn in the graph as the measurement 
is performed. Use this window to monitor the analysis as it occurs. The blue peak denotes 
carbon, while the red peak denotes nitrogen. To see the peak profile of a previous injection, 
click its row in the Injection Table. To see the peak profile of all the injections for a sample, 
select All Peaks from the drop-down list at the top of the graph. Use the graph right-mouse 
menu to customize the peak profile graph. 

Reference: Refer to Section 4.4.4.3 "Sample Window" for a detailed description of the Sample Window 
options.

12. When the measurements are complete, the autosampler moves to the rinse well for a 
flow line rinse and the instrument status tab displays a Ready status. Close the Sample 
Window.

Evaluating the Results (Step 7)

The Sample Table now contains measurement information in the columns in the right 
portion of the table. Use the scroll bars to view the measurement information.

We will check the calibration curve results and then evaluate the results for the unknown 
sample.
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Checking the TC Calibration Curve Results

1. Place the cursor in the first row of the Sample Table, which contains analysis 
information for the TC calibration. 

2. From the View menu, select Calibration Curve, or click the Calibration Curve button 
 on the toolbar.

The Calibration Curve Properties window for the TC calibration is displayed.

3. Select the Graph tab to view the TC calibration curve data in graph form.

Figure 4.64  Calibration Curve Properties: Graph Tab

The coefficient of determination (r2) value is a measure of the linearity of the 
relationship between concentration and area. An r2 value was calculated for the TC 
calibration and displayed in the window because we selected the linear regression 
calculation when we created the calibration file. Use the r2 value to determine the 
success of the calibration. A r2 value of 1 indicates a perfectly linear relationship 
between concentration and area. Application methods used for future analyses may 
specify an acceptable limit for the r2 value. 

4. Select the Data tab to view calibration statistics such as Standard Deviation (SD) and 
Coefficient of Variation (CV). These statistics can also be used to evaluate the success 
of the calibration.

TIP » A successful calibration can be used for future analyses by specifying the calibration file 
name (*.cal) in the method.

5. Close the TC Calibration Curve Properties window when the evaluation is complete.

Checking the TN Calibration Curve Results

Evaluate the TN calibration curve results by placing the cursor in the second row of the 
Sample Table, which contains analysis information for the TN calibration. Then follow 
Steps 2 through 5 in the procedure listed above for evaluating the TC calibration curve 
results.
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Viewing Peak Profiles 

1. View peak profiles by placing the cursor in the desired row of the Sample Table and 
either selecting Sample Window from the View menu or clicking the Sample button 

 on the toolbar.
The Sample Window is displayed; this is the same window we used to observe the 
real-time injections.

2. To view the peak profiles for all injections in a Sample Table row, select All Peaks 
from the drop-down list at the top of the graph. 
All peak profiles for the selected row are displayed in the graph.

TIP » When All Peaks is selected from the drop-down list at the top of the graph, clicking in 
another row of the Sample Table will automatically update the Sample Window display with 
the peak profiles for that row.

3. To view the peak profile for individual injections, click in the appropriate row of the 
Injection Table and select Current Peak from the drop-down list at the top of the 
graph.

Evaluating the Sample Results

1. Place the cursor in the third row of the Sample Table, which contains analysis 
information for the sample.

2. Examine the concentration results by scrolling to the Result column in the Sample 
Window. 
Note: The results should be close to 50ppm for the TC analysis and

10ppm for the TN analysis. 

Figure 4.65  View Sample Results

TIP » Use the TC and TN tabs at the bottom of the Sample Information table to view the results 
for both analyses.

3. Close the Sample Window when the evaluation is complete.
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Outlier Test

The Outlier Test is used to provide additional information about the measurement result.

1. Place the cursor in the third row of the Sample Table, which contains analysis 
information for the unknown sample.

2. From the View menu, select Outlier Test.
Note: The Outlier Test is conducted to identify suspect results. The test

statistically compares all unknown samples that have the same
sample name. Because this tutorial includes only one measurement
of the unknown sample, the outlier test calculation is not
meaningful. 

Printing a Report (Step 8)

Print a report after measurement is complete and the results have been evaluated.

Selecting the Report Items

1. From the File menu, select Page Setup. 

2. The Page Setup window is displayed. Each tab in the window represents a section of 
the report and contains several items. Selections will be made on each tab to print a 
typical report for the calibration standards and unknown sample.

Reference: Refer to Section 4.4.2.15 "Page Setup" for detailed descriptions of the Page Setup options.

3. On the Instrument tab, ensure that the Print system information check box is selected, 
then select the options shown in the figure below.

Figure 4.66  Page Setup: Instrument Tab
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4. Click the Calibrations tab and select the options shown in the figure below.

Figure 4.67  Page Setup: Calibrations Tab
5. Click the Samples tab and select the options shown in the figure below.

Figure 4.68  Page Setup: Samples Tab
Note: Use the default selections on the Header and Grid tabs.

6. Click the Miscellaneous tab and enter “Tutorial” in the Organization name field. 
Select the Footer check box to include page numbers on the report.

TIP » A company logo can be added to the report header by selecting the Logo check box and 
specifying the logo graphic file. 

Figure 4.69  Page Setup: Miscellaneous Tab
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Previewing the Report

1. Select the Preview button from any of the Page Setup tabs to preview the entire report 
before printing.

TIP » The report can also be previewed from outside the Page Setup window by selecting Print 
Preview>Sample Report from the File menu.

The Preview feature displays each page of the report exactly as it will be printed. 
Notice that each item that was selected in the Page Setup window appears in the 
report.

Figure 4.70  Report Appearance

TIP » Magnify the view by clicking the magnifying glass tool, or on the Zoom In button. Move 
from page to page by clicking the Next Page and Previous Page buttons. 

2. Print the report by clicking the Print button.

This ends the Tutorial. 

Reference: The tutorial provided instructions for setting instrument configuration and analysis 
parameters, adding calibration standard and unknown sample information to the Sample 
Table, creating calibration curves and method files, conducting measurements, and 
checking and printing results. More details on all of these procedures are discussed in 
Section 3.2 "Instrument Setup and System Properties", Section 4.2 "Setting General 
Measurement Parameters", and  Section 4.4 "Sample Table Editor".
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4.3.3  Ending Measurement

Follow the procedure below to end measurement.

Procedure

1. From the Instrument menu, select Standby.

Figure 4.71  Standby Window

2. Two procedures are available for ending measurement:
• Shut down instrument
• Auto restart
These procedures are described below.

Shut Down Instrument

Use the “Shut down instrument” option to end measurement and switch off power to the 
instrument.

1. Select “Shut down instrument” in the Standby window, then click the Standby button.
A 30-minute countdown to instrument shutdown begins. During the shutdown pro-
cess, the carrier gas flow and power to the furnace are automatically turned off and 
after 30 minutes, the power to the instrument is switched off. 

2. To end TN measurement, manually switch off the TN unit using the power switch 
located in the lower right area of the ozone generator.
Note: When “Shut down instrument” is selected, the instrument power is

turned off and the power to the autosampler exhaust fan is turned
off. If acidic samples are being measured or if sparging is being
performed using the autosampler in NPOC measurement, there is a
danger that following measurement, volatilization of acid in the
sample could cause corrosion of the autosampler. Do not switch off
the power to the instrument. (Do not select Shutdown.)
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Auto Restart

The Auto Restart function is used to shut down the instrument and then restart it at a 
specified time. Selections are made for the date and time that measurement will next be 
performed, as well as for the instrument restart settings. After shutting down the 
instrument, the carrier gas flow and power to the furnace are automatically turned off. 
Approximately one hour before the restart time, the furnace and the carrier gas will 
automatically be turned on to allow the instrument to achieve a Ready state by the restart 
time. 

1. Select Auto Restart in the Standby window.

2. Select the appropriate instrument restart settings (TC furnace, carrier gas, ozone 
generator) and set the restart date and time. If a check is placed in the box beside a 
unit, the furnace power remains on and the carrier gas continues to flow. In order to 
have the power turned off automatically, do not place a check mark in any of these 
boxes. 

3. Click the Standby button.
Power to the instrument is automatically switched off and will be automatically 
switched on approximately one hour before the restart date and time. Using Auto 
Restart, measurement can be performed immediately at the specified startup time.

Reference: Refer to Section 4.4.6.3 "Standby" for detailed descriptions of the available instrument 
shutdown options.



4.4    Sample Table Editor
4.4.1    Sample Table Window Overview

122 TOC-VCPH/CPN

4.4  Sample Table Editor

The TOC-Control V Sample Table Editor menus and commands are described in this 
section.

4.4.1  Sample Table Window Overview

4.4.1.1  Toolbar Functions

If the Toolbar is not visible, select Toolbar from the View menu, then specify the desired 
Toolbar options.

Note: Many of the Toolbar functions are disabled until a Sample Table is opened or 
communication is established with an instrument.

TIP » A description of each Toolbar button’s function appears when the mouse pointer is 
positioned over the button. 

TIP » All of the Toolbar commands are also accessible through the Sample Table Editor menus.

New File

Opens a new, blank Sample Table.

Open File

Opens a saved Sample Table. Clicking the button displays the Open dialog box, 
in which a *.t32 file can be selected.

Save File

Saves the data in the open Sample Table. If the open Sample Table is new and has 
not yet been saved, the Save As dialog box is displayed.

Cut

Removes data from highlighted cells in a table and saves them to the clipboard.

Copy

Copies data from highlighted cells in a table and saves them to the clipboard.

Paste

Copies the contents of the clipboard to a selected location in a table.

Print

Sends the data from the currently displayed window to the printer. Clicking the 
button starts printing immediately using the current printer settings.

Help - About

Provides information about the TOC-Control V software.

Background Monitor

Displays the Background Monitor window, which displays the status of the ASI 
and the instrument detector(s). 
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Connect

Opens or closes the electronic connection between the instrument and the PC.

Standby

Shuts down or reactivates the instrument.

Start/Continue

Starts measurement. Either the Manual Injection Parameter or Sparging/Acid 
Addition window is displayed, depending on the instrument settings.

Stop

Stops the measurement sequence after all injections of the current sample are 
complete.

Halt

Immediately stops the current measurement and discards data from the inter-
rupted measurement.

Peak Stop

Stops the measurement sequence and aborts analysis of the current sample. The 
peak in progress is treated as if it were a completed analysis.

Properties

Displays the Sample/Method Properties dialog box.

Calibration Curve (View)

Displays the calibration curve data. Highlight the calibration standard row in a 
Sample Table to select the calibration curve to examine.

Sample

Opens the Sample Window, which displays detailed information for each sample 
injection and can be used to view measurement data in real time. 

Method

Opens the Method Properties window, which contains the method parameters for 
a selected sample.

Exclude

Excludes a selected sample or injection from the calculation. Toggles to include 
an excluded sample.

Recalculate Highlighted

Recalculates the highlighted sample results after applying a new calibration 
curve or excluding injections.

Recalculate All

Recalculates all sample results after applying a new calibration curve or exclud-
ing injections.

Delete Highlighted Data

Deletes the highlighted measurement data. This function does not change the 
structure of the Sample Table.

Delete All Data

Deletes the measurement data for all samples. This function does not change the 
structure of the Sample Table.
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Format

Displays the Floating Point Format dialog box, where options for numeric for-
mats can be modified.

Font

Displays the Font dialog box, where options for fonts can be modified.

Insert Sample

Opens the Sample Wizard, and allows a sample to be inserted in the active posi-
tion of the Sample Table.

Autogenerate

Opens the Sample Group Wizard, and allows a specified group of samples to be 
inserted in the active position of the Sample Table.

Insert Control

Displays the Open dialog box, and allows a selected control sample template to 
be added to the Sample Table.

Insert Calibration Curve

Displays the Open dialog box, and allows a selected calibration curve to be added 
to the Sample Table.

4.4.1.2  Status Bar and Notification Bar

The Status Bar displays the status of various software functions and is displayed at the 
bottom of the open window for all applications. If the Status Bar is not visible, select Status 
Bar from the View menu.

The Notification Bar displays information about the status of the TOC-Control V software, 
the connection between the instrument and the PC, measurement events, and operation 
errors. Use the Options>Display Settings>Notification Bar Settings window to enable, 
disable, or select settings for the Notification Bar. Refer to Section 4.4.9.5 "Display 
Settings>Notification Bar Settings". 

Figure 4.72  Status Bar and Notification Bar

Status Bar

Notification
Bar
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4.4.2  File Menu

Figure 4.73  File Menu

4.4.2.1  New

The New command opens the New dialog box, which displays the options for all new file 
types. The options are Sample Run, Calibration Curve, Method, Control Sample Template, 
and Parameter File, as shown in the figure below and described in the text following the 
figure.

Figure 4.74  New Dialog Box

TIP » A new file can also be created by clicking the New File button on the Toolbar and typing in 
the new file name.

Sample Run

Displays the General Information window, which can also be accessed by select-
ing General Information from the Options menu. Refer to Section 4.4.9.1 "Gen-
eral Information" for a detailed description of the General Information window.

Calibration Curve

Opens the Calibration Curve Wizard, which can also be accessed by selecting 
Calibration Curve from the Insert menu. Refer to Section 4.4.2.2 "Calibration 
Curve" for a detailed description of the Calibration Curve Wizard.



4.4    Sample Table Editor
4.4.2    File Menu

126 TOC-VCPH/CPN

Method

Opens the Method Wizard. Refer to Section 4.4.2.3 "Method Wizard" for a 
detailed description of the Method Wizard.

Control Sample Template

Opens the Control Sample Wizard. Refer to Section 4.4.5.3 "Control" for a 
detailed description of the Control Sample Wizard. Refer to Appendix B for a 
description of the Control Charts function.

Parameter File

Displays the Save As dialog box, which can be used to save a parameter file.

OK Button

Opens a new file for the selected icon, and closes the New dialog box.

Cancel Button

Press the Cancel button to close the New dialog box without making a new file.

4.4.2.2  Calibration Curve

The Calibration Curve command is used to insert a calibration curve into the Sample Table. 
Selecting the command displays the File>Open dialog box.

Figure 4.75  Selecting Insert>Calibration Curve displays the File>Open dialog box

A table of calibration information is displayed in the window at the bottom of the Open 
dialog box after a calibration curve is selected. Click the OK button to insert the selected 
calibration curve into the Sample Table. Click the Cancel button to abort the operation.

Note: • The Insert>Calibration Curve command is not available during sample
analysis. 

• An error message is displayed if the selected file does not have the correct 
format or is not a calibration curve.
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To create a new calibration curve for insertion into the Sample Table, click the New button 
to open the Calibration Curve Wizard. The Calibration Curve Wizard consists of several 
windows, each of which defines specific parameters for the calibration curve, as described 
below.

TIP » The Calibration Curve Wizard can also be accessed by selecting File>New and double-
clicking the Calibration Curve icon in the New dialog box.

Calibration Curve Wizard (Page 1) System Information

Figure 4.76  Calibration Curve Wizard (Page 1) System Information

Parameter Description

System Select the system to be used.

User Displays the user name. This field cannot be changed.

Date of Creation Displays the current system date and time. This field cannot 
be changed.

Comment Enter a comment (512 characters maximum).
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Calibration Curve Wizard (Page 2) Calibration Curve Type

The Calibration Curve Type window is used to specify the calibration curve type. 

Figure 4.77  Calibration Curve Wizard (Page 2) Calibration Curve Type

Calibration Curve Wizard (Page 3) Analysis Information

Calibrations using automatic dilution

Parameter Description

Calibration points are distrib-
uted uniformly over the con-
centration range

Select this option to calculate the calibration point concentra-
tions automatically. The software will calculate the concen-
trations by distributing them in equal amounts over the 
measuring range of the calibration curve.

Edit calibration points manu-
ally

Select this option to enter the calibration point concentrations 
manually on a subsequent Wizard page, the Calibration 
Points List.

Calibration curve according 
to DIN 38402/P-51

Select this option to create a calibration curve according to 
DIN 38402. This type of curve consists of 10 calibration stan-
dards, with 10 injections of the lowest and highest standards 
and a single injection of the intermediate standards.

Calibration curve according 
to USP/EP

Select this option to create a calibration curve that consists of 
2 calibration standards with concentrations between 0 and 
500µg/L and one control sample with a concentration of 
500µg/L.

Dilution Factor Manual Set-
ting

For manually setting dilution factor of standard solution. 
Enter the dilution factor.

Dilution Factor Automatic 
Setting

Automatically calculates dilution factor for standard solution, 
and performs measurement using that dilution factor. 

Use Source Dilution Function Prepares standard solution automatically inside the instru-
ment, and performs measurement using that diluted standard 
solution.
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Note: In the case of the TOC-VCPN, dilution measurement cannot be performed for IC 
measurement. Therefore, since the dilution function will not work even if Use 
Source Dilution Function or Dilution Factor Manual Setting are selected, select 
Dilution Factor Automatic Setting. In IC measurement using the TOC-VCPH, the 
dilution function can be used. 

The Analysis Information window is used to specify the type of analysis and the standard 
name for the calibration curve.

Figure 4.78  Calibration Curve Wizard (Page 3) Analysis Information

Parameter Description

Analysis Select the analysis type.

Default Sample Name Enter the sample name for the calibration standards (64 char-
acters maximum).

Default Sample ID Enter the default sample identification for the calibration 
standards (64 characters maximum).

Calculation Method Select the calculation method to be used for the calibration 
from the drop-down list. Available calculation methods are 
point-to-point and linear regression. Refer to Section 4.4.4.5 
for detailed descriptions of the calibration methods.

Zero Shift Select this option to shift the calibration curve through the 
origin. Refer to Section 4.4.4.5 for a detailed description of 
the Zero Shift option.

Multiple Injections Select to enable the syringe to draw up a single aliquot with a 
volume equal to that required for all injections of the stan-
dard. When this option is not selected, the syringe will draw 
up a separate aliquot for each injection; as a result, selecting 
this option reduces analysis time.

File Name Enter the file name of the calibration curve.
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Calibration Curve Wizard (Page 4) Calibration Measurement Parameters

The Calibration Measurement Parameters window is used to specify measurement 
parameters for the calibration standards.

Figure 4.79  Calibration Curve Wizard (Page 4) Calibration Measurement Parameters

Parameter Description

Units Select the concentration units from the options on the drop-
down list.

Concentration Range Enter the maximum and minimum concentrations of the cali-
bration curve standard solutions.

No. of Cal. Points Enter the number of calibration standards that will be used to 
create the calibration curve.

No. of Injections Enter the minimum/maximum number of injections for the 
calibration standards.

No. of Washes Specifies the number of times the syringe is to be washed 
with standard prior to the first injection. Note that if the Auto 
Dilution option was selected, the standard will be diluted and 
the syringe will then be washed with the diluted standard. 
Enter an integer from 0 to 10.

SD Max and CV Max Specifies the maximum standard deviation and coefficient of 
variation that is acceptable for the injections. Enter a value 
ranging from 0 to 9999 for SD Max and from 0 to 100 for CV 
Max. If either of these values are met, no additional injec-
tions are required. However, if both of these values are 
exceeded, the calibration standards are automatically rein-
jected up to the maximum number of times specified in the 
No. of Injections field. The SD Max and CV Max fields are 
disabled if the No. of Injections is 1 or if the minimum is 
equal to the maximum.

Sparge Time Enter the length of time sparging will occur. (0 - 20 minutes)

Acid Addition Enter the desired quantity of acid to be added. This option is 
available only for NPOC or related analyses.
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Calibration Curve Wizard (Page 5) Calibration Points List

The Calibration Points List window displays a list of parameters for each calibration point. 
The parameters can be edited by using the buttons below the list. A user must have access 
rights for updating data to edit calibration information. 

Figure 4.80  Calibration Curve Wizard (Page 5) Calibration Points List

Parameter Description

No. Displays the calibration point number. Note that the standards 
will be analyzed in the order shown. To add a calibration 
point at a certain position, click the desired number in the 
“No.” column, then click the Add button and enter the appro-
priate information. The new point will be added in the speci-
fied position, and the point that was previously in that 
position will move down the list to the next position.

Inj. Volume Displays the injection volume for the calibration standards.

Calibration Points Displays a table of measurement parameters (such as those 
entered in the previous page of the Calibration Curve Wizard) 
for each calibration point. To edit the parameters for a cali-
bration point, highlight the point in the table and click the 
Edit button. To add a calibration point, click the appropriate 
number in the No. column to specify the insertion point, then 
click the Add button. To delete a calibration point, highlight 
the point in the table and click the Delete button. To delete all 
calibration points, click the Delete All button. 
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Click the Edit and Add buttons to display the Edit Calibration Point Parameters window. 
This window is used to enter calibration points manually and to edit the parameters of 
existing calibration points. 

Figure 4.81  Edit Calibration Point Parameters Window

Parameter Description

Calibration Point No. Displays the calibration point number. This field will reflect 
the number selected by clicking in the “No.” field in the Cali-
bration Points List. The number cannot be changed directly in 
the window. 

Standard Solution Conc. Enter the concentration of the calibration standard solution. 
When creating a calibration curve from a single standard 
solution by using the Auto Dilution function, enter the con-
centration of the original standard solution in this field.

Auto Dilution Enter the factor by which the instrument should automati-
cally dilute the calibration standard solution to obtain the 
desired concentration for the calibration point.

Cal. Point Conc. Displays the actual concentration of the calibration point. The 
concentration is calculated automatically based on the values 
entered into the Standard Solution Conc. and Auto Dilution 
fields.

No. of Injections Enter the minimum and maximum number of injections.

SD Max and CV Max Enter the maximum standard deviation or coefficient of vari-
ation values.
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Calibration Curve Wizard (Page 6) Peak Time Parameters

The Peak Time Parameters window is used to set peak detection parameters.

Figure 4.82  Calibration Curve Wizard (Page 6) Peak Time Parameters

Setting Item Description

Use default settings Select this option to use the default peak detection parame-
ters. When this option is selected, all other options in this 
window are disabled.

Allowed peak start delay The allowed peak start delay is the amount of time (in min-
utes) that can elapse before the analysis is stopped because a 
peak is not detected. Enter a number between 0 and 20:00.

Total integration time The total integration time is the amount of time (in minutes) 
that analysis continues after the end of the peak is detected. 
Enter a number between 4:50 and 20:00.
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Calibration Curve Wizard (Page 7) History

The History window is used to enable the History Log. The History Log records all 
modifications to the calibration curve properties. The History Log can be set to require 
users to enter comments for each modification.

If the History Log is not required, it need not be enabled, as the software operates properly 
without it.

Note: Once the History Log is enabled, it cannot be changed. All modifications to the 
calibration curve properties will be tracked. If the mandatory comment option is 
selected, the user will be required to enter a comment each time any parameter in 
the calibration curve is modified.

Figure 4.83  Calibration Curve Wizard (Page 7) History

Setting Item Description

Enable history log Select this option to enable the software to monitor all modi-
fications to the system. Once the History Log is enabled, it 
cannot be changed if GLP is selected during installation. The 
GLP laboratory guidelines require that a history of changes 
be maintained for the system.

User has to comment all 
modifications

Select this option to require the user to comment all modifi-
cations. 
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4.4.2.3  Method Wizard

The Method Wizard is used to set method parameters and is accessed by selecting 
File>New>Method. The Method Wizard consists of several windows, each of which is 
described below. The Back and Next buttons are used to navigate between windows. Note 
that each set of parameters selected for a specific method applies only to that method.

Note: Selected windows in the Method Wizard will be repeated for combined analysis 
types such as TOC, POC + NPOC. Each duplicate window represents one analy-
sis type. Parameters that are not applicable to an analysis type will not appear in 
the Method Wizard window.

Method Wizard (Page 1) System Information

Figure 4.84  Method Wizard (Page 1) System Information

Setting Item Description

System Select one of the configured instruments.

Operator Displays the current operator name.

Date of Creation Displays the current system time.

Comment Enter a comment (512 characters maximum), if desired.
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Method Wizard (Page 2) Analysis Information

The Analysis Information window is used to set analysis parameters for the method being 
created.

Figure 4.85  Method Wizard (Page 2) Analysis Information

Setting Item Description

Analysis Select the analysis type from the drop-down list.

Default Sample Name Enter the default sample name (64 characters maximum).

Default Sample ID Enter the default sample ID (64 characters maximum).

Dilution Enter the preparation dilution factor, which will be used to 
calculate concentration results. The default value is 1.

No. of Determinations Enter the number of times each sample is to be measured. 
Note that determinations and injections are different; each 
determination is made up of one or more injections. 

File Name Enter the name of the new method. Click the Browse button 
to save the file in a directory other than the default directory.
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Method Wizard (Page 3) Calibration Curves

The Calibration Curves window is used to specify the calibration curves that will be used to 
calculate results for samples analyzed by the method. Up to 3 calibration curves can be 
entered and, during analysis, the system automatically determines which curve is most 
suitable for the sample. Refer to  Section 6.2.5 "Automatic Selection of Optimum 
Calibration Curve".

Figure 4.86  Method Wizard (Page 3) Calibration Curves

Setting Item Description

Analysis Displays the previously selected analysis type.

Calibration Curve 1/2/3 Enter the name of the calibration curve or click the Browse 
button to select a file using the File>Open dialog box.

Skip the injection parameter 
pages of the wizard

Select this item to skip the Injection Parameters window of 
the Method Wizard. Use this option when the sample injec-
tion parameters will be the same as those used for calibration 
curve measurements.



4.4    Sample Table Editor
4.4.2    File Menu

138 TOC-VCPH/CPN

Method Wizard (Page 4) Injection Parameters

The Injection Parameters window is used to specify the injection parameters for the 
method.

Figure 4.87  Method Wizard (Page 4) Injection Parameters

Setting Item Description

Analysis Displays the previously selected analysis type.

Units Select the concentration units to be used for samples.

Injection Volume Enter the injection volume.

Expected Conc. Range Enter the expected sample concentration if it is known.

No. of Injections Enter the minimum/maximum number of injections for the 
samples that will be analyzed using this method.

SD Max Enter the maximum standard deviation that is acceptable for 
the injections. If this value is met, no additional injections are 
required. However, if both this value and the CV Max value 
are exceeded, the samples are automatically reinjected up to 
the maximum number of times specified in the No. of Injec-
tions field. The SD Max field is disabled if the No. of Injec-
tions is 1 or if the minimum is equal to the maximum.

CV Max Enter the maximum coefficient of variation that is acceptable 
for the injections. If this value is met, no additional injections 
are required. However, if both this value and the SD Max 
value are exceeded, the samples are automatically reinjected 
up to the maximum number of times specified in the No. of 
Injections field. The CV Max field is disabled if the No. of 
Injections is 1 or if the maximum and minimum values are 
the same.

No. of Washes Enter the number of times the syringe is to be washed with 
sample prior to the first injection. Note that if the Auto Dilu-
tion option was selected, the sample will be diluted and the 
syringe will then be washed with the diluted sample.
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Auto Dilution Enter a dilution factor for the samples. The instrument will 
automatically dilute the samples by this factor, and the result 
will be multiplied by the factor to obtain the final concentra-
tion. The default Auto Dilution value is 1.

Sparge Time Enter the desired sparge time. This option is available only 
for POC, NPOC, and related analyses. The default Sparge 
Time value is 1.

Acid Addition Enter the desired quantity of acid to be added. This option is 
available only for NPOC or related analyses.

Multiple Injections Select to enable the syringe to draw up a single sample ali-
quot with a volume equal to that required for all injections of 
the sample. When this option is not selected, the syringe will 
draw up a separate sample aliquot for each injection. Select-
ing this option reduces analysis time.

Use blank check area Select to include blank check result in the concentration cal-
culation.

Auto correction of inj. vol. 
and dilution

Select to enable the instrument to automatically adjust the 
injection volume and dilution factor when the peak height for 
the initial injection exceeds full scale. After the adjustment, 
measurement will be repeated.

Setting Item Description
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Method Wizard (Page 5) Peak Time Parameters

The Peak Time Parameters window is used to set peak integration parameters.

Figure 4.88  Method Wizard (Page 5) Peak Time Parameters

Setting Item Description

Analysis Displays the previously selected analysis type.

Use default settings Select this option to use the default integration parameters. 
When this option is selected, all other options in this window 
are disabled.

Allowed peak start delay The allowed peak start delay is the amount of time (in min-
utes) that can elapse before the analysis is stopped because a 
peak is not detected. Enter a number between 0 and 20:00.

Total integration time The total integration time is the amount of time (in minutes) 
that analysis continues after the end of the peak is detected. 
Enter a number between 4:50 and 20:00.
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Method Wizard (Page 6) USP/EP

The USP/EP window is displayed only for TC or NPOC methods, and is used to enable 
samples to be checked in accordance with USP standards. Select the check box to enable 
the function.

Figure 4.89  Method Wizard (Page 6) USP/EP
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Method Wizard (Page 7) History

The History window is used to enable the History Log. The History Log records all 
modifications to the method. The History Log can be set to require users to enter comments 
for each modification. 

Note: Once the History function is enabled, it cannot be changed. All modifications to 
the method will be tracked. If the mandatory comment option is selected, the user 
will be required to enter a comment each time any method parameter is modified.

Figure 4.90  Method Wizard (Page 7) History

Setting Item Description

Enable history log Select this option to enable the software to monitor all modi-
fications to the system. Once the history log is enabled, it 
cannot be changed. 

User has to comment all 
modifications

Select this option to require comments or approval for all 
method modifications. If the History Log is not required, it 
need not be enabled, as the software operates properly with-
out it.
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4.4.2.4  Open

The Open command is used to select and open a Sample Table, Method, Calibration Curve, 
Parameter, or Control Sample Template file. Save the open Sample Table before executing 
the Open command. More than one Sample Table can be opened at the same time. 
Selecting the Open command displays the Open dialog box shown below.

Figure 4.91  Open Dialog Box

TIP » The Open dialog box can also be displayed by clicking the Open File button on the Toolbar.

Table 4.2 displays the types of files that can be opened using this function. No other file 
types should be opened using this menu command.

Table 4.2 • Acceptable File Types for Open Function

The opened file replaces the currently displayed table or function, depending on the type of 
file selected. 

File Extension Description

.t32 Sample Table

.met Method

.cal Calibration Curve

.tpl Control Sample Template

.trd Data Profile

Dialog Box Options Description

File name Enter the name of the file to be opened.

Look in Find the file to be opened by choosing the appropriate folder 
or accessing other directories. The selected file will appear in 
the File name text box.

Files of type Select the type of file from the drop-down list. Choose only 
files of type *.t32 when opening a Sample Table.

Open button Opens the selected file.

Cancel button Aborts the Open operation.
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4.4.2.5  Close

The Close command is used to close the current window and is an option only when a file is 
open. If the open file has not been saved and the Close command is selected, the Save As 
dialog box is displayed. Refer to Section 4.4.2.7 "Save As". Enter a name for the file and 
click the OK button to save the file. If the open file has been modified but not saved and the 
Close command is selected, a dialog box is displayed as shown below. Click the Yes button 
to save the file before closing. Click the No button to close the file without saving the 
modified information. Click the Cancel button to abort the Close command.

Figure 4.92  Dialog box for Saving Modified Data

4.4.2.6  Save

The Save command is used to save data in the current active file. If the file has not yet been 
saved and the Save command is selected, the Save As dialog box is displayed. Refer to 
Section 4.4.2.7 "Save As".

TIP » The Save command can also be executed by selecting the Save File button on the Toolbar.
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4.4.2.7  Save As

The Save As command is used to save the current active file with a new file name. 
Selecting the command opens the Save As dialog box shown below. Button options in the 
dialog box are similar to those in the Open dialog box. Refer to Section 4.4.2.4 "Open". 
Click the Save button to save the data under the specified file name. Click the Cancel 
button to abort the Save As operation.

Figure 4.93  Save As Dialog Box

Dialog Box Options Description

File name Enter a name for the file. The applicable file extension will 
automatically be added if it is not entered.

Save in Select the directory in which the file is to be saved by choos-
ing the folder or accessing other directories from the drop-
down list. The currently selected directory appears in the 
Save in text field.

Save as type Select the type of file from the drop-down list. A list of avail-
able file types is listed in Table 4.2.
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4.4.2.8  ASCII Export Options

The ASCII Export function is used to export Sample Table data to an ASCII file. Open a 
Sample Table that contains completed measurement data. Select ASCII Export from the 
File menu. The Save As dialog box is displayed. Refer to Section 4.4.2.7 "Save As". Enter 
a file name for the ASCII file to be created and confirm that the “Save as type” field 
contains the ASCII file type (*.txt). If the entered file name matches a file that already 
exists, a confirmation message is displayed.

Figure 4.94  Save As Confirmation Message

Click the Yes button to overwrite the existing file and close the dialog box. Click the No 
button to redisplay the Save As dialog box and enter a new file name.

Select the ASCII Export Options command from the File menu. The ASCII Export Options 
dialog box, which contains several tabs, is displayed. Each tab contains a list of export 
options, as shown in the figures below. Note that on each tab, certain items are selected by 
default. Individual options can be selected or deselected by clicking in the check box. Use 
the Select All and Select None buttons to quickly select and deselect all options on a tab. 
Use the Default button to select the default options on a tab. Click the Cancel button to exit 
the ASCII Export Options dialog box without saving changes. Click the OK button to save 
changes and exit the ASCII Export Options window.

Header Tab

Figure 4.95  ASCII Export Options Window: Header Tab

Setting Item Description

Export header information Select to enable export of the selected header options. This 
option is selected by default.
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System Tab

Figure 4.96  ASCII Export Options Window: System Tab

Data Tab

Figure 4.97  ASCII Export Options Window: Data Tab

Setting Item Description

Export system information Select to enable export of the selected system options. This 
option is selected by default.

Setting Item Description

Export data Select to enable export of the selected data options. This 
option is selected by default.
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Miscellaneous Tab

Figure 4.98  ASCII Export Options Window: Miscellaneous Tab

The Miscellaneous tab contains additional options for the format of exported data. To 
change data format, open a Sample Table, select File>ASCII Export Options, then select 
the file to which changes should be made. On the Miscellaneous tab, select the desired type 
of Separator from the drop-down list. The Separator is the type of delimiter that will be 
used to separate items of data. Select the “Export strings in quotation marks” option to 
enclose all of the character string items in quotation marks.

4.4.2.9  Database Export

The Database Export command is used to enable automatic export of data to an external 
(Microsoft Access) database during analysis. Selecting the command displays the 
Database Options window.

Figure 4.99  Database Options Window

Setting Item Description

Enable automatic database 
export

Select this option to enable the database export function

Database Enter the name and filepath of the database, or click the 
Browse button to select the database using the File>Open 
dialog box.
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4.4.2.10  Print>Table

The Print>Table command is used to print the active Sample Table in a table format. Select 
this command to open the Print dialog box, which may have a variable display depending 
on the installed printer driver. Specify items to be included in the printout by using the Page 
Setup command. Refer to Section 4.4.2.15 "Page Setup" for more information.

Figure 4.100  Print Dialog Box

The Name text field identifies the printer that will be used to print the table. Specify a 
different printer by selecting it from the Name drop-down list.

Setting Item Description

Properties Modify the printer settings using standard Windows proce-
dures.

Print range Click the All radio button to print all pages of the table. Click 
the Pages radio button and enter the page numbers to be 
printed if all pages are not desired.

Number of copies Enter the number of copies to be printed.
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4.4.2.11  Print>Sample Report

The Print>Sample Report command is used to open the Print dialog box to print the Sample 
Table in report format. The print dialog box is the same as that described in  Section 
4.4.2.10 "Print>Table".

Figure 4.101  Print Dialog Box

4.4.2.12  Print Preview>Table

The Print Preview>Table option is used to display the sample table before printing. Use the 
buttons at the top of the Print Preview window to change the display or print the table, as 
described below. 

Button Description

Next Page and Previous Page Click the Next Page button to display the next page of the 
report. Click the Previous page button to display the previous 
page of the report. Note that the Next Page button is disabled 
when the last page of the report is displayed, and the Previous 
Page button is disabled when the first page of the report is 
displayed.

One Page/Two Page Click the One Page button to display one page at a time in the 
Print Preview window. After selection, the button toggles to 
the Two Page button. Click the Two Page button to display 
two pages side by side.

Zoom In and Zoom Out Click the Zoom In and Zoom Out buttons to change the mag-
nification of the displayed pages. Three different zoom fac-
tors are available. Repeated selection of either option will 
continue to increase or decrease the magnification, as appli-
cable.

Close Click the Close button to close the Print Preview window and 
return to the previous window. Note that the Print Preview 
window must be closed to edit the report.

Print Click the Print button to print the report.
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4.4.2.13  Print Preview>Sample Report

The Print Preview>Sample Report option is used to display the sample report before 
printing. Use the buttons at the top of the Print Preview window to change the display or 
print the report, as described in Section 4.4.2.12 "Print Preview>Table".

Figure 4.102  Print Preview>Report Window

4.4.2.14  Print Setup

The Print Setup command is used to set print options. Select this command to open the 
Print Setup dialog box, which may have a variable display depending on the installed 
printer driver. Modifications to the Print Setup dialog box are saved until the TOC-Control 
V software is exited.

Figure 4.103  Print Setup Dialog Box
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4.4.2.15  Page Setup

The Page Setup command is used to select items to be printed on a report or table and to 
specify format parameters such as margins, headers, and footers. Selecting the command 
displays the Page Setup window, which consists of several tabs. Each tab contains a list of 
page setup options shown in the figures below. On each tab, certain options are selected by 
default. Individual options can be selected or deselected by clicking in the check box. Use 
the Select All and Select None buttons to quickly select and deselect all options on a tab. 
Use the Default button to select the default options for a tab. Click the Cancel button to exit 
the Page Setup window without saving changes. Click the OK button to save changes and 
exit the Page Setup window.

Instrument Tab

The Instrument tab displays a list of instrument information items that can be printed on the 
report.

Figure 4.104  Page Setup Window: Instrument Tab

Calibrations Tab

The Calibrations tab displays a list of calibration information items that can be printed on 
the report.

Figure 4.105  Page Setup Window: Calibrations Tab
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Samples Tab

The Samples tab displays a list of sample information items that can be printed on the 
report.

Figure 4.106  Page Setup Window: Samples Tab

Header Tab

The Header tab displays a list of header items that can be printed on the report.

Figure 4.107  Page Setup Window: Header Tab
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Miscellaneous Tab

The Miscellaneous tab displays a list of format items for the report, as described below.

Figure 4.108  Page Setup Window: Miscellaneous Tab

Setting Item Description

Margins Use the spin controls to enter the page margins (in mm).

Footer, Page No. Select this option to print the page number in the footer of 
each page.

Header Organization: Select this option and enter the name of the 
organization in the text box to print the organization name in 
the page header. 
Logo: Select this option to print a bitmap in the page header. 
Use the Browse button to select the bitmap file.
Date/Time: Select this option to print the current system date 
and time in the page header.
User: Select this option to print the current user name in the 
page header.
Document name: Select this option to print the document file 
name in the page header.
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4.4.2.16  Exit

The Exit command is used to exit the Sample Table Editor. If the active file has been 
modified but not saved and the Exit command is selected, a dialog box is displayed as 
shown below. Click the Yes button to save the file before exiting. Click the No button to 
exit without saving the modified information. Click the Cancel button to abort the Exit 
command.

Figure 4.109  Prompt to Save Data Changes

If the software is connected to an instrument and the Exit command is selected, a dialog 
box is displayed as shown below. Click the OK button to disconnect the instrument before 
exiting the software. Click the Cancel button to abort the Exit command.

Figure 4.110  Prompt to Disconnect Instrument
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4.4.3  Edit Menu

The Edit menu contains functions that allow a user to modify data. To change data using the 
Edit menu functions, a user must have the appropriate access rights. Options such as Cut, 
Copy, and Paste are available only when a content selection from an open file is made.

Figure 4.111  Edit Menu

4.4.3.1  Undo

The Undo function is used to reverse the last change made in the active Sample Table and is 
only available after the user changes the content of a cell in the table. The Undo function is 
not available during actual measurement or when the user has inserted or deleted completed 
samples, calibration curves, or control samples.

4.4.3.2  Cut/Copy/Paste

The Cut, Copy, and Paste functions are used to edit selected Sample Table cells and rows. 
The Cut command deletes selected information from rows or cells and stores it on the 
clipboard. Note that the Cut command cannot be used to delete entire samples after 
measurement is completed. The Copy command copies selected data from rows or cells and 
stores it on the clipboard. The Paste command copies the contents of the clipboard to the 
selected cells or rows of the table. When pasting an entire row, click the destination row 
number to highlight the entire destination row, then execute the Paste command.

Note: • When pasting, do not select a destination row that currently contains data.
The data will be overwritten!

• The Cut, Copy, and Paste commands can also be accessed by clicking the 
icons on the Toolbar. 
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4.4.3.3  Replace

The Replace function is used to replace text in Sample Table cells with specified text. 
Select the Replace function to open the Replace dialog box. The Replace command can be 
used to replace data in the Sample Name, Sample ID, Dilution, and Comment fields of the 
Sample Table. The command cannot be used to replace data for samples after measurement 
is complete. 

Figure 4.112  Replace Dialog Box

4.4.3.4  Find

The Find function is used to search for specified text. Selecting the Find command opens 
the Find dialog box, which is similar to the Replace dialog box.and displays the options 
described below. Refer to Section 4.4.3.3 "Replace". 

Setting Item Description

Find what Enter the text to be searched for.

Replace with Enter the text that the searched-for text should be replaced 
with.

Match case Select to perform a case-sensitive text search.

Find Next Select to begin the search and to continue a search that has 
already begun.

Replace Select to replace the found text with the text in the “Replace 
with” field.

Replace All Select to replace all occurrences of found text with the text in 
the “Replace with” field.

Cancel Select to close the Replace dialog box.

Setting Item Description

Find what Enter the text to be searched for.

Match case Select to perform a case-sensitive text search.

Direction Click the Up radio button to search the table backwards from 
the current location. Click the Down radio button to search 
the table forward from the current location.

Find Next Select to begin the search and to continue a search that has 
already begun.

Cancel Select to close the Find dialog box.
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4.4.3.5  Exclude

The Exclude function is used to exclude selected injections from the calculations. A user 
must have access rights for updating data to use the Exclude function. To exclude data, 
highlight the desired injection shown in the Sample Window Injection Table and select 
Exclude from the Edit menu. A confirmation dialog box is displayed. Click the Yes button 
to exclude the selected data. Click the No button to abort the operation.

Figure 4.113  Exclude Confirmation Dialog Box

4.4.3.6  Recalculate>All

The Recalculate>All function is used to recalculate the data for all measured samples in a 
Sample Table after applying a new calibration curve or excluding injections. To execute the 
command, open the appropriate Sample Table and select Recalculate All from the Edit 
menu. A message is displayed in the Notify folder of the Notification Bar when the 
recalculation is complete.

4.4.3.7  Recalculate>Highlighted

The Recalculate>Highlighted function is used to recalculate the data for selected samples 
after applying a new calibration curve or excluding injections. The function is similar to the 
Recalculate All function described in Section 4.4.3.6 "Recalculate>All". To execute the 
command, open the appropriate Sample Table, highlight the samples to be recalculated, and 
select Recalculate Highlighted from the Edit menu.

4.4.3.8  Delete Data>All

The Delete Data>All function can only be used if the GLP conformity was disabled during 
system installation. The function is used to delete all measurement data in the Sample 
Table. The Sample Table structure can then be used to enter new data. A user must have 
access rights for updating data to use the Delete Data>All function. 

To use the Delete Data>All function, open a Sample Table that contains measurement data 
and select Delete Data>All from the Edit menu. A confirmation dialog box is displayed, as 
shown in the figure below. Click the Yes button to delete the data. Click the No button to 
abort the operation. A message is displayed on the Notifications tab in the Notification Bar 
when the data has been deleted.

Figure 4.114  Delete Data Confirmation Dialog Box
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4.4.3.9  Delete Data>Highlighted

The Delete Data>Highlighted function is used to delete the measurement data for selected 
samples. To execute the command, open the appropriate Sample Table, highlight the 
samples to be deleted, and select Delete Data>Highlighted from the Edit menu. A message 
is displayed on the Notifications tab in the Notification Bar when the selected data has been 
deleted.

4.4.3.10  Import

The Import function is used to import data from an ASCII file into a Sample Table. Note 
that the Import function is not available during sample analysis. To import data, open the 
destination Sample Table and place the cursor in the row of the table into which data will be 
imported. Select the Import function from the Edit menu. The Open dialog box is 
displayed. Select the ASCII file from which data will be imported. The data is inserted in 
the current position of the active Sample Table.
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4.4.4  View Menu

The View menu contains options for viewing calibration, method, and sample information, 
and for selecting settings for the display screen.

Figure 4.115  View Menu

4.4.4.1  Calibration Curve

The View>Calibration Curve command is used to view the calibration curve information 
associated with a sample. Place the cursor in the desired row of the Injection Table and 
select the Calibration Curve command from the View menu. The Calibration Curve 
Properties window is displayed. Refer to Section 4.4.4.5 "Properties".

TIP » The Calibration Curve Properties window can also be displayed by clicking the 
Calibration Curve (View) button on the Toolbar.
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4.4.4.2  Method

The View>Method command is used to view the properties associated with a method. 
Selecting the command displays the Sample/Method Properties window, which consists of 
several tabs, including a separate tab for each applicable method. Each tab lists options for 
method properties, as shown in the figures below. Individual options can be selected, 
deselected, or edited by clicking in the check boxes or entering information into the text 
fields. Note that certain options will be disabled if sample analysis is complete. Each tab 
contains the same command buttons: OK, Cancel and Apply. Click the OK button to save 
changes and exit the Sample/Method Properties window. Click the Cancel button to exit the 
Sample/Method Properties window without saving changes. Click the Apply button to save 
changes without exiting the Sample/Method properties window.

Figure 4.116  Sample/Method Properties Window: Common Tab

Common Tab

Setting Item Description

System Displays the system currently in use. Changes cannot be 
made to this field.

User Displays the name of the user who created the method. 
Changes cannot be made to this field.

Date of Creation Displays the date on which the method was created. Changes 
cannot be made to this field.

Comment Enter a comment (512 characters maximum).
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Parameter Tab

Figure 4.117  Sample/Method Properties Window: Parameter Tab

Setting Item Description

Analysis Displays analysis type. Changes cannot be made to this field. 

Dilution Displays the preparation dilution factor, which will be used to 
calculate sample concentrations. This field can be edited.

Sample Name Displays the default sample name (64 characters maximum). 
This field can be edited.

Sample ID Displays the default sample ID (64 characters maximum). 
This field can be edited.

No. of Determinations Displays the number of times (1-10) the sample is to be mea-
sured. Note that determinations and injections are different; 
each determination is made up of one or more injections. This 
field can be edited.

Perform sample checking 
according to USP/EP

Select to enable USP sample checking. 

Current Method Displays the file name of the current method. Changes cannot 
be made to this field.
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TC Tab

Figure 4.118  Sample/Method Properties Window: TC Tab

Setting Item Description

Analysis Parameters Units: Displays the concentration units. This field can be edited by selecting 
another option from the drop-down list. 
No. of Injections: Displays the minimum/maximum number of injections for the 
samples analyzed with this method. This field can be edited.
No. of Washes: Displays the number of times the syringe is to be washed with 
sample prior to the first injection. Note that if the Auto Dilution option was 
selected, the sample will be diluted and the syringe will then be washed with the 
diluted sample. This field can be edited.
SD Max: Displays the maximum standard deviation. If this value is met, no 
additional injections are required. However, if both this value and the CV Max 
value are exceeded, the samples are automatically reinjected up to the maxi-
mum number of times specified in the No. of Injections field. This field can be 
edited.
CV Max: Displays the maximum coefficient of variation. If this value is met, no 
additional injections are required. However, if both this value and the SD Max 
value are exceeded, the samples are automatically reinjected up to the maxi-
mum number of times specified in the No. of Injections field. This field can be 
edited. 
Acid Addition: Displays the quantity of acid to be added to each sample. This 
value is expressed as a percent or the sample volume and is available only for 
NPOC and related analyses. This field can be edited.



4.4    Sample Table Editor
4.4.4    View Menu

164 TOC-VCPH/CPN

IC Tab

The IC tab options are similar to those described above for the TC tab.

Figure 4.119  Sample/Method Properties Window: IC Tab

Peak Time Parameters Use default settings: Select this option to use the default settings for peak inte-
gration.
Allowed peak start delay: Displays the amount of time (in minutes) that can 
elapse before the analysis is stopped because a peak is not detected. This field 
can be edited by entering a number between 0 and 20:00. This option is disabled 
when Use default settings is selected.
Total integration time: Displays the amount of time (in minutes) that analysis 
continues after the end of the peak is detected. This field can be edited by enter-
ing a number between 4:50 and 20:00. This option is disabled when Use default 
settings is selected.

Multiple Injections Select this option to enable the syringe to draw up a single sample aliquot with a 
volume equal to that required for all injections of the sample. When this option 
is not selected, the syringe will draw up a separate sample aliquot for each 
injection; as a result, selecting this option reduces analysis time. 

Auto correction of inj. 
volume and dilution

Select this option to enable the instrument to automatically adjust the injection 
volume and dilution factor when the peak height for the initial injection exceeds 
full scale. After the adjustment, measurement will be repeated.

Auto Dilution Displays the factor by which the instrument will automatically dilute the sam-
ple. This field can be edited.

Inj. Volume Displays the injection volume. This field can be edited.

Expected Conc. Range Enter the expected concentration if it is known.

Use area retrieved from 
the blank check

Select to include blank check result in the concentration calculation.

Calibration Curve 1/2/3 Displays the name(s) of calibration curve(s) used to quantitate samples ana-
lyzed by the method. These fields can be edited by entering a calibration curve 
file name or clicking the Browse button to search for the file.

Setting Item Description
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NPOC and POC Tabs

The NPOC and POC tab options are similar to those described above for the TC tab.

Figure 4.120  Sample/Method Properties Window: NPOC Tab

TN Tab

The TN tab options are similar to those described above for the TC tab, except that some 
options (such as Use area retrieved from blank check) are not available for TN 
measurements.

Figure 4.121  Sample/Method Properties Window: TN Tab
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History Tab

If the History Log was enabled when the method was created, the History tab displays a list 
of changes made to the method parameters. If the History Log was not enabled previously, 
it can be enabled on the History tab.

Figure 4.122  Sample/Method Properties Window: History Tab

A list of the Comment dialog box contents is shown below:

Table 4.3 • Comment dialog box contents

Setting Item Description

Enable history log Select this option to enable the software to monitor all modi-
fications to the system. If the History Log is not required, it 
need not be enabled, as the software operates properly with-
out it. Once this is enabled, it cannot be disabled.

User has to comment all 
modifications

Select this option to require comments or approval for all 
modifications. If the History Log is not required, it need not 
be enabled, as the software operates properly without it. Once 
this is enabled, it cannot be disabled.

ACSII Export The displayed items in the list are exported as tab-delimi-
nated text files.

Item Description

Date/Time Displays the date and time of the modification.

User Displays the user who made the modification.

Changed item Describes the parameter that changed.

From Displays the previous parameter value.

To Displays the new parameter value.

Comment Lists the reason for the modification.
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4.4.4.3  Sample Window

The Sample Window is used to display detailed measurement information. The information 
displayed in the Sample Window varies based on the type of analysis performed. To view 
the Sample Window, open a Sample Table, place the cursor in the row of the Sample Table 
that contains the desired sample, and select Sample Window from the View menu. The 
Sample Window is displayed.

TIP » To view measurement data in real time, place the cursor in the row of the Sample Table that 
contains the current sample, then open the Sample Window.

The Sample Window is divided into 3 sections: the Graph, the Parameter Table, and the 
Injection Table. Note that the sections can be resized by dragging the dividers between 
sections. 

Figure 4.123  Sample Window

Graph

The upper left section of the Sample Window displays the peak profile graph. Change the 
graph type by choosing from the options on the drop-down list. 

Note: To view the peak profile of the measurement in progress, click the row with the 
asterisk in the Sample No. column. To view a previous measurement, click the 
desired row.

Parameter Table

The upper right section of the Sample Window displays sample parameters.

Setting Items Description

Current Peak Displays the peak profile of the highlighted injection.

All Peaks Displays all injection peaks for the selected sample.

Calibration curve Displays calibration curves (for calibration standards only). 
This function is not available during real-time analysis

Setting Item Description

Sample Name Displays the name of highlighted sample.

Sample ID Displays the sample identification from the Sample Table.

Analysis Displays the analysis method used for the sample.

Result Displays the sample concentration.

Dilution Factor Displays the dilution factor. The result will be multiplied by 
this factor to calculate the final concentration. If the sample 
was not diluted, do not change the default value of 1.
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Injection Table

The lower section of the Sample Window displays the Injection Table, which contains 
detailed information about the injections performed for the selected sample. Asterisks are 
displayed in the Injection Table for the injection that is currently being measured. Some 
columns in the Injection Table use the Merge Cell function to display information that is 
common to all the injections of a particular sample. If the sample has been analyzed by 
more than one analysis method, the Injection Table contains several folders displayed as 
tabs at the bottom of the window. The columns in the Injection Table are described below.

Setting Items Description

Spl. No. Displays the sample number.

Inj. No. Displays the injection number.

Area Displays the area value.

Mean area Displays the mean area value for all injections of the sample.

Conc. Displays the concentration obtained for the injection.

Mean Conc. Displays the mean concentration obtained for all injections of 
the sample.

Result Displays the analysis result.

Notes Displays any analysis flags or notations associated with that 
sample.

SD Area Displays the standard deviation calculated from the area.

CV Area Displays the coefficient of variation calculated from the area.

SD Conc. Displays the standard deviation calculated from the concen-
tration.

CV Conc. Displays the coefficient of variation calculated from the con-
centration.

Status Displays the analytical status, either “measuring” or “fin-
ished”.

Vial Displays the vial number (for ASI samples only).

Excluded Displays the exclusion flag, denoted as “E” for user exclusion 
of the sample, “ES” for exclusion by the system, or “Not 
Excluded”.

Modified Displays the modification flag of “M” if the sample was 
modified.

Inj. Volume Displays the injection volume for each injection.

Dilution Factor Displays the dilution factor used in measurement. 

Calibration curve Displays the calibration curve used.
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4.4.4.4  Outlier Test

The Outlier Test (also known as the Grubb test) is used to determine whether a selected 
injection is an outlier. The test also determines whether the injection with the highest 
deviation from the mean value is still within an acceptable range. The Outlier Test can only 
be performed if the sample contains at least three non-excluded injections.

Figure 4.124  Outlier Test Window

To perform the Outlier Test, open the Sample Window and select the cells containing the 
data to be tested. From the View menu, select Outlier Test. The Outlier Test window is 
displayed. Select either Conc. or Area (CNV) for the data source. Exclude the injection that 
is suspected of being an outlier, then select OK to close the dialog box.

If the sample does not contain enough injections for the test to be performed, an error 
message is displayed and the Outlier Test window will not open.

The Outlier Test window contains the parameters listed below.

Setting Items Description

Result List Displays the result of the Outlier Test.

Conc. radio button Select to indicate that test calculations are to be performed 
based on the concentration data.

Area (CNV) radio button Select to indicate that test calculations are to be performed 
based on the area data.

Result Displays the result of the test.

Exclude button Click this button to exclude a suspect sample and recalculate 
the test result.

Suspicious inj. Indicates the injection suspected of being an outlier, which is 
identified as the sample with the highest deviation from the 
mean value.

SD Displays the standard deviation for all of the injections.

CV Displays the coefficient of variation for all of the injections.

Grubb Value Displays the corresponding value from the Grubb table.

Test Value Displays the calculated Outlier Test value.
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4.4.4.5  Properties

The View>Properties function displays various windows. The display depends on the 
content of the cell selected in the Sample Table. If a range of cells is selected, the upper left 
cell is considered the active cell. The table below shows the possible selections and the 
corresponding Properties windows.

Table 4.4 • Properties Windows

The Properties window contains options for viewing and modifying the method, calibration 
curve, and sample properties. Each Properties window consists of several tabs. The 
Calibration Curve Properties window tabs are shown and described below.

Calibration Curve Properties Window

Figure 4.125  Calibration Curve Properties Window: The Common Tab

Common Tab

The Common tab of the Calibration Curve properties window contains the following 
information about the calibration curve.

Content of Active Cell Properties Window

Calibration Curve Calibration Curve Properties window

Method Sample/Method Properties window

Any other cell for a sample Sample/Method Properties window

Any other cell of a control 
sample

Control Sample Properties window

Setting Item Description

System Displays the system used to create the calibration curve. This 
field cannot be edited.

User Displays the name of the user who created the calibration 
curve. 

Date of Creation Displays the date and time the calibration curve was created. 

Comment A comment regarding the calibration curve may be entered 
here.

Print Prints the calibration curve information.
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Parameter Tab

Figure 4.126  Calibration Curve Properties Window: Parameter Tab

Setting Item Description

Analysis Displays the analysis method used to create the calibration curve. This field can-
not be edited.

Unit Displays the concentration units. This field cannot be edited.

Sample Name Displays the default sample name used for the calibration standards (64 characters 
maximum). This field can be edited.

Sample ID Displays the default sample ID (64 characters maximum). This field can be edited.

No. of Cal. Points Displays the number of calibration standards used. This field cannot be changed.

Catalyst Type Displays the type of catalyst used.

Calibration Curve 
Type

Displays the calibration curve type. This field cannot be changed.

Calculation Method Displays the calibration curve calculation method. This field can be edited by 
selecting a different option from the drop-down list. Two calculation methods are 
available: point-to-point and linear regression. For both types, a curve represent-
ing the relationship between detector response and concentration is displayed. 
The point-to-point curve fit draws a straight line between adjacent data points and 
considers each line segment to be a separate calibration line governed by its own 
equation. A linear regression statistically determines the line that best fits the pat-
tern of all data points. The number used to describe the agreement between the 
calculated line and the data points is called the Coefficient of Determination (r2). 
A coefficient of 1 indicates that the line fits the data points perfectly.
The general equation for a straight line is: 

Y = mX + b
where:    Y = Y-axis data point
              X = X-axis data point
              m = slope of line
               b = Y-axis intercept point
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Analysis Tab

The Analysis tab displays additional analysis parameters.

Figure 4.127  Calibration Curve Properties Window: Analysis

Analysis Parameters

Zero Shift Select Zero Shift to shift the regression curve through the origin. Note that this 
option does not change the slope of the line. Use this option as a correction when 
the TC content in the Zero water used to prepare the calibration standards is too 
large to ignore.

Multiple Injections Select to enable the syringe to draw up a single aliquot with a volume equal to that 
required for all injections of the standard. When this option is not selected, the 
syringe will draw up a separate aliquot for each injection; as a result, selecting this 
option reduces analysis time.

Calibration Curve 
File

Displays the file name of the calibration curve. This field cannot be changed.

Setting Item Description

No. of Washes Displays the number of times (0-10) the syringe is washed with standard 
prior to the first injection. Note that if the Auto Dilution option was 
selected, the standard will be diluted and the syringe will then be washed 
with the diluted standard. This option is not available for SSM. This field 
can be edited.

Acid Addition Displays the quantity of acid to be added to each standard prior to injec-
tion. This value is expressed as a percent of the sample volume and is 
available only for NPOC or related analyses. This field can be edited.

Sparge Time Displays the pre-sparge time (0-20 minutes). This option is only avail-
able when the external sparge kit is installed and the analysis type is 
NPOC. This field can be edited.

Density: Displays the sample density. This option is available only for SSM.

By Weight/Volume: Displays the basis (Weight or Volume) for sample calculations. This 
option is available only for SSM.

Setting Item Description
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Peak Time Parameters

Data Tab

The Data tab displays information about each calibration standard used in the calibration 
curve.

Figure 4.128  Calibration Curve Properties Window: Data Tab

Setting Item Description

Use default settings This option is selected if the default settings are used for peak 
integration.

Allowed peak start delay Displays the amount of time (in minutes) that can elapse 
before the analysis is stopped because a peak is not detected. 

Total integration time Displays the amount of time (in minutes) that analysis contin-
ues after the end of the peak is detected. 

Setting Item Description

Auto Dilution Displays the auto dilution factor.

Inj. Volume Displays the injection volume, which varies depending on the 
analysis type.
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Columns of data are displayed in a window below the Inj. Volume selection, as described 
below.

Table 4.5 •  Data Tab Columns

Additional buttons are displayed, below the data columns and can be used to manipulate the 
calibration parameters. The buttons are described below. Refer to Section 4.4.2.2 
"Calibration Curve" for more detailed descriptions.

Column Name Description

Auto Dilution Displays the dilution factor for auto dilution.

Standard Solution Concentra-
tion

Displays the concentration of the standard solution used for 
analysis.

No. Displays the calibration point number.

Conc. Displays the concentration of calibration point.

Mean Area Displays the mean area value from all non-excluded injec-
tions

No. of Injections Displays the minimum and maximum number of injections.

Excluded “E” indicates calibration point has been excluded.

SD Max Displays the maximum standard deviation.

CV Max Displays the maximum coefficient of variation.

SD Displays the standard deviation.

CV Displays the coefficient of variation.

Button Function

Edit Edit the parameters for the selected calibration point.

Add Add a new calibration point.

Delete Delete the selected calibration point.

Delete All Delete all calibration points.

Exclude Exclude the selected calibration point.
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Graph Tab

The Graph tab displays the calibration curve in a graphic format.

Figure 4.129  Calibration Curve Properties Window: Graph Tab

Setting Item Description

Slope/Intercept/r^2 The values for Slope, Intercept, and r2 are displayed for the 
selected calibration curve. 
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History Tab

If the History Log was enabled when the calibration curve was created, the History tab 
displays a list of changes made to the calibration curve parameters. If the History Log was 
not enabled previously, it can be enabled on the History tab.

Figure 4.130  Calibration Curve Properties Window: History Tab

A list of the Comment dialog box contents is shown below:

Table 4.6 • Comment dialog box contents

Setting Item Description

Enable history log Select this option to enable the software to monitor all modi-
fications to the system. If the History Log is not required, it 
need not be enabled, as the software operates properly with-
out it. Once this is enabled, it cannot be disabled.

User has to comment all 
modifications

Select this option to require comments or approval for all 
modifications.f the History Log is not required, it need not be 
enabled, as the software operates properly without it. Once 
this is enabled, it cannot be disabled.

ACSII Export The displayed items in the list are exported as tab-delimi-
nated text files.

Item Description

Date/Time Displays the date and time of the modification.

User Displays the user who made the modification.

Changed item Describes the parameter that changed.

From Displays the previous parameter value.

To Displays the new parameter value.

Comment Lists the reason for the modification.
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4.4.4.6  Customize

The View>Customize window contains two tabs, one that displays or hides the toolbars and 
one that customizes the toolbar content.

Figure 4.131  Customize Window: Toolbars Tab

Toolbars Tab

Select the desired toolbars from the list. All items are selected by default.

Option Description

Show Tooltips Displays tooltips when the mouse cursor is positioned over 
the toolbar button.

Cool Look Select this option to display the toolbar buttons as flat but-
tons. This item is selected by default.

Large Buttons Select this option to display the toolbar buttons in a larger 
size.

New button Click this button to create a user-defined toolbar button.

Reset/Delete button Click this button to reset the toolbar display to its original 
state or delete a user-defined toolbar button.
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Command Tab

Figure 4.132  Customize Window: Command Tab

4.4.4.7  Toolbar

The View>Toolbar function is used to select or deselect individual toolbars for display. 
Toolbar display options (such as button size or appearance) can also be set using this 
command.

Figure 4.133  Toolbar Window

4.4.4.8  Status Bar

The View>Status Bar function toggles the display state of the status bar between Show and 
Hide. If the status bar is currently displayed, selecting this option will hide the status bar. If 
the status bar is not displayed, selecting this option will display the status bar.

Option Description

Categories Displays the available toolbars.

Buttons Displays the buttons in the selected toolbar. The buttons can 
be moved by dragging them to another toolbar.

Description Displays a description of the selected button.
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4.4.4.9  ASI / 8-Port Sampler Vials

This function displays the ASI or 8-Port Sampler dialog box, and allows the user to enter 
vial numbers for measurement using the ASI or the 8-Port Sampler. To access this 
command, either create or open a sample table, and select View > ASI / 8-Port Sampler 
Vials. The Sparge / Acid Addition dialog box opens automatically when the Start command 
is made. The OK button saves the changes and closes the dialog box.

Using the Autosampler

Figure 4.134  Sparge / Acid Addition Dialog Box for the ASI-V Autosampler

Using One 8-Port Sampler 

Figure 4.135  Sparge / Acid Addition Dialog Box for One 8-Port Sampler

Using Two 8-Port Samplers 

Figure 4.136  Sparge / Acid Addition Dialog Box for Two 8-Port Samplers



4.4    Sample Table Editor
4.4.4    View Menu

180 TOC-VCPH/CPN

When the mouse is positioned over a vial in the drawing of the of ASI or 8-Port Sampler, a 
tool-tip showing the vial number is displayed. Click the vial to display the following items.

TIP » The desired vial position for a sample can be entered either directly into the Vial column or 
by placing the cursor in the appropriate row of the Sparging/Acid Addition window and 
then double-clicking the desired position in the tray diagram.

4.4.4.10  Data Profile

Displays the raw measurement data. The data profile is never modified or processed 
following the initial collection. It includes the corresponding measurement parameters. The 
files which were created and named using the object ID, each occupy a row in the sample 
table, and are stored within the RawData folder in folders named using the date of creation. 

The View>Data Profile function is used to view the data profile for a sample. Highlight the 
desired row of the Sample Table, then select the command.

Parameter Description

Vial No. Displays the currently selected vial number.

Acid Addition rate Displays the acid addition rate for each vial.

Sparge time Displays the sparge time for each vial.

Total injection volume Displays the total injection volume for each vial.
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4.4.5  Insert Menu

The Insert menu contains options for inserting sample groups, calibration curves, 
individual samples, and control samples into the Sample Table.

Figure 4.137  Insert Menu

4.4.5.1  Auto Generate

The Auto Generate command opens the Sample Group Wizard, which is used to create a 
group of unknown samples, control samples, and calibration standards, and then insert the 
group into the active position of the Sample Table.

Sample Group Wizard (Page 1) Sample Source

The Sample Source window is used to specify the source of sample measurement 
parameters.

Figure 4.138  Sample Group Wizard (Page 1) Sample Source

Setting Item Description

Method radio button Click this option to analyze the samples using the measure-
ment parameters from a specified method. This is the default 
option.

Method text field Enter the desired method or select the method using the 
Browse button.

Calibration curve radio but-
ton

Click this option to analyze the samples using the measure-
ment parameters from a specified calibration curve.

Calibration curve text field Enter the desired calibration curve or select the curve using 
the Browse button.
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Sample Group Wizard (Page 2) Sample Parameter

The Sample Parameter window is used to enter basic information about the sample group.

Figure 4.139  Sample Group Wizard (Page 2) Sample Parameter

Setting Item Description

No. of Samples Enter the number of samples in the group. Enter an integer 
ranging from 1 to 200. The default value is 1.

Start Vial Enter the starting vial position for the sample group. Enter an 
integer ranging from 0 to 9 or 1 to 100, depending on the 
sample tray size. The default value is 1. This field is disabled 
if an autosampler is not a component of the configured sys-
tem.

Sample Name/Sample ID The default designations for these fields are obtained from 
the method or calibration curve identified in Page 1 of the 
Sample Group Wizard. Enter other names if desired.

Index Start Select this option to start the counting index. Each sample 
added receives an increased counting index number.



4.4    Sample Table Editor
4.4.5    Insert Menu

183TOC-VCPH/CPN

Sample Group Wizard (Page 3) Calibration Curves

The Calibration Curves window is used to identify the calibration standards in the sample 
group and to specify their placement in the group. The window is also used to revise the list 
of calibration curves that will be used to quantitate samples in the group.

Figure 4.140  Sample Group Wizard (Page 3) Calibration Curves

Setting Item Description

Perform Calibration Select one of the available options for when calibration 
should be performed: At the beginning of the sample group or 
Always, after (a selected number of) Samples have been ana-
lyzed.

Add button Use this button to add a calibration curve.

Delete button Highlight a calibration curve listed in the window and click 
the Delete button to remove the curve from the sample group.

Calibration Curves No.: Displays the number of the calibration point.
File name: Displays the name of the calibration curve.
Analysis: Displays the analysis type.
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Sample Group Wizard (Page 4) Controls

The Controls window is used to identify the control samples in a sample group and to 
specify their placement in the sample group.

Figure 4.141  Sample Group Wizard (Page 4) Controls

Insert Control Samples

Use the options listed below to insert individual control samples in the sample group.

Control Templates

The Control Templates table displays a list of the control sample templates currently 
assigned to the sample group. The templates specify measurement parameters, evaluation 
criteria, and failure actions for the control samples. This table is empty by default. Use the 
options listed below to revise the list of control sample templates associated with the 
sample group.

After all four pages of the Sample Group Wizard are complete, click the Finish button to 
save changes and add the sample group to the Sample Table. If invalid parameter values 
were entered, an error message will be displayed and the sample group will not be inserted 
into the Sample Table until after the error is corrected.

Setting Items Description

At the beginning of the sam-
ple group

Select this option to add control samples at the beginning of 
the sample group.

Always, after (number of) 
samples

Select this option to add control samples at defined intervals 
between unknown samples.

At the end of the sample 
group

Select this option to add control samples at the end of the 
sample group.

Option Description

Add Select this option to add a control template to the sample 
group.

Delete Select this option to delete a highlighted control template 
from the list.
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4.4.5.2  Sample

The Sample command opens the Sample Wizard, which is used to insert sample 
measurement parameters into an existing Sample Table. The Sample Wizard is not 
accessible during an analysis. 

Sample Wizard (Page 1) Parameter Source

The Parameter Source window is used to specify the source of the sample measurement 
parameters. The source can either be a method file or a calibration file. When one of these 
sources is selected, the sample will be analyzed using the same measurement parameters as 
those in the specified method or calibration file. Some of the source parameters can be 
edited in subsequent pages of the Sample Wizard. Note that a sample can also be added to 
the Sample Table without specifying a source, an option that is desirable when a sample is 
to be analyzed using different parameters than those specified in the method or calibration 
files. In this case, unique measurement parameters for the sample will be entered on 
subsequent pages of the Sample Wizard.

Figure 4.142  Sample Wizard (Page 1) Parameter Source

Parameter Description

Method radio button Select this option to use the sample measurement parameters from a specified 
method. This is the default option. Enter the method name in the text field, or 
use the Browse button to select the file using the File>Open dialog box

Calibration Curve radio 
button

Select this option to use the measurement parameters from a specified cali-
bration curve. Enter the calibration curve name in the text field, or use the 
Browse button to select the file using the File>Open dialog box. 

Edit parameters manually 
radio button

Select this option to insert a sample without defining a source. Sample mea-
surement parameters will be entered in subsequent pages (1-12) of the Sam-
ple Wizard.

Skip remaining Wizard 
pages and use measure-
ment parameters from the 
source

Select this option to accept all measurement parameters from the source file. 
The Next button will become a Finish button, and subsequent pages of the 
Sample Wizard will not be displayed. This option is disabled if Edit parame-
ters manually is selected.
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Sample Wizard (Page 2) Analysis Information

Figure 4.143  Sample Wizard (Page 2) Analysis Information

Note: For combined analyses such as TC/TN or POC+NPOC, subsequent Sample Wiz-
ard windows may appear more than once so that parameter modifications spe-
cific to each analysis type can be made. The analysis type that is associated with 
each Sample Wizard window can be found in the Analysis box at the top of the 
window.

Parameter Description

Analysis Select the analysis type from the drop-down list. 

Default Sample Name Enter the sample name. 

Default Sample ID Enter the sample identification.

Dilution Enter the preparation dilution factor. 

No. of Determinations Use the spin controls to enter the number of times the sample 
is to be measured. Note that determinations and injections are 
different; each determination is made up of one or more 
injections. Enter an integer from 1 to 10.
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Sample Wizard (Page 3) Calibration Curve

The Calibration Curve window is used to identify the calibration curve(s) that will be used 
to calculate the sample concentration. If more than one curve is identified, the software 
automatically selects the curve to be used in calculating sample concentration. Refer to 
Section 6.2.5 "Automatic Selection of Optimum Calibration Curve".

Figure 4.144  Sample Wizard (Page 3) Calibration Curve

Parameter Description

Analysis Displays the analysis type. This field cannot be changed.

Calibration Curve 1/2/3 Enter the name of the calibration curve or click the Browse 
button to select a file using the File>Open dialog box.

Skip the injection parameter 
pages of the wizard

Select this item to skip the Measurement Parameters window 
of the Sample Wizard. Use this option when the sample mea-
surement parameters will be the same as those used for cali-
bration curve measurements.
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Sample Wizard (Page 4) Injection Parameters

Figure 4.145   Sample Wizard (Page 4) Injection Parameters

Parameter Description

Analysis Displays the analysis type. This field cannot be changed.

Units Enter the concentration units.

Injection Volume Enter the injection volume.

Expected Conc. Range Enter the maximum expected sample concentration.

No. of Injections Enter the minimum and maximum number of injections for 
the sample.

SD Max Enter the maximum standard deviation. If this value is met, 
no additional injections are required. However, if both this 
value and the CV Max value are exceeded, the sample is 
automatically reinjected up to the maximum number of times 
specified in the No. of Injections field. The SD Max field is 
disabled if the No. of Injections is 1 or if the minimum is 
equal to the maximum.

CV Max Enter the maximum coefficient of variation. If this value is 
met, no additional injections are required. However, if both 
this value and the SD Max value are exceeded, the sample is 
automatically reinjected up to the maximum number of times 
specified in the No. of Injections field. The CV Max field is 
disabled if the No. of Injections is 1 or if the minimum is 
equal to the maximum.

No. of Washes Enter the number of times the syringe is to be washed with 
sample prior to the first injection. Note that if the Auto Dilu-
tion option was selected, the sample will be diluted and the 
syringe will then be washed with the diluted sample.
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Auto Dilution Enter a dilution factor for the sample. The instrument will 
automatically dilute the sample by this factor, and the result 
will be multiplied by the factor to obtain the final concentra-
tion. The default Auto Dilution value is 1.

Sparge Time Enter the sparge time.

Acid Addition Enter the desired quantity of acid to be added. This value is 
expressed as a percent of the sample volume and is available 
only for NPOC or related analyses.

Multiple Injections Select this option to enable the syringe to draw up a single 
sample aliquot with a volume equal to that required for all 
injections of the sample. When this option is not selected, the 
syringe will draw up a separate sample aliquot for each injec-
tion. Selecting this option reduces analysis time.

Use blank check area Select this option to subtract the blank check area from the 
measured area of the sample. This option is only available for 
TC and NPOC analyses that use the high sensitivity catalyst.

Auto. correction of inj. vol. 
and dilution

Select this option to enable the instrument to automatically 
adjust the injection volume and dilution factor when the peak 
height for the initial injection exceeds full scale. After the 
adjustment, measurement will be repeated.

Parameter Description
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Sample Wizard (Page 5) Peak Time Parameters

Figure 4.146  Sample Wizard (Page 5) Peak Time Parameters

Parameter Description

Analysis Displays the analysis type. This field cannot be changed.

Use default settings Select this option to use the default integration parameters. 
When this option is selected, all other options in this window 
are disabled.

Allowed peak start delay The allowed peak start delay is the amount of time (in min-
utes) that can elapse before the analysis is stopped because a 
peak is not detected. Enter a number between 0 and 20:00.

Total integration time The total integration time is the amount of time (in minutes) 
that analysis continues after the end of the peak is detected. 
Enter a number between 4:50 and 20:00.



4.4    Sample Table Editor
4.4.5    Insert Menu

191TOC-VCPH/CPN

Sample Wizard (Page 6) Calibration Curve

A second Calibration Curve window is only displayed when more than one analysis type 
has been specified. This window is the same as Page 3 of the Sample Wizard, which is 
described above. Verify the analysis type in the Analysis text box at the top of the page and 
make the appropriate selections.

Figure 4.147  Sample Wizard (Page 6) Calibration Curve Window (Second Analysis)

Sample Wizard (Page 7) Injection Parameters

A second Injection Parameters window is only displayed when more than one analysis type 
has been specified. This window is the same as Page 4 of the Sample Wizard, which is 
described above. Verify the analysis type in the Analysis text box at the top of the page and 
make the appropriate selections.

Figure 4.148  Sample Wizard (Page 7) Injection Parameters Window (Second Analysis)
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Sample Wizard (Page 8) Peak Time Parameters

A second Peak Time Parameters window is only displayed when more than one analysis 
type has been specified. This window is the same as Page 5 of the Sample Wizard, which is 
described above. Verify the analysis type in the Analysis text box at the top of the page and 
make the appropriate selections.

Figure 4.149  Sample Wizard (Page 8) Peak Time Parameters Window (Second Analysis)

Sample Wizard (Page 9) USP/EP

The USP/EP window is displayed only for TC or NPOC methods, and is used to enable 
samples to be checked in accordance with USP/EP standards. This window is the same as 
Page 6 of the Sample Wizard, which is described above. Select the check box to enable this 
function.

Figure 4.150  Sample Wizard (Page 9) USP/EP
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4.4.5.3  Control

The Control command is used to insert a control sample into an existing Sample Table. 

Note: A control sample template must be created before a control sample can be 
inserted into a Sample Table. A control sample template has a file extension of 
*.tpl and specifies measurement parameters for the Control Sample. 

The following subsections describe the procedures for creating a control sample template 
and for inserting a control sample into a Sample Table.

Creating a Control Sample Template

Control sample templates are created using the Control Sample Wizard. To access the 
Control Sample Wizard select New>Control Sample Template from the File menu. The 
Control Sample Wizard consists of several windows, each of which defines specific 
parameters for the control sample template, as described below.

Control Sample Wizard (Page 1) System Information

Figure 4.151  Control Sample Wizard (Page 1) System Information

Parameter Description

System Select the instrument.

Operator Displays the current operator name. This field cannot be 
changed.

Date of Creation Displays the current date and time. This field cannot be 
changed.

Comment Enter a comment (512 characters maximum).
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Control Sample Wizard (Page 2) Control Sample Type

The Control Sample Type window is used to identify the type of control sample.

Figure 4.152  Control Sample Wizard (Page 2) Control Sample Type

Parameter Description

Control Sample Select this option to define individual sample parameters. 
This is the default option.

Control Chart Sample Select this option to add the control sample to a defined con-
trol chart. Enter the file name or use the Browse button to 
select the control chart file from the File>Open dialog box.

System Suitability Test for 
USP/EP

Select this option to check the control sample using USP/EP 
criteria.

Save the data in a control 
sample template

Enter a file name for the control sample template.
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Control Sample Wizard (Page 3) Parameter Source

The Parameter Source window is used to specify the source of the control sample 
measurement parameters. The source can either be a method file or a calibration file. When 
one of these sources is selected, the control sample will be analyzed using the same 
measurement parameters as those in the specified method or calibration file. Some of the 
source parameters can be edited in subsequent pages of the Control Sample Wizard. Note 
that a control sample can also be added to the Sample Table without specifying a source, an 
option that is desirable when a control sample is to be analyzed using different parameters 
than those specified in the method or calibration files. In this case, unique measurement 
parameters for the sample will be entered on subsequent pages of the Control Sample 
Wizard.

Figure 4.153  Control Sample Wizard (Page 3) Parameter Source

Parameter Description

Method radio button Select this option to use the measurement parameters from a 
specified method. Enter the method name in the text field, or 
use the Browse button to select the file using the File>Open 
dialog box. This is the default option.

Calibration Curve radio but-
ton

Select this option to use the measurement parameters from a 
specified calibration curve. Enter the calibration curve name 
in the text field, or use the Browse button to select the file 
using the File>Open dialog box. 

Edit parameters manually 
radio button

Select this option to insert a control sample without defining 
a source. Control sample measurement parameters will be 
entered in subsequent pages of the Control Sample Wizard.

Skip remaining Wizard pages 
and use measurement param-
eters from the source

Select this option to accept all measurement parameters from 
the source file. The Next button will become a Finish button, 
and subsequent pages of the Control Sample Wizard will not 
be displayed. This option is disabled if Edit parameters man-
ually is selected.



4.4    Sample Table Editor
4.4.5    Insert Menu

196 TOC-VCPH/CPN

Control Sample Wizard (Page 4) Analysis Parameters

Figure 4.154  Control Sample Wizard (Page 4) Analysis Parameters

Parameter Description

Analysis Select the analysis type from the drop-down list. If a source 
method or calibration file was specified on Page 3 of the 
Control Sample Wizard, this field is disabled and the applica-
ble analysis type is displayed.

Default Sample Name Enter the sample name. If a source method or calibration file 
was specified on Page 3 of the Control Sample Wizard, the 
default sample name from the source is displayed.

Default Sample ID Enter the sample identification. If a source method or calibra-
tion file was specified on Page 3 of the Control Sample Wiz-
ard, the default sample identification from the source is 
displayed.

Dilution Enter the dilution factor. If a source method or calibration file 
was specified on Page 3 of the Control Sample Wizard, the 
default dilution factor is displayed.

Calibration Curve Enter the calibration file name that is to be used to calculate 
control sample concentration. If a source method or calibra-
tion file was specified on Page 3 of the Control Sample Wiz-
ard, the default calibration curve name from the source is 
displayed.
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Control Sample Wizard (Page 5) Injection Parameters

Figure 4.155  Control Sample Wizard (Page 5) Injection Parameters

Parameter Description

Analysis Displays the analysis type. This field cannot be changed.

Units Select the concentration units.

Injection Volume Enter the injection volume.

Expected Conc. Range Enter the maximum expected concentration.

No. of Injections Enter the minimum/maximum number of injections for the control sample. 
The setting range is from 1-20.

SD Max Enter the maximum standard deviation that is acceptable for the injections. If 
this value is met, no additional injections are required. However, if both this 
value and the CV Max value are exceeded, the control sample is automatically 
reinjected up to the maximum number of times specified in the No. of Injec-
tions field. The SD Max field is disabled if the No. of Injections is 1 or if the 
minimum is equal to the maximum.

CV Max Enter the maximum coefficient of variation that is acceptable for the injec-
tions. If this value is met, no additional injections are required. However, if 
both this value and the SD Max value are exceeded, the control sample is 
automatically reinjected up to the maximum number of times specified in the 
No. of Injections field. The CV Max field is disabled if the No. of Injections is 
1 or if the minimum is equal to the maximum.

No. of Washes Enter the number of times the syringe is to be washed with sample prior to the 
first injection. Note that if the Auto Dilution option was selected, the sample 
will be diluted and the syringe will then be washed with the diluted sample.

Auto Dilution Enter a dilution factor for the samples. The instrument will automatically 
dilute the control sample by this factor, and the result will be multiplied by the 
factor to obtain the final concentration. The default Auto Dilution value is 1.

Acid Addition Enter the desired quantity of acid to be added. This option is available only for 
NPOC and related analyses.

Sparge Time Enter the sparge time.
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Control Sample Wizard (Page 6) Peak Time Parameters

The Peak Time Parameters window is used to set peak detection parameters for the control 
samples.

Figure 4.156  Control Sample Wizard (Page 6) Peak Time Parameters

Multiple Injections Select to enable the syringe to draw up a single sample aliquot with a volume 
equal to that required for all injections of the sample. When this option is not 
selected, the syringe will draw up a separate sample aliquot for each injection; 
as a result, selecting this option reduces analysis time.

Use area retrieved from 
the blank check

Select this option to subtract the blank check area from the measured area of 
the control sample. This option is only available for TC and NPOC analyses 
that use the high sensitivity catalyst.

Setting Item Description

Use default settings Select this option to use the default integration parameters. 
When this option is selected, all other options in this window 
are disabled.

Allowed peak start delay The allowed peak start delay is the amount of time (in min-
utes) that can elapse before the analysis is stopped because a 
peak is not detected. Enter a number between 0 and 20:00.

Total integration time The total integration time is the amount of time (in minutes) 
peak detection continues. Enter a number between 4:50 and 
20:00.

Parameter Description
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Control Sample Wizard (Page 7) History

The History window is used to enable the History Log. The History Log records all 
modifications to the control sample template properties. The History Log can be set to 
require users to enter comments for each modification.

Note: Once the History Log is enabled, it cannot be disabled. All modifications to the 
control sample template will be tracked. If the mandatory comment option is 
selected, the user will be required to enter a comment each time any parameter in 
the control sample template is modified.

Figure 4.157  Control Sample Wizard (Page 7) History

Setting Item Description

Enable history log Select this option to enable the software to monitor all modi-
fications to the control sample template. Once the History 
Log is enabled, it cannot be disabled. If the History Log is not 
required, it need not be enabled, as the software operates 
properly without it.

User has to comment all 
modifications

Select this option to require comments or approval for all 
modifications. 
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Control Sample Wizard (Page 8) Control Checking

The Control Checking window is used to select options for control checks and control 
limits. This window is not displayed if the USP/EP system suitability criteria are used 
because the control limits are already defined.

Figure 4.158  Control Sample Wizard (Page 8) Control Checking

Setting Option Description

Recovery Select this option to check recovery amounts in control sam-
ples.

Spiked Select this option to use an original and a spiked sample to 
calculate the recovery amount. This option is enabled only 
when the Recovery option is selected.

Original Concentration Enter the original concentration of the spiked sample. This 
field is enabled only when the Recovery option is selected.

Spiked Concentration Enter the concentration of the spiked sample. This field is 
enabled only when the Recovery and Spiked options are 
selected.

Mean Value (Concentration) Select this option to check the mean value of the measured 
concentrations.

Blind Value (Area) Select this option to check the mean value of the measured 
area values.

Spanwidth (Concentration) Select this option to check the deviation of the measured con-
centrations.

Max. Dev. Enter the maximum acceptable deviation. This field is 
enabled only when the Spanwidth option is selected.

Low Enter the lower limit of the valid control range, if the Blind 
Value option is selected.

Up Enter the upper limit of the valid control range, if the Blind 
Value option is selected.
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Control Sample Wizard (Page 9) Failure Action

The Failure Action window is used to specify the actions taken when a control sample 
exceeds the specified control limits.

Figure 4.159  Control Sample Wizard (Page 9) Failure Action

Save the control sample template and close the Control Sample Wizard by clicking the 
Finish button.

Setting Item Description

Action when the failure event 
occurs the first time

Select the action to be taken the first time a control sample 
exceeds the control limits. Options available from the drop-
down list are:
Continue (notify): Select this option to allow the analysis 
sequence to continue normally and display a failure message 
in the Notification Bar.
Stop (Whole Sample Run): Select this option to stop the sam-
ple run and display a failure message in the Notification Bar.
Repeat (From last control or calibration): Select this option 
to automatically reanalyze all samples analyzed after the pre-
vious valid control sample or calibration curve (whichever 
occurred most recently) and display a failure message in the 
Notification Bar.

Action when the failure event 
occurs the second time

Select the action to be taken the second time a control sample 
exceeds the control limits. The options available from the 
drop-down list are Continue and Stop. The Repeat option is 
not available.
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Inserting a Control Sample into the Sample Table

Once the control sample template has been created, a control sample can be entered into the 
Sample Table by following the procedure below.

Procedure

1. Open the Sample Table and place the cursor in the row where the control sample will 
be inserted.

2. From the Insert menu, select Control.
The Open dialog box displays the available control sample template files.

3. Select the appropriate control sample template and click the Open button.
The Open dialog box closes and the Sparging/Acid Addition window is displayed.

4. Enter the ASI vial position for the control sample into the appropriate cell in the 
Sparging/Acid Addition window. 

5. Click the OK button.
The Sparging/Acid Addition window closes.

6. Scroll through the Sample Table to verify that the control sample has been inserted at 
the correct location.
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4.4.6  Instrument Menu

The Instrument menu contains commands for connecting, starting, and stopping the 
instrument, and for instrument maintenance functions.

Figure 4.160  Instrument Menu

4.4.6.1  Background Monitor

The Background Monitor command is used to open the Background Monitor window, 
which displays the status of the autosampler and all installed instrument detectors. The real 
time signal and ready status for various detectors can be viewed by toggling between the 
individual instrument tabs. The command is available only when an instrument is 
connected to the software. Instrument and communication errors are displayed in the 
Notification Bar. The Background Monitor window cannot be open during measurement.

TOC Tab

Figure 4.161  Background Monitor Window: TOC Tab

The bottom portion of the TOC tab window displays a graph of the selected items.

Parameter Description

Furnace Displays the temperature of the TC furnace.

Dehumidifier Displays the temperature of the dehumidifier.

NDIR Baseline Pos.: Displays the status of the NDIR detector baseline position.
Baseline Fluc.: Displays the status of the NDIR detector baseline fluctuation.
Baseline Noise: Displays the status of the NDIR detector baseline noise.
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TN Tab

Figure 4.162  Background Monitor Window: TN Tab

The bottom portion of the TN tab window displays a graph of the selected items.

ASI Tab

The ASI tab is available only if the ASI is connected to the instrument. The ASI Power 
indicator displays the power status of the ASI. The ASI Cover indicator displays the status 
of the ASI cover.

Figure 4.163  Background Monitor Window: ASI Tab

Parameter Description

TN Reactor Displays the temperature of the TN reactor.

Chemiluminescence Baseline Pos.: Displays the status of the chemiluminescence detector baseline 
position.
Baseline Fluc.: Displays the status of the chemiluminescence detector baseline 
fluctuation.
Baseline Noise: Displays the status of the chemiluminescence detector baseline 
noise.
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4.4.6.2  Connect

The Connect command is used to connect or disconnect the instrument and the software. If 
the instrument is not connected, selecting the Connect command opens the communication 
port, initializes the instrument, and downloads and checks the instrument parameters. 
During this process, the Sequence window displays the progress of the connection. To abort 
the Connect operation while it is in progress, click the Cancel button.

Figure 4.164  Sequence Window

The bottom portion of the Sequence window displays a list of tasks that are performed 
during the Connect process. The progress of each task and the result after completing the 
task are shown in columns to the right of the task list. The Sequence window closes when 
the connection process is complete. If an error occurs during the Connect process, an error 
message is displayed in the Notification Bar and the result column, and the Sequence 
window remains open.

If the instrument is already connected to the software, the Connect command is used to 
disconnect the instrument. A confirmation request dialog box is displayed when the 
command is selected, as shown below.

Figure 4.165  Disconnect Confirmation Request Dialog Box

Click the OK button to disconnect the instrument, or the Cancel button to abort the 
operation. 
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4.4.6.3  Standby

The Standby function is used to shut down the instrument. To access the Standby function, 
open a Sample Table, then select Standby from the Instrument menu. The Standby window, 
which lists options for the shut down operation, is displayed. Select the desired options and 
click the Standby button. Click the Escape button to abort the Standby operation and 
maintain the instrument in Ready mode. 

Reference:  To end measurement, refer to Section 4.3.3 "Ending Measurement".

CAUTION
Do not turn off the TOC-V main instrument switch for at least 30 minutes after
initiating the shut down procedure. 

Figure 4.166  Standby Window

Setting Item Description

Shut down instrument Select this option to begin a 30-minute countdown to instru-
ment shutdown. During the shutdown process, the carrier gas 
is turned off and the furnace cools down. The power to the 
instrument is automatically turned off when the countdown is 
complete.

Auto restart Select this option to shut down the instrument but automati-
cally restart it at a specified time. Set the restart time using 
the spin controls for Auto start time. The default settings are 
the current system date and time.

Keep TC furnace heating Select this option to keep the TC furnace on during the 
Standby mode. This option is available only when the Auto 
restart option is selected.

Keep carrier gas flowing Select this option to keep the carrier gas flowing during the 
Standby mode. This option is available only when the Auto 
restart option is selected.
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4.4.6.4  Measurement Start

Click the Measurement Start command to open the Standby dialog box if the ASI is 
included in the system configuration. If the ASI is not included, the Measurement Mode 
dialog box is displayed. To start measurement, open the Sample Table, define a new 
sample, and connect to the instrument. 

Figure 4.167  Measurement Mode Dialog Box

Select OK to continue on to the measurement, or select Cancel to cancel the start of 
measurement.

4.4.6.5  Stop>Peak Stop

The Stop>Peak Stop command is used to interrupt the current measurement. The peak 
measured up to the stopping point is considered a complete peak. After the Stop>Peak Stop 
command is executed, the next injection listed in the Sample Table is made and analysis 
continues normally.

4.4.6.6  Stop>Finish Current Sample

The Stop>Finish Current Sample command is used to interrupt measurement after all 
injections of the current sample are complete. After the Stop>Finish Current command is 
executed, the instrument remains in Ready mode.

4.4.6.7  Stop>Halt

The Stop>Halt command is used to immediately interrupt the current measurement, discard 
data from the current injection, and return the instrument to Ready mode.

Item Setting Description

Normal Mode Select this option to conduct analysis sample-by-sample. 
Between samples, the instrument waits for the user command 
before starting the next measurement. 

Multiple Row Continuous 
Mode

Select this option to perform continuous, uninterrupted mea-
surement of multiple rows until the user stops the measure-
ment sequence.

Continuous Mode Select this to perform measurement using multiple measure-
ment modes, without stopping measurement between modes.
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4.4.7  Maintenance Menu 

Instrument maintenance procedures are described in Section 5.6 "Software-Controlled 
Maintenance Functions". All maintenance functions can be initiated using the options 
displayed in the Instrument>Maintenance menu.

4.4.8  Tools Menu

Figure 4.168  Tools Menu

4.4.8.1  Control Charts

The Control Charts function is used to create control charts. Refer to Appendix B for a 
detailed description of the function.

4.4.8.2  Method Validation

The Method Validation function is used to validate analytical methods. Refer to Appendix 
A for a detailed description of the function.

4.4.8.3  Administration

The Administration function is used to access the Administration program of the TOC-
Control V software. Refer to Section 3.1 "Introduction to System Administration 
Functions" for a detailed description of the Administration program.
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4.4.8.4  Screen Lock

If the user must temporarily leave the PC he/she is logged into, the screen can be locked by 
using the password function to prevent another individual from performing operations in 
TOC-Control V. This function can be used only if the User ID / Password item is checked 
in the Security dialog box.

To lock the screen, select Screen Lock in the Tools menu. The screen will then be locked 
and the Re-enter Password dialog box is displayed. To release the screen lock, enter the 
user ID and password into the designated fields. If the user ID and password entered are not 
the same as those used up to that point, the screen lock will not be released.

Figure 4.169   Re-enter Password Dialog Box
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4.4.9  Options Menu

The Options menu contains commands for viewing and displaying system information and 
for setting default measurement parameters.

Figure 4.170  Options Menu

4.4.9.1  General Information

The General Information command is used to view information about the system. The 
General Information window contains two tabs, one that displays System parameters and 
one that displays History information. Most of the fields in the General Information 
window are disabled because they were set previously. After changing an active field, click 
the OK button to close the window and save the changes or click the Apply button to save 
the changes without closing the window. Click the Cancel button to close the window 
without saving changes.

Figure 4.171  General Information Window: System Tab

System Tab

The System tab displays general parameters.

Parameter Description

System Displays the instrument identification.

File Version Displays the instrument file version.

User Displays the name of the user who set up the system. 

Date of Creation Displays the date the system was set up.

Comment Enter a comment (512 characters maximum), if desired.
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History Tab

Figure 4.172  General Information Window: History Tab

The History tab is used to view the system’s History Log or to enable the log if it was not 
previously selected.

Note: Once the History Log is enabled, it cannot be disabled.

Setting Item Description

Enable history log Select this option to enable the software to monitor all modi-
fications to the system. Once the History Log is enabled, it 
cannot be disabled. If the History Log is not required, it need 
not be enabled, as the software works properly without it.

User has to comment all 
modifications

Select this option to require comments or approval for all 
modifications. 
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4.4.9.2  Default Measurement Parameters

The Default Measurement Parameters command is used to enter the default values for 
samples, methods, and calibration curves. The Default Measurement Parameters window 
contains a separate tab for each analysis type, into which the default values are entered. The 
SSM-TC and SSM-IC tabs are items associated with the installation of SSM-5000A. For 
details, refer to the SM-5000A User's Manual

Figure 4.173  Default Measurement Parameters: TC Tab

Figure 4.174  Default Measurement Parameters: TN Tab

The parameters shown on each of the tabs are similar and are described below.

Parameter Description

Units Select the default concentration units.

No. of Injections Enter the default minimum/maximum number of injections.

No. of Washes Enter the default number of times the syringe is to be washed 
with sample prior to the first injection. Note that if the Auto 
Dilution option was selected, the sample will be diluted and 
the syringe will then be washed with the diluted sample.
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4.4.9.3  Display Settings>Display Font

The Display Settings>Display Font function is used to select font options for both the 
general screen display (such as in the Sample Table and Print Preview screens) and printed 
reports. Select a font type, style, size, and color from the lists in the Font dialog box. A 
preview of the font appearance is displayed in the Sample field.

Figure 4.175  Font Dialog Box

Max SD Enter the default maximum standard deviation that is accept-
able for the injections. If this value is met, no additional 
injections are required. However, if both this value and the 
Max CV value are exceeded, the samples are automatically 
reinjected up to the maximum number of times specified in 
the No. of Injections field. The SD Max field is disabled if 
the No. of Injections is 1 or if the minimum is equal to the 
maximum.

Max CV Enter the default maximum coefficient of variation that is 
acceptable for the injections. If this value is met, no addi-
tional injections are required. However, if both this value and 
the Max SD value are exceeded, the samples are automati-
cally reinjected up to the maximum number of times speci-
fied in the No. of Injections field. The CV Max field is 
disabled if the No. of Injections is 1 or if the minimum is 
equal to the maximum.

Parameter Description
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4.4.9.4  Display Settings>Table Settings

The Display Settings>Table Settings function is used to select the parameters that will be 
displayed in the Sample Table window. The Table Options window contains two tabs, one 
that lists Sample Table parameters and one that lists Injection Table parameters. Note that 
on each tab, certain options are selected by default. Individual options can be selected or 
deselected by clicking in the check box. Use the All and None buttons to quickly select and 
deselect all options on a tab. Use the Default button to select the default options.

Sample Table Tab

Select the parameters that will be displayed in the Sample Table.

Figure 4.176  Table Options Window: Sample Table Tab

Samples Tab

Select the parameters that will be displayed in the Injection Table.

Figure 4.177  Table Options Window: Samples Tab
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4.4.9.5  Display Settings>Notification Bar Settings

The Display Settings>Notification Bar Settings function is used to set options for the 
Notification Bar, where error messages and other notices are displayed. The Notification 
Bar is located at the bottom of the Sample Table Editor window. 

Four folders can be displayed in the Notification Bar: Notifications, System Folders, 
Errors, and Events. When a folder is selected for display, a tab appears for that folder in the 
Notification Bar. When more than one folder is selected for display, the contents of a 
specific folder can be displayed by clicking the appropriate tab.

Figure 4.178  Notification Bar Settings Window

To select a folder for display in the Notification Bar, click the folder in the Folder List, then 
select the Display Folder option. Set the Max. Number of Displayed Lines field to a value 
greater than 0. To change the color or appearance of the text displayed in the folder, use the 
Font option. Note that the Display Folder check box, Max. Number of Displayed Lines 
field, and Font option apply only to the selected folder; as a result, these options must be set 
separately for each folder. 

Note: A folder will not be displayed in the Notification Bar unless the Display Folder 
option is selected and the Max. Number of Displayed Lines field is set to a value 
greater than 0.

Setting Item Description

Folder List Lists the folders that can be displayed in the Notification Bar.

Display Folder Place a check in this box to display the folder. 

Max. Number of Displayed 
Lines

Enter the maximum number of lines to be displayed in the 
Notification Bar. Acceptable values range from 0 to 200.

Font Displays the selected font. Modify the font by selecting the 
Browse button to open the Font dialog box.
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4.4.9.6  Display Settings>Floating Point Number Formats

The Display Settings>Floating Point Number Formats command is used to select display 
options for numeric results in the Sample Table. Note that these options apply only to the 
manner in which numbers are displayed; internal data retain their original values.

Figure 4.179  Floating Point Format Window

Select settings for both common numbers and percent values, as described below.

Common Floating Point Numbers

Percent Values

Setting Item Description

Number of significant digits Select this option to display common floating point numbers 
using a specified number of significant digits. Use the spin 
control to set the number of significant digits. The default 
value is 4.

Number of digits after the 
decimal point

Select this option to display common floating point numbers 
using a specified number of digits after the decimal point. 
Use the spin control to set the number of digits after the deci-
mal point. The default value is 2.

Setting Item Description

Number of significant digits Select this option to display percent values using a specified 
number of significant digits. Use the spin control to set the 
number of significant digits. The default value is 4.

Number of digits after the 
decimal point

Select this option to display percent values using a specified 
number of digits after the decimal point. Use the spin control 
to set the number of digits after the decimal point. The default 
value is 2.
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4.4.9.7  Directories

The Directories function is used to modify system directories. Select Options>Directories 
to display the Folder window.

Figure 4.180  Folder Window

Show all directories for

Use the drop-down list to access various directories. Available directories are listed in the 
Folder text field.

Add

Click the Add button to add a new directory to the list for a specified topic, and the Folder 
dialog box is displayed. Highlight the desired directory from the drop-down Drive and 
Directory lists, then select it by clicking the OK button. Click the Network button to access 
at network drive.

Figure 4.181  Folder Dialog Box

Delete

Click the Delete button to delete a selected directory from the list.

Up

Click the Up button to move the selected directory up one line in the list. The order of the 
directories in the list is the order in which the directories will be searched during instrument 
operation.

Down

Click the Down button to move the selected directory down one line in the list. The order of 
the directories in the list is the order in which the directories will be searched during 
instrument operation.
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4.4.10  Window Menu

Figure 4.182  Window Menu

4.4.10.1  Cascade

The Cascade command is used to stack all open windows so that the title bars are visible.

4.4.10.2  Tile

The Tile command is used to size all open windows so that each window occupies an equal 
portion of the screen.

4.4.10.3  Arrange Icons

The Arrange Icons command is used to neatly organize windows that have been minimized 
or reduced to icons.

4.4.11  Help Menu

Figure 4.183  Help Menu

About

The About command is used to view copyright, software registration, and software version 
information.
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4.5  Application Operations

4.5.1  Manual Injection Analysis

Samples can be injected manually to perform analysis without the sample injector syringe, 
when the optional manual injection kit is installed.

4.5.1.1  Analysis Preparation

Installing the Manual Injection Kit

1. Remove the knurled thumbscrew that secures the slider then remove the TC/TN 
injector slider.

Figure 4.184  Removing the Slider

2. Install the TC/TN block provided in the kit.

Figure 4.185  Installing the TC/TN Block

Knurled Thumbscrew

TC/TN Block
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3. If the IC reactor kit is being used, remove the IC injector slider, and install the IC 
block provided in the manual injection kit. 

Figure 4.186  Installing the IC Block

Note: When installing the block, be sure that it is aligned with the
injection port.

Software Settings

Select the Manual Injection Kit option in the Instrument Setup Wizard Options window 
during System Setup. Refer to Section 3.2.2 "Options Window".

Note: Selecting the Manual Injection Kit option disables operation of the TOC-V injec-
tor syringe.

IC Block
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4.5.1.2  Measurement

Measurement procedures using the manual injection kit are similar to those described in 
Section 4.3 "Measurement Procedures and Tutorial".

Calibration Curve Measurement

Procedure

1. From the File menu, select New. The New dialog box is displayed.

Figure 4.187  New Dialog Box

2. Double-click the Calibration Curve icon. The Calibration Curve Wizard opens. The 
System Information window of the wizard is displayed.

Figure 4.188  Calibration Curve Wizard (Page 1) System Information

3. From the System drop-down list, select the system that was configured with the 
Manual Injection Kit during setup.

4. Select the desired options on pages 2 and 3 of the Calibration Curve Wizard, which 
list calibration curve type and analysis information settings, respectively. Enter the 
name of the new calibration curve in the text box at the bottom of page 3 of the 
wizard.
Note: Select the settings described in Section 4.2 "Setting General Mea-

surement Parameters".
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5. Enter the desired number of injections on page 4 of the Calibration Curve Wizard 
(Calibration Measurement Parameters).

6. Enter the injection volume on page 5 of the Calibration Curve Wizard (Calibration 
Points List).
Note: An injection volume is displayed automatically. The displayed

value is based on the volume of the last injection that was per-
formed using the sample injector. This value can be changed by the
user as appropriate. 

7. Select the desired options on pages 6 and 7 of the Calibration Curve Wizard, which 
list peak time parameter and history settings, respectively. Click the Finish button to 
create the new calibration curve.
Note: Select the settings described in Section 4.2 "Setting General Mea-

surement Parameters".

8. Create a Sample Table for the calibration curve. From the Insert menu, select 
Calibration Curve. Select the newly created calibration curve from the list of files in 
the Open dialog box.

9. Connect the instrument by selecting Connect from the Instrument menu. Then select 
Start from the Instrument menu. The Manual Injection Parameter dialog box is 
displayed.

10. Draw an appropriate amount of sample into the syringe.
Note: Draw in and discharge the sample 3 or 4 times before filling the

syringe for measurement.

11. Enter the injection volume in the Manual Injection Parameter dialog box, and click 
the Set button.

12. Verify that the instrument is ready for measurement, and click the Start button.

13. For TC or TN measurement, open the injection port valve and insert the syringe 
needle into the injection port. For IC measurement, insert the syringe needle into the 
injection port septum.
Note: • Insert the syringe needle as far as possible into the injection port.

• To obtain reproducible results, perform all injections at the same 
speed.

14. Withdraw the syringe from the injection port. For TC or TN measurement, close the 
injection port valve.
The results are displayed when measurement is complete.

15. Click Additional Measurements to perform repeat measurements. Repeat the 
procedure. Click the Finish button when all measurements are complete.
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Sample Measurement

Procedure

1. From the File menu, select New. The New dialog box is displayed.

Figure 4.189  New Dialog Box

2. Double-click the Method icon. The Method Wizard opens. The System Information 
window of the wizard (page 1) is displayed.

Figure 4.190  Method Wizard (Page 1) System Information

3. Select the system that was configured with the Manual Injection Kit and used to 
create the calibration curve. Advance to page 2 of the Method Wizard (Analysis 
Information) and enter the new method name in the text box at the bottom of the 
window.

4. Advance to page 3 of the Method Wizard (Calibration Curves). Select the appropriate 
calibration curve file.

5. Enter “1” in the No. of Injections field on page 4 of the Method Wizard (Injection 
Parameters).
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6. Select the desired options on pages 5, 6, and 7 of the Method Wizard, which list peak 
time parameter, USP/EP check, and history settings, respectively. Click the Finish 
button to create the new method.
Note: Select the settings described in Section 4.2 "Setting General Mea-

surement Parameters".

7. From the Insert menu, select Sample to open the Sample Wizard. Select the newly 
created method from the list of files in the Open dialog box. Complete the remaining 
wizard pages.

8. From the Instrument menu, select Start. The Manual Injection Parameter dialog box is 
displayed.

9. Draw an appropriate amount of sample into the syringe.

10. Draw in and discharge the sample 3 or 4 times before filling the syringe for 
measurement.

11. Enter the injection volume in the Manual Injection Parameter dialog box, and click 
the Set button.

12. Verify that the instrument is ready for measurement, and click the Start button.

13. For TC or TN measurement, open the injection port valve and insert the syringe 
needle into the injection port. For IC measurement, insert the syringe needle into the 
injection port septum.
Note: • Insert the syringe needle as far as possible into the injection port.

• To obtain reproducible results, perform all injections at the same 
speed.

14. Remove the syringe from the injection port. For TC or TN measurement, close the 
injection port valve.

15. Click Additional Measurements to perform repeat measurements. Repeat the 
procedure. Click the Finish button when all measurements are complete.
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4.5.1.3  Measurement Precautions for Low Concentration Samples

In manual injections of sample concentrations lower than 1µg/mL, it is necessary to take 
the following precautions to prevent contamination of the sample and the measurement 
process.

Injecting Sample into the Injection Port

Use a separate micro syringe (500µL) for high sensitivity measurement. Any 
contamination on the sample injection port may affect the result for high sensitivity 
measurement.The inside of the injection port can be contaminated by sample solution that 
adheres to the tip of the micro syringe needle. When inserting the micro syringe into the 
injection port, use extreme care to avoid touching the tapered portion of the inside of the 
sample injection port. After filling the syringe, wipe the excess solution from the needle 
surface with soft tissue paper. Prevent excess drops of solution from forming on the tip of 
the needle by gently pulling back on the plunger.

Cleaning the Sample Injection Port

Under normal operating conditions, fill a 500µL micro syringe with pure water and insert it 
into the injection port. Keep the bottom of the syringe barrel 8-10mm above the injection 
port. Under normal operation, the bottom of the syringe barrel is inserted until it comes into 
contact with the injection port allowing the needle tip to protrude from the needle guide 
pipe by about 5-6mm. With the needle 8-10mm higher than normal operation, the tip of the 
needle inside the needle guide pipe. Slowly dispense the pure water. The pure water does 
not flow into the combustion tube. It is driven out of the injection port by the carrier gas 
flowing through the needle guide pipe. Wipe off the water coming out of the injection tube 
with soft tissue paper. The internal injection port and inside of the needle guide pipe are 
now clean.

Measurement of service water or contamination free environmental water, such as river 
water, often reveals that IC is the major part of TC when the TOC content is around 1ppm. 
For these types of samples it is preferable to remove the IC content before measuring TOC 
through the TC channel.

Errors for TC and IC analyses are additive. For samples that have a comparatively high IC 
content relative to the TOC content, the TOC analysis error will be large if it is determined 
by the difference between TC and IC results. 
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4.5.1.4  Maintenance

Replacing the IC Injection Port Septum (Cushion O-Ring)

The septum used with the IC injection port is a consumable item. The septum typically can 
be used for 200 or more injections; however, it should be replaced if there is deterioration 
in reproducibility or peak shapes.

Part number for replacement cushion O-ring (20 pcs.): P/N 630-01559-01

Replacement Procedure

1. Loosen and remove the injection port bushing.

2. Remove the old septum, and insert a new one.

3. Replace the bushing and tighten it.

CAUTION
IC reaction solution may spatter close to the injection port septum and injection
port; however, this poses no problem during analysis. When replacing the
septum, wipe away any liquid, taking care to avoid contact.

Gas-tight Syringe

For analysis, use a needle length of 50mm, or a 2 inch gas-tight syringe. The following gas-
tight syringes are available from Shimadzu. Order replacement syringes as necessary.

* Set comprises one replacement gas-tight syringe needle and one plunger.

Table 4.7 •  Gas-Tight Syringes (Option)

Part Name P/N Capacity

Gas-tight syringe set 25uL     638-60733-02 25uL

Gas-tight syringe set 50uL -03 50uL*

Gas-tight syringe set 100uL -04 100uL*

Gas-tight syringe set 250uL -05 250uL*

Gas-tight syringe set 500uL -06 500uL*

Gas-tight syringe 1mL     046-00026-02 1mL

Gas-tight syringe set 5mL -03 5mL

Gas-tight syringe set 10mL -04 10mL
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4.5.2  Gas Sample Analysis

If the optional manual injection kit is installed, analysis of TC and IC in gaseous samples 
can be performed by using gas-tight syringes or other applicable injectors to inject the 
gaseous samples. 

Precautions for Gas Sample Analysis

CAUTION
• Do not inject a large quantity of sample at one time when measuring combustible

or explosive gases. The combustion tube could break. The injection volume
should not exceed 10mL.

• Use caution when measuring combustible or explosive gases.
• Do not analyze samples that can release toxic substances during combustion. The

exhaust gas released during analysis passes through the CO2 detector to the CO2
absorber, after which it is used as NDIR purge gas, and then is vented inside the
instrument. Take appropriate countermeasures if there is a possibility that toxic
substances could be included in the exhaust gas. If appropriate countermeasures
cannot be taken, do not perform such analyses.

 

• The sample analysis results are displayed according to the gas concentration used in cal-
ibration. For example, if CO2 is used to generate the calibration curve, the sample anal-
ysis result is displayed based on a conversion using the CO2 gas concentration.

• Gaseous samples have certain properties such as adsorption, condensation and reactiv-
ity, and some gaseous samples are partially liquid or contain a solid component. 
Depending on the properties, certain conditions may occur that cannot be ignored. Some 
of these conditions are residual substances and contamination in the flow line, which 
may result in peak tailing, carryover, baseline fluctuation, or other analytical problems.

• High concentrations of NOx or SOx in the sample or in the post combustion-oxidized 
sample can interfere with the NDIR activity. To evaluate the degree of the interference, 
combine the analysis of the base gas without the TOC component together with the 
sample analysis. 
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4.5.2.1  Analysis Preparation

Installation of the Manual Injection Kit

Installation Procedure

1. Remove the knurled thumbscrew that secures the slider then remove the TC/TN 
injector slider, and install the TC/TN block provided in the kit. 

2. If the IC reactor kit is being used, remove the IC injector slider, and install the IC 
block provided in the manual injection kit.
Note: When installing the block, be sure that it is aligned with the

injection port.

Software Settings

Select the Manual Injection Kit option in the Instrument Setup Wizard Options window 
during System Setup. Refer to Section 3.2.2 "Options Window".

Note: Selecting the Manual Injection Kit option disables operation of the
TOC-V injector syringe.

Reference: Refer to  4.5.1.1 "Analysis Preparation".
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4.5.2.2  Measurement

The procedure for setting the various parameters is the same as described in Section 4.2 
"Setting General Measurement Parameters", Section 4.3 "Measurement Procedures and 
Tutorial" and Section 4.4.2.2 "Calibration Curve".

Calibration Curve Measurement

Procedure

1. Prepare standard gas containing a known concentration of carbon.
Note: For IC (carbon dioxide) analysis, prepare a standard gas with a

known carbon dioxide concentration. For TC analysis, another
organic gas (for example, methane) of known concentration can be
used. 

2. From the File menu, select New. The New dialog box is displayed.

Figure 4.191  New Dialog Box

3. Double-click the Calibration Curve icon. The Calibration Curve Wizard opens. The 
System Information window of the wizard (page 1) is displayed.

Figure 4.192  Calibration Curve Wizard (Page 1) System Information

4. From the System drop-down list, select the system that was configured with the 
Manual Injection Kit during setup.
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5. Select the desired options on pages 2 and 3 of the Calibration Curve Wizard, which 
list calibration curve type and analysis information settings, respectively. Enter the 
name of the new calibration curve in the text box at the bottom of page 3 of the 
wizard.
Note: Select the settings described in Section 4.2 "Setting General Mea-

surement Parameters".

6. Enter the desired number of injections on page 4 of the Calibration Curve Wizard 
(Calibration Measurement Parameters).

7. Enter the injection volume on page 5 of the Calibration Curve Wizard (Calibration 
Points List).
Note: An injection volume is displayed automatically. The displayed

value is based on the volume of the last injection that was per-
formed using the sample injector. This value can be changed by the
user as appropriate. 

8. Select the desired options on pages 6 and 7 of the Calibration Curve Wizard, which 
list peak time parameter and history settings, respectively. Click the Finish button to 
create the new calibration curve.
Note: Select the settings described in Section 4.2 "Setting General Mea-

surement Parameters".

9. Create a Sample Table for the calibration curve. From the Insert menu, select 
Calibration Curve. Select the newly created calibration curve from the list of files in 
the Open dialog box.

10. Connect the instrument by selecting Connect from the Instrument menu. Then select 
Start from the Instrument menu. The Manual Injection Parameter dialog box is 
displayed.

11. Draw an appropriate amount of sample into the syringe.
Note: Draw in and discharge the sample 3 or 4 times before filling the

syringe for measurement.

12. Enter the injection volume in the Manual Injection Parameter dialog box, and click 
the Set button.

13. Verify that the instrument is ready for measurement, and click the Start button.

14. For TC or TN measurement, open the injection port valve and insert the syringe 
needle into the injection port. For IC measurement, insert the syringe needle into the 
injection port septum.
Note: • Insert the syringe needle as far as possible into the injection port.

• To obtain reproducible results, perform all injections at the same 
speed.

15. Withdraw the syringe from the injection port. For TC or TN measurement, close the 
injection port valve.
The results are displayed when measurement is complete.

16. Click Additional Measurements to perform repeat measurements. Repeat the 
procedure. Click the Finish button when all measurements are complete.
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Sample Measurement

Procedure

1. From the File menu, select New. The New dialog box is displayed.

Figure 4.193  New Dialog Box

2. Double-click the Method icon. The Method Wizard opens. The System Information 
window of the wizard (page 1) is displayed.

Figure 4.194  Method Wizard (Page 1) System Information

3. Select the system that was configured with the Manual Injection Kit and used to 
create the calibration curve. Advance to page 2 of the Method Wizard (Analysis 
Information) and enter the new method name in the text box at the bottom of the 
window.

4. Advance to page 3 of the Method Wizard (Calibration Curves). Select the appropriate 
calibration curve file.

5. Enter “1” in the No. of Injections field on page 4 of the Method Wizard (Injection 
Parameters).
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6. Select the desired options on pages 5, 6, and 7 of the Method Wizard, which list peak 
time parameter, USP/EP check, and history settings, respectively. Click the Finish 
button to create the new method.
Note: Select the settings described in Section 4.2 "Setting General Mea-

surement Parameters".

7. From the Insert menu, select Sample. Select the newly created method from the list of 
files in the Open dialog box. Complete the remaining pages of the Sample Wizard.

8. From the Instrument menu, select Start. The Manual Injection Parameter dialog box is 
displayed.

9. Draw an appropriate amount of sample into the syringe.
Note: Draw in and discharge the sample 3 or 4 times before filling the

syringe for measurement.

10. Enter the injection volume in the Manual Injection Parameter dialog box, and click 
the Set button.

11. Verify that the instrument is ready for measurement, and click the Start button.

12. For TC or TN measurement, open the injection port valve and insert the syringe 
needle into the injection port. For IC measurement, insert the syringe needle into the 
injection port septum.
Note: • Insert the syringe needle as far as possible into the injection port.

• To obtain reproducible results, perform all injections at the same 
speed.

13. Withdraw the syringe from the injection port. For TC or TN measurement, close the 
injection port valve.

14. Click Additional Measurements to perform repeat measurements. Repeat the 
procedure. Click the Finish button when all measurements are complete.

Maintenance

Replacing the IC Injection Port Septum (Cushion O-Ring)

The septum used with the IC injection port is a consumable item. The septum typically can 
be used for 200 or more injections; however, it should be replaced if there is deterioration 
in reproducibility or peak shapes.

Part number for replacement cushion O-ring (20 pcs.): P/N 630-01559-01

Replacement Procedure

1. Loosen and remove the injection port bushing.

2. Remove the old septum, and insert a new one.

3. Replace the bushing and tighten it.
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CAUTION
IC reaction solution may spatter close to the injection port septum and injection
port; however, this poses no problem during analysis. When replacing the
septum, wipe away any liquid, taking care to avoid contact.

Gas-tight Syringe

For analysis, use a needle length of 50mm., or a 2-inch gas-tight syringe. The following 
gas-tight syringes are available from Shimadzu. Order replacement syringes as necessary.

* Set comprises one replacement gas-tight syringe needle and one plunger.

*The values indicated in this table are reference values only. Data will vary slightly among
instruments.

Table 4.8 • Gas-Tight Syringes (Option)

Part Name P/N Capacity

Gas-tight syringe set 25uL 638-60733-02 25uL*

Gas-tight syringe set 50uL -03 50uL*

Gas-tight syringe set 100uL -04 100uL*

Gas-tight syringe set 250uL -05 250uL*

Gas-tight syringe set 500uL -06 500uL*

Gas-tight syringe 1mL 046-00026-02 1mL

Gas-tight syringe set 5mL -03 5mL

Gas-tight syringe set 10mL -04 10mL

Table 4.9 • Relationship Between Appropriate Peak Height and (CO2) Gas 
Concentration / Injection Volume *

Gas Concentration (CO2) Gas Injection Volume

TC 100ppm 10mL

1000ppm 1mL

1% 500uL

10% 300uL

100% 30uL

IC 100ppm 6uL

1000ppm 600uL

1% 300uL

10% 200uL

100% 20uL
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5Maintenance
Inspection and maintenance of the TOC-V instrument are required to ensure normal 
operation and reliable and accurate data acquisition. 

5.1 Daily Inspection
Describes the daily inspection procedures that should be performed before 
instrument startup.

5.2 Periodic Inspections
Describes periodic inspection procedures for the TOC-V.

5.3 Autosampler (ASI-V) Maintenance
Describes periodic inspection procedures for the autosampler.

5.4 8-Port Sampler (OCT-1) Maintenance
Describes periodic inspection procedures for the 8-Port Sampler.

5.5 TN Unit (TNM-1) Maintenance
Describes periodic inspection procedures for the TN unit.

5.6 Software-Controlled Maintenance Functions
Describes maintenance functions controlled by the TOC-Control V software.

5.7 Troubleshooting
Describes the error messages and troubleshooting procedures.

5
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5.1  Daily Inspection 

Check the levels of dilution water, acid, drain vessel water, and humidifier water each day 
before starting the instrument. 

5.1.1  Checking Dilution Water 

Verify that the dilution water volume is sufficient for analysis. If necessary, replenish the 
dilution water as described in Section 4.1.6 "Preparation of Dilution Water".

5.1.2  Checking Acid 

Verify that the acid volume is adequate for analysis. If necessary, replenish the acid as 
described in Section 4.1.7 "Acid Preparation". Any container such as a small-mouth glass 1 
liter bottle can be used.

5.1.3  Checking Drain Vessel Water Level 

Figure 5.1  Drain Vessel Water Level

Verify that the water level in the drain vessel inside the instrument is within 10mm of the 
overflow tube on the side of the drain vessel. Replenish as necessary with purified water 
(ion-exchange water).

Reference: Refer toSection 4.1.4 "Water Supply to the Cooler Drain Container", for details on adding 
purified water,. 

Confirm that the carrier gas does not leak from the tip of the drain tubing when the flow 
rate is 150mL/min.

Drain
Vessel

Overflow Tube

Pure Water
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5.1.4  Checking Humidifier Water Level 

Figure 5.2  Humidifier Water Level

Verify that the water level in the humidifier is above the “Lo” mark. If the level is below the 
“Lo” mark, replenish by adding purified water through the water supply port on top of the 
vessel. Add water until the level reaches the “Hi” mark.

Supply Port

“Lo” Mark

Pure Water
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5.2  Periodic Inspections

Periodically inspect the items listed in this section to maintain instrument performance 
quality.

5.2.1  Catalyst Regeneration 

Inorganic substances contained in the samples accumulate in the catalyst as salts and 
oxides. Buildup of these residues decreases the sensitivity and reproducibility of analyses. 
(Catalyst performance can be checked by measuring a standard solution.) This type of 
catalyst contamination occurs when measuring alkaline samples and samples that contain 
high concentrations of IC compounds. When catalyst contamination occurs, performance 
can be restored by regenerating the catalyst. Catalyst regeneration is also an effective 
means of reducing the system blank peaks that are present when using new catalyst or 
catalyst that has not been used for a long time. The catalyst regeneration procedure has little 
effect on TN analysis. 

Catalyst is regenerated by injecting dilute hydrochloric acid onto the catalyst. The acid used 
in the procedure is 2M hydrochloric acid obtained from the instrument reservoir (acid used 
during IC and NPOC analysis). The catalyst regeneration process is the same for both TOC 
standard catalyst and TOC high sensitivity catalyst. If performance is not restored after the 
regeneration process has been conducted, replace the catalyst. Refer to Section 5.2.2 
"Washing or Replacing Catalyst". 

Regeneration Procedure 

The procedure for regenerating the TC catalyst is controlled by the TOC-Control V 
software, as described below.

1. From the Instrument menu in the Sample Table Editor, select 
Maintenance>Regeneration of the TC Catalyst.

The Regeneration of TC-Catalyst dialog box is displayed.

Figure 5.3   Regeneration of TC-Catalyst Dialog Box

2. Click the Start button to begin the procedure. A progress bar is active until the TC 
catalyst has been regenerated.

3. Click the Close button.
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CAUTION
Dilute hydrochloric acid is the only type of acid that can be used to regenerate
TC catalyst. Other acids, particularly phosphoric acid, cause abnormally high
peaks and scattered peak values to occur. If this happens, the catalyst must be
replaced.

5.2.2  Washing or Replacing Catalyst

Large quantities of salts accumulate in the catalyst when measuring samples with high salt 
concentrations. If sensitivity and reproducibility do not improve after catalyst regeneration, 
wash or replace the catalyst. Refer to Section 5.2.1 "Catalyst Regeneration".

5.2.2.1  Washing Catalyst

Standard catalyst can be washed and reused several times using the following procedure. 
High sensitivity catalyst cannot be washed and reused.

WARNING
Due to the danger of burn injury, allow the oven temperature to cool to room
temperature before starting any maintenance procedure involving the
combustion tube or catalyst. 

Procedure

1. Thoroughly wash the catalyst with tap water to remove any accumulated salts. 

2. Neutralize the alkalis with dilute hydrochloric acid (5:1). 

3. Thoroughly wash the catalyst with tap water to remove the hydrochloric acid.

4. Rinse with pure water (ion exchange water acceptable) and then dry.

CAUTION
• Dry the catalyst at a temperature lower than 700°C to avoid the degradation of

catalyst activity that occurs at higher temperatures. 
• A large quantity of steam is produced when the regenerated catalyst is placed in

the oven and heated.  Due to the danger of burn injury, leave the outlet of the
combustion tube open until no more steam is released. 
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5.2.2.2  Replacing Catalyst

If performance is not restored after washing the catalyst, it must be replaced. Replace the 
catalyst with new platinum catalyst (alumina spherical support). Keep extra platinum 
catalyst on hand for such a contingency. One bottle of platinum catalyst is enough for one 
replacement. 

Use the following procedure to replace the platinum catalyst. 

Procedure

1. Wash the platinum mesh and the inside of the combustion tube with (1:2) 
hydrochloric acid (1 part concentrated HCl and 2 parts water). 

2. Rinse with water.

3. Dry, and reuse these items. 

4. Fill the combustion tube as described in Section 4.1.1 "Catalyst Filling". 

TOC High Sensitivity Catalyst

TOC high sensitivity catalyst cannot be washed and reused like standard catalyst. If 
analysis sensitivity and reproducibility are not restored after catalyst regeneration, replace 
the deteriorated high sensitivity catalyst with new high sensitivity catalyst. The platinum 
mesh and combustion tube can be washed with hydrochloric acid and reused.

Disposal of Catalyst

Used catalyst should be disposed of according to local industrial waste disposal regulations. 
It must be clearly disclosed using an industrial waste manifest that the used catalyst 
contains platinum.

5.2.2.3  Replacing the Carrier Gas Purification Tube and Catalyst

The carrier gas purification tube burns the carrier gas and oxidizes carbon-based impurities, 
converting them to carbon dioxide. The carbon dioxide is absorbed and eliminated by the 
CO2 absorber. The carrier gas purification tube is filled with oxidation catalyst (same as 
TOC standard catalyst).

The procedure for replacing the purification tube and catalyst is as follows.

Removal of Carrier Gas Purification Tube

WARNING
Before attempting to remove the carrier gas purification tube, be sure to allow
the oven temperature to cool to room temperature.  There is a danger of burn
injury if this procedure is performed while the oven is hot.



5.2    Periodic Inspections
5.2.2    Washing or Replacing Catalyst

241TOC-VCPH/CPN

Removal Procedure

1. Remove the compression fitting joints at the top and bottom of the carrier gas 
purification tube.

2. Detach the TC/TN sample injection block from the combustion tube. Refer toSection 
4.1.2 "Connecting the Combustion Tube".

3. Extract the carrier gas purification tube from the electric oven by pulling upward.

Replacing Catalyst

CAUTION
The top nut of the compression fitting joint is hand-tightened. Do not use tools to
tighten or loosen this nut. Because the tube is constructed of quartz glass,
over-tightening or aggressive handling may result in damage.

Procedure

1. Remove the catalyst from the carrier gas purification tube through the opening at the 
top.

2. Remove the quartz wool using a thin tube or other instrument.

3. Insert a small amount of new TOC standard catalyst into the combustion tube from 
the bottom (straight end).

4. Pack a small amount of quartz wool into the tube from the bottom. 

Note: The quartz wool is inserted to prevent the catalyst from falling out
of the bottom.  Packing too much quartz wool into the tube will
greatly impede airflow, so do not use too much quartz wool.  To
prevent contamination of the catalyst or the inclusion of foreign
particles, use the same precautions used when filling the
combustion tube with TOC platinum catalyst. 

5. Insert the straight end of the carrier gas purification tube down into the front 8mm 
diameter hole in the oven.

6. Using the compression fitting joints, restore the tubing connections to their original 
condition. 
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5.2.3  Washing/Replacing the Combustion and Carrier Gas Purification Tubes 

The inner surface of the combustion tube devitrifies (becomes crystalline in texture and 
turns white) when it reacts with salts contained in the samples. The tube can continue to be 
used in this condition until it breaks or cracks. 

During the catalyst washing or replacing process, wash the interior of the combustion tube 
and carrier gas purification tube with (1:2) hydrochloric acid (1 part concentrated HCl and 
2 parts water) to remove the contaminants and accumulated salts. Rinse with water, dry, 
and then reuse the tube(s). 

5.2.4  Replacing the High-Purity Air Cylinder 

A 47-liter cylinder of high-purity air used as the carrier gas will last for approximately three 
months using the H Type instrument, and two months using the N Type. 

• Replace the cylinder when the residual pressure diminishes to a few hundredkPa.  Do 
not wait until it is completely empty. 

• When connecting a new cylinder, clean the connections thoroughly. After connecting 
the cylinder, do not allow dust or other matter to enter the instrument.

• Keep a spare cylinder available at all times. 

5.2.5  Replacing the CO2 Absorber

Once a year, replace each of the CO2 absorbers (P/N 630-00999), which are located in the 
holder behind the instrument. 

CO2 Absorber Disposal Procedure

Used CO2 absorbers should be disposed of according to local industrial waste disposal 
regulations. It must be clearly disclosed using an industrial waste manifest that the used 
CO2 absorber contains soda lime.

Reference: For details on replacing the CO2 absorbers, refer to Section 4.1.8 "Installation of the CO2 
Absorber". 
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5.2.6  Replacing the Halogen Scrubber

The absorbent inside the halogen scrubber turns black as it absorbs chlorine. The 
discoloration band advances toward the outlet as the amount of chlorine absorbed 
increases. Replace the scrubber with a new halogen scrubber when the front of the 
discoloration band reaches the position shown in Figure 5.4 "Halogen Scrubber". 

Replacement Procedure 

1. Unclip the upper and lower clips that secure the halogen scrubber.

2. Remove the upper and lower connection clamps.

3. Disconnect the Viton connectors and remove the halogen scrubber. 

Figure 5.4  Halogen Scrubber

The baseline may fluctuate immediately after replacement. Allow the instrument to run for 
a short time until the baseline stabilizes. Stabilization normally occurs within one hour. 

Used halogen scrubbers should be disposed of according to local industrial waste disposal 
regulations. It must be clearly disclosed using an industrial waste manifest that the halogen 
scrubber contains copper.

Figure 5.5  Halogen Scrubber Replacement

Dehumidifier

Gas Flow Direction

To Sample

Halogen Reactant-filled Cylinder
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5.2.7  Replacing the Syringe Plunger Tip

The syringe plunger tip is constructed of fluororesin and wears with use. Gaps will 
eventually form between the plunger and the inner wall of the syringe barrel (glass tube), 
causing leaks. When leaks occurs, bubbles are produced near the syringe tip when sample 
is drawn into the syringe or sample may leak from the bottom of the barrel when the sample 
is discharged. When these problems are observed, replace the plunger tip.

Replacement Procedure

1. Remove the syringe referring to Section 4.1.3 "Installing the Syringe". 

2. Use a sharp knife to make two or three incisions at the bottom of the plunger tip, as 
shown in Figure 5.6 "Removing the Old Plunger Tip". 

3. Grasp the plunger tip with a pair of pliers and remove it from the plunger. The O-ring 
that is held in place by the plunger tip also comes off. DO NOT reuse this O-ring. 

Figure 5.6  Removing the Old Plunger Tip

4. Pushing down on the plunger, press the leading edge of the new plunger tip straight 
into the plunger tip seat, as shown in Figure 5.7 "Installing the New Plunger Tip 
(cross-section)". Save the syringe for future use since the plunger tip seat is enclosed 
inside the syringe. 

Figure 5.7  Installing the New Plunger Tip (cross-section)

Note: • Do not scratch the perimeter of the plunger tip. This could cause leaks. 
• Use only Shimadzu-specified plunger tips. Use of unspecified parts may

result in malfunction and/or diminished performance. 

 
Plunger Tip

Plunger Tip SeatPlunger Tip Seat
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5.2.8  Replacing Ferrules at the Combustion Tube Outlet Connection 

For High Sensitivity Analysis Kit

The front and rear Teflon ferrules used in the compression fitting connections at the 
combustion tube outlet gradually become deformed and scratched with repeated use, and 
may cause gas leakage. When this occurs, replace them with new ferrules. Keep a 6F-T 
Sleeve set on hand as replacement parts. 

Reference: For details on the replacement procedure, refer to Section 4.1.2 "Connecting the 
Combustion Tube". 

5.2.9  Replacing the Sliding Sample Injector O-rings 

Two types of O-rings are stacked between the injection block and the slider of the sample 
injector. If a gas leak develops in this area, replace both O-rings. 

• White Upper O-ring:  O-ring, Teflon P10 (P/N 036-11408-84)
• Black Lower O-ring:  O-ring, 4DP10A (P/N 0936-11209-84) 

Figure 5.8  Replacing the Sliding Sample Injector O-rings

If a gas leak develops between the injector block and the combustion tube, replace the 
O-ring there as well. 

CAUTION
Do not scratch the O-rings or the O-ring seat when replacing the O-rings. 

White O-ring

Black O-ring
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5.2.10  Replacing the Syringe Pump 8-port Valve Rotor

The fluororesin rotor of the syringe pump 8-port valve gradually becomes worn and 
scratched after prolonged use due to suspended particles in the samples. This wear 
eventually causes leaks from the 8-port valve.

The following symptoms are associated with leaks from the 8-port valve and indicate that 
rotor replacement is necessary. 

• Droplets of liquid around the 8-port valve (especially around the upper shaft) 
• Decreased analysis reproducibility
• Presence of bubbles in the syringe

If the leakage is great, sample remaining in the tubing after it is drawn into the syringe may 
flow back into the sample container. This is most likely due to a sampling tubing flange or 
connection problem.

CAUTION
Switch OFF the instrument before replacing the 8-port valve rotor.

Procedure

1. Shut down the instrument and turn OFF the power.

2. Verify that the O mark on the 8-port valve interrupt plate is directed toward the No. 1 
port. If not, the instrument was not shut down using the appropriate procedure. In this 
case, switch the instrument back ON, and follow the correct shutdown procedure.

Reference: For the correct shutdown procedure, refer to Section 4.3.3 "Ending Measurement".

3. Remove the nut using the provided wrench.

Figure 5.9  Removing the Nut

4. Pull up to remove the rotor drive component. Hang it on the screw on the right side of 
the plunger.

Nut



5.2    Periodic Inspections
5.2.10    Replacing the Syringe Pump 8-port Valve Rotor

247TOC-VCPH/CPN

5. Loosen the retaining nut using the provided wrench.

Figure 5.10  Removing the Retaining Nut

6. Note the orientation (toward port No. 1) of the flat surface of the spring-equipped rod. 
Remove the spring-equipped rod and retaining nut.

7. Note the orientation of the rotor hole position. Grasp the rotor with forceps and 
remove by pulling up.

Figure 5.11  Removing the Rotor

8. Insert a new rotor, taking care that the rotor hole matches original orientation.

9. Reinsert the retaining nut and spring-equipped rod, with the flat surface directed 
toward port No. 1. Tighten the retaining nut.

10. Replace the rotor drive component, and tighten the nut.

11. Switch the instrument ON.

Note: Perform the syringe pump zero detection procedure before analysis.
Refer to Section 4.1.3.1 "Syringe Pump Zero Point Detection".

Retaining Nut

Spring-equipped Rod

Rotor
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5.2.11  Replacing the CO2 Absorber for the Optional Carrier Gas Purifier

The NDIR baseline becomes unstable with a decrease in the carbon dioxide absorption in 
the carrier gas purifier CO2 absorber. The baseline position rises and reproducibility 
diminishes, making analysis impossible. The soda lime must be replaced when this occurs.

The frequency with which soda lime must be replaced depends on the frequency of 
analysis, quantity of organic impurities in the carrier gas, and the TOC content of the 
samples. It is recommended that soda lime be replaced once every four months.

Soda Lime Replacement Procedure

CAUTION
The carrier gas pressure applied to the carrier gas purifier CO2 absorber is
approximately 200kPa. It is dangerous to perform this maintenance procedure
under these conditions. Before replacing the soda lime, lower the carrier gas
pressure in the instrument to normal as follows:

• Turn the supply valve of carrier gas source OFF.
• Switch OFF the instrument.

Procedure

1. Remove the elbow joints of the carrier gas purifier CO2 absorber, which are behind 
the instrument.

2. Invert the CO2 absorber and remove the screw cap.

3. Remove the used soda lime.

4. Refill the absorber container with about 500g of new soda lime until it reaches about 
5mm from the interior screw threads. 

CAUTION
Do not allow any soda lime to enter the tube in the center of the container when
refilling the CO2 absorber.

5. Fill the hollow in the screw cap with quartz wool and screw the cap back on the 
container. 

CAUTION
To maintain an airtight seal, a rubber O-ring is placed between the container and
the screw cap. Inspect the O-ring to verify that it is not scratched or twisted, then
attach the cap. 
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6. Using the elbow joints, connect the carrier gas purifier CO2 absorber to the two tubes 
exiting the back of the instrument as follows:

• Tubing labeled “L”: Affixed to the connection port of the CO2 absorber container 
labeled “L”

• Tubing labeled “S”: Affixed to the connection port of the CO2 absorber container 
labeled “S”

CAUTION
Tighten the nut by hand only. Do not use tools.

7. Place the carrier gas purifier CO2 absorber container on the stand behind the 
instrument. 

Used soda lime should be disposed of according to local industrial waste disposal reg-
ulations. It must be clearly disclosed using an industrial waste manifest that the mate-
rial contains soda lime. 

CAUTION
Soda lime is a corrosive chemical substance. Be careful not to touch it with bare
hands. For details, refer to Section 6.9 "Material Safety Data Sheets".

5.2.12  Replenishing IC Reaction Solution 

For the H Type, verify that there is sufficient IC reaction solution in the IC reaction solution 
vessel before performing IC analysis. If not, replenish the IC reaction solution referring to 
Section 4.1.11 "IC Analysis Preparations". 

CAUTION
The IC reaction solution is acidic. Use care not to spill or touch the fluid when
handling it. For details, refer to Section 6.9 "Material Safety Data Sheets".
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5.2.13  Replacing the Pump Head of the IC Reaction Solution Pump 

The IC reaction solution pump is a roller type pump that uses a rotating roller to flatten the 
rubber tube carrying the IC reaction solution, thereby feeding solution into the system. This 
rubber tubing gradually deteriorates, requiring periodic replacement of the pump head. 

The life of the rubber tubing is generally about 300 hours of pump operation. It is 
recommended that 300 hours be entered as the warning value in the Maintenance History 
dialog box. Refer to Section 4.2.4 "Maintenance History Settings".

CAUTION
The pump head and rubber tubing inside the IC reagent pump are filled with IC
reagent solution. This solution is acidic. Use care to avoid touching or spilling
the solution when changing the pump heads. For details refer to Section 6.9
"Material Safety Data Sheets".

Replacement Procedure

Use the following procedure to replace the rubber tubing of the pump head. 

1. Grasp the front and rear stops of the pump head by hand. Pull the white pump head 
from the black pump body. 

2. Disconnect both of the yellow rubber tubes on the left side of the pump head from the 
Teflon tubes. 

3. Connect the new rubber tubing to the Teflon tubes of the pump head. 

4. Replace the pump head by following the above procedure in reverse. 

Figure 5.12  Replacing the Pump Head of the IC Reaction Solution Pump 
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5.2.14  Replacing the Filler of the Optional POC Analysis CO2 Absorber

The CO2 absorber for POC analysis is filled with about 6 grams of lithium hydroxide, 
which is sufficient to absorb carbon dioxide gas for several hundred analyses under normal 
conditions. Airflow resistance gradually increases with use and may become excessive 
irrespective of adequate carbon dioxide absorbency. 

Replace the lithium hydroxide in the CO2 absorber with a new batch if analysis values 
become unstable or carrier gas flow is impeded. For the procedure on filling the CO2 
absorber with lithium hydroxide, refer to Section 4.1.12 "Preparation for POC analysis".

CAUTION
• Lithium hydroxide is a corrosive (strongly alkali) powder. Be carefuel not to spill

or touch it during handling.  For details, refer to Section 6.9 "Material Safety
Data Sheets".

• Used lithium hydroxide should be disposed of by a certified industrial waste
handler according to local industrial waste disposal regulations. It must be clearly
disclosed using an industrial waste manifest that the waste is lithium hydroxide.

• Lithium hydroxide crystal is found in both anhydrous and hydrated forms.
Because the carbon dioxide gas absorbance properties of the hydrated form are
slightly inferior to those of the anhydrous form, use anhydrous lithium hydroxide
to fill the CO2 absorber. 

• The life of the CO2 absorber will be shortened by performing POC analysis on
samples with high concentrations of IC. 
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5.3  Autosampler (ASI-V) Maintenance 

Maintenance of the autosampler includes periodic inspection of the rinse bottle, sample 
catcher and rinse pump.

5.3.1  Rinse Bottle Inspection

Perform the following inspections before conducting analysis with the autosampler. If the 
following inspections are not properly conducted, air will be drawn into the autosampler 
injection pump, preventing the delivery of rinse water. 

• Check the rinse water level 
Verify that the water in the rinse bottle is above the 2-liter level mark.  Add water if nec-
essary. 

• Check the rinse tubing
Verify that the tip of the rinse tubing reaches nearly to the bottom of the rinse bottle. 
Adjust the tubing position if necessary.

Figure 5.13  Rinse Bottle Inspection

5.3.2  Sample Catcher Inspection 

Examine the turntable (black plate) and the sample catcher tray below the turntable when 
installing or removing the autosampler vial rack. If they are wet or dirty, wipe them clean.

CAUTION
Corrosion of the instrument may occur if spilled sample is allowed to remain in
the sample catcher. Keep the sample catcher clean.

Rinse Tubing

Rinse Bottle
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5.3.3   Replacing the Pump Head of the Rinse Pump

The rinse pump is located inside the autosampler and supplies rinse water to the rinse port. 
The rinse pump is a roller type pump that uses a rotating roller to flatten the rubber tubing 
carrying the rinse water, thereby feeding rinse water into the system. This rubber tubing 
gradually deteriorates, requiring periodic replacement. 

The life of the rubber tubing is generally about 300 hours of pump operation. It is 
recommended that 300 hours be entered as the warning value in the Maintenance History 
dialog box. For details, refer to Section 4.2.4 "Maintenance History Settings".

Replacement Procedure

Use the following procedure to replace the pump head.

1. Remove the rectangular pump access cover on the back left side of the autosampler.

2. Grasp the latch on the pump head by hand and pull the white pump head from the 
black pump body.

3. On the left side of the pump head, disconnect both of the yellow rubber tubes from the 
Teflon tubes.

4. Connect the new rubber pump head tubing to the Teflon tubes. 

5. Replace the pump head by following the above procedure in reverse and then replace 
the pump access cover. 

Figure 5.14  Replacing the Pump Head of the Rinse Pump

Pump
Head
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5.4  8-Port Sampler (OCT-1) Maintenance

5.4.1 Replacing the 8-Port Valve Rotor
The OCT-1 uses a fluororesin 8-port valve rotor. The valve rotor may become worn or 
scratched after prolonged use due to the suspended particles in the samples. This wear 
eventually causes leaks from the 8-port valve. 

The following symptoms are associated with leaks from the 8-port valve and indicate 
that it is necessary to replace the rotor. 

• Droplets of liquid around the 8-port valve (especially, around the upper shaft)

• Decreased analysis reproducibility.

• Presence of bubbles in the TOC-V syringe.

If the leak is large, sample remaining in the tubing after the syringe has been filled may 
flow back into the sample container. This is most likely due to a sample tubing or 
flange connection problem.

CAUTION

Switch OFF the power before replacing to the 8-port valve rotor.

Replacement Procedure

1. Shut down the TOC-V unit and switch OFF the power.

Reference: Refer to Section 4.3.3 "Ending Measurement" for details on shutting down the TOC-V unit.

2. Remove the 4 screws at the top of the 8-Port Sampler, and take OFF the cover.

3. Verify that the O mark on the 8-port valve cover is directed toward port No.1. 

Note: If the O mark is not directed toward port No.1, the instrument was not 
shut down properly. If this is the case, turn the TOC-V on again, and 
shut it down properly. 
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4. Remove the nut using the wrench supplied with the TOC-V. 

Figure 5.15   Removing the Nut

5. Remove the 8-port valve by pulling it downward. 

6. Loosen the retaining nut using the provided wrench.

Figure 5.16  Removing the Retaining Bracket

7. Note the orientation (toward port No. 1) of the flat surface of the spring-equipped rod. 
Remove the spring-equipped rod and retaining nut. 

8. Note the orientation of the rotor hole position. Grasp the rotor with forceps, and 
remove by pulling upwards. 

Figure 5.17  Removing the Rotor

9. Insert a new rotor, positioning the rotor hole to the original position.

10. Reinsert the spring-equipped rod and retaining nut with the flat surface directed 
toward port No. 1. Tighten the retaining nut.

11. Replace the 8-port valve in its original position, and secure it using the nut.

12. Replace the cover of the 8-Port Sampler and secure it with four screws. 

13. Switch on the TOC-V unit.

Nut

Retaining Nut

Rotor
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5.5  TN Unit (TNM-1) Maintenance 

Maintenance of the TN unit includes periodic inspection of the ozone treatment unit 
catalyst, chemiluminescence detector and ozone generator.

5.5.1  Replacing the Catalyst in the Ozone Treatment Unit 

The ozone treatment unit breaks down ozone gas produced by the ozone generator. The 
catalyst inside the ozone treatment unit must periodically be replaced. Replace the catalyst 
once a year for an instrument that runs 8 hours a day and 5 days a week.

Perform maintenance to the ozone treatment unit only after stopping the instrument as 
described inSection 4.3.3 "Ending Measurement". 

CAUTION
The interior of the ozone treatment unit is heated to 50°C. Perform maintenance
only after cooling for at least two hours. 

Replacement Procedure

Use the following procedure to replace the catalyst in the ozone treatment unit. 

1. Remove the knurled screw at the bottom of the unit, and remove the installation 
bracket. 

Figure 5.18  Removing the Ozone Treatment Unit Screw and Bracket

Knurled Screw

Installation Bracket

Ozone 
Treatment Unit
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2. Remove the hose clamp at the bottom of the ozone treatment unit and pull off the 
Viton tubing. 

Figure 5.19  Removing the Viton tube

3. Remove the hose clamp at the top of the unit and remove it from the Viton coupling. 

Figure 5.20  Removing the Ozone Treatment Unit 

Hose Clamp

Viton Tubing

Hose Clamp

Viton Coupling
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4. Remove the cap from the ozone treatment unit and take out the used catalyst and 
polypropylene packing material. 

Figure 5.21  Emptying and Removing the Ozone Treatment Catalyst

5. Pack a small amount of new polypropylene packing material into the bottom of the 
ozone treatment unit, then fill with approximately 60 grams of catalyst. 

6. Insert a small amount of new polypropylene packing material on top of the catalyst. 

7. Place the cap back on the container. 

8. Remove the Viton coupling connecting the detector exhaust opening to the inlet of the 
ozone treatment unit. 

Replace this Viton coupling with a new one whenever the catalyst is replaced.  Inspect 
the Viton tubing at the outlet of the ozone treatment unit and replace it if cracked or 
damaged. 

9. Reconnect the Viton tubing and Viton coupling, and reinstall the ozone treatment unit. 

CAUTION
Used catalyst should be disposed of according to local industrial waste disposal
regulations. It must be clearly disclosed using an industrial waste manifest that
the catalyst contains manganese dioxide.
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5.5.2  Chemiluminescence Detector

The light receiving window of the chemiluminescence detector may become soiled by 
components in the samples. Inspect and clean the window and gasket at least once a year. 

Maintenance Procedure

Perform maintenance on the detector only after shutting down the instrument. 

1. After removing the tubing from the reactor, as shown in the figure below, loosen the 4 
mounting screws, and detach the reactor. 

Figure 5.22  Removing the Reactor

2. Remove the gasket and confirm that it is not dirty or cracked. Replace it if necessary. 

3. Confirm that the detector window is not dirty. If necessary, gently wipe the window 
clean with a cloth. 

4. Place the flat side of the gasket facing the detector window, sandwiching it between 
the window and the reactor. 

5. Secure the gasket in place with the 4 mounting screws, tightening them uniformly. 

6. Reconnect the tubing.

CAUTION
Recheck the tubing after completing the maintenance work to make absolutely
certain that there are no mistakes in the line connections and that everything has
been properly tightened. 

  Mounting
  Screws

Detector

Reactor

Gasket
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5.5.3  Ozone Generator Replacement 

Replace the ozone generator with a new one after 8000 hours of operation. Set a warning 
generation value of 8000 hours in the Maintenance History dialog box. For details, refer to 
Section 4.2.4 "Maintenance History Settings".

Ozone generator replacement must be carried out by an authorized Shimadzu service 
engineer, or someone who has been properly trained in the procedure. Contact your 
Shimadzu representative to request replacement at the appropriate time.

Confirming Operation Time

The ozone generator operating time is displayed in the Maintenance History window, 
which is accessed through the Sample Table Editor. From the Instrument menu, select 
Maintenance>Maintenance History.

CAUTION
If the ozone generator is used after 8000 hours of operation, ozone generation
may not be sufficient for analysis, or ozone may leak from inside the generator.
Replace the ozone generator without fail.

5.5.4  Replacing the NOx Absorber

The NOx absorber absorbs NOx gas generated in the TN unit. A CO2 absorber is used for 
the NOx absorber. The CO2 absorber was previously used for purging the NDIR detector 
optical system Section 5.2.5 "Replacing the CO2 Absorber" and is still effective for this 
application. 

During the annual replacement of the CO2 absorber used to purge the optical system of the 
NDIR detector, replace the NOx absorber for the TN unit with the used CO2 absorber from 
the TOC-V. 

Discarding the NOx Absorber (CO2 Absorber)

Place a request to an authorized industrial waste contractor to process the used NOx 
absorber (CO2 absorber). Clearly indicate in the industrial waste material manifest that the 
absorber contains soda lime. 
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5.6  Software-Controlled Maintenance Functions

Maintenance functions that can be performed using the TOC-Control V software are 
described below. These functions can be accessed through the Instrument>Maintenance 
menu.

Figure 5.23  Instrument>Maintenance Menu

To access the menu, select Instrument>Maintenance in the Sample Table Editor.

5.6.1  Zero Point Detection

Use this function to determine the zero point of the syringe. Click the Start button to begin 
the procedure, during which a progress bar is active. The progress bar becomes inactive 
after the syringe zero point is determined. Click the Close button.

Figure 5.24  Zero Point Detection Dialog Box
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5.6.2  Regeneration of the TC Catalyst

Use this function to restore the sensitivity and efficiency of the TC catalyst, which decrease 
over time as inorganic substances are deposited on the catalyst surface. During the 
procedure, dilute hydrochloric acid is injected onto the catalyst. Be sure to verify that 
sufficient hydrochloric acid is in the instrument acid reservoir before starting the procedure.

Figure 5.25  Regeneration of TC Catalyst Dialog Box

Click the Start button to begin the procedure. A progress bar is active until the TC catalyst 
is regenerated. Click the Close button.

5.6.3  Regeneration of the IC Solution

Use this function to restore the acidity of the IC solution, which decreases over time as the 
acid reacts with IC sample constituents. During the procedure, IC reagent is automatically 
pumped to the IC reaction vessel. This option is available only if an IC unit is connected to 
the system.

Figure 5.26  Regeneration of IC Solution Dialog Box

Click the Start button to begin the procedure. A progress bar is active until the IC solution 
is regenerated. Click the Close button.
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5.6.4  Residue Removal

Use this function to remove residue from the flow lines and syringe.

Figure 5.27  Residue Removal Dialog Box

Click the Start button to begin the procedure. A progress bar is active until the residue 
removal procedure is complete. Click the Close button.

5.6.5   Replace Flowline Content

Select this command to replace the contents of the flow lines connected to the 8-port valve 
from the dilution solution bottle and the hydrochloric acid bottle.

Figure 5.28  Replace Flow Line Content Dialog Box

Click the Start button to begin the procedure. A progress bar is active until the flow line 
content has been replaced. Click the Close button.
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5.6.6  Flowline Washing

Use this function to wash the selected flow lines.

Figure 5.29  Washing Dialog Box

To perform flow line washing, click the Select Flow Lines button to open the Wash Flow 
Lines dialog box. Select the flow lines to be washed, and click the Washing button. The 
ports for the 8-Port Sampler 1 (2) can be selected if the 8-Port Sampler 1 (2) is being used.

Figure 5.30  Wash Flow Lines Dialog Box

While this process is being executed, the buttons in the Washing dialog box are disabled, 
and progress bar activity is displayed. 
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5.6.7  Mechanical Check

Select this function to check mechanical components of the instrument or to make 
adjustments. The Mechanical Check window consists of several tabs, one for each 
connected instrument.

TOC Tab

Figure 5.31  Mechanical Check Window:  TOC Tab

Syringe Pump

Use the buttons to move the syringe pump to the Zero, Home, or Sparge posi-
tions. Click the Reset button to move the plunger to the highest position.

Solenoid Valves

Use the buttons to open or close the various solenoid valves. Different options 
are available depending on the instrument configuration and oxidation method.

Port Select

Open the line between the syringe and an injection port by clicking the button for 
the desired port.

TC Inj. Port

Specify whether the port should be set to drain or measure by clicking the appro-
priate button.

IC Inj. Port

Specify whether the port should be set to drain or measure by clicking the appro-
priate button.

Acid Pump

Use the buttons to open or close the IC acid pump lines.
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ASI / 8-Port Sampler Tab

Figure 5.32  ASI / 8-Port Sampler Tab of Operation Verification Dialog Box 

Rinse

Use the On and Off buttons to start and stop the ASI flow line rinsing option.

Move Tray

Use the directional arrows to move the ASI tray to the desired position. Click the 
Reset button to return the tray to its home position.

Arm

Use the directional arrows to move the arm vertically. Use the drop-down list to 
move the arm horizontally.

Vial Position

Use the spin controls to enter a vial position, then click the Move button to verify 
that the arm moves to the specified vial position. This is the only option that is 
enabled for systems using the OCT-1 8-port sampler.

Magnetic Stirrer

Use the On and Off buttons to start and stop the magnetic stirrer.
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5.6.8  ASI / 8-Port Sampler Initialization

Use this function when first connecting the instrument to establish communication between 
the TOC-Control V software and the ASI or 8-Port Sampler. This option is disabled if an 
ASI or 8-Port Sampler is not connected to the system.

Figure 5.33   Initialize ASI / 8-Port Sampler Window

Click the Start button to begin the procedure, during which a progress bar is active. The 
progress bar becomes inactive after the ASI or 8-Port Sampler is initialized. Click the Close 
button.

5.6.9  ASI Rack Change

Use this function to change the ASI rack. This option is disabled if an ASI is not connected 
to the system. 

Figure 5.34   ASI Rack Change Window

Click the Preparation Start button to begin the procedure. A progress bar is active while the 
rack moves to the position where it can be replaced. When the progress bar begins blinking, 
replace the rack. Click the Finish Replacement button to initialize the ASI and complete the 
rack change process. Click the Close button.
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5.6.10  ASI Needle Change

Use this function to change the ASI needle. This option is disabled if an ASI is not 
connected to the system.

Figure 5.35  ASI Needle Change Window

Click the Preparation Start button to begin the procedure. A progress bar is active while the 
needle moves to the position where it can be replaced. When the progress bar begins 
blinking, replace the needle. Click the Finish Replacement button to initialize the ASI and 
complete the needle change process. Click the Close button.

5.6.11  Change Syringe

Use this function to replace the syringe.

Figure 5.36  Syringe Change Window

Click the Preparation Start button to begin the procedure. A progress bar is active while the 
syringe moves to the position where it can be replaced. When the progress bar begins 
blinking, replace the syringe. Verify that the syringe moves smoothly between the upper 
and lower positions by clicking the directional arrows. Click the Finish Replacement button 
to move the syringe to its initialization position, then click the Close button.

Note: Perform the zero point detection procedure whenever a new syringe is installed
or the syringe is replaced. Refer to Section 4.1.3.1 "Syringe Pump Zero Point
Detection".
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5.6.12  Blank Check

Use this function to automatically determine the background TC level of the instrument. 
Conducting the Blank Check procedure is recommended prior to performing high 
sensitivity measurements and after loading high sensitivity catalyst. Open a blank Sample 
Table, connect the instrument, and select the Blank Check option from the Instrument 
menu. Refer to Section 4.1.15.2 "TC Blank Check Analysis" for details. Set the injection 
volume using the spin controls, then click the Start button to begin the procedure.

Figure 5.37  Blank Check Parameters Window

Note: Do not insert a sample into the Sample Table. The Blank Check procedure only
works in a blank Sample Table.

5.6.13  Maintenance Log

Refer to Section 4.2.4 "Maintenance History Settings" for more details.

5.6.14  History

Use this option to view the operational history of various instrument components and to set 
limits for various parameters of the components. When a limit is exceeded for an 
instrument component, a warning message will be generated on the PC screen to remind the 
user to perform maintenance on the component. Refer to Section 4.2.4 "Maintenance 
History Settings" for a detailed description of this function.

5.6.15  Sparge Gas Valve

Select this option to start and stop the flow of sparge gas when the external sparge kit is 
used. 

5.6.16  Adjust Sparging Flow Rate (Wet Chem.)

Use this function to adjust the sparge gas flow rate. This option is available only when the 
wet chemical oxidation method is used.
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5.7  Troubleshooting

This section describes the error messages displayed by the TOC-Control V software and 
the actions recommended to resolve the underlying causes.

5.7.1  Error Messages

The following error messages are displayed on the PC screen when setting or operation 
errors are made, or when problems with instrument operation occur. Take the corrective 
actions indicated in the table below. 

Table 5.1• Error Message List 1

Error Message Description Corrective Action
WARNING: Dilution water 
depleted

Actual amount of dilution water used 
exceeds value set in the Maintenance 
History Settings.

Replenish the water in the dilution water con-
tainer. Then, reset the Dilution Water amount in 
the Maintenance History Settings. 

WARNING: Acid depleted Actual amount of hydrochloric acid 
used exceeds value set in the Mainte-
nance History Settings.

Replenish the hydrochloric acid in the acid con-
tainer. Then, reset the Total Acid Volume in the 
Maintenance History Settings.

ERROR: Combustion tube 
sample injections exceeded.

Actual volume of sample injected into 
combustion tube exceeds value set in 
the Maintenance History Settings.

Either regenerate the catalyst or replace the cata-
lyst and combustion tube. Then, reset the Total 
TC Injection Volume in the Maintenance History 
Settings.

ERROR: Syringe stroke num-
ber exceeded

Actual number of syringe strokes per-
formed exceeds value set in the Mainte-
nance History Settings.

Replace the plunger tip. Then, reset the Syringe 
Stroke value in the Maintenance History Set-
tings.

WARNING: IC pump tube 
operating hours exceeded.

Actual IC pump tubing operation time 
exceeds value set in the Maintenance 
History Settings.

Replace the IC pump tubing. Then, reset the IC 
Unit Pump time in the Maintenance History Set-
tings.

WARNING: ASI pump tube 
operating hours exceeded.

Actual ASI pump tubing operation time 
exceeds value set in the Maintenance 
History Settings.

Replace the ASI pump tubing. Then, reset the 
ASI Rinse Pump time in the Maintenance His-
tory Settings.
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Table 5.2• Error Message List 2

Error Message Description Corrective Action
Information entered is incorrect. 
Re-enter user name and password.

The user name and password entered are not 
valid.

Enter the correct user name and 
password. These fields are 
case-sensitive. If the user account 
has not been set up, contact the 
system administrator.

Database path not found. The specified file does not exist in the specified 
path.

Check the file name and path. 
Check if the specified file has been 
deleted or moved, or if the system 
used for the file has been deleted.

Opening of communication port 
has timed out. Check instrument 
connection and transmission set-
tings.

The process of opening the communication port 
has timed out.

Verify that the instrument is 
switched on, and that the instru-
ment connection and communica-
tion port settings are correct.

Closing of communication port has 
timed out. Transmission will be 
ended.

The process of closing the communication port 
has timed out.

Verify that the instrument is 
switched on, and that the instru-
ment connection and communica-
tion port settings are correct. 
Communication is automatically 
closed in that condition.

Instrument initialization has timed 
out.

The process of initializing the instrument has 
timed out.

Check if there is a problem with 
the instrument operation, or if there 
is a problem with communication 
between the PC and the instrument.

The selected communication port 
is already open. Verify that it is not 
used with another connection.

An attempt was made to open a communication 
port that has already been opened. 

Check if the selected port is being 
used with another connection.

Cannot open communication port. 
Check instrument status and trans-
mission settings.

The communication port failed to open. Verify that the instrument is 
switched on, and that the instru-
ment connection and communica-
tion port settings are correct.

Mode error: Check instrument con-
dition. If necessary, restart instru-
ment.

The operation was not accepted due to the instru-
ment condition.

Verify the instrument operation. If 
necessary, restart the instrument.
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The following messages indicate that an error has occurred that prevents measurement 
from continuing. Take the appropriate corrective actions as indicated in the following table. 

If the cause of the problem cannot be discovered, or if the same error message appears after 
taking the indicated corrective actions, contact your Shimadzu representative.

Note: When the following errors are generated, power to the instrument oven is auto-
matically stopped. When power to the oven is switched on again, wait until the
temperature rises before starting measurement.

Table 5.3• Error Message List 3

Error Message Description Corrective Action
ERROR: Syringe Zero Point 
Detection.

Syringe zero point detection could 
not be performed. Syringe is not 
properly installed.

Properly mount the syringe. Then select Zero 
Point Detection from the Maintenance menu.

WARNING: TC furnace temper-
ature is too low to regenerate cat-
alyst.

TC furnace temperature is too low to 
perform the catalyst regeneration 
procedure.

Wait for the furnace temperature to rise before 
executing the catalyst regeneration procedure.

ERROR: Vial rack not present. Operation cannot continue because 
there is no vial rack in the turntable. 

Mount a vial rack, and then execute the operation 
again.

ERROR: Vial rack has been 
exchanged.

Measurement cannot be performed 
because the vial rack specified in the 
settings differs from the type actu-
ally detected.

Verify the type of vial rack mounted in the 
ASI-V, and then set the vial rack type in the soft-
ware.

ERROR: Vial rack type not set. The measurement parameters cannot 
be validated because the vial rack 
type is not specified in the software.

Set the vial rack type in the software.

ERROR: ASI Cover is open. The ASI-V cover is open. The 
ASI-V operation has stopped as a 
safety measure.

Close the ASI-V cover.
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Table 5.4• Error Message List 4

Error Message Description Corrective Action
ERROR: ROM Write 
Error

An error occurred while writing to 
memory.

Switch off power to the instrument. Contact your Shi-
madzu representative.

ERROR: Electric Fur-
nace Overheating

The electric furnace overheated. With the power ON, wait approximately 20 minutes for 
the oven temperature to decrease then switch OFF the 
instrument. After switching on the power and running 
the instrument again, see if the same error is generated. 

ERROR: Electric Fur-
nace Sensor

The oven temperature does not rise. Switch off power to the instrument. After switching on 
the power and running the instrument again, see if the 
same error is generated.ERROR: Syringe Posi-

tion Detection
The syringe is not operating normally.

ERROR: Syringe Opera-
tion

The syringe is not operating normally 
due to clogging of the tubing connected 
to the 8-port valve. 

Switch off the instrument, and remove any foreign parti-
cles from the line. After switching on the power and 
running the instrument again, see if the same error is 
generated.

ERROR: Syringe Zero 
Point Detection

The syringe is not operating normally. Switch off the instrument. After switching on the power 
and running the instrument again, see if the same error 
is generated.

ERROR: 8-Port Valve 
Position Detection

The 8-port valve is not operating nor-
mally due to clogging inside of the sam-
ple injector 8-port valve.

Switch off the instrument, and remove the rotor from the 
8-port valve. Remove any particles found in the 8-port 
valve and wash valve. 

ERROR: TC Slider The TC slider is not operating normally 
due to particles wedged between the 
moving parts.

Switch off the instrument, inspect the slider and remove 
any foreign particles from the slider mechanism. Then 
switch on the power again. 

ERROR: IC Slider The IC slider is not operating normally 
due to particles wedged between the 
moving parts.

ERROR: ASI Arm Verti-
cal Position Detection

The ASI-V arm is not operating nor-
mally in the vertical direction.

Switch off power to the TOC-V main instrument. After 
switching on the power and running the instrument 
again, see if the same error is generated. 
Since the problem is unrelated to the TOC-V main unit, 
disconnect the ASI-V from the main unit, and perform 
operations using the TOC-V main unit alone until nor-
mal operation of the ASI-V is restored.

ERROR: ASI Arm Verti-
cal Movement

The ASI-V arm is not operating nor-
mally in the vertical direction.

ERROR: ASI Arm Hori-
zontal Position Detection

The ASI-V arm is not operating nor-
mally in the horizontal direction.

ERROR: ASI Arm Hori-
zontal Movement

The ASI-V arm is not operating nor-
mally in the horizontal direction.

ERROR: ASI Turntable 
Position Detection

The ASI-V turntable position could not 
be detected. Either the rack is not prop-
erly seated in the turntable, or some 
object may be blocking a position detec-
tion notch on the periphery of the rack.

Switch off power to the TOC-V main unit. Make sure 
the rack is properly seated, and remove any objects that 
may be blocking the position detection notch on the 
periphery of the rack. After eliminating the cause of the 
problem, place the cover on the ASI-V, and switch on 
the power to the instrument again.

ERROR: TN Reactor 
Temperature

The TNM-1 reactor temperature does 
not rise.

Switch off power to the TOC-V main unit. After switch-
ing on the power and running the instrument again, see 
if the same error is generated.
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5.7.2  Troubleshooting

5.7.2.1  TOC-V

(1) An error message is displayed.
→Refer to error message.

(2) The Ready lamp will not light.
→ Access the Background Monitor screen by selecting Background Monitor from the 
Instrument menu. Refer to the screen to see which parameters are not satisfied.

(3) The baseline stays over the auto zero range. Baseline position never reaches the ready 
state.

8-Port Sampler 1 posi-
tion detection

8-Port Sampler 1 operation error 
occurred due to foreign matter infiltra-
tion into 8-port valve, etc.

Switch off instrument. Remove 8-port valve rotor from 
8-Port Sampler 1, remove debris, etc., and wash valve.

8-Port Sampler 1 opera-
tion

8-Port Sampler 2 posi-
tion detection

8-Port Sampler 2 operation error 
occurred due to foreign matter infiltra-
tion into 8-port valve, etc.

Switch off instrument. Remove 8-port valve rotor from 
8-Port Sampler 2, remove debris, etc., and wash valve.

8-Port Sampler 2 
operation

Table 5.4• Error Message List 4

Error Message Description Corrective Action

Does carrier 
normally

Carrier gas leak.

Repair the leak.

analysis

The dehumidifier temperature 
setting is bad.

Contact your Shimadzu 
representative.

The infrared gas

Contact your Shimadzu 
representative.

Is dehumidifier
the specified

analyzer is bad.

temperature?

YES

YES

gas flow 
to the

cell?

within 

NO

NO
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(4) The baseline is unstable.

Is carrier gas 
flowing normally?

Repair the leak.

Was

Accumulated obstructing

Replace the catalyst.

substance.

Carrier gas leak.

Is the

The dehumidifier is bad.

Contact your Shimadzu
representative.

 operating

Are

External conditions are

Eliminate the adverse

conditions (vibration,
temperature, power

normal?
voltage) 

adverse.

condition.
The infrared gas analyzer

Contact your Shimadzu
representative.

is bad.

NO

NO

NO

NO

YES

YES

YES

YES

the catalyst
replaced?

dehumidifier

normally?

   external
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(5) Poor reproducibility with standard solution.

Is the

Bad standard solution.

Prepare new standard 

Is the

Poor injection condition.

Adjust injector. 

solution.

normally from injection
 tube?

 normal?

Do

Poor injection volume

Eliminate bubbles.

Was plunger tip 

Backlash of plunger tip.

Replace plunger tip.

Does

Low water level.

Replenish the water.

 repeatability.

 

 in syringe? (especially
 in dilution

replaced recently?

 sometimes leak from 
the drain

Does the

IC reaction solution has

Regenerate the IC reactionTC

Was the

Insufficient regeneration of 

Regenerate the TC catalyst.

TC catalyst deteriorated.

Replace the TC catalyst.

 deteriorated.

 solution.

theTC catalyst .

TC or IC

 regenerated?

IC

YES

YES

YES

YES

YES

YES

NO

NO

NO

NO

NO

NO

standard solution

sample injected

analysis)

bubbles remain

carrier gas

occur in the 

circuit?

bottle?

TC catalyst

poor reproducibility
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(6) No peaks appear after sample injection.

Is

Poor injection.

Correct the injection

Is carrier gas

Is the

Low water level.

Replenish water.

Was membrane filter

Clogged membrane filter.

Replace the membrane filter.

Large resistance downstream

Contact your Shimadzu

Bad infrared gas analyzer.

Contact your Shimadzu

injected into TC
combustion tube or IC

vessel?

 visually)

condition.

always flowing from
the drain

 normal in the
 drain bottle?

 replaced?

of dehumidifier.

representative.
representative.

reaction 
(confirm

sample

bottle?

level of the water

YES

YES

NO

NO

NO

YES

YES
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5.7.2.2  ASI-V

(1) The ASI-V does not operate.

(2) Rinse water is not delivered from the rinse port.

Is

Improperly connected cable.

Properly connect the cables.

Bad electrical system.

Contact your Shimadzu

and power cable
properly connected?

representative.

cable
connection

YES

NO

Is there

Insufficient rinse water.

Replenish the rinse water.

Is the

The rinse tubing is not properly

Properly insert the tubing into

The rinse pump is bad.

Contact your Shimadzu

rinse water in rinse
water bottle?

properly inserted into
the rinse water

bottle?
inserted into rinse water bottle.

the rinse water bottle.

representative.

YES

YES

NO

NOsufficient

rinse tubing
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(3) Reproducibility is poor.

5.7.2.3 8-Port Sampler OCT-1

(1) 8-Port Sampler does not operate.

Is there

Poor reproducibility due to

Remove the obstruction from

Is there

Air is drawn in at the

Properly reconnect the tubing.

Poor reproducibility due to

Refer to Troubleshooting #1.

adhering to the
  sample

connection of sample
needle and ASI

sample

foreign matter.

the opening at the tip of the
sample needle.

connection.

a problem with the TOC-V.

NO

NO

YES

YESany material

needle?

a leak at the

tubing?

TOC-V item (5)

 

 

YES

NOAre the signal and 
power cables properly 

connected?
Cables are not properly 
connected.
Connect the cables properly.

Electrical system is defective.

Contact your Shimadzu 
representative.
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(2) Reproducibility is poor.

5.7.2.4  Corrective Actions for Poor Reproducibility

Corrective Action for Poor Sample Injection

The manner in which sample is discharged from the TC or IC sample injection tubing has a 
large influence on reproducibility. The sample should be injected as vertically as possible 
onto the TC catalyst or into the IC reaction vessel. If the sample is scattered or injected 
obliquely, detach the sample injection tubing from the slider, and remove any obstruction 
that may be adhering to the opening at the tip of the sample tubing.

Figure 5.38  Sample Injection Patterns from Sample Tubing

Ensure that the tip of the tubing does not protrude beyond the bottom surface of the slider. 
The O-ring or other seal parts will be scratched if the tubing protrudes, resulting in gas 
leaks. The sample is not properly injected unless the tip of the tubing extends into the 
depression in the bottom of the slider.

Check the state of the injection for TC analysis by looking through the TC combustion tube 
while it is attached to the instrument. The sample injection tubing can be detached from the 
slider, and water can be injected for inspection using the functions available in the 
Instrument>Maintenance>Mechanical Check screen.

 

 

NO

NO

YES

YES

Is any foreign material 
adhering to the sample 

tubing?

Is the leakage 
present at the 8-port valve 

and sample tubing 
connection?

Reduced reproducibility due to 
foreign material.
Eliminate blockage at the tip of the 
sample tubing.

Connection is leaking.

Connect the tubing properly.

Poor reproducibility is due to the 
TOC-V unit.

Refer to the TOC-V User Manual.

Appropriate
Unacceptable Unacceptable
(oblique spray) (scattered spray)
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Salt or other substances adhering to the tip of the tubing after rinsing can allow large 
droplets of sample to remain on the tip of the tubing after injection. A deformed tip on the 
sample injection tubing (a beard-like protrusion, for example) may cause the sample to be 
injected obliquely. In either case, reproducibility is adversely affected and the sample 
injection tubing should be replaced. Another option available only if there is sufficient 
length of tubing remaining is to use a sharp cutting tool at a 90° angle to cut off 2 - 3mm 
from the tip of the currently used sample injection tubing. 

Figure 5.39  Slider Assembly

Corrective Action to Eliminate Bubbles Inside the Syringe

Small bubbles that adhere to the inside of the syringe by the plunger tip will have little 
effect on analysis values. Larger bubbles inside the syringe will affect values and result in 
poor reproducibility. Large bubbles form easily inside a dirty syringe. This is evident when 
sample is mixed with dilution water in the syringe and when sparging with carrier gas 
inside the syringe for IC removal pretreatment for NPOC analysis. In this case, detach the 
syringe from the syringe pump. Repeatedly draw in and discharge laboratory glassware 
detergent to wash the inside of the syringe. Then draw in a full-stroke volume of the 
cleaning agent and let it sit for about 20 minutes, or overnight if the syringe is extremely 
dirty. Thoroughly rinse away all of the detergent and reattach the syringe to the syringe 
pump.

Decreased Reproducibility Due to Plunger Tip Backlash

The plunger tip is a consumable item and, as it is used, wears in the following ways: 

(1) The surface of the plunger tip becomes worn and the seal between the plunger tip and 
the inside of the glass syringe barrel deteriorates, allowing slight amounts of water to 
leak out with vertical movements of the plunger.

(2) The contact site of the plunger tip and plunger becomes loose, causing a slight 
backlash with vertical movement of the plunger.

As the above conditions start to occur, repeatability of sample injection volume decreases, 
resulting in diminished analysis reproducibility. Item (2) above rapidly leads to decreased 
reproducibility. Since it is very difficult to determine backlash by inspecting movement of 
the plunger tip, inspect as follows.

Before sample injection, observe the wash injection used to replace the previous sample in 
the syringe and flow line with the new sample. After injection, if a droplet forms at the tip 
of the injection tubing and increases in size, there is a strong possibility that backlash has 
increased. The corrective action in this case is to replace the plunger tip.

Note: The effect of backlash increases with smaller sample injection volumes. Poor
results might be obtained with a sample injection volume of 10µL, while the
effect might be negligible with a 100µL sample injection volume. 

Approximately

Tube

Bushing 

2 - 2.5mm

Packing (spacer,
washer, gasket)
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6Reference Information
This chapter describes the principles of analysis and lists instrument specifications, 
accessories, and parts. This chapter also includes installation procedures, for use in the 
event that the instrument is relocated.

6.1 Principles of Analysis
The principles for TC, IC, POC, NPOC, TOC and TN analysis are described in 
this section.

6.2 Analysis-Related Technical Information
This section summarizes technical information related to analysis, including 
peak area analysis and calibration curve selection.

6.3 Specifications
This section lists specifications for the TOC-VCPH/CPN main unit, autosampler, 
TN unit and the various optional kits.

6.4 Standard Accessories
The standard accessories are listed in this section.

6.5 Special Accessories
The optional accessories are listed in this section.

6.6 Consumable Parts List
The consumable parts are listed in this section.

6.7 Maintenance Parts List
The maintenance parts are listed in this section.

6.8 Installation
The installation site requirements and installation procedures for future 
relocation of the instrument are described here.

6.9 Material Safety Data Sheets
Material Safety Data Sheets are provided in this section.

6
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6.1  Principles of Analysis

Two types of carbon are present in water: organic carbon and inorganic carbon. Organic 
carbon (TOC) bonds with hydrogen or oxygen to form organic compounds. Inorganic 
carbon (IC or TIC) is the structural basis for inorganic compounds such as gas carbonates 
and carbonate ions. Collectively the two forms of carbon are referred to as total carbon 
(TC) and the relationship between them is expressed TOC=TC-IC. 

Nitrogen is also present in water in two types:  organic and inorganic.  The sum of these is 
referred to as total nitrogen (TN). 

The principles underlying TC and TN analysis are explained in the following sections. 

6.1.1  Principles of TC (Total Carbon) Analysis 

Sample is introduced into the TC combustion tube, which is filled with an oxidation 
catalyst and heated to 680°C. The sample is burned in the combustion tube and, as a result, 
the TC components in the sample are converted to carbon dioxide. Carrier gas, which flows 
at a rate of 150mL/min to the combustion tube, carries the sample combustion products 
from the combustion tube to an electronic dehumidifier, where the gas is cooled and 
dehydrated. The gas then carries the sample combustion products through a halogen 
scrubber to remove chlorine and other halogens. Finally, the carrier gas delivers the sample 
combustion products to the cell of a non-dispersive infrared (NDIR) gas analyzer, where 
the carbon dioxide is detected. The NDIR outputs an analog detection signal that forms a 
peak; the peak area is measured by the TOC-Control V software. 

The peak area is proportional to the TC concentration of the sample. A calibration curve 
equation that mathematically expresses the relationship between peak area and TC 
concentration can be generated by analyzing various concentrations of a TC standard 
solution. The TC concentration in a sample can be determined by analyzing the sample to 
obtain the peak area and then using the peak area in the calibration curve equation. 



6.1     Principles of Analysis
6.1.2     Principles of IC (Inorganic Carbon) Analysis

285TOC-VCPH/CPN

6.1.2  Principles of IC (Inorganic Carbon) Analysis

Two methods for measuring IC using the TOC-V are available: analysis within the injection 
syringe and analysis using the optional IC reactor. In both methods, the measured IC 
consists of carbon derived from carbonates, hydrogen carbonates and dissolved carbon 
dioxide. 

Defining IC

The IC measured by TOC analysis consists of the carbon contained in carbonates and in 
carbon dioxide dissolved in water.  By acidifying the sample with a small amount of 
hydrochloric acid to obtain a pH less than 3, all carbonates are converted to carbon dioxide 
(CO2) by the following reactions:

Me2CO3 + 2HCl --> CO2 + 2MeCl + H2O

MeHCO3 + HCl --> CO2 + MeCl + H2O

Carbon dioxide and dissolved carbon dioxide in the sample are volatilized by bubbling 
(sparging) air or nitrogen gas that does not contain carbon dioxide through the sample.

Analysis Using the IC Reaction Vessel (H Type Instrument)

The TOC-V IC reactor kit is used to sparge the IC reaction solution (acidified reaction 
liquid) with carrier gas. Sample is injected into the IC reaction vessel and the IC in the 
sample is converted to carbon dioxide, which is volatilized by the sparging process and 
detected by the NDIR. 

Analysis Within the Syringe (N Type Instrument)

The sample is acidified to pH 3 or lower in the syringe, using hydrochloric acid. The 
sample is sparged with carrier gas and the IC in the sample is converted to carbon dioxide 
and detected by the NDIR.
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6.1.3  Principles of NPOC (Non-Purgeable Organic Carbon) Analysis

After acidifying the sample to pH 2 to 3, sparge gas is bubbled through the sample to 
eliminate the IC component. The remaining TC is measured to determine total organic 
carbon, and the result is generally referred to as TOC. However, in the TOC-V, this analysis 
value is referred to NPOC to distinguish it from the TOC value obtained by calculating the 
difference between TC and IC. NPOC stands for non-purgeable organic carbon and refers 
to organic carbon that is present in a sample in a non-volatile form. 

NPOC and TOC (obtained by IC elimination) described in the TOC-related standard 
methods and referred to in water quality-related test methods (JIS, ASTM, EPA, EN) are 
identical. Purgeable organic substances in the sample can be lost during the sparging 
process. Consequently, when the sample contains purgeable organic substances, TOC 
should not be measured by the NPOC method. If the dissolved purgeable organic 
component in the water sample is large, the amount volatilized during sparging is relatively 
small. Generally, the amount of purgeable organic substances in natural environmental, 
public and purified water is small; as a result, NPOC can be referred to as TOC. 

Table 6.1 • Residual Rate of Volatile Organic Substances using Sparging (Nitrogen Gas)

Organic Substance Pre-Sparging Conc. 
(ppm)

Post-Sparging Conc. 
(ppm)

Residual Rate (%)

Methanol 117. 5 116 98.6

Ethanol 106.5 105 98.5

Isopropyl alcohol 129 127 98.5

n-butyl alcohol 117 115 98.3

Acetone 106 101 95.3

Acetaldehyde 130 117 90.0

Ethyl acetate 102 88 86.3

Tyrosine 117 116.5 99.5

Benzene 85 2.5 2.9

Cyclohexane 79 2 2.5
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6.1.4  Principles of POC (Purgeable Organic Carbon) Analysis

POC analysis is used to measure the volatilized component of TOC, which is produced 
during the NPOC sample sparging process.  As a result, NPOC+POC is equivalent to TOC. 
POC analysis is performed as follows.

Sparge gas containing the volatilized CO2 and POC components of the sample is carried to 
the lithium hydroxide-filled CO2 absorber to eliminate the CO2 that was converted from the 
IC in the sample. The gas, which now contains only the POC component of the sample, 
then passes through the combustion tube to be oxidized. The POC component is converted 
to CO2 during oxidation and the CO2 is detected by the NDIR. Data processing is 
conducted in the same manner as for TC.

POC is not precisely defined. Factors that determine whether or not, or to what degree, a 
volatile organic carbon component is volatilized during sparging include the type of 
organic compound, the gas/liquid contact with the sparge gas, and the ambient temperature 
during sparging. The target of POC analysis is the organic component present in the 
aqueous phase. As a result, organic compounds that are highly soluble in water (such as 
methanol or ethanol) and not easily volatilized by sparging produce almost no peaks in 
POC analysis.

Organic compounds with low solubility in water (such as methylene chloride or 
chloroform) produce sharp peaks in POC analysis. Over a long period of time, compounds 
such as acetone and methyl isobutyl ketone generate extremely broad, tailing peaks with no 
specific end time. 

The lithium hydroxide-filled CO2 absorber eliminates the carbon dioxide that was 
generated along with the POC substances. Therefore, POC components that are easily 
caught in the CO2 absorber (such as esters) produce low values in POC analysis. POC 
results obtained using this technique are not absolute. The user should take all the above 
factors into consideration when measuring POC using this instrument.
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6.1.5  Principles of Measuring TOC

TOC can be measured using the following 3 methods:

• TC-IC Method 

• NPOC Method

• POC+NPOC Method

TC-IC Method

In the TC-IC method, TOC is measured as the difference between the TC and IC analysis 
values. The TC-IC method is not recommended for samples that contain more IC than TOC 
(samples where TC consists almost entirely of IC); the NPOC method is recommended for 
such samples. The TOC value determined using the TC-IC method includes errors 
associated with each of the individual TC and IC measurements, and can therefore result in 
a large error in the TOC value.

Because detection accuracy decreases with increasing IC concentration, the NPOC method 
is also recommended for samples containing IC concentrations exceeding 10ppm for TOC/
TN catalyst and 5ppm for high sensitivity catalyst.

NPOC Method

The NPOC method is the most widely used TOC analysis method.  The NPOC method is 
not recommended for samples that foam during sparging.  Samples that become foamy 
during sparging tend to form bubbles that flow out of the syringe, which removes the 
concentrated TOC sample components and leaves a small amount of TOC in the syringe. 
The TC-IC method is recommend in this situation.

POC+NPOC Method

The POC+NPOC method should be used when the amount of POC present in the sample 
cannot be disregarded.

6.1.6  Principles of Measuring TN (Total Nitrogen) 

When a sample is introduced into the combustion tube (furnace temperature 720°C), the 
TN in the sample decomposes to nitrogen monoxide. Nitrogen gas does not become 
nitrogen monoxide under these circumstances. The carrier gas, which contains the nitrogen 
monoxide, is cooled and dehumidified by the electronic dehumidifier. The gas then enters a 
chemiluminescence gas analyzer, where the nitrogen monoxide is detected. The detection 
signal from the chemiluminescence gas analyzer generates a peak and the TN concentration 
in the sample can then be measured. 

Note: TN Detection Rate

In TN analysis, the state (crystalline state) in which TN exists in the sample 
greatly affects the TN detection rate. Nitrogen contained in nitrates, nitrites, 
ammonia and the majority of other organic nitrogen compounds exhibit high 
detection rates. Conversely, some organic nitrogen-containing compounds (such 
as hydrazines, pyrazolones, and azide compounds) have detection rates ranging 
from 10% to 60%, depending on the concentration. 
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6.2  Analysis-Related Technical Information

6.2.1  Peak Area Analysis

When a sample is analyzed, the TOC-Control V software automatically detects the 
beginning and end of each peak produced, and calculates the peak areas.  Detection of the 
beginning and end of each peak is based on the slope of the tangent, which changes from 
moment to moment.  Peak detection begins when that slope exceeds a predetermined value 
and ends when a negative slope falls below a specified value. 

Note: • Separated Peaks:  In TC analysis, multiple peaks may occur when a large
quantity of sample is injected.  Only the end of the last peak is detected.  The
total area of the multiple peaks is calculated. 

• Baseline Correction:  Baseline correction is performed for peaks produced 
with fluctuating baseline to obtain the correct peak area.

Figure 6.1  Determining Peak Area

6.2.2  Peak Shape

Multiple peaks are especially prominent when using the high sensitivity catalyst with 
sample injections greater than 100µL. As sample is injected onto the catalyst, the easily 
volatilized organic substances and the crystalline organic substances are combusted at 
different rates. As a result, carbon dioxide is generated multiple times, resulting in the 
formation of multiple peaks. Easily volatilized organic substances are organic compounds 
that are volatilized with water when an aqueous solution of the compounds is heated; 
ethanol is one example of such a compound. Crystalline organic compounds remain in a 
solid form following the heating of an aqueous solution of the compound; glucose is one 
example of such a compound. 

The manner in which the sample is injected also has an effect on peak shape.  If a portion of 
the sample is injected into the center of the combustion tube while another portion is 
injected at the periphery, combustion may occur at different times, resulting in multiple 
peaks.

Peak shape does not affect the analysis results. Even if multiple peaks occur due to the type 
of organic substance or injection manner described above, the TOC-Control V calculates 
the total area of the peaks generated to determine the TOC (or TC) accordingly. 
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6.2.3  Calibration Curves 

6.2.3.1  Types of Calibration Curves

1-Point and 2-Point Calibration Curves

The output signals of the TOC-V are linearized. As a result, there are almost no factors in 
the reaction systems of the TC/TN combustion and IC reaction components that might 
cause the concentration-output characteristic to deviate from linearity. Consequently, 
calibration curves are commonly generated as 1-point curves consisting of 1 span point, or 
2-point curves consisting of 1 span point and the zero point. 

The concentration of TC and IC, or of TN, varies with standard solutions prepared with 
pure water. A calibration curve generated using concentrations greater than 50 - 100mg/L 
will pass very close to the zero point. In this case, it is practical to generate a 1-point 
calibration curve.

Use a 2-point calibration curve when the concentration of TC and IC or TN in the pure 
water used to prepare the standard solutions cannot be disregarded with respect to the 
standard solution concentration. For information on handling of this type of curve, refer to 
Section 6.2.3.2 "Shifting of Calibration Curves".

Multi-Point Calibration Curves

Calibration curves can be generated using up to 10 points.  Calibration curves consisting of 
3 or more points can be generated as a point-to-point curve or as a regression line using the 
least squares method.  With the least squares regression curve, a correlation coefficient is 
displayed. 

6.2.3.2  Shifting of Calibration Curves

Shift to Origin

The “shift to origin” function is used when the amount of TC and IC or TN in the pure 
water used for standard solution preparation cannot be ignored with respect to the standard 
solution concentration. A correction must be made by shifting the calibration curve in a 
parallel fashion so that it passes through the origin. This corrects for the TC and IC or TN 
concentration in the water used for standard solution preparation. An example of a situation 
in which the “shift to origin” function is useful is described below.

When water containing 0.5mg/L TC is used to prepare a 10mg/L TC standard solution, the 
actual TC concentration in the standard solution will be 10.5mg/L (0.5mg/L from the water 
+ 10mg/L from the standard solution). The 2-point calibration curve generated using such a 
solution is shown by the solid line in Figure 6.2 "Shifting of Calibration Curve". If this 
curve is used without correction, the sample analysis values will always be 0.5mg/L less 
than the true value. By shifting the calibration curve so that it passes through the origin, as 
shown by the broken line in Figure 6.2 "Shifting of Calibration Curve", the calibration 
curve is effectively corrected. 
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A system blank is water that contains absolutely no carbon (zero water). When 
measurement of a system blank produces a peak, the TC concentrations measured in 
samples will be biased high by the amount of TC in the system blank. In most cases (with 
the exception of high sensitivity analysis), this bias is not significant. Measurement error 
resulting from the TC or TN content in the water used to prepare standard solutions is 
typically much greater than measurement error resulting from the system blank value. 
Correcting the calibration curve based on the TC or TN content in the standard solution 
preparation water will produce satisfactory analyses. Using this correction method, the 
value obtained for a system blank would be greater than zero by the amount of the blank 
value.

The instrument allows shifting of calibration curves only to the extent of the system blank 
value. The system blank peak height varies with such factors as the system configuration 
and the type of catalyst used. 

Shift to Blank Point

The “shift to blank point” procedure is performed for high sensitivity analyses when the 
system blank value could have a significant effect on the measurement value. 

By selecting the “shift to blank point” option, a TC blank check analysis is performed using 
the same injection volume that will be used for sample measurement.  The calibration curve 
zero point is shifted to the TC blank check value. 

Figure 6.2  Shifting of Calibration Curve
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6.2.4  Sparging During Standard Solution Analysis 

Standard solutions that have TC concentrations so low as to be affected by the amount of 
dissolved carbon dioxide in the solution should be sparged with carrier gas prior to 
measurement. Sparging eliminates the dissolved carbon dioxide, thereby preventing it from 
affecting the concentration of the standard solution. 

The amount of dissolved carbon dioxide in water used for standard solution preparation is 
affected by factors such as water purification method, length and condition of storage, and 
the concentration of carbon dioxide in the atmosphere. Concentrations of dissolved carbon 
dioxide increase when the water is exposed to the atmosphere during the standard solution 
preparation process. Refer to “Table 6.2 • CO2 Content (ppm) in Distilled Water 
Equilibrated with Atmosphere Temperature (°C)” for the dissolution rates of atmospheric 
carbon dioxide in water. 

It is important to consider both the concentration of the standard solution and the 
concentration of TOC contained in the preparation water when deciding whether to use the 
sparging function.  Use of sparging is appropriate if the TOC contained in the water is low 
enough to not substantially affect the standard solution concentration, but not low enough 
to be ignored. 

Note: Do not use sparging with IC standard solutions, as sparging decreases the IC con-
centration. 

The above CO2 content can be converted to IC using the following equation. 
IC (ppm) = CO2 (mg/L) x 0.27

6.2.5  Automatic Selection of Optimum Calibration Curve

Up to three different calibration curves can be selected for use in a method. The curves are 
specified in the “Calibration Curve 1”, “Calibration Curve 2” and “Calibration Curve 3” 
fields on page 3 of the Method Wizard when the method is being created. Refer to Section 
4.4.2.3 "Method Wizard" for more information. When more than one calibration curve is 
specified, the TOC-Control V software automatically selects the optimum calibration curve 
to be used for calculating measurement results. 

Table 6.2 • CO2 Content (ppm) in Distilled Water Equilibrated with Atmosphere 
Temperature (°C)

Atmospheric CO2 
(vol%)

0 5 10 15 20 25 30

0.030 1.00 0.83 0.79 0.59 0.51 0.44 0.38

0.033 1.10 0.91 0.76 0.65 0.56 0.48 0.42

0.044 1.47 1.22 1.02 0.87 0.74 0.64 0.56
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The automatic selection process occurs on a measurement-by-measurement basis. 
Measurement values are always calculated first using Calibration Curve 1. The TOC-
Control V software then evaluates the result, applies the optimum calibration curve, and 
recalculates the value if necessary. The calibration curve with a concentration range that is 
greater than and closest to the measured value is used. Examples are shown below:

(1) If the measured value is less than the concentration of Calibration Curve 1 and greater 
than the concentration of Calibration Curve 2 and Calibration Curve 3, Calibration 
Curve 1 is used. 
Conc. of Calibration Curve 1 > Measured Value > Conc. of Calibration Curves 2 and 3 → 

Calibration Curve 1 is used

(2) If the measured value is less than the concentrations of Calibration Curve 1 and 
Calibration Curve 2, and if the concentration of Calibration Curve 2 is less than that of 
Calibration Curve 1, Calibration Curve 2 is used.
Conc. of Calibration Curve 1 > Conc. of Calibration Curve 2 > Measured Value → 

Calibration Curve 2 is used

(3) If three calibration curves are specified, the calibration curve that is greater than and 
closest to the measured value is used.
Conc. of Calibration Curve 1 > Conc. of Calibration Curve 3 > Measured Value > Conc. of Calibration 
Curve 2 → 

Calibration Curve 3 is used

(4) If the measured value is greater than the concentration of all curves and the 
concentration of Calibration Curve 1 is greater than the concentration of Calibration 
Curves 2 and 3, Calibration Curve 1 is used.
Measured Value > Conc. of Calibration Curve 1 > Conc. of Calibration Curve 2 > Conc. of Calibration 
Curve 3 → 

Calibration Curve 1 is used

Note: By setting the concentration ratio between calibration curves to a factor of
approximately 10, the automatic selection function can be effectively utilized for
analyses covering a wide range of concentrations. For example, use a concentra-
tion of 10ppm for Calibration Curve 1, 100ppm for Calibration Curve 2, and
1000ppm for Calibration Curve 3.

Considerations for the Automatic Selection Function 

• The automatic selection process rules do not change when multi-point calibration 
curves are included. 

• When more than one injection is performed, the calibration curve is selected based 
on the measured value of the first injection. 

• Because the measured value is always calculated first using Calibration Curve 1, 
specify the most commonly used calibration curve in this field.

• The priority of the second and third calibration curves is determined based on the 
calibration curve concentrations and the sample concentration. 
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6.3  Specifications 

6.3.1  TOC-VCPH/CPN

Analyte TC, IC, TOC (TC-IC), NPOC

Measurement principle 680°C catalytically-aided combustion oxidation/non-dispersive 
infrared detection (NDIR)

Measuring range TC: 0 - 25000mg/L
IC:

• TOC-VCPH: 0 - 30000mg/L
• TOC-VCPN: 0 - 3000mg/L

Detection limits TC: 
• TOC-VCPH: 4µg/L
• TOC-VCPN: TC: 50µg/L

IC: 4µg/L

Measurement time TC: Approx. 3min
IC: 

• TOC-VCPH: Approx. 3min
• TOC-VCPN: Approx. 4min

Repeatability CV within 1.5% 

Sample introduction Auto injection using syringe pump/slider

Sample injection volume 10 - 2000µL (variable)

Sample dilution function Dilution within syringe, dilution factor 2 - 50 times

Pretreatment for IC Automatic acid addition and sparging

Carrier gas High purity air (from cylinder)

Carrier gas pressure Approx. 300 - 600kPa

Carrier gas flow rate TOC-VCPH: 150mL/min (230mL/min when performing in-syringe 
sparging)
TOC-VCPN: 230mL/min

Ambient temperature 5 - 35°C

Power requirements AC 100-120V ±10% or AC 220-240V ±10%, 6 A, 50/60Hz (power 
consumption: approx. 230VA)

Fuse 8A.T (100V Systems) 15A.T (200V Systems)

Approximate dimensions (W) 440 x (D) 560 x (H) 460mm (excluding projections)

Weight Approx. 40kg
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6.3.2  ASI-V

6.3.3  OCT-1 8-Port Sampler

6.3.4  TNM-1 

Sample containers 24mL vial rack: 24mL (External diameter 23 x Height 85mm), 100 
vials, 100 septum-equipped caps
40mL vial rack: 40mL (External diameter 27 x Height 9mm), 72 
vials, 72 septum-equipped caps

Vial rack capacity 24mL vial rack: 93nvials

40mL vial rack: 68 vials

Sample pretreatment • Acid addition and sparging possible for NPOC analysis
• Needle rinse possible
• Stirring with magnetic stirrer (with optional magnetic stirrer)

Ambient temperature 5 - 35°C

Approximate dimensions (W) 370 x (D) 540 x (H) 490mm (excluding projections)

Weight Approx. 13kg

No. of sample containers 
accommodated

8 containers

16 containers (using 2 OCT-1 units)

Ambient temperature 5 - 35° C

External dimensions Approx. (W) 245 x (D) 245 x (H) 440mm (excluding protruding 
parts)

Weight Approx. 3.5 kg

Analyte TN (total nitrogen)

Measurement principle Thermal decomposition / NO detection (chemiluminescence 
method)

Measuring range 0 - 4000mg/L

Measurement time Approx. 4min

Repeatability CV within 3% 

Ambient temperature 5 - 35°C

Power requirements AC 100-120V ±10% or AC 220-240V ±10%, 6 A, 50/60Hz (power 
consumption: approx. 230VA)

Approximate dimensions (W) 160 x (D) 235 x (H) 400mm (excluding projections)

Weight Approx. 8kg
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6.3.5  POC Kit 

6.3.6  Carrier Gas Purifier Kit

6.3.7  Manual Injection Kit (Gas Sample Injection Kit)

Analyte POC 

Measurement method Sparging / CO2 removal / combustion oxidation

CO2 removal method Absorption via lithium hydroxide, removal

Measuring range 0 - 500mg/L

Measurement time Approx. 4min

Repeatability CV within 5% 

Gas purification method Combustion oxidation / CO2 removal

Carrier gas supply Pressurized air or oxygen (free of dust, oil mist, water droplets, etc.)

Carrier gas supply pressure 300 - 600kPa

Analyte Liquid samples: TC, IC, TOC (TC-IC)
Gas samples: TC, carbon dioxide, TOC (determined by TC-carbon dioxide; 
Carbon monoxide and other inorganic carbon containing gases aside from 
carbon dioxide are also measured as TOC)
Measurement of IC, TOC and carbon dioxide is possible with the TOC-VCPH

Measurement principle 680°C catalytically-aided combustion oxidation/non-dispersive infrared 
detection (NDIR)

Measuring range Liquid sample: 
• TC: 0 - 20000mg/L
• IC: 0 - 20000mg/L

Gas sample: 
6ppm - 100% CO2

Sample injection volume Liquid sample: 1 - 150µL
Gas sample: 20µL - 10mL

Measuring time Liquid sample:
• TC: Approx. 3min
• IC: Approx. 3min

Gas sample: 2 - 4min

Repeatability Liquid sample: CV within 2% (CV is within 3% when sample concentration 
is 8000mg/L or greater)
Gas sample: CV within 2% 

Sample introduction Manual injection using microsyringe
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6.3.8  PC Hardware Requirements

PC IBM-PC/AT or compatible, with 9-pin RS-232C connector

CPU 233MHz or better

Memory 32 MB or greater

Hard drive 2 GB or greater

OS Windows95, Windows98, Windows2000, WindowsNT 4.0 (SP3 or
later), WindowsXP (*For compliance with FDA 21 CFR Part 11, use
Windows2000) 
The User Authentication function cannot be used with WindowsXP.

Monitor resolution 800 x 600 or better, 1024 x 768 suggested
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6.4  Standard Accessories 

Table 6.3 • Standard Accessories List 1 (TOC-VCPH/CPN)

Part Number Part Name TOC-VCPH TOC-VCPN

638-41323 Combustion tube, in case 2 1

638-92069-02 TOC regular catalyst set 1 1

638-92070-01 TOC high sensitivity catalyst set 1 -

638-16023 Catalyst filling rod 1 1

630-00999 CO2 absorber 1 1

630-00315-09 Plastic tube 9mm ID x 12mm OD 2m 2m

071-60813 Adapter, ground 1 1

071-60814-01 Power cord set (100-127V) 1 1

071-60814-06 Power cord set (220-240V) 1 1

638-59213-01 Plunger tip 1 1

630-00635-01 Potassium biphthalate, 2g 1 1

630-00962-01 Sodium carbonate, 25g 1 1

638-59213 Syringe 1 1

017-30812-01 Silicone grease 1 1

072-60359-01 Wiring band 2 2

630-00963-01 Sodium bicarbonate, 25g 1 1

072-02004-25 Fuse, 218 008 (100-127V) 2 2

072-02004-27 Fuse, 218 015 (220-240V) 2 2

631-20265 Plug, 35154 1 1

631-78002 Wrench, for 8-port valve 1 1

638-52337 Rinse water bottle 1 1

638-20072 Cap 1 -

638-60074 Ceramic fibers 1 1

638-64727 CD-ROM “TOC-Control V” 1 1

638-74029 Cable, (RS-232C) 1 1

631-81214 Plate, for CO2 absorber 1 1

035-55026-02 Half union 1 1

038-00292-04 Plastic bottle 2 1

638-94241 Instruction manual 1 1
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Table 6.4 • Standard Accessories List 2 (ASI Unit)

Part Number Part Name 24mL 40mL
638-41462 Vials, 24mL 100

038-00165-21 Vials, 40mL (with cap, septum) 72

638-20074-01 Cap, 24mL 100

038-00165-48 Septum, 24mL 100

638-52337 Rinse water bottle 1 1

072-60310-03 Wiring band, TM-53M 2 2

631-51869-20 Name plate, SAMPLE 1 1

631-51869-21 Name plate, GAS 1 1

072-60301 Wiring band, Nylon TY-23M 1 1

638-74027 Cable ASSY, ASI, signal 1 1

638-41448-01 Needle, regular type 24, 40 1 1
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* Flanged tubing in C sets have an inner diameter of 1.0 mm. This set is provided for use
with the combustion type TOC-V.

** Connect this tubing to the common (COM) port of the 8-Port Sampler and port No. 2 on
the TOC-V unit.

*** Flanged tubing in W sets have an inner diameter of 1.5 mm. This set is provided for use
with the wet chemical type TOC-V.

**** Connect this tubing to the common (COM) port of the 8-Port Sampler and port 1on the
TOC-V unit.

Table 6.5 • Standard Accessories List 3 (OCT-1 8-Port Sampler) 

Part Number Part Name 8-Port 
Sampler 1

8-Port 
Sampler 2

Details

631-20265 Plug 35154 1 1 Rotor (for replacement 
maintenance)

638-41443-03 Common Tubing C 1 Common port connection 
tubing**

638-41443-04 Additional Common 
Tubing C2

1 Common port connection 
tubing****

638-41443-05 Common Tubing W 1 Common port connection 
tubing**

638-41443-06 Additional Common 
Tubing W2

1 Common port connection 
tubing****

638-41337-03 Flanged Tubing C* 1 1 Sample tubing for combustion 
analyzers (CSH/CSN/CPH/
CPN)

631-41660 Flanged Tubing W*** 1 1 Sample tubing for wet 
chemical analyzers (WS/WP)

638-74004-01 Power Cable 1 Cable for connection to the 
main unit

638-74028-01 Power Cable 1 Cable for connection to the 
main unit

638-74028-02 Power/Signal Cable 1 Cable for connecting 8-Port 
Sampler 1 to 8-Port Sampler 2

M393-E228 User Manual 1
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Table 6.6 •  Standard Accessories List 4 (TN Unit)

Part Number Part Name Qty
630-00999 CO2 absorber 1

638-60074 Ceramic fibers 1

017-40533-01 Potassium nitrate 1

072-02004-19 Fuse, 218  002 1

020-46547 SS screw pan head M 4 x 8 5

631-81157 Mounting plate TNM 1

072-60301 Wiring band, TY-23M 5

630-00315-05 Plastic tubing 5mm ID x 7mm OD 5m

631-41200-02 Viton tubing 5mm ID x 8mm OD 0.45

638-52353-03 Ozone treatment unit ASSY 1

035-60690-97 Tee 2

016-43284-01 Tube 0.1m

072-60338-03 Clip 2

638-42035 Capillary 1

071-60813 Adapter 1

071-60814-01 Power cord set (100-127V) 1

071-60814-06 Power cord set (220-240V) 1

Table 6.7 • Standard Accessories List 5 (Manual [Gas Sample] Injection Kit)

Part Number Part Name Qty
638-10194 Block, M-INJ TC ASSY 1

638-10195 Block, M-INJ IC ASSY 1

631-43291 Syringe packing 10

Table 6.8 • Standard Accessories List 6 (POC Measurement Kit)

Part Number Part Name Qty
630-00557 Quartz wool 1
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Table 6.9 • Standard Accessories List 7 (Carrier Gas Purifier Kit)

Part No. Part Name  Qty
638-42013 L-shaped combustion tube (in case) 1

638-60116 TOC regular catalyst 1

630-00557 Quartz wool 1

638-52578-01 CO2 absorber container 1

630-00556 Soda lime 1

638-40168 Compression fitting, elbow 4

016-37504 Teflon tube (3×4) 2.9m

040-82074-03 Filter 1

035-65104 Union 2

016-43284-01 Nylon tube 0.1m
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6.5  Special Accessories 

Table 6.10 • Special Accessories List

Part Number Part Name CommentComment
638-93141-04 Autosampler ASI-V (24mL) 24mL vials

638-93141-08 Autosampler ASI-V (40mL) 40mL vials

638-93150-01 8-Port sampler OCT-1 For TOC-VCPH/CPN/CSH/CSN

638-93150-11 8-Port sampler OCT-2     (second 
unit)

For TOC-VCPH/CPN/CSH/CSN

638-91065-01 TN unit TNM-1 For AC 100-127V

638-91065-02 TN unit TNM-1 For AC 220-240V

638-91066 POC measurement kit

638-72596 Option wiring kit Required to install the POC kit or 
external sparge kit for the TOC-VCPH

638-41447 Carrier gas purifier kit

638-77152 External sparge kit

638-93149-03 Manual injection kit

638-41460 Suspended solids kit (when used 
with TOC-V alone)

638-93151 Suspended Solids Kit (when 
autosampler is used)

638-53044-01 Sample rack and vial sets for 
24mL sample vials

24mL sample rack
24mL sample vials
Vial caps
Septa

638-53044-02 Sample rack and vial sets for 
40mL sample vials

40mL sample rack
40mL sample vials
Vial caps
Septa

638-67075 Stirrer (for 24mL vials) For autosampler 24mL vials

638-67076 Stirrer (for 40mL vials) For autosampler 40mL vials

046-00617-02 Stirrer bar (for 24mL vials) Stirrer bar for 24mL vials, 1 required for 
sample measurement

046-00617-03 Stirrer bar (for 40mL vials) Stirrer bar for 40mL vials, 1 required for 
sample measurement

630-00960 High purity air cylinder Recommended that user provide this 
item.

630-08585-05 Cylinder pressure regulator User can provide this item.

638-41204 Air supply tubing set (with 20 
meters of tubing) 

User can provide this item.

630-02525-01 High speed homogenizer

638-52344 Drain bottle (for ASI)
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6.6  Consumable Parts List 

Table 6.11 • Consumable Parts List 1 (TOC-VCPH)

Part Number Part Name Comment
638-41323 Combustion tube, in case

638-60116 TOC regular catalyst

630-00105-01 Platinum mesh To support catalyst, 2 
included

630-00557 Quartz wool To support catalyst, 1g 

630-00996 TOC high sensitivity catalyst

638-41308-01 Cooling coil

630-00999 CO2 absorber

630-00992 Halogen scrubber

036-11209-84 O-ring, 4D P 10A For slider, 5pcs.

036-11408-84 O-ring, Teflon P10 For slider, 5pcs.

036-11222-84 O-ring, 4D P22 For IC reaction tube, 5pcs.

036-11219-84 O-ring, 4D P20 For TC reaction tube, 5pcs.

035-62994-03 Sleeve set 6F-T

042-00405-11 IC reaction solution supply 
pump head

630-00635-01 Potassium biphthalate, 25 g

630-00962-01 Sodium carbonate, 25 g

630-00963-01 Sodium bicarbonate, 25 g

046-00044-11 Membrane filter

017-30812-01 Silicone grease, H.V.G.

630-08913-01 Chart paper 10 rolls

638-60074 Ceramic fibers

631-20265 8-port valve rotor

638-59213-01 Plunger tip

638-92206-01 Consumables set Refer to Table 6.13 for 
contents
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Table 6.12 • Consumable Parts List 2 (TOC-VCPN)

Part Number Part Name Comment
638-41323 Combustion tube, in case

638-60116 TOC regular catalyst

630-00105-01 Platinum mesh To support catalyst, 2 
included

630-00557 Quartz wool To support catalyst, 1g 

630-00999 CO2 absorber Contains 500mL

630-00992 Halogen scrubber

036-11209-84 O-ring, 4D P 10A For slider, 5pcs.

036-11408-84 O-ring, Teflon P10 For slider, 5pcs.

036-11219-84 O-ring, 4D P20 For TC reaction tube, 5pcs.

630-00635-01 Potassium biphthalate, 25 g

630-00962-01 Sodium carbonate, 25 g

630-00963-01 Sodium bicarbonate, 25 g

046-00044-11 Membrane filter

017-30812-01 Silicone grease, H.V.G.

638-60074 Ceramic fibers

631-20265 8-port valve rotor

638-59213-01 Plunger tip

638-92206-02 Consumables set Refer to Table 6.13 for 
contents
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Table 6.13 • Consumable Parts List 3 (TOC-VCPH/CPN)

Part No. Description Qty Remark

TOC-
VCPH

TOC-
VCPN

638-41323 Combustion tube (in case) 2 2

638-60116 TOC regular catalyst 2 2

630-00996 TOC high sensitive catalyst 1 0

630-00557 Quartz wool 1 1

630-00999 CO2 absorber 1 1

630-00992 Halogen scrubber 2 2

036-11209-84 O-ring, 4D P 10A 1 1  5 pcs

036-11408-84 O-ring, Teflon P10 1 1  5 pcs

036-11219-84 O-ring, 4DP 20 1 1  5 pcs

630-00635-01 Potassium hydrogen 
phthalate, 25g

1 1

630-00962-01 Sodium carbonate,25g 1 1

630-00963-01 Sodium bicarbonate, 25g 1 1

638-60074 Ceramic fiber 1 1

042-00405-11 IC reagent supply pump head 1 0

631-20265 8-port valve rotor 1 1

638-59213-01 Plunger tip 2 2

Table 6.14 • Consumable Parts List 4 (ASI-V)

Part Number Part Name Comment
038-00165-21 Vial set 40mL, 72 vials, septa and 

caps

638-41462 Vial 24mL, 100pcs

038-00165-48 Septum 24mL, 100pcs.

038-00165-50 Septum 40mL, 100pcs.

638-20074-01 Cap 24mL, 100pcs.

038-00165-40 Cap 40mL, 200pcs.

042-00405-11 Rinse pump head

Table 6.15 • Consumable Parts List 5 (8-Port Sampler OCT-1)

Part Number Part Name Comment
631-20265 8-Port valve rotor
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Table 6.16 • Consumable Parts List 6 (TNM-1)

Part Number Part Name Comment
638-65232 Ozone treatment - catalyst 300g included

638-71162 Ozone treatment unit ASSY

631-43818 Reactor packing 

631-40316 Viton joint, reactor outlet

036-19004-19 O-ring, Ozone treatment unit 1pc.

017-40533-01 Potassium nitrate, 25 g

Table 6.17 • Consumable Parts List 7 (Carrier Gas Purifier Kit)

Part Number Part Name Comment
638-42013 L-shaped combustion tube, 

in case

630-00556 Soda lime Carrier gas purifier kit, 500g 
included

638-60116 TOC regular catalyst
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6.7  Maintenance Parts List

Table 6.18 • Maintenance Parts List 1 (TOC-VCPH)

Part Number Part Name Comment
638-56135 8-port valve

638-59213 Syringe

638-41337-03 Flared tubing

631-41660 Flared tubing, for dilution 
water

638-65383 Tandem cell (in case)

Table 6.19 • Maintenance Parts List 2 (TOC-VCPN)

Part Number Part Name Comment
638-56135 8-port valve

638-59213 Syringe

638-41337-03 Flared tubing

631-41660 Flared tubing, for dilution 
water

638-65383 Tandem cell (in case)

Table 6.20 • Maintenance Parts List 3 (ASI-V)

Part Number Part Name Comment
638-41472-01 Needle, sampling For 24mL and 40mL, 1pc.

638-41448-01 Needle, sparging For 24mL and 40mL, 1pc.

638-41449-01 Needle, simultaneous sparge 
type

For 24mL, 40mL, 1pc.

638-41450-01 Needle, suspended solids kit, 
0.8mm

For 24mL, 40mL, 1pc.

638-42029-04 Tubing set (sampling) 1 sampling tube, with 
retainer and tube seal

638-42029-05 Tubing set (sparge) 1 sparge tube, with retainer 
and tube seal

638-42029-03 Tubing set (sampling + 
sparge for simultaneous 
sparge)

1 each of sampling and 
sparge tube for simultaneous 
sparging, with retainers and 
tube seals
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Table 6.21 • Maintenance Parts List 4 (OCT-1 8-Port Sampler)

Part Number Part Name Comment
631-20265 8-port valve rotor Spare rotor

638-41337-03 Flared tubing C Sampling tube; for 
combustion type TOC-V

638-41443-03 Common tubing C Main unit - OCT-1 
connection tube; for 
combustion TOC-V, 1 unit

638-41443-04 Common tubing C2 Main unit - OCT-1 
connection tube;   for 
combustion TOC-V, add-on

Table 6.22 • Maintenance Parts List 5 (Manual Injection Kit)

Part Number Part Name Comment
630-00261 Open / Close valve, TC 

injection port

638-60733-01 Microsyringe, MANU10 10µL

638-60733-02 Microsyringe, MANU25 25µL

638-60733-03 Microsyringe, MANU50 50µL

638-60733-04 Microsyringe, MANU100 100µL

638-60733-05 Microsyringe, MANU250 250µL

638-60733-06 Microsyringe, MANU500 500µL



6.8     Installation
6.8.1     Before Installation

310 TOC-VCPH/CPN

6.8  Installation 

6.8.1  Before Installation 

Parts Inspection 

Confirm that all of the components listed in Section 6.4 "Standard Accessories" have been 
included in the shipping package. 

6.8.2  Installation Site

Be sure to take into account the size of the instrument, how it will be used, and the 
installation conditions indicated below when selecting an installation site. Instrument 
damage or measurement errors may occur based on the conditions of the installation site. 

6.8.2.1  Installation Site Selection 

The instrument is designed for use on a desk or bench. 

The external dimensions of the instrument are shown in Figure 6.3 "External Dimensions 
of Instrument with ASI-V". A space of at least 200mm is required on either side of and 
behind the instrument to enable unhindered operation and maintenance. 

Figure 6.3  External Dimensions of Instrument with ASI-V

TOC-V Main Unit

Autosampler TOC-V Main Unit    TN Unit

63
5m

m

370mm
100

440mm 160mmmm
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Figure 6.4  External Dimensions of Instrument with OCT-1 8-Port Sampler

CAUTION
When lifting the instrument, lift from the bottom and at both sides of the
instrument. 
Do not lift the instrument by the front access door, as this may cause damage. 

6.8.2.2  Installation Site Conditions 

Select an installation site with the following conditions: 

• A clean environment free of corrosive gases, organic gases, and dusts. 
Note: Contamination in the atmosphere will cause analysis errors, especially for high

sensitivity analyses. 

• A strong, level bench, free of vibration and shock. 
• A location with a stable ambient temperature. 
• A location with access to a completely grounded, stable power supply. 

CAUTION
Avoid locations where flames are prohibited. Some internal parts reach high
temperatures and could cause a fire hazard.

Avoid the following kinds of locations: 

• Locations close to heat sources, windows in direct sunlight, or in direct contact with 
drafts from air conditioning vents. 

• Near equipment that generates intense magnetic fields, electrical fields, or high 
frequency waves. 
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6.8.3  Installation Procedure

6.8.3.1  Connecting Power Supply and Ground 

Connecting Power Supply 

Connect the instrument to a stable, AC 100-127V (100V System) or AC 220-240V (200V 
System), 50Hz or 60Hz (single phase) power supply with sufficient capacity to 
accommodate 6A or greater current. 

CAUTION
The instrument may not operate properly if the power supply voltage exceeds
the range of AC100-127V ±10% or AC 220-240V ±10%. Unstable voltage may
cause problems during high sensitivity analysis. 

Note: The instrument is compatible with both 50 Hz and 60 Hz power supplies and can
be used with either frequency. 

Grounding

The included power cord is a three-conductor cable including a ground wire, and a 2P plug 
(with ground) at the end. If the power outlet does not have ground receptacle, use the 
included 2P (no ground) adapter. Connect the external ground terminal to the ground. 

The voltage terminals (AC) and ground terminal (ACC) on the power plug of this 
instrument are arranged as shown in Figure 6.5 "Power Plug". Connect them so that they 
match the power outlet being used. 

Figure 6.5  Power Plug

Voltage terminal (AC) Ground terminal (ACC)

Ground terminal (G)
(Be sure to ground completely.)
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CAUTION

• In addition to the consideration of safety, complete grounding is necessary to
prevent as much as possible the occurrence of signal noise.  A Type-3 ground
(ground resistance: 100W or less, see Electrical Facilities Engineering Standards
for details) is recommended. 

• Perform grounding separately and avoid contact with water supply pipes, gas
pipes, and lightning rods. 

6.8.3.2  Changing the Power Supply Voltage 

The instrument is set up before shipment to match the power supply voltage in the locale 
where it will be used.  In the event that it becomes necessary to change the power supply 
voltage, please contact your Shimadzu representative.  Depending on the voltage change, 
an authorized Shimadzu service engineer may be required to rewire connections to the 
terminal block to change the power supply voltage and/or perform changes to the main 
board. 

6.8.3.3  Connecting Gas 

Use one of the following as the carrier gas supply for this instrument. 

• Cylinders filled with high purity air 
• Compressed air or instrumentation air (Requires special Carrier Gas Purifier Kit 

accessory) 

High Purity Air Cylinders

High purity air is synthetic air manufactured from pure nitrogen and pure oxygen. It must 
be guaranteed to contain less than one 1ppm of each of the following impurities: carbon 
dioxide, carbon monoxide, and hydrocarbons. 

The cylinder must be equipped with a pressure regulator to supply it at 300kPa to the gas 
connection inlet of the instrument. 

Note: If the carrier gas contains excessive impurities, analysis accuracy is diminished
and good results will not be obtained. 
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Precautions for Handling Gas Cylinders 
The handling and safety management of high-pressure gases is strictly regulated
by high-pressure gas control laws, general high-pressure gas safety codes, and
fire laws. 
The gas used in the instrument is not dangerous, but mistakes in handling of
high-pressure gas cylinders can be extremely hazardous. Carefully read and
obey the following precautions. 

• Place gas cylinders in a well-ventilated location out of direct sunlight. 

• Ensure that gas cylinders never reach temperatures higher than 40°C. 

• Make sure there are no open flames anywhere within 2 meters of a gas cylinder. 

• Secure cylinders with bands or other fasteners to prevent tipping and falling. 

• Turn OFF, immediately and completely, all valves on the cylinder, when finished
using gas. 

• Inspect the operation of the pressure gauge at least once every three (3) months. 

Compressed Air or Instrument Air Purified with the Carrier Gas Purification 
Kit

Using the Carrier Gas Purification Kit enables air from a compressor or instrumentation air, 
or high-impurity pressurized air in a cylinder, to be used as the carrier gas. 

Since there are limits to the capabilities of the Carrier Gas Purification Kit, the following 
conditions must be met when supplying compressed air. 

• Provide an air filter in the supply line to remove dust, oil mist, water drops, and other 
contaminants.  Place an air filter in the tubing near the gas connection inlet of the 
instrument when a compressor is used. 

• Select the Oil-less Carrier Gas Purification Kit when a compressor is used. 
• There are cases where the organic gas concentration is too high to be removed 

completely by the gas purifier.  Analysis accuracy is poor in atmospheres containing 
high concentrations of volatile gases from exposed organic solvents and gasoline, or 
high concentrations of automobile and diesel engine exhaust.  If the possibility of the 
presence of these kinds of gases cannot be avoided, use a filter to remove organic 
particles and/or gases. 

Gas Supply Pressure 

Ensure that the gas supplied to the gas inlet of the instrument maintains a constant, stable 
pressure of 300kPa. When using compressed air or instrumentation air, verify that the gas 
supply pressure is greater than 300kPa and less than 600kPa.

Note: Do not allow the carrier gas supply pressure to exceed 600kPa. 

Gas Tubing Connections

The special accessory Air Supply Tubing Set includes nylon tubing and connectors (two [2] 
half unions). 
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Procedure

Figure 6.6  Gas Tubing Connection 

1. Connect the half unions to the carrier gas inlet on the instrument and the connection 
outlet (¼” NPT) of the gas supply source. 

2. Connect the nylon tubing (4mm OD, 2.5mm ID) between the gas supply source and 
the instrument. 
Note: To connect the nylon tubing, firmly insert it into the half union.  To

disconnect the tubing, pull the tubing off while pushing down
firmly on the blue ring of the half union with a screwdriver.

3. Verify that there are no gas leaks. 

CAUTION

• Do not allow acute bends in the tubing. 

• Clean the tubing and connectors to remove any oils or other contaminants on
their inner surfaces. 

• Copper tubing or stainless steel tubing may also be used. 

Half Union

Connection Inlet

Nylon Tubing
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6.8.3.4  Connecting the Drain Tubing 

Drain tubing is connected to provide for external discharge of measured samples and other 
liquid waste. If a nearby drainage pit is not available, use a 10 to 20 liter polypropylene 
container as the drain receptacle. 

Figure 6.7  Connect the Drain Tubing 

The drain tubing from the dehumidifier drain port is located inside the right panel. Connect 
it to the external drain tubing using two of the provided wiring bands so that there are no 
leaks. 

CAUTION

• Drainage occurs on a gravity basis.  Keep resistance to a minimum.  Ensure that
the drain tubing is never higher than the drain discharge port.  Do not allow the
tip of the drain tubing to come in contact with the surface of the liquid in the
container.  If resistance is high, insufficient drainage could cause the drainage liq-
uid to overflow inside the instrument. 

• Corrosive substances such as acids may be present in the drainage liquid. Avoid
touching or spilling these liquids. 
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6.8.3.5  PC Cable Connections

This section describes the procedure for connecting the TOC-V to the PC using the 
supplied RS-232C cable. 

Procedure

1. Insert the supplied RS-232C cable into the RS-232C-1 connector on the back of the 
TOC-V, and tighten the retaining screws on both sides. Figure 2.4 "Rear View"

2. Insert the plug at the other end of the RS-232C cable into the RS-232C connector of 
the PC, and tighten the retaining screws on both sides.

6.8.4  Installing the Autosampler 

This section describes procedures for installing the ASI-V autosampler.

Positioning the Autosampler

The autosampler is placed to the left of the TOC-V, as shown in Figure 6.8 "Installing the 
Autosampler".

Figure 6.8  Installing the Autosampler

Note: Keep the distance between the autosampler and main unit to a minimum to allow
a free range of motion of the autosampler. If the autosampler tubing becomes
stretched taut, it may impede the movement of the autosampler arm, resulting in
operation errors and damage.

Removing the Shipping Screw

The ASI arm is secured with a shipping screw to prevent damage during shipment. Before 
connecting power to the instrument, remove the ASI cover to access the shipping screw, 
which is located on the retaining bracket. Remove the shipping screw and replace the cover. 
Label the shipping screw and store it for future use.
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CAUTION
To prevent instrument damage, verify that the ASI arm is firmly attached to the
retaining bracket with the shipping screw before shipping the instrument or
moving it to another location. 

Connecting Cables

The TOC-V and ASI-V are connected using cables, as described below.

CAUTION
Verify that the TOC-V is switched OFF before performing the following
procedure.

Procedure

1. Connect the ASI-V power cord at the rear of the ASI-V to the ASI-V power connector 
at the rear of the TOC-V.

2. Connect the provided signal cable to the ASI-V signal connectors at the rear of the 
TOC-V and the ASI-V.

Figure 6.9  Connecting the Cables (TOC-V to ASI-V)
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Connecting the Sample Tubing and Sparge Tubing (External Sparge Kit)

The procedure for connecting the ASI-V sample tubing and sparge tubing for the External 
Sparge Kit is as follows.

Procedure

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>ASI Needle Change.

3. Click the Preparation Start button.
The autosampler arm moves to the front of the needle replacement window, allowing 
easy access.  

4. Remove the screw at the lower left side of the needle replacement window, and detach 
the window cover by pulling downward. 

5. Install the tubing clamp.

Figure 6.10   Tubing Installation

6. Install the bushing at the end of the sample tubing to the Number 2 port of the TOC-V 
sample injector 8-port valve.

Needle Replacement Window

Sample Catcher
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7. Draw the sparge tubing out through the joint and connect the sparge tubing.

Figure 6.11  Installing the External Sparge Kit

Note: Do not use the flow controller knob to turn off the sparge gas flow.

Installing the Needle

This section describes installation of the ASI-V needle. There are two types of needles, the 
sample needle (same as the sparge needle) and the coaxial needle, which is a combined 
sample/sparge needle.

When installing the needle, remove the needle replacement window cover. Refer to Figure 
6.11 "Installing the External Sparge Kit", for the removal procedure.

Sparge Tubing 

External Sparge Unit

Sparge Tubing

Sampling NeedleAdvance Sparge
Needle

Sparge Tubing
(External Sparge Kit)

ASI-V Cover

Tubing Installation Label
(External Sparge Kit)

Installation figure using the anvance
sparge needle and the sampling needle. 

(External Sparge Kit)
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Installation Procedure for the Sample Needle and Sparge Needle 

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>ASI Needle Change.

3. Click the Preparation Start button.
The autosampler arm moves to the front of the needle replacement window, allowing 
easy access.  

4. Remove the screw, and then detach the needle holder from the arm.

5. Insert the needle into the opening in the needle holder.

6. Secure the needle by turning the retaining bracket and tightening the screw at the top 
of the needle holder.
Note: There are two openings; the left opening is for the sample tubing

and the right opening is for the sparge tubing.

Figure 6.12  Installing the Needle - 1

7. Securely fit the sample tubing or sparge tubing onto the upper end of the needle.
Note: Verify that the bushing is in position to secure the sample tubing

onto the sample needle.

8. Insert the lower tip of the needle into the needle guide opening, thrusting the needle 
holder into the pin of the arm, and then tighten the screw. 

Sample Needle

Retaining Bracket

Needle Holder
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9. Reinstall the needle replacement window cover, and tighten the screw.

Figure 6.13  Installing the Needle - 2

Installing the Coaxial Needle

1. Open the TOC-Control V Sample Table Editor and connect the instrument.

2. From the Instrument menu, select Maintenance>ASI Needle Change.

3. Click the Preparation Start button.
The autosampler arm moves to the front of the needle replacement window, allowing 
easy access.  

4. Detach the needle holder from the arm.

5. Insert the needle into the opening in the needle holder.

6. Secure the needle by turning the retaining bracket, and tightening the screw at the top 
of the needle holder.

7. Install the provided 3-way joint on the top of the needle.

8. Connect the sample tubing to the top of the 3-way joint, and the sparge tubing to the 
side of the joint.

9. Insert the tip of the needle into the needle guide opening, thrusting the needle holder 
into the pin of the arm, and then tighten the screw. 

10. Reinstall the needle replacement window cover, and tighten the screw at the lower left 
of the cover.
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Installing the Turntable, Vial Rack and Cover

Installing the Turntable

1. Place the turntable on the ASI-V.
Note: There is no distinction between front and rear of the turntable, so

placement orientation is irrelevant.

2. Place the turntable so that the 3 guides on the ASI-V pass through the 3 holes at the 
center of the turntable. 

Figure 6.14  Installing the Turntable

Installing the Vial Rack

1. Place the vial rack on top of the turntable.

2. Rotate the vial rack until the guides of the turntable fit into the vial rack.  This secures 
the vial rack in place.

Installing the Cover

1. Place the cover on the ASI-V.
Note: There is a magnet at the left rear of the cover.  Verify that the cover

and ASI-V are in contact at the magnet.  

Install the Rinse Bottle and Drain Tank

Installation of the rinse bottle and drain tank is explained below. 

Rinse and drain tubing are attached to the autosampler, and are respectively labeled 
“RINSE” and “DRAIN.”  Use the rinse water tubing as is, and cut the drain tubing to an 
appropriate length. 

Turntable
Three Holes at  
Center of Turntable
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CAUTION

• Verify that the drain tubing remains lower than the drain port of the ASI-V, and
that the end of the drain tubing remains above the surface of the liquid in the
drain tank.

• Corrosive substances such as acids may be present in the drainage liquid.  Avoid
touching or spilling these liquids. 

Preparation 

• The rinse bottle is provided as a standard accessory. 
• The drain bottle is a special accessory (P/N 638-52344).  A suitable substitute may be 

used as the drain container. 

Procedure

1. Place the rinse bottle on the bench with the TOC-V and the autosampler. 

2. Place the drain container on the floor. 

3. To minimize resistance, keep the tip of the drain tubing above the surface of the drain 
liquid and as close to the instrument as possible. 

CAUTION 
Do not allow any slack or bends in the tubing that could cause a buildup of water
pressure.

Before Starting Analysis 

Check the following before starting analysis. 

• The rinse water bottle is filled to above the 2 L mark.
• The tip of the rinse tubing reaches nearly to the bottom of the rinse water bottle. 

CAUTION
Perform the checks described above to ensure that rinse water will be delivered
and air will not be taken into the TOC-V injection pump.
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6.8.5  OCT-1 8-Port Sampler Installation

The OCT-1 8-port sampler is installed as described below.

6.8.5.1  Installation Procedure

This section describes the procedure for installing the OCT-1 8-Port Sampler.

The unit is set up to the left of the TOC-V main body as shown in Figure 6.15“Installation 
of the 8-Port Sampler”.

TIP » When 2 OCT-1 8-Port Samplers are to be used, place both units to the left of the TOC-V 
main unit as shown in the overhead view of Figure 6.4“External Dimensions of Instrument 
with OCT-1 8-Port Sampler”.

Figure 6.15  Installation of the 8-Port Sampler

Cable Connections

The cable is connected between the main unit of the TOC-V and the 8-Port Sampler.

CAUTION

Confirm that the power to the TOC-V main unit is switched OFF before
performing this procedure. 

Connection Procedure

1. Remove the 4 screws at the top of the 8-Port Sampler, and take off the cover.

2. Connect the power and signal cable to the circuit board of the 8-Port Sampler. 

3. Connect the ground wire of the power cable to the grounding terminal on the circuit 
board of the OCT-1.

4. Pass the cable through the rear panel, and replace the cover of the 8-Port Sampler.

8-Port Sampler TOC-V Main Unit
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Figure 6.16  Cable Connections (TOC-V and 8-Port Sampler)

5. Connect the power cable to the power receptacle on the back of the TOC-V.

6. Connect the signal cable to the 8-Port Sampler connection on the back of the TOC-V.

Installing Two 8-Port Sampler Units

When installing two 8-Port Sampler units, a signal cable (standard accessory) is connected 
between 8-Port Sampler 1 and 8-Port Sampler 2. 

Installation Procedure

1. Remove the covers from both 8-Port Sampler units.

2. Connect the signal cable exiting 8-Port Sampler 2 to the connector of 8-Port Sampler 
1.

Figure 1.17 Connecting Two 8-Port Samplers

8-Port Sampler Signal Cable 8-Port Sampler Power Cable

Rear Panel

Signal Cable

8-Port Sampler 1

8-Port Sampler 2
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3. Remove the port number label from the 8-Port Sampler 2 unit and replace it with the 
port number label provided with the unit.
Note: The port that was originally labeled as port No. 1 should be labeled

as port No. 9.

4. Replace the covers on the 8-Port Samplers.

Connecting the Sample Tubing

Use the following procedure to connect the sample tubing of the 8-Port Sampler.

Tubing Connection Procedure

1. The sample tubing differs according to the TOC-V model that is used with the 8-Port 
Sampler
Note: Refer to Table 6.21 •“Maintenance Parts List 4 (OCT-1 8-Port Sam-

pler)” for the appropriate part numbers.

2. Connect the fitting at one end of the tubing to the common (COM) port of the 8-Port 
Sampler.

3. Pass the sample tubing through the hole in the left side panel of the TOC-V main unit. 
Connect the fitting at the other end of the sample tubing to port No. 2 of the 8-port 
valve of the TOC-V sample injector. Connect to port No. 1 when installing 8-Port 
Sampler 2. 

4. Connect the sample tubing to ports 1 - 8 (ports 9 - 16 for 8-Port Sampler 2) of the 8-
Port Sampler. 

Figure 6.18  Tubing Connections

Note: Connection to the TOC-V Main Unit

• 8-Port Sampler 1

Connect the COM tubing to the common (COM) port of 8-Port Sampler 1 and 
port No. 2 on the TOC-V unit. 

• 8-Port Sampler 2

Connect the COM tubing to the common (COM) port of 8-Port Sampler 2 and 
port No. 1 on the TOC-V unit

Sample Tubing 
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6.8.6  Installing the TN Unit

6.8.6.1  Connecting the Power and Installation

Connecting the Power Supply

Connect the TN unit to a stable, AC100V±10 V, 50Hz or 60Hz (single phase) power supply 
with sufficient capacity to accommodate 2A or greater current. The symbol “~” on the 
name plate indicates alternating current.

CAUTION
The instrument may not operate properly if the power supply voltage exceeds
the range of AC100-127V ±10% or AC 220-240V ±10%. Unstable voltage may
cause problems during high sensitivity analysis. 

Note: The instrument is compatible with both 50Hz and 60Hz power supplies and can
be used with either frequency. 

Grounding

The included power cord is a three-conductor cable including a ground wire and a 2P plug 
(with ground) at the end. If the power outlet does not have ground receptacle, use the 
included 2P (no ground) adapter and ground the external ground tap terminal. 

The voltage terminals (AC) and ground terminal (ACC) on the power plug of this 
instrument are arranged as shown in Figure 6.19 "Power Plug". Connect them so that they 
match the power outlet being used. 

Figure 6.19  Power Plug

Voltage Terminal (AC) Ground Terminal (ACC)

Ground Terminal (G)
(Be sure to ground completely.)
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CAUTION

• In addition to the consideration of safety, complete grounding is necessary to
prevent as much as possible the occurrence of signal noise.    A Type-3 ground
(ground resistance: 100W or less, see Electrical Facilities Engineering Standards
for details) is recommended. 

• Perform grounding separately and avoid contact with water supply pipes, gas
pipes, and lightning rods. 

6.8.6.2  Connecting Ozone Source Air 

The TNM-1 incorporates an internal ozone generator, requiring a source of air gas 
(supplied at about 500mL/min) separate from the carrier gas supplied to the TOC-V. While 
it is possible to use TOC-V high purity carrier gas by providing branch tubing, the 
consumption of the combined-use carrier gas would increase to about 150 - 250mL/min. 
Assuming operation at the rate of 8 hours/day, 5 days/week, the 47 L, 12MPa air cylinder 
would require monthly replacement (as compared to every 3 months when used for carrier 
gas alone).

Because air gas for ozone generation is not required to be the high purity air used as carrier 
gas, it is recommended to use instrumentation air or compressor-supplied air for ozone 
generation, separate from the carrier gas.

Using Compressor Air or Instrumentation Air

When using compressor air or instrumentation air for generation of ozone, be sure that the 
following conditions are satisfied.

• Install an air filter in the air supply line to eliminate dust, oil mist and water droplets 
from the air. If a compressor is used, install the air filter (equipped with drain separation 
and discharge branch) close to the tubing connection at the instrument.

• If a compressor is used, select an oil-less type air compressor. The oil-less air compres-
sor SLP-5D-2 SVF (P/N 638-59203-01) is available as an option.

Using a High Purity Air-Filled Cylinder (Via Branch Tubing from Carrier Gas)

High purity air is synthesized air using pure nitrogen and pure oxygen. Ensure that 
contaminants, including carbon dioxide, carbon monoxide and total hydrocarbons, are 
guaranteed not to exceed 1ppm each.

Install a pressure regulator on the gas cylinder and supply gas to the instrument so that the 
pressure is 300kPa at the instrument gas connection port.

Note: If there are excessive contaminants in the carrier gas, measurement results will be 
adversely affected due to low measurement reproducibility, etc. 
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 Precautions in Handling Gas Cylinders 
The handling and safety management of high-pressure gases is strictly regulated
by high-pressure gas control laws, general high-pressure gas safety codes, and
fire laws. 
The gas used in this instrument itself is not dangerous, but mistakes in the
handling of high-pressure gas cylinders can be extremely hazardous. Carefully
read and obey the following precautions. 

• Place gas cylinders in a well-ventilated location out of direct sunlight. 

• Ensure that gas cylinders never reach temperatures higher than 40°C. 

• Make sure there are no open flames anywhere within 2 meters of a gas cylinder. 

• Secure cylinders with bands or other fasteners to prevent tipping and falling. 

• When finished using gas, immediately and completely turn OFF all valves on the
cylinder. 

• Inspect the operation of the pressure gauge at least once every three (3) months. 

Gas Supply Pressure

Supply gas at a constant, stable pressure of 300kPa (44PSI)at the gas inlet connection of the 
TNM-1. 

Note: Keep the carrier gas supply pressure to the instrument from exceeding 600kPa 
(87PSI). 

Gas Tubing Connections

The special accessory Air Supply Tubing Set includes nylon tubing and connectors (two (2) 
half unions). 

Figure 6.20  Gas Tubing Connection 

Half Union

Connection Inlet

Nylon Tubing
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Procedure

1. Connect the half unions to the carrier gas inlet on the instrument and the connection 
outlet (¼” NPT) of the gas supply source. 

2. Connect the nylon tubing (4mm O.D., 2.5mm I.D.) between the gas supply source and 
the instrument. 

Note: The nylon tubing can be connected simply by firmly inserting it 
into the half union. When disconnecting the tubing, pull off the tub-
ing while pushing down firmly on the green-colored ring of the half 
union using a screwdriver.

3. After connection, check to see that there are no gas leaks. 

CAUTION

• Do not allow any acute bends in the tubing. 

• When tubing and connectors are prepared by the user, be sure to use clean
components that are free of oils or other contaminants on their inner surfaces. 

• Copper tubing or stainless steel tubing may also be used. 

Low Ozone Air Supply Pressure Safety Mechanism

To ensure safety, the TN unit is equipped with an ozone air gas pressure sensor that will 
automatically cause the ozone generator to be switched off when the ozone air gas pressure 
decreases below 50kPa. 

If this occurs, the red lamp labeled “PRESS” at the lower right of the TNM front panel will 
illuminate. Take the appropriate measures to correct the low pressure problem.
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6.8.6.3  Connecting Gas Exhaust Tubing

Because the unit uses a chemiluminescence system for the detection of TN components, it 
is equipped with an internal ozone generator. The ozone and NOx generated are removed 
by the ozone treatment unit and NOx absorber, and are then exhausted. However, in the 
event that the performance of the ozone treatment catalyst and NOx absorber deteriorate, 
ozone and NOx gas may be expelled in the exhaust gas. Be sure to discharge exhaust gas to 
the outdoors or to an exhaust pit using a 5mm I.D. flexible vinyl hose. 

CAUTION

• To minimize resistance, leave the gas exhaust tubing open to the atmosphere. 

• Be sure to connect the gas exhaust tubing to the instrument and discharge the
exhaust gas to the outdoors or an exhaust pit. 

• If the gas exhaust tubing is not connected, ozone and NOx gas may be exhausted
from the instrument, causing harm to the respiratory organs of individuals in the
vicinity.
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6.9  Material Safety Data Sheets

6.9.1  Hydrochloric Acid (HCl)

 MATERIAL SAFETY DATA SHEET
SECTION I PRODUCT IDENTIFICATION
CAT. NO.: 630-00998-00 CAS NO.: Hydrochloric Acid -7647-01-0 
NAME: Hydrochloric Acid OTHER NAME: Muriatic Acid; Regeneration Liquid 
PRODUCT USE: This product is for specific use in the regeneration of the catalysts of the Shimadzu TOC. Refer to the Instruction Manual of the 

unit for proper use.
SECTION II PRECAUTIONS TO BE TAKEN IN HANDLING
Do not get in eyes, on skin or on clothing. Wear rubber or neoprene gloves and impervious boots, apron or coveralls, as needed, to prevent skin contact. Avoid 
breathing mist. Use only with adequate ventilation; local and/or general exhaust is recommended to keep employee exposure below the Airborne Exposure Limits. 
If TLV is exceeded, a full face piece chemical cartridge respirator may be worn, in general, up to 100 times the TLV or the maximum use concentration specified 
by the respirator supplier, whichever is less. Store in tightly closed containers, in cool, dry, ventilated area. Protect from physical damage and direct sunlight. Iso-
late from incompatible substances. Protect from moisture. Remove and wash contaminated clothing promptly. Wash hands thoroughly after handling. This sub-
stance is classified as a POISON under the Federal Caustic Poison Act. 
SECTION III PHYSICAL DATA                     

SECTION IV REACTIVITY DATA
Stable under ordinary conditions of use and storage. Containers may burst when heated. When heated to decomposition, emits toxic hydrogen chloride fumes and 
will react with water or steam to produce heat and toxic and corrosive fumes. Hazardous Polymerization will not occur. Incompatibilities: A strong mineral acid; 
concentrated hydrochloric acid is highly reactive with strong bases, metals, metal oxides, hydroxides, amines, carbonates and other alkaline materials. Incompati-
ble with materials such as cyanides, sulfides, sulfites and formaldehyde.
SECTION V FIRE AND EXPLOSION HAZARD DATA
FIRE: Can react with metals to release flammable hydrogen gas.
EXPLOSION: Not considered to be an explosion hazard.
EXTINGUISHING MEDIA: If involved in a fire, use water spray. Special firefighting procedures: Use full protective clothing and NIOSH-approved self-

contained breathing apparatus with full face piece operated in the pressure demand or other positive pressure mode.
SECTION VI TOXICITY DATA 

SECTION VII HEALTH HAZARD DATA
Symptoms of overexposure: Inhalation: corrosive; can cause coughing, choking, inflammation of the nose, throat and upper respiratory tract. Inhalation of higher 
concentrations may cause lung damage. Ingestion: corrosive; swallowing product can cause immediate pain and burns of the mouth, throat, esophagus and gas-
trointestinal tract; may cause nausea, vomiting and diarrhea. Contact with skin: corrosive; can cause redness, pain, and severe skin burns; deep ulcers and discol-
ored skin; severe burns and eye damage. Chronic exposure: long-term exposure to concentrated vapors may cause erosion of teeth; long-term exposure seldom 
occurs due to the corrosive properties of the acid. Persons with preexisting skin disorders or eye disease may be more susceptible to the effects of this substance.
SECTION VIII FIRST AID
An antidote is a substance intended to counteract the effect of a poison. It should be administered only by a physician or trained emergency personnel. Medical 
advice can be obtained from a POISON CONTROL CENTER.
In case of contact: Immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing and shoes. Assure 
adequate flushing of the eyes by separating eyelids with fingers. If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing is difficult, 
give oxygen. If swallowed, wash out mouth with water provided person is conscious. CALL A PHYSICIAN. DO NOT INDUCE VOMITING. If conscious, give 
large quantities of milk or water. Never give anything by mouth to an unconscious or convulsing person. Get medical attention immediately.
SECTION IX SPILL OR LEAK PROCEDURES
Cleanup personnel should wear protective clothing and respiratory equipment suitable for toxic or corrosive fluids or vapors. Isolate or enclose the area of the leak 
or spill. Small spills: Flush with water and neutralize with alkaline material (soda ash, lime, etc.). Sewer neutralized material with excess water. Larger spills and 
lot sizes: Neutralize with alkaline material, pick up with absorbent material (sand, earth, vermiculite). Provide forced ventilation to dissipate fumes. For disposal, 
neutralize with alkaline materials (soda ash, lime, etc.). Dispose in a RCRA-approved waste facility or sewer the neutralized slurry with excess water if local ordi-
nances allow. Reportable quantity (RQ) (CWA/CERCLA): 5000 labs. Ensure compliance with federal, state and local regulations.
SECTION X SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive and shall be used only as a guide. SHIMADZU shall not be held liable for 
any damage resulting from handling or from contact with the above product. Users should make their own investigations to determine the suitability of the infor-
mation for their particular purposes.

Shimadzu Scientific Instruments, Inc. 957006
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 November, 1995

Melt 
Point

Boil Point Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water Solubility

N/A N/A N/A N/A N/A N/A Pungent Colorless / Clear Fuming 
Liquid

Infinite / slight 
evolution / heat

RAT/MOUSE LD50 RTECS# OSHA PEL ACGIH TLV-TWA
900mg/kg(hydrocloric acid concentrated) N/A 5ppm (TWA) Ceiling 5ppm (TWA) Ceiling
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6.9.2  Phosphoric Acid

MATERIAL SAFETY DATA SHEET 
SECTION I  PRODUCT IDENTIFICATION
CAT NO.: 630-00710-00 CAS NO.: 07664-38-2
NAME: Phosphoric Acid 25% Ultrapure SYNONYM: Phosphoric Acid, IC Reaction Liquid
SECTION II  PRDUCT USE
This product is specifically for use in the IC channel of the TOC 500, TOC 5000, and TOC 4000 series of TOC analyzers. Refer to the appropriate instruction man-
ual for directions on proper use. Keep tightly sealed in a cool, dry, well ventilated place. Store separate form flammable and combustible materials. Wear appropri-
ate protective clothing and eye protection.
SECTION III  PHYSICAL DATA

SECTION IV  HAZARDS IDENTIFICATION
Corrosive, causes burns. Harmful if swallowed. Target organ(s): liver, blood. In case of contact with eyes, rinse immediately with plenty of water and seek medical 
advice. Take off immediately all contaminated clothing. Wear suitable protective clothing, gloves and eye/face protection.
SECTION V TOXICITY DATA
UNR-MAN LDLO:220mg/kg ORL-RAT LD50:1530mg/kg         
IHL-RAT LC50: >850mg/m3/1h SKN-RBT LD50:2740mg/kg
SECTION VI HEALTH HAZARD DATA
Acute Effects: Harmful if swallowed. May be harmful if inhaled. May be harmful if absorbed through the skin. Material is extremely 

destructive to tissue of the mucous membranes and upper respiratory tract, eyes and skin. Inhalation may result in spasm, 
inflammation and edema of the larynx and bronchi, chemical pneumonitis and pulmonary edema. Symptoms of exposure may 
include burning sensation, coughing, wheezing, laryngitis, shortness of breath, headache, nausea and vomiting. May cause 
cyanosis.

Chronic Effects: Target organ(s): liver, blood, bone marrow. To the best of our knowledge, the chemical, physical, and toxicological properties 
have not been thoroughly investigated. 

SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing and shoes. Assure 
adequate flushing of the eyes by separating the eyelids with fingers. If inhaled, remove to fresh air. If not breathing give artificial respiration. If breathing is diffi-
cult, give oxygen. If swallowed, wash out mouth with water provided person is conscious. Call a physician. Wash contaminated clothing before reuse. Discard con-
taminated shoes.
SECTION VIII FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA: Carbon dioxide, dry chemical powder or appropriate foam. 
SPECIAL FIREFIGHTING PROCEDURES: Wear self-contained breathing apparatus and protective clothing to prevent contact 

with skin and eyes. 
UNUSUAL FIRE AND EXPLOSIONS HAZARDS: Emits toxic fumes under fire conditions.
SECTION IX ACCIDENTAL RELEASE MEASURES
Evacuate area. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves. Cover with dry lime or soda ash, pick up, keep in a closed container 
and hold for waste disposal. Ventilate area and wash spill site after material pickup is complete.
SECTION X STABILITY AND REACTIVITY 
INCOMPATIBILITIES: Strong bases, finely powdered metals
HAZARDOUS COMBUSTION OR DECOMPOSITION PRODUCTS: Thermal decomposition may produce toxic fumes of phosphorus 

oxides and/or phosphine.
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc. 957006
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 November, 1995

Melt Point Boil Point Density Vapor Pressure Color Phase Water Solubility
N/A N/A N/A N/A Colorless / Clear Liquid Completly Soluble
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6.9.3  CO2 Absorber, CA(OH)2, KOH, NAOH: soda lime

MATERIAL SAFETY DATA SHEET
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-00556-00 CAS NO. 80006-28-8
NAME: Soda Lime OTHER NAME: Soda Lime; Soda and Lime
PRODUCT USE: CO2 Scrubber in Shimadzu TOC Analyzers
SECTION II PRECAUTIONS TO BE TAKEN IN HANDLING
Protect skin, eyes and clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling. Safety shower and eye bath. Use 8" minimum face shield. 
Store as a corrosive. Keep tightly closed and store in a cool, dry, place. Air and moisture sensitive. Use as directed in the TOC-4000 Instruction Manual.
SECTION III PHYSICAL DATA

SECTION IV REACTIVITY DATA
Incompatible with strong acids. Absorbs CO2, moisture inactivates.
SECTION V FIRE AND EXPLOSION HAZARD DATA
EXTINGUISHING MEDIA: Dry chemical fire extinguisher. Wear self-contained breathing apparatus and protective clothing to prevent skin and eye 

exposure.
UNUSUAL FIRE HAZARD: Emits toxic fumes in a fire.
SECTION VI TOXICITY DATA

SECTION VII HEALTH HAZARD DATA
Acute effects: Harmful if swallowed, inhaled, or absorbed through skin. Material is extremely destructive to tissue of the mucous membranes and upper respiratory 
tract, eyes and skin. Inhalation may be fatal as a result of spasm, inflammation and edema of the larynx and bronchi, chemical pneumonitis and pulmonary edema. 
Symptoms of exposure may include burning sensation, coughing, wheezing, laryngitis, shortness of breath, headache, nausea and vomiting. To the best of our 
knowledge, the chemical, physical, and toxicological properties have not been thoroughly investigated.
SECTION VIII FIRST AID
An antidote is a substance intended to counteract the effect of a poison. It should be administered only by a physician or trained emergency personnel. Medical 
advice can be obtained from a POISON CONTROL CENTER.

In case of contact: Immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing and shoes. Assure 
adequate flushing of the eyes by separating eyelids with fingers. If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing is difficult, 
give oxygen. If swallowed, wash out mouth with water provided person is conscious. CALL A PHYSICIAN. Wash contaminated clothing before reuse. Discard 
contaminated shoes. For complete information, see actual entry in RTECS #VX965000.
SECTION IX SPILL OR LEAK PROCEDURES
Occupational spill: Evacuate area. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves. Absorb on sand or vermiculite and place in 
closed containers for disposal. Ventilate area and wash spill site after material pickup is complete.
SECTION X SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive and shall be used only as a guide. SHIMADZU shall not be held liable for 
any damage resulting from handling or from contact with the above product. Users should make their own investigations to determine the suitability of the infor-
mation for their particular purposes.

Shimadzu Scientific Instruments, Inc. 957003
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 November, 1995

Melt 
Point

Boil 
Point

Density Vapor Pressure Vapor Density Evaporation 
Rate

Odor Color Phase Water 
Solubility

N/A N/A N/A N/A N/A N/A N/A White Granules, various sizes N/A

RAT/MOUSE LD50 RTECS# OSHA PEL ACGIH TLV-TWA
N/A VX965000 N/A N/A



6.9     Material Safety Data Sheets
6.9.4     Lithium Hydroxide (monohydrate)
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6.9.4  Lithium Hydroxide (monohydrate)

MATERIAL SAFETY DATA SHEET
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-00961-00 CAS NO. 1310-66-3
NAME: Lithium Hydroxide Anhydride, 99.95%OTHER NAME: Lithium Hydroxide Hydrate, Lithium Hydroxide Anhydride 

(DOT,N2680(DOT)
TRADE NAME: IC Absorbent
PRODUCT USE: This product is for specific use with TOC instruments.
SECTION II PRECAUTIONS TO BE TAKEN IN HANDLING
Wear appropriate NIOSH/MSHA-approved respirator, chemical-resistant gloves, safety goggles, other protective clothing. Safety shower and eye bath. Use only in 
a chemical fume hood. Face shield, 8-inch minimum. Do not breathe dust. Do not get in eyes, on skin, or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Corrosive, harmful solid. Keep tightly closed. Hygroscopic. Store under nitrogen, in a cool, dry, place.
SECTION III PHYSICAL DATA

SECTION IV REACTIVITY DATA
Substance is strongly alkali. In contact with or mixed with acid, reaction is extremely strong. Aluminum and zinc are corroded by this substance and not suitable as 
containers. Corrosive effect is enhanced in presence of humidity or water. Absorbs CO2 from air. Containers made of steel, stainless steel, glass, ceramic and many 
synthetic compounds are relatively durable. Nature of decomposition products not known.
SECTION V FIRE AND EXPLOSION HAZARD DATA
FIRE: This substance is nonflammable. Use water mist, powdered extinguishing reagents, foam or carbon dioxide gas. Cool container 

using water mist, and move container to safe location.
EXPLOSION: Not considered to be an explosion hazard.
EXTINGUISHING MEDIA: Carbon dioxide, dry chemical powder, alcohol or polymer foam. Special Firefighting Procedures: Use full protective clothing 

and NIOSH-approved self-contained breathing apparatus with full face piece operated in the pressure demand or other positive 
pressure mode.

SECTION VI TOXICITY DATA

REVIEWS, STANDARDS, AND REGULATIONS: NOES 1983, HZD X6293000; TNF 60; NIS 6239; NOS 54; TNE 59941; TFE 6243
SECTION VII HEALTH HAZARD DATA
Acute Effects: Harmful if swallowed, inhaled or absorbed through skin. Material is extremely destructive to tissue of the mucous membranes and upper respiratory 
tract, eyes and skin. Inhalation may be fatal as a result of spasm, inflammation and edema of the larynx and bronchi, chemical pneumonitis and pulmonary edema. 
Symptoms of exposure may include burning sensation, coughing, wheezing, laryngitis, shortness of breath, headache, nausea and vomiting. Uncontrolled move-
ment, muscle spasms, and loss of consciousness may occur. To the best of our knowledge, the chemical, physical and toxicological properties have not been thor-
oughly investigated.
SECTION VIII FIRST AID
An antidote is a substance intended to counteract the effect of a poison. It should be administered only by a physician or trained emergency personnel. Medical 
advice can be obtained from a POISON CONTROL CENTER. In case of contact: Immediately flush eyes or skin with copious amounts of water for at least 15 
minutes while removing contaminated clothing and shoes. Assure adequate flushing of the eyes by separating the eyelids with fingers. If inhaled, remove to fresh 
air. If not breathing, give artificial respiration. If breathing is difficult, give oxygen. If swallowed, wash out mouth with water, provided person is conscious. CALL 
A PHYSICIAN. Wash contaminated clothing before reuse, discard contaminated shoes. Additional information: Large doses of lithium ion have caused dizziness 
and prostration, and can cause damage if sodium intake is limited. Dehydration, weight loss, dermatological effects and thyroid disturbances have been reported. 
Central nervous system effects that include slurred speech, blurred vision, sensory loss, ataxia and convulsions may occur. Diarrhea, vomiting and neuromuscular 
effects such as tremor, clonus and hyperactive reflexes may occur as a result of repeated exposure to lithium ion.
SECTION IX SPILL OR LEAK PROCEDURES
Occupational Spill: Evacuate area. Wear protective footwear. Sweep up and place in a bag and hold for waste disposal. Waste Disposal Method: For small quanti-
ties, cautiously add to a large stirred excess of water. Adjust the pH to neutral, separate any insoluble solids or liquids and package them for hazardous-waste dis-
posal. Flush the aqueous solution down the drain with plenty of water. The hydrolysis and neutralization reactions may generate heat and fumes which can be 
controlled by the rate of addition. Observe all federal, state and local environmental regulations. Water Contamination: Harmful to marine life. Change in pH will 
result in alkaline damage to marine life.
SECTION X SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive and shall be used only as a guide. SHIMADZU shall not be held liable for 
any damage resulting from handling or from contact with the above product. Users should make their own investigations to determine the suitability of the infor-
mation for their particular purposes.

Shimadzu Scientific Instruments, Inc. 957002
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 November, 1995

Melt 
Point

Boil 
Point

Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

N/A N/A 1.510 N/A N/A N/A N/A White Crystals N/A

RAT/MOUSE LD50 RTECS# OSHA PEL ACGIH TLV-TWA

N/A 0j6307080 Lithium hydroxide, Monohydrate N/A N/A



6.9     Material Safety Data Sheets
6.9.5     Halogen Scrubber
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6.9.5  Halogen Scrubber

MATERIAL SAFETY DATA SHEET 
SECTION I  PRODUCT IDENTIFICATION
CAT. NO. 630-0092-00 CAS NO. 07740-50-8
NAME: Halogen Scrubber OTHER NAME: Copper Wool
PRODUCT USE: This product is for specific use with TOC instruments.
SECTION II PRODUCT USE
For use specifically with the Shimadzu TOC 500, TOC 5,000, and TOC 4,000 instruments. Consult the appropriate instrument manual for proper use.
SECTION III PHYSICAL DATA
 

SECTION IV  HAZARDS IDENTIFICATION
Dust, mist or fumes may cause eye and skin irritation. Avoid contact. 
SECTION V TOXICITY DATA

SECTION VI HEALTH HAZARD DATA
Exposure to large amounts can cause gastrointestinal disturbances, nausea, vomiting, headaches, or dizziness.
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes with copious amounts of water for at least 15 minutes. in case of skin contact, immediately wash skin with soap and 
copious amounts of water. if ingested and subject is conscious, immediately give large amounts of water. get medical attention.
SECTION VIII FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA: Appropriate to surrounding fire. Possible formation of toxic copper fumes. Use appropriate respiratory support. 
SECTION IX ACCIDENTAL RELEASE MEASURES 
N/A
SECTION X STABILITY AND REACTIVITY 
INCOMPATIBILITIES:  Strong acids, active halogens such as chlorine, fluorine, iodine, and bromine. ammonia.
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

1083°C 2595°C N/A N/A N/A N/A N/A Reddish Solid Malleable 
Metal

N/A

RAT/MOUSE LD50 RTECS# OSHA PEL ACGIH TLV-TWA

N/A GL5325000 N/A N/A



6.9     Material Safety Data Sheets
6.9.6     Quartz Wool
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6.9.6  Quartz Wool

MATERIAL SAFETY DATA SHEET 
 SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-0557-00 CAS NO. 14808-60-7
NAME: Quartz Wool OTHER NAME: N/A 
SECTION II PRODUCT USE
Support for catalyst in reaction tubes of TOC instruments. consult instrument manuals for proper use. 
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
Possible eye and skin irritation. Avoid contact.
SECTION V TOXICITY DATA
INERT
SECTION VI HEALTH HAZARD DATA
INERT
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes with copious amounts of water for at least 15 minutes. In case of skin contact, immediately wash skin with soap and 
copious amounts of water. 
SECTION VIII FIRE FIGHTING MEASURES
N/A
SECTION IX ACCIDENTAL RELEASE MEASURES
N/A
SECTION X STABILITY AND REACTIVITY 
N/A
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

N/A N/A N/A N/A N/A N/A N/A Grey Fibrous N/A
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6.9.7     High Sensitivity Catalyst
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6.9.7  High Sensitivity Catalyst

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-00996-00 CAS NO. N/A
NAME: High Sensitivity TC Catalyst OTHER NAME: Platinum on Quartz Wool
SECTION II PRDUCT USE
This product is specifically for use as a catalyst in the TOC 500,TOC 5000, and TOC 4000 series of TOC analyzers. Refer to the appropriate instruction manual for 
directions on proper use. 
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
FLAMMABLE:  Possible sensitizer. Keep away from sources of ignition - NO SMOKING. Take precautionary measures against static 

discharges. Keep container tightly closed and in a well-ventilated place.
SECTION V TOXICITY DATA
ACUTE EFFECTS: May be harmful by inhalation or ingestion. May cause eye irritation. May cause skin irritation. Material may be irritating to 

mucous membranes and upper respiratory tract. Prolonged or repeated exposure may cause allergic reactions in certain 
sensitive individuals.

EXPOSURE CAN CAUSE: Coughing, chest pains, difficulty in breathing. To the best of our knowledge, the chemical, physical, and toxicological 
properties have not been thoroughly investigated.

SECTION VI HEALTH HAZARD DATA
SEE SECTION 5.
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing and shoes. IF 
inhaled, remove to fresh air. If not breathing give artificial respiration. If breathing is difficult, give oxygen. If swallowed, wash out mouth with water provided 
person is conscious. Call a physician. Remove and wash contaminated clothing promptly.
SECTION VIII FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA: CARBON dioxide, dry chemical powder or appropriate foam.
SECTION IX ACCIDENTAL RELEASE MEASURES
Shut off all sources of ignition. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves.
Sweep up, place in a bag and hold for waste disposal. Ventilate area and wash spill site after material pickup is complete.
SECTION X STABILITY AND REACTIVITY 
INCOMPATIBILITIES: Strong oxidizing agents, organic materials.
HAZARDOUS COMBUSTION OR DECOMPOSITION PRODUCTS:Nature of decomposition products not known. Hazardous polymerization will not occur.
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

N/A N/A N/A N/A N/A N/A N/A Grey Fibrous Solid N/A



6.9     Material Safety Data Sheets
6.9.8     Normal Sensitivity Catalyst
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6.9.8  Normal Sensitivity Catalyst

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 017-42801-00 and 017-42801-01 CAS NO. 7440-06-4(Platinum) and 1344-28-1(Alumina)
NAME: Regular Sensitivity Catalyst OTHER NAME: Platinum on 1/8" Alumina Pellets
SECTION II PRDUCT USE
This product is specifically for use as a catalyst in the TOC 500,TOC 5000, and TOC 4000 series of TOC analyzers. Refer to the appropriate instruction manual for 
directions on proper use. 
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
FLAMMABLE: Possible sensitizer. keep away from sources of ignition - no smoking. Take precautionary measures against static discharges. 

Keep container tightly closed and in a well-ventilated place. Harmful by inhalation. Irritating to respiratory system.
TARGET ORGAN(S): Lungs, bones, do not breathe dust. In case of insufficient ventilation, wear suitable respiratory equipment. Wear suitable 

protective clothing.
SECTION V TOXICITY DATA

ACUTE EFFECTS: May be harmful by inhalation or ingestion. May cause eye irritation. may cause skin irritation. Material may be irritating to 
mucous membranes and upper respiratory tract. prolonged or repeated exposure may cause allergic reactions in certain 
sensitive individuals.

EXPOSURE CAN CAUSE: Coughing, chest pains, difficulty in breathing, gastrointestinal disturbances. 
CHRONIC EFFECTS: Prolonged exposure can cause damage to the lungs and bones. TO the best of our knowledge, the chemical, physical, and 

toxicological properties have not been thoroughly investigated. 
TARGET ORGAN DATA: Lungs, thorax or respiration (tumors) tumorigenic (neoplastic by RTECS criteria) tumorigenic (equivocal tumorigenic agent by 

RTECS criteria) tumorigenic (tumors at site of application) only selected registry of toxic effects of chemical substances 
(RTECS) data is presented here. see actual entry in RTECS.

SECTION VI HEALTH HAZARD DATA
OSHA PEL: 8H TWA 5MG/ME respirable fraction; 8h TWA 10MG/M3 total dust
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes with copious amounts of water for at least 15 minutes while removing contaminated clothing and shoes. If inhaled, 
remove to fresh air. If not breathing give artificial respiration. If breathing is difficult, give oxygen. If swallowed, wash out mouth with water provided person is 
conscious. Call a physician. Remove and wash contaminated clothing promptly. In case of skin contact, immediately wash skin with soap and copious amounts of 
water. 
SECTION VIII FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA: Carbon dioxide, dry chemical powder or appropriate foam. 
UNUSUAL FIRE AND EXPLOSIONS HAZARDS: Material may have an exothermic reaction above 200 c with halocarbon vapors and may produce toxic 

hydrochloric acid and phosgene.
SECTION IX ACCIDENTAL RELEASE MEASURES
Shut off all sources of ignition. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves. Sweep up, place in a bag and hold for waste dis-
posal. Ventilate area and wash spill site after material pickup is complete.
SECTION X STABILITY AND REACTIVITY 
Stability: Stable. 
Incompatibilities: Strong acids, strong bases, chlorine trifluoride, ethylene oxide, halocarbons, oxygen difluoride, sodium nitrate, vinyl acetate, 

strong oxidizing agents,organic materials. Protect from moisture. Hazardous combustion or decomposition products. Nature of 
decomposition products not known. Hazardous polymerization will not occur.

SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

N/A N/A N/A N/A N/A N/A N/A Grey Solid Pellets N/A



6.9     Material Safety Data Sheets
6.9.9     Potassium Nitrate
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6.9.9  Potassium Nitrate 

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
 CAT. NO. CAS NO. 7757-79-1
NAME: Potassium Nitrate OTHER NAME: Nitric Acid, Potassium Salt, Saltpeter
PRODUCT USE: This product is for specific use with TOC instruments.
SECTION II PHYSICAL DATA

SECTION III HAZARDS IDENTIFICATION
Possible eye and skin irritation. Avoid contact.
SECTION IV HEALTH HAZARD DATA
TARGET ORGANS: Blood, Central Nervous System
SIGNS/SYMPTOMS OF OVEREXP: Chronic exposure can cause anemia, nephritis and methemoglobinemia.
SECTION V FIRST-AID MEASURES
INGESTION: If conscious, induce vomiting and call a physician.
SKIN: Flush with water.
EYES: Flush with water for 15 minutes and call a physician.
SECTION VI FIRE FIGHTING MEASURES
EXTUNGUISHING MEDIA Carbon dioxide, dry chemical, or appropriate foam. 
SPECIAL. Use NIOSH/MSHA approved SCBA & full protective equipment. Move containers from fire area if it can be done without 

risk. Use water to keep fire exposed containers cool.
UNUSUAL FIRE AND EXPLOSIONS HAZARDS.Strong oxidizer. Contact with other materials may cause fire. When exposed to heat, closed containers may 

explode.Emits toxic fumes under fire conditions.
SECTION VII ACCIDENTAL RELEASE MEASURES
Absorb on sand or vermiculite and place in closed containers for disposal. Ventilate area and wash spill site after material pickup is complete. Evacuate the area. 
Wear self-contained breathing apparatus, rubber boots, and heavy rubber gloves.
SECTION VIII SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Specific 
Gravity

Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

334°C N/A 2.11 N/A 3.0 N/A Odorless White Crystalline Pow-
der

Appreciable 
(>10%)



6.9     Material Safety Data Sheets
6.9.10     Sodium Bicarbonate
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6.9.10  Sodium Bicarbonate

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-00963-01 CAS NO. 144-55-8
NAME: Sodium Bicarbonate 100% OTHER NAME: Baking Soda
SECTION II PRDUCT USE
This product is specifically for use as a catalyst in the TOC 500,TOC 5000, and TOC 4000 series of TOC analyzers. Refer to the appropriate instruction manual for 
directions on proper use. 
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
Possible eye and skin irritation. Avoid contact. 
SECTION V TOXICITY DATA
N/A
SECTION VI HEALTH HAZARD DATA
Exposure to large amounts can cause gastrointestinal disturbances.
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes with copious amounts of water for at least 15 minutes. In case of skin contact, immediately wash skin with soap and 
copious amounts of water. 
SECTION VIII  FIRE FIGHTING MEASURES
N/A
SECTION IX ACCIDENTAL RELEASE MEASURES
N/A
SECTION X STABILITY AND REACTIVITY 
N/A
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

50°C N/A 2.16 N/A N/A N/A N/A White Solid Powders 10%
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6.9.11     Sodium Carbonate
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6.9.11  Sodium Carbonate

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-0092-01 CAS NO. 497-19-8
NAME: Sodium Carbonate, 100% OTHER NAME: N/A
SECTION II PRDUCT USE
This product is specifically for use in the IC channel of the TOC 500, TOC 5000, and TOC 4000 series of TOC analyzers. Refer to the appropriate instruction man-
ual for directions on proper use. Keep tightly sealed in a cool, dry, well ventilated place. Store separate form flammable and combustible materials. Wear appropri-
ate protective clothing and eye protection.
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
Corrosive, causes burns, harmful if swallowed. Target organ(s): liver, blood. In case of contact with eyes, rinse immediately with plenty of water and seek medical 
advice. Take off all contaminated clothing. Wear suitable protective clothing, gloves and eye/face protection.
SECTION V TOXICITY DATA
ORL-RAT LD50:4090mg/KG,IHL-RAT LC50:2300mg/M3/2H
ORL-MUS LD50:6600mg/KG,IHL-MUS LC50:1200mg/M3/2H 
SCU-MUS LD50:2210mg/KG,IHL-GPG LC50:800mg/M3/2H
SECTION VI HEALTH HAZARD DATA
Harmful if swallowed, inhaled, or absorbed through skin.causes severe irritation. High concentrations are extremely destructive to tissues of the mucous mem-
branes and upper respiratory tract, eyes and skin. Symptoms of exposure may include burning sensation, coughing, wheezing, laryngitis, shortness of breath, head-
ache, nausea and vomiting. To the best of our knowledge, the chemical, physical, and toxicological properties have not been thoroughly investigated.
SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing and shoes. Assure 
adequate flushing of the eyes by separating the eyelids with fingers. If inhaled, remove to fresh air. If not breathing give artificial respiration. If breathing is diffi-
cult, give oxygen. If swallowed, wash out mouth with water provided person is conscious. Call a physician. wash contaminated clothing before reuse. Discard con-
taminated shoes.
SECTION VIII FIRE FIGHTING MEASURES
NONCOMBUSTIBLE. Use extinguishing media appropriate to surrounding fire conditions. 
SPECIAL. Wear self-contained breathing apparatus and protective clothing to prevent contact with skin and eyes. 
UNUSUAL FIRE AND EXPLOSIONS HAZARDS.Emits toxic fumes under fire conditions.
SECTION IX ACCIDENTAL RELEASE MEASURES
Evacuate area. Wear self-contained breathing apparatus, rubber boots and heavy rubber gloves. Wear disposable coveralls and discard them after use. Sweep up, 
place in a bag and hold for waste disposal. Avoid raising dust.Ventilate area and wash spill site after material pickup is complete.
SECTION X  STABILITY AND REACTIVITY 
INCOMPATIBILITIES: Strong acids, aluminum, protect from moisture. 
HAZARDOUS COMBUSTION OR DECOMPOSITION PRODUCTS:Carbon monoxide, carbon dioxide.
SECTION XI SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

N/A N/A 2.16 N/A N/A N/A N/A White Solid Powder or 
Crystals

Completely 
Soluble
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6.9.12     Potassium Hydrogen Phthalate
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6.9.12  Potassium Hydrogen Phthalate

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. 630-00635-01 CAS NO. 877-24-7
NAME: Potassium Hydrogen Phthalate OTHER NAME: Phthalic Acid, Monopotassium Salt, Khp Primary Standard
SECTION II PRODUCT USE
Specifically for use as an organic carbon standard in the Shimadzu TOC 500, TOC 5,000, and TOC 4,000 instruments. Consult the appropriate instrument manual 
for proper use.
SECTION III PHYSICAL DATA

SECTION IV HAZARDS IDENTIFICATION
Irritant, irritating to eyes, respiratory system and skin. Possible sensitizer. In case of contact with eyes, rinse immediately with plenty of water and seek medical 
advice. Wear suitable protective clothing.
SECTION V TOXICITY DATA
RTECS #: CZ4326000
1,2-BENZENEDICARBOXYLIC ACID, MONOPOTASSIUM SALT
ORL-RAT LD50:>3200mg/KG                  KODAK* 21MAY1971
SKN-GPG LD50:>1 GM/KG                         KODAK* 21MAY1971
Only selected registry of toxic effects of chemical substances (RTECS) data is presented here. See actual entry in RTECS for complete information. 
SECTION VI HEALTH HAZARD DATA
ACUTE EFFECTS: May be harmful by inhalation, ingestion, or skin absorption; causes skin irritation; vapor or mist is irritating to the eyes, 

mucous membranes and upper respiratory tract.
EXPOSURE CAN CAUSE ASTHMATIC SYMPTOMS: Cough, hoarseness, rhinorrhea, wheezing, and conjunctivitis, nausea, or vomiting. Prolonged or repeated 

exposure may cause allergic reactions in certain sensitive individuals. To the best of our knowledge, the chemical, physical, and 
toxicological properties have not been thoroughly investigated.

SECTION VII FIRST-AID MEASURES
In case of contact, immediately flush eyes or skin with copious amounts of water for at least 15 minutes while removing contaminated clothing and shoes. If 
inhaled, remove to fresh air. if not breathing give artificial respiration. If breathing is difficult, give oxygen. If swallowed, wash out mouth with water provided per-
son is conscious. Call a physician. wash contaminated clothing before reuse.
SECTION VIII FIRE FIGHTING MEASURES
EXTINGUISHING MEDIA:  Water spray, carbon dioxide, dry chemical powder or appropriate foam.
SPECIAL FIREFIGHTING PROCEDURES: Wear self-contained breathing apparatus and protective clothing to prevent contact with skin and eyes.
UNUSUAL FIRE AND EXPLOSIONS HAZARDS:Emits toxic fumes under fire conditions.
SECTION IX ACCIDENTAL RELEASE MEASURES
Wear respirator, chemical safety goggles, rubber boots and heavy rubber gloves. Sweep up, place in a bag and hold for waste disposal. Avoid raising dust. Ventilate 
area and wash spill site after material pickup is complete.
SECTION X  STABILITY AND REACTIVITY 
STABILITY: Stable.
INCOMPATIBILITIES: Strong oxidizing agent
HAZARDOUS COMBUSTION OR DECOMPOSITION PRODUCTS:Toxic fumes of carbon monoxide, carbon dioxide
HAZARDOUS POLYMERIZATION:Will NOT occur.
SECTION XI  SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Density Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

Odor Color Phase Water 
Solubility

295-300°C N/A N/A N/A N/A N/A N/A White  Crystals N/A
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6.9.13  Water

MATERIAL SAFETY DATA SHEET 
SECTION I PRODUCT IDENTIFICATION
CAT. NO. CAS NO. 7732-18-5 
NAME: Water OTHER NAME: Dihydrogen Oxide
MOLECULAR WEIGHT: 18 CHEMICAL FORMULA:H2O 
SECTION I  HAZARDS IDENTIFICATION
EMERGENCY OVERVIEW: Not applicable. 
HEALTH RATING: 0 - None FLAMMABILITY RATING: 0 - None 
REACTIVITY RATING: 1 - Slight CONTACT RATING: 0 - None 
LAB PROTECTIVE EQUIP: Goggles; lab coat STORAGE COLOR CODE: Orange (General Storage) 
SECTION II  HEALTH EFFECTS
POTENTIAL HEALTH EFFECTS: Water is non-hazardous. 
INHALATION: Not applicable. INGESTION: Not applicable. 
SKIN CONTACT Not applicable. EYE CONTACT: Not applicable. 
CHRONIC EXPOSURE: Not applicable. AGGRAVATION OF PRE-EXISTING CONDITIONS: Not applicable. 
SECTION III FIRST AID MEASURES
INHALATION: Not applicable. INGESTION: Not applicable. 
SKIN CONTACT: Not applicable. EYE CONTACT: Not applicable. 
SECTION IV FIRE FIGHTING MEASURES
FIRE: Not applicable. EXPLOSION: Not applicable. 
FIRE EXTINGUISHING MEDIA: Use extinguishing media appropriate for surrounding fire. 
SPECIAL INFORMATION: In the event of a fire, wear full protective clothing and NIOSH-approved self-contained breathing apparatus with full facepiece 

operated in the pressure demand or other positive pressure mode. 
SECTION V ACCIDENTAL RELEASE MEASURES
Non-hazardous material. Clean up of spills requires no special equipment or procedures. 
SECTION VI HANDLING AND STORAGE
Keep container tightly closed. Suitable for any general chemical storage area. Protect from freezing. Water is considered a non-regulated product, but may react 
vigorously with some specific materials. Avoid contact with all materials until investigation shows substance is compatible. 
SECTION VII EXPOSURE CONTROLS/PERSONAL PROTECTION
AIRBORNE EXPOSURE LIMITS: Not applicable. VENTILATION SYSTEM: Not applicable. 
PERSONAL RESPIRATORS (NIOSH APPROVED): Not applicable. 
SKIN PROTECTION: None required. EYE PROTECTION: None required. 
SECTION VIII PHYSICAL AND CHEMICAL PROPERTIES

SECTION IX STABILITY AND REACTIVITY
STABILITY: Stable under ordinary conditions of use and storage. 
HAZARDOUS DECOMPOSITION PRODUCTS: Not applicable. 
HAZARDOUS POLYMERIZATION: Will not occur. 
INCOMPATIBILITIES: Strong reducing agents, acid chlorides, phosphorus trichloride, phosphorus pentachloride, phosphorus oxychloride. 
SECTION X ECOLOGICAL INFORMATION
ENVIRONMENTAL FATE:  Not applicable. 
ENVIRONMENTAL TOXICITY:  Not applicable. 
SECTION XI DISPOSAL CONSIDERATIONS
Whatever cannot be saved for recovery or recycling should be flushed to sewer. If material becomes contaminated during use, dispose of accordingly. Dispose 
of container and unused contents in accordance with federal, state and local requirements. 
SECTION XII TRANSPORT INFORMATION
Not regulated. 
SECTION XIII OTHER INFORMATION
NFPA RATINGS: Health: 0 Flammability: 0 Reactivity: 0 
LABEL HAZARD WARNING: Not applicable. 
LABEL PRECAUTIONS: Keep in tightly closed container. 
LABEL FIRST AID: Not applicable. 
PRODUCT USE: Laboratory Reagent. 
SECTION XIV  SPECIAL PRECAUTIONS AND COMMENTS
The above information is believed to be correct but does not purport to be all inclusive. It shall serve only as a guide. Shimadzu shall not be held liable for any 
damage resulting from handling or contact with the above product. Users should make their own determinations regarding the suitability of this information for 
their particular purposes.

Shimadzu Scientific Instruments, Inc.
7102 Riverwood Drive Columbia, MD 21046 Control No.
Tel: 1(800) 477-1227 Date:

Melt 
Point

Boil 
Point

Specific 
Gravity

Vapor 
Pressure

Vapor 
Density

Evaporation 
Rate

pH Color Phase Water 
Solubility

0°C 100°C 1.00 17.5 @ 20°C N/A N/A 7.0 Clear, 
Colorless

 Liquid Complete
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Appendix A

Appendix A Method Validation
The Method Validation function tests the variance and the linearity of the data. The 
function also determines performance characteristics according to the requirements of DIN 
38402-Part 51. The Method Validation function displays the data used for executing 
method validation, performs the required calculations and displays the results. Data can 
either be imported directly from the TOC-Control V Sample Table, or entered manually 
into the data table. Data can also be exported to ASCII files, stored and printed.
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A.1  Main Window

The Main Window is separated into three sections. The upper left section of the window 
displays the calibration curve, the upper right section displays the calculated validation 
results and the lower portion displays the data table, which contains all relevant data for 
performing the validation. The toolbar options (such as Open, Save, Cut, Copy, and Paste) 
are similar to those described in Section 4.4.2 "File Menu" and Section 4.4.3 "Edit Menu".

Figure A.1  Method Validation Main Window

The windows can be resized by dragging the dividers between the sections.
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A.2  File Menu

Figure A.2  File Menu

A.2.1  New

Use the New command to create a new, empty method validation file. A new file can also 
be created by clicking the New toolbar button. If a file that contains modified and unsaved 
data is open when the New command is selected, a prompt is displayed in a dialog box. 
Select one of the options in the dialog box to determine if the unsaved data should be saved 
before opening a new method validation file. Click the Yes button to save the document and 
create a new method validation file. Click the No button to create a new document without 
saving previous data.

Figure A.3  Prompt for Saving Data 
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A.2.2  Open

Use the Open command to open a saved method validation file (*.val). A file can also be 
opened by clicking the Open toolbar button.

Start the method validation process by selecting a.cal file; application of DIN 38402 will 
begin. The process can also be started by selecting the calibration curve row in the Sample 
Table and opening the method validation function using the Tools>Method Validation 
command. 

Figure A.4  Open Dialog Box

When the Open command is selected, the File>Open dialog box is displayed. To open an 
existing file, select the filename and choose the Open button. To create a new method 
validation file, type the filename into the File name text field, then select the New button. 
For further information on the standard functions of the Open dialog box, refer to Section 
4.4.2.4 "Open".

Note: An error message is displayed if a file that is not in a correct, TOC-Control V for-
mat is selected. 
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A.2.3  Save

Use the Save command to save data in the current active file. If the file has not been saved, 
selecting the Save command opens the Save As dialog box. The Save command can also be 
executed by clicking the Save toolbar button.

A.2.4  Save As

Figure A.5  Save As Dialog Box

The Save As command saves the active, current data to a new file name. Enter the desired 
name in the File Name field. Two different file types are available: validation files (*.val) 
used for storing the data in binary files and ASCII files (*.txt) used for exporting the data. 
Select the desired file type from the Save As Type drop-down list. Use the Save In window 
to select the location where the file should be saved. For details about the Save As 
command, refer to Section 4.4.2.7 "Save As".

A.2.5  Print

Use the Print command to print data from a method validation file. Executing the Print 
command opens the Print dialog box; displayed options vary based on the installed printer 
driver. The Print command can also be executed by clicking the Print toolbar button.

Figure A.6  Print Dialog Box 

Use the Print Range option to specify the range to be printed. The All selection prints all 
pages in the file. Specific pages can be printed by selecting the Pages option and entering 
the desired page numbers. Use the Number of Copies field to select the number of copies to 
be printed. 
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A.2.6  Print Preview

Use the Print Preview command to view the method validation file before printing.

Figure A.7  Print Preview Window

Button Description

Next Page and Previous Page Click the Next Page button to display the next page of the 
report. Click the Previous page button to display the previous 
page of the report. The Next Page button is disabled when the 
last page of the report is displayed, and the Previous Page 
button is disabled when the first page of the report is dis-
played.

One Page/Two Page Click the One Page button to display one page at a time in the 
Print Preview window. After selection, the button toggles to 
the Two Page button. Click the Two Page button to display 
two pages side by side.

Zoom In and Zoom Out Click the Zoom In and Zoom Out buttons to change the mag-
nification of the displayed pages. Three different zoom fac-
tors are available. Repeated selection of either option will 
continue to increase or decrease the magnification, as appli-
cable.

Close Click the Close button to close the Print Preview window and 
return to the previous window.The Print Preview window 
must be closed to edit the report.

Print Click the Print button to print the report.
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A.2.7  Print Setup

Select Print Setup to open the Print Setup dialog box.

Figure A.8   Print Setup Dialog Box

The print options available vary based on the printer installed. Select the paper size and 
source from the drop-down lists, and select Portrait or Landscape to change the orientation 
of the printed pages. Click the OK button to save the selections, or click the Cancel button 
to close the dialog box without saving changes.

A.2.8  Page Setup

Use the Page Setup command to select items to be printed and to select options for printing 
format, such as margins, headers, and footers. 

Figure A.9   Page Setup Window:  Data Tab

The Page Setup window consists of several tabs. Use the OK button to save changes and 
exit the Page Setup window. Click the Cancel button to exit the Page Setup window without 
saving changes. Click the Apply button to update the parameters without closing the Page 
Setup window.

Note: On each tab in the Page Setup window, certain items are checked (selected) by
default. To deselect these options, click the item.
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Data Tab

The Data tab displays a list of items that can be selected for printing. Select the desired 
items and click the OK button.

Grid Tab

Figure A.10  Page Setup Window:  Grid Tab

The Grid tab displays a list of format items for the report, as described below.

Option Description

Row Headers Prints row headers in the table.

Column Headers Prints column headers in the table.

Print Frame Prints a frame around the table.

Vertical Lines Prints vertical lines in the table.

Horizontal Lines Prints horizontal lines in the table.

Only Black and White Prints only in 2 colors, without gray backgrounds or other 
colors.

First Rows, then Columns Prints rows first, followed by columns, when more than one 
page is printed

First Columns, then Rows Prints columns first, followed by rows, when more than one 
page is printed.

Vertical Prints the table on the vertical center of the page.

Horizontal Prints the table on the horizontal center of the page.
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Miscellaneous Tab

Figure A.11  Page Setup Window:  Miscellaneous Tab

The Miscellaneous tab displays a list of format items for the report, as described below.

A.2.9  Exit

Select Exit to close the Method Validation application. If an active file contains unsaved 
information, a prompt to save changes is displayed. Select Yes or No, or select Cancel to 
abort the exit function.

Figure A.12  Prompt to Save Data Changes

Setting Item Description

Margins Use the spin controls to enter the page margins (in mm.).

Footer, Page No. Select this option to print the page number in the footer of 
each page.

Header Organization: Select this option and enter the name of the 
organization in the text box to print the organization name in 
the page header. 
Logo: Select this option to print a bitmap in the page header. 
Use the Browse button to select the bitmap file.
Date/Time: Select this option to print the current system date 
and time in the page header.
Operator: Select this option to print the current user name in 
the page header.
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A.3  Edit Menu

Options such as Cut, Copy, and Paste are available only if content is selected.

Figure A.13  Edit Menu

A.3.1  Undo

Use the Undo function to reverse the last change made in the data table. This function is 
available only in documents that can be manually edited and when the user changes the 
content of a cell in the data table.

A.3.2  Cut/Copy/Paste

Use the Cut, Copy, and Paste commands to edit highlighted table cells and rows. The Cut 
command deletes information in rows or cells and stores it on the clipboard. The Copy 
command copies data from rows or cells to the clipboard. The Paste command copies the 
contents of the clipboard to the current row of the table. When pasting a whole row, select 
the entire destination row first by clicking the row number.

Note: Do not select a row for pasting that currently contains data. The data will be over-
written!

TIP » The Cut, Copy and Paste commands have shortcut buttons on the toolbar.

A.3.3  Insert Row

Use the Insert Row command to add an additional row to the data table. This command is 
available only for documents that can be manually edited. TOC-Control V method 
validation documents have a fixed number of rows equivalent to the number of calibration 
points in the calibration curve.
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A.3.4  Delete Row

Use the Delete Row command to delete a row from the data table. The command is 
available only for documents that can be manually edited. TOC-Control V method 
validation documents have a fixed number of rows equivalent to the number of calibration 
points in the calibration curve. The Delete Row function is not available if the number of 
rows is 4 or less. Once a row is deleted, the format of the remaining rows is updated. A 
confirmation dialog box opens asking you to confirm the deletion. 

Figure A.14  Delete Row Confirmation Dialog Box

A.3.5  Insert Column

Use the Insert Column command to add an additional column to the data table. The 
command is available only for documents that can be manually edited. TOC-Control V 
method validation documents have a fixed number of columns equivalent to the maximum 
number of injections specified for the calibration points.

A.3.6  Delete Column

Use the Delete Column function to delete a column from the data table. The command is 
available only for documents that can be manually edited. TOC-Control V method 
validation documents have a fixed number of columns equivalent to the maximum number 
of injections specified for the calibration points. The Delete Column function is not 
available if the number of columns is 3 or less. Once a column is deleted, the format of the 
remaining columns is updated. A confirmation dialog box opens asking you to confirm the 
deletion. 

A.3.7  Recalculate

Use the Recalculate command to recalculate all method validation data. The results and 
calibration curve sections of the Method Validation window are also updated when the 
Recalculate command is selected. Errors that occur during the recalculation process are 
displayed in message boxes. For example, an error message may be displayed if the data in 
the table does not contain sufficient information, if there are not enough data points defined 
in the table, if less than 3 injections are available, and if numeric data is incorrect and 
results in an illegal mathematical operation (such as division by zero).

TIP » The Recalculate command has a shortcut button on the toolbar.
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A.4  View Menu

Figure A.15  View Menu

Toolbar

The Toolbar function displays or hides the toolbar. 

Status Bar

The Status Bar function displays or hides the status bar. 
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A.5  Options Menu

Figure A.16  Options Menu

A.5.1  General Parameter

Select the General Parameter command to display the General Information dialog box. 

Figure A.17  General Information Dialog Box

The General Information dialog box is used to view and edit information about the method 
validation file, such as the system used to create the file, the file version, the operator who 
created the file and the date on which the file was created. Some information fields may be 
disabled. Comments about the file are displayed in the Comment field.
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A.5.2  Method Validation Parameter

The Method Validation Parameter command displays the Method Validation Parameter 
window, which contains detailed information about the method, as described below.

Figure A.18  Method Validation Parameter Window 

Item Description

Enable manual editing Select to allow data tables to be edited manually. This option 
is disabled for files linked to TOC-Control V calibration 
curves. If this option is deselected, it is disabled and cannot 
be selected again. This option is selected by default.

Unit Displays the calibration curve units. This option is disabled if 
the Enable manual editing option is not selected.

Analysis Type Displays the analysis used to create the calibration curve. 
This option is disabled if the Enable manual editing option is 
not selected.

Date/Time Displays the date and time the file was created. 

Title Displays the title of the method validation file.

Calibration curve file name Displays the name of the TOC-Control V calibration curve.
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A.5.3  Font

Use the Font command to select fonts for printed reports and display screens. Selecting the 
Font command opens the Font dialog box. 

TIP » The Font command has a shortcut button on the toolbar.

Figure A.19   Font Dialog Box

Choose a font for printed reports by selecting options from the Font, Font Style, Size, Color 
and Script drop-down lists. A preview of the font appearance is visible in the Sample field 
on the lower portion of the Font dialog box.
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A.5.4  Floating Point Numbering Format

Use the Floating Point Numbering Format command to select display options for numeric 
results in the method validation tables. These options apply only to the manner in which 
numbers are displayed; internal data retain their original values.

Figure A.20  Floating Point Format Window

Common Floating Point Numbers

Percent Values

Setting Item Description

Number of significant digits Select this option to display common floating point numbers 
using a specified number of significant digits. Use the spin 
control to set the number of significant digits. The default 
value is 4.

Number of digits after the 
decimal point

Select this option to display common floating point numbers 
using a specified number of digits after the decimal point. 
Use the spin control to set the number of digits after the deci-
mal point. The default value is 2.

Setting Item Description

Number of significant digits Select this option to display percent values using a specified 
number of significant digits. Use the spin control to set the 
number of significant digits. The default value is 4.

Number of digits after the 
decimal point

Select this option to display percent values using a specified 
number of digits after the decimal point. Use the spin control 
to set the number of digits after the decimal point. The default 
value is 2.
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A.5.5  ASCII Export Options

Use the ASCII Export Options function to export method validation data to an ASCII file.

Figure A.21  ASCII Export Options Dialog Box

To export a file, create or open a method validation file. Select the desired options from the 
ASCII Export Options dialog box and select OK. The File>Save As dialog box is 
displayed. Enter a file name for the ASCII file and select the *.txt file type.

Setting Item Description

Header Select this option to export method validation file header.

Data Select this option to export method validation data.

Results Select this option to export method validation results.

Separator Select the type of separator to be used between items in the 
ASCII file.

Export strings in quotation 
marks

Select this option to add quotation marks to all exported 
strings.



Method Validation
Options Menu

364 TOC-VCPH/CPN

A.5.6  Validation Strictly Following DIN38402

Use the Validation Strictly Following DIN38402 option to conduct the validation 
calculation by DIN 38402 requirements; that is, only the area obtained from the first 
injection of every standard is used in the calibration calculation. When this option is not 
selected, the mean value of the area counts from all injections of each standard is used in 
the calibration calculation. 

Perform method validation according to DIN regulations as follows:

Step 1 Select the estimated working range.

Step 2 Prepare 10 calibration standards, with concentrations distributed uniformly 
over the complete working range.

Step 3 Create a Sample Table, with 10 injections of the highest and lowest standard 
concentrations and a single injection for all other standards. If more than one 
injection is made of the intermediate standards, the linearity test is calculated 
with the results of the first replicates only.

Step 4 Analyze the standards. The results are saved in a.cal file.

Step 5 Select Method Validation from the Tools menu in the Sample Table Editor. 
The Method Validation main window is displayed.

Step 6 Select the Validation Strictly Following DIN from the Options menu.

Step 7 Select Open from the File menu.

Step 8 Select.cal from the file type drop-down list.

Step 9 From the list of file names, select the.cal file where the measurement data was 
saved. Then select OK.

Step 10 The calculations are automatically performed, and the validation data 
displayed.

Step 11 Select Save from the File menu, assign a file name in the dialog box, and 
select OK. The validation data is saved with a.val file name extension.

When the Validation Strictly Following DIN option is enabled, a check mark is displayed in 
front of the menu item. After selecting this option, a confirmation message is displayed.

Figure A.22  Confirmation Message for Validation Strictly Following DIN 38402

Select Yes to execute recalculation. The calibration curve and result sections of the Method 
Validation window are updated accordingly.
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A.6  Help Menu

About Meth Val...

Use the About command to view copyright and version information.
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Appendix BControl Charts
The Control Charts software monitors precision and accuracy of a defined data set. The 
software supports five types of Control Charts:

•Mean Value Control Charts
•Recovery Control Charts
•Blind Value Control Charts
•Spanwidth Control Charts
•User Defined Control Charts

The Mean Value Control Chart checks the accuracy of an analytical method on an 
instrument. Control value drifts may indicate a change in system performance.

The Recovery Control Chart tests an analytical method for matrix influences and provides a 
restrictive control of accuracy by testing proportional system errors. Using certified 
standards will test the accuracy of the system as well as the recovery rate.

The Blind Value Control Chart is a special form of the Mean Value Control Chart used for 
quality assurance of the instrument and variable elements. Unlike the Mean Value Control 
Chart, the control value is the information value (absorbance, peak height, peak area) 
received from the analysis.

The Spanwidth Control Chart tests the precision of an analytical method and monitors the 
accuracy under actual conditions (Drift Control). For this type of Control Chart, there are 
several existing models for calculating the control and warning limits.

Each type of control chart can be used to create charts for different working range and 
analysis methods. For each control chart, a file is created which contains general 
information about the type, data structure and other global data.



Control Charts
File Menu

368 TOC-VCPH/CPN

B.1  File Menu

Figure B.1  File Menu

B.1.1  New

The New function is used to define new control charts and displays the Control Chart 
Wizard. Follow the Control Chart Wizard process to enter a new control chart. The file 
extension *.cc is used for all control charts.

Note: Control Chart parameters can be changed at a later time by selecting
Options>Control chart options from the main menu bar.

Control Chart Wizard System Information Window

The first page of the Control Chart Wizard is used to enter basic system information and is 
similar to the System Information pages in the Method and Sample Wizards. Refer to 
Section 4.4.5.2 "Sample" and Section 4.4.2.3 "Method Wizard". 

Figure B.2  Control Chart Wizard:  System Information Window
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Control Chart Wizard Control Chart Type Window

Select the type of control chart to be created and select the analysis type from the drop 
down list.

Figure B.3  Control Chart Wizard:  Control Chart Type Window

Control Chart Wizard Control Chart Parameters Window

Enter the control chart parameter values and limits as described below.

Figure B.4  Control Chart Wizard:  Control Chart Parameters Window

Setting Item Description

Automatic calculation of the 
control chart limits

Select to enable automatic calculation of the control chart 
limits. The upper and lower warning and control limits are 
calculated after the control samples for the preparation period 
are added to the control chart.

No. of samples in the pre-
period

Enter the number of samples in the preparation period. The 
default value is 12. This option is disabled if the Automatic 
calculation of the control chart limits option is not selected.

No. of samples in the control 
period

Enter the number of samples in the control period. The 
default value is 50.
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Control Chart Wizard Recovery Control Chart Parameter Window

This window is only displayed if the Recovery Control Chart is selected in the Control 
Chart Wizard, and Automatic calculation of the control chart limits is not selected.

Figure B.5  Control Chart Wizard:  Recovery Control Chart Parameter Window

Working range Enter the upper and lower limits of the working range. Match 
the range with the concentration of samples used for control 
tracking and the concentration range of the selected calibra-
tion curve. Use the drop-down list to select the units.

Rated Value Enter the rated value of the working range. This option is dis-
abled if the Automatic calculation of the control chart limits 
option is not selected.

Control Limits Enter the upper and lower control limits. This option is dis-
abled if the Automatic calculation of the control chart limits 
option is not selected.

Warning Limits Enter the upper and lower warning limits. This option is dis-
abled if the Automatic calculation of the control chart limits 
option is not selected.

Exclusion Limits Enter the upper and lower exclusion limits.

Setting Item Description

Use of certified standard Select this option to use a certified sample as a control sam-
ple.

Fixed theoretical concentra-
tion

Select this option if the standard has a fixed concentration. 
Enter the concentration in the text box.

Use of real sample Select this option if the control sample is a real sample.

Fixed concentration of the 
spiked component.

Select this option if the spiked component has a fixed con-
centration. Enter the concentration in the text box.

Setting Item Description
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Control Chart Wizard Spanwidth Control Chart Options Window

This window is only displayed if the Spanwidth Control Chart is selected in the Control 
Chart Wizard.

Figure B.6  Control Chart  Wizard:  Spanwidth Control Chart Options Window

Setting Item Description

No. of inj. per sample Enter the number of injections for a sample used in the con-
trol chart. The default value is 3, and the range is 3-25.

Refuse control samples with 
different inj. no

Select this option to exclude from the control chart samples 
whose number of injections differs from those specified in 
the No. of inj. per sample field.
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Control Chart Wizard History Window

The Control Chart Wizard History function is identical to other history functions in the 
TOC-Control V system. Refer to Section 4.4.2.3 "Method Wizard" for more details about 
the History function. The History window provides information on all control chart 
changes when enabled. 

Figure B.7  Control Chart Wizard:  History Window

B.1.2  Following Control Chart

Select the Following Control Chart menu item to create a Following Control Chart. It is 
recommended that a new control chart be created after 50 samples have been entered in the 
control period. The new control chart uses the calculated standard deviation from the 
control period as the new control chart limits. Control chart options are:

Setting Item Description

Enable history log Select this option to enable the History Log, which is used to 
monitor all modifications to the control charts. Once the His-
tory Log is enabled, it cannot be turned off.

Operator has to comment on 
all modifications

Select this option to require the user to enter comments or 
obtain approval for modifications to the control charts.

Setting Item Description

File Name Displays the name of the currently active control chart.

Save the current control chart 
as

Enter a new file name in this field to save the currently active 
control chart to a new location or with a new file name. A 
confirmation message is displayed to confirm the operation.

Create Select this option to create the Following Control Chart. The 
new limits are calculated from the samples of the control 
period stored in the previous control chart.

Parameter Select this option to display the parameters of the newly cre-
ated Following Control Chart. This function can also be 
accessed using the Options>Control Chart Options command 
in the main window. 
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B.1.3  Open

The Open command is used to open files. Select a *.cc file to open a control chart file. 
Refer to Section 4.4.2.4 "Open" for further information on the standard File>Open dialog 
box.

B.1.4  Save

The Save command saves the current control chart.

B.1.5  Save As

Use the Save As command to save files for the first time, or to save a file using a new file 
name. Files can be saved as file types *.cc or *.txt (ASCII format). For more information 
on the Save As function, refer to Section 4.4.2.7 "Save As".

B.1.6  Print>Data

Use the Print>Data command to print data in spreadsheet format. For more information on 
the Print function, refer to Section 4.4.2.10 "Print>Table".

B.1.7  Print>Graph

Use the Print>Graph command to print data in graphical format. For more information on 
the Print function, refer to Section 4.4.2.10 "Print>Table". 

B.1.8  Print Preview>Data/Print Preview>Graph

Use the Print Preview>Data function to display a preview of the data to be printed. Use the 
Print Preview>Graph function to display a preview of the graph to be printed. For more 
information on the Print Preview function, refer to Section 4.4.2.12 "Print Preview>Table".



Control Charts
File Menu

374 TOC-VCPH/CPN

B.1.9  Print Setup

Use the Print Setup command to select the printing parameters.

Figure B.8  Print Setup Dialog Box

The print options available vary based on the printer installed. Select the paper size and 
source from the drop-down lists, and select Portrait or Landscape to change the orientation 
of the printed file. Select OK to save the selections, or Cancel to close the dialog box 
without saving changes.

B.1.10  Page Setup

Use the Page Setup command to select items to be printed and to select options for printing 
format, such as margins, headers, and footers. 

Figure B.9  Page Setup Window:  Data Tab

The Page Setup window consists of several tabs. Use the OK button to save changes and 
exit the Page Setup window. Click the Cancel button to exit the Page Setup window without 
saving changes. Click the Apply button to update the parameters without closing the Page 
Setup window.

Note: On each tab in the Page Setup window, certain items are checked (selected) by
default. To deselect these options, click the item.
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Data Tab 

The Data tab displays a list of items that can be selected for printing. Select the desired 
items and click the OK button.

Grid Tab 

Figure B.10  Page Setup Window:  Grid Tab

The Grid tab displays a list of format items for the report. 

Option Description

Row Headers Prints row headers in the table.

Column Headers Prints column headers in the table.

Print Frame Prints a frame around the table.

Vertical Lines Prints vertical lines in the table.

Horizontal Lines Prints horizontal lines in the table.

Only Black and White Prints only in 2 colors, without gray backgrounds or other 
colors.

First Rows, then Columns Prints rows first, followed by columns, when more than one 
page is printed

First Columns, then Rows Prints columns first, followed by rows, when more than one 
page is printed.

Vertical Prints the table on the vertical center of the page.

Horizontal Prints the table on the horizontal center of the page.
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Miscellaneous Tab 

Figure B.11   Page Setup Window:  Miscellaneous Tab

The Miscellaneous tab displays a list of format items for the report, as described below. 

B.1.11  Exit

Select Exit to close the Control Chart application.

Setting Item Description

Margins Use the spin controls to enter the page margins (in mm).

Footer, Page No. Select this option to print the page number in the footer of 
each page.

Header Organization: Select this option and enter the name of the 
organization in the text box to print the organization name in 
the page header. 
Logo: Select this option to print a bitmap in the page header. 
Use the Browse button to select the bitmap file.
Date/Time: Select this option to print the current system date 
and time in the page header.
Operator: Select this option to print the current user name in 
the page header.
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B.2  Edit Menu

Figure B.12  Edit Menu

Copy

Use the Copy command to copy the selected range from the data table to the clipboard.

Recalculate

Use the Recalculate command to recalculate the limits of the control chart. This function 
should be performed after one or more control samples have been excluded or added to the 
control chart.

Exclude

Use the Exclude command to exclude a selected range of control samples from the control 
chart calculations. When Exclude is selected, the Exclude dialog box is displayed. Enter a 
comment describing the reason for excluding the sample. The Exclude function is only 
available when one or more control samples are selected. A dialog box displays a message 
requesting confirmation that the sample be excluded. Select Yes to confirm and recalculate 
the control limits, or No to abort recalculation.
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B.3  View Menu

Figure B.13  View Menu

B.3.1  Statistics

The Statistics command displays the Statistics window. 

Figure B.14  Statistics Window

Setting Item Description

Type Displays the type of control chart.

No. of samples (pre-period) Displays the number of samples in the preparation period. 
This value was entered in the Control Chart Wizard.

Total no. of samples Displays the total number of samples in the control chart. 
Excluded samples are not included in the total number.

Control limits Displays the control limits.

Data from the control period Displays the Average Control Value, which is the mean value 
of the samples in the control period. Also displays the calcu-
lated standard deviation and coefficient of variation.
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B.3.2  Comparison

After a control chart is completed, the results from the control period must be compared 
with the results from the preparation period. For control charts without a preparation 
period, the current values must be compared with the results of the preparation period or the 
control period from the previous control chart. The View>Comparison command displays 
the Comparison between control charts window.

Figure B.15  Comparison Between Control Charts Window

Setting Item Description

Previous control chart Displays the file name of the previous control chart, if appli-
cable.

Mean value t-test Displays the results of the T-test in the text box beneath the 
Item and Value lists. The T-table value and the calculated test 
value are also displayed in the Item and Value list. The test 
value is calculated based on the mean values and variances 
obtained from the control and preparation period. The T-test 
result shows whether the long term deviation of the control 
samples is significant. 

F-test Displays the results of the F-test in the text box beneath the 
Item and Value list. The F-table value and the calculated test 
value are also displayed in the Item and Value list.
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B.3.3  Out of Control Events

The Out of Control Events window displays a list of all out of control events.

Figure B.16  Out of Control Events Window

Spl. No.

Displays the sample number for which the out of control event occurred.

Event

Describes the out of control event.

B.3.4  Toolbar/Status Bar

The View>Toolbar and View>Status Bar commands show and hide the Toolbar and Status 
Bar, respectively.
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B.4  Options Menu

Figure B.17  Options Menu

B.4.1  Control Chart Options

Use the Control Chart Options command to view and edit the control chart parameters 
entered in the various pages of the Control Chart Wizard. Refer to Section B.1.1 "New". 

Note: Some options within the Control Chart Options tabs (such as control chart type or
sample concentrations) may be disabled if the control chart contains data. The
disabled parameters are options that cannot be modified once data is entered.

B.4.2  Font

The Font command opens the standard Font dialog box. Refer to Section 4.4.9.3 "Display 
Settings>Display Font" for detailed information about font options.
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B.4.3  Floating Point Numbering Format

The Floating Point Numbering Format command is used to select display options for 
numeric results in the control charts. These options apply only to the manner in which 
numbers are displayed; internal data retain their original values.

Figure B.18  Floating Point Format Window

Common Floating Point Numbers

Percent Values

Setting Item Description

Number of significant digits Select this option to display common floating point numbers 
using a specified number of significant digits. Use the spin 
control to set the number of significant digits. The default 
value is 4.

Number of digits after the 
decimal point

Select this option to display common floating point numbers 
using a specified number of digits after the decimal point. 
Use the spin control to set the number of digits after the deci-
mal point. The default value is 2.

Setting Item Description

Number of significant digits Select this option to display percent values using a specified 
number of significant digits. Use the spin control to set the 
number of significant digits. The default value is 4.

Number of digits after the 
decimal point

Select this option to display percent values using a specified 
number of digits after the decimal point. Use the spin control 
to set the number of digits after the decimal point. The default 
value is 2.
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B.4.4  ASCII Export Options

The ASCII Export Options function is used to export control chart data to an ASCII-
formatted file.

Figure B.19  ASCII Export Options Dialog Box

To export a file, create or open a control chart. Select the desired options from the ASCII 
Export Options dialog box, and select OK. The File>Save As dialog box is displayed. Enter 
a file name for the ASCII file and select the *.txt file type.

B.4.5  Enable Exclusion

Use the Enable Exclusion command to exclude a selected range of control samples from 
the control chart calculations. When the Enable Exclusion command is executed, the 
Exclude dialog box is displayed. Enter a comment describing the reason for excluding the 
sample. This option is only available when one or more control samples are selected. A 
dialog box displays a message requesting confirmation that the sample be excluded. Select 
Yes to confirm and recalculate the control limits, or No to abort the process.

Setting Item Description

Header Select this option to export control chart file header.

Data Select this option to export control chart data.

Limits Select this option to export control chart limits.

Separator Select the type of separator to be used between items in the 
ASCII file.

Export strings in quotation 
marks

Select this option to add quotation marks to all exported 
strings.
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B.5  Help Menu

About ContrCharts...

Use the About command to view copyright and version information.
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